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1. EasyBuilder Pro Installation

and Startup Guide

This chapter explains how to install EasyBuilder Pro.

1.1.  Installation REQUIFEMENTS........cciiiiiiee ettt et e e e e e e e e s eneeeeeeaes 1-2
1.2.  Steps to Install EaSyBUIlAer Pro .......coooccuiiiiiciiie ettt e e e e 1-3
1.3.  Software Update REMINAET .....ccooiiiie et e e e e e e e e eneeeeeeaas 1-7
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1.1. Installation Requirements

Software:

Visit Weintek Labs, Inc.’s website at and download the installation
package which include the following languages: Simplified Chinese, Traditional Chinese,
English, Japanese, German, Italian, Korean, Spanish, Russian, French, Polish, and Turkish. The

latest updates can be downloaded too.

Operating System:

Windows® 7 SP1 (32bit / 64bit)
Windows® 8 (32bit / 64bit)
Windows® 8.1 (32bit / 64bit)
Windows® 10 (32bit / 64bit)
Windows® 11 (32bit / 64bit)
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1.2. Steps to Install EasyBuilder Pro

1. Click [Install] and select the language for the installation process, and then click [Next].

15! Setup - EasyBuilder Pro V6.05.02.200 o] @

Welcome to the EasyBuilder Pro

C‘@ V6.05.02.200 Setup Wizard

This will install EBpro V6.05.02.200 on your computer.

Itis recommended that you close all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

{ Next > ‘ [ Cancel ‘

2. Ifthere is a previous version of EasyBuilder Pro on the PC, please remove it before
installation.

3. Please read and accept the License Agreement before continuing.

15! Setup - EasyBuilder Pro V6.05.02.200

@

)
License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

GENERAL TERMS ("The Terms”)

Version 2.0
March 2019

1. OWNERSHIP AND ABOUT THE TERMS

1.1 cMT Viewer, EasyBuilder Pro, EasyConverter, EasyDownload, EasyDiagnoser,
EasyLauncher, EasyPrinter, and Utility Manager software ("Weintek Software”) is
developed by Weintek Labs., Inc. ("Weintek™), and the authorized user will be
granted for license to operate it exdusively on Weintek's specific products 2

9 I accept the agreement

(7)1 do not accept the agreement ( Third-party Licenses... ]

[ < Back H Next > ][ Cancel ‘

4. Select a folder for EasyBuilder Pro installation, or use the default folder. Click [Next].
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15! Setup - EasyBuilder Pro V6.05.02.200 =) B ]

Select Destination Location H
Where should EasyBuilder Pro V6.05.02. 200 be installed? C

J Setup will install EasyBuilder Pro V6.05.02.200 into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

C:\EBpro Browse...

At least 1,685.8 MB of free disk space is required.

[ < Back ][ Next > ][ Cancel

5. Select a start menu folder, or use the default folder. Click [Next].

(5 Setup - EasyBuilder Pro V6.05.02.200 =<

Select Start Menu Folder
Where should Setup place the program's shortcuts?

(v
L'] Setup will create the program's shortcuts in the following Start Menu folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

EasyBuilder Pro Browse...

[ < Back ][ Next > J[ Cancel ]

6. Select additional tasks, for example: [Create a desktop icon]. Click [Next].
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Select Additional Tasks H
Which additional tasks should be performed? C

Select the additional tasks you would like Setup to perform while installing EasyBuilder
Pro V6.05.02.200, then dick Next.

Additional icons:

[V] Create a desktop icon

[ < Back H Next > ][ Cancel ]

15! Setup - EasyBuilder Pro V6.05.02.200 =) B ]

all setting. To change the setting, click [Back]. To start installation, clic

i5! Setup - EasyBuilder Pro V6.05.02.200 = @ [

Ready to Install H
Setup is now ready to begin installing EasyBuilder Pro v6.05.02.200 on your C
computer. <

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\EBpro

Start Menu folder:
EasyBuilder Pro

Additional tasks:
Additional icons:
Create a desktop icon

< Back ]{ Install ] [ Cancel l

k [Install].

8. Installati
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Installing

Extracting files...

_6—' Setup - EasyBuilder Pro V6.05.02.200

Please wait while Setup installs EasyBuilder Pro v6.05.02. 200 on your computer.

C:\EBpro\firmware\opcua.c30

L |

1

=

Cancel

9. Click [Finish] to complete the installation.

BJ Setup - EasyBuilder Pro V6.05.02.200 ol @ | &

&

Welcome to the EasyBuilder Pro
V6.05.02.200 Setup Wizard

Setup has finished installing EasyBuilder Pro v6.05.02,200on
your computer. The application may be launched by selecting
the installed icons.

Click Finish to exit Setup.

| Finsh |

10. The EasyBuilder shortcut can be found in [Start] » [All Programs] » [EasyBuilder Pro].

The description of each item in EasyBuilder Pro menu:

Installed file

Description

Administrator Tools

Saves User Accounts, USB Security Key, e-Mail SMTP
Server Setting, e-Mail Contacts to an external device
(USB drive or SD card) so that the data become
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portable and can be imported to HMI.

cMT Viewer Supports access to cMT / cMT X Series HMI via
network, for operating cMT / cMT X Series HMI on
PC.

Easy Access Supports access to remote HMI by connecting

EasyAccess server over Internet.

EasyBuilder Pro

EasyBuilder Pro project editor.

EasyConverter

Conversion tool for Data Sampling and Event Log.

EasyDiagnoser

Monitoring and debugging tool operated on HMI.

EasyPrinter

Allows exporting data to a remote server on PC via

Ethernet, realizing remote printing / backup.

EasySimulator

Executes simulation.

EasySystemSetting

Allows updating hardware system settings by using
SD card or USB drive.

EasyWatch

An easy to use debugging and remote monitoring
tool running on PC that allows monitoring or setting
HMI and PLC addresses and executing macro.

Recipe Editor

Tool for setting the format of Recipe data. Users can
open Recipe data or the data in the External

Memory.

Release Note

Software release notes.

UtilityManagerEx

EasyBuilder Pro management tool.

‘@ Note

Certain HMI supports downloading/uploading projects via USB cable. After installing
EasyBuilder Pro, the USB driver will be automatically installed. A message saying
“Windows can’t verify the publisher of this driver” may show, please continue anyway.
After installing the USB driver, open [Computer Management] » [Device Manager] to

check if installation succeeded.

1.3. Software Update Reminder

After launching EasyBuilder Pro, the system will check whether the latest version has been

installed, and show a reminder dialog if there is a newer version.
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Software Update X

EI A new version of EasyBuilder Pro is avaliable.

EasyBuilder Pro v6.05.02.200 is now avaliable. Would you like to
download it now?

Remind Me Later™ | |Download Mow

After clicking [Download Now], the latest version of EasyBuilder Pro will be downloaded to a
temporary folder, and a progress bar is shown as below. After download, please follow the
steps explained in the previous section to install EasyBuilder Pro.

&J tasyBuilder Pro Downloading — >

downloading. ..

[ 2%

Cancel

@ Note

B In [File] » [Preferences] » [Misc] an option can be selected to receive a notification when a
new version of EasyBuilder Pro is available.

Users can open File » About in EasyBuilder Pro to see current version and check for updates.

About EasyBuilder Pra *

EasyBuilder Pro V6.05.02, 180 Build 2021.01.18
| ‘I Copyright c 2006 Weintek Lab., Inc.

All rights reserved

Licenses 4 sreement. .
Third-pauty Licenses... Check for updates... i 0K
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2. Utility Manager

This chapter explains how to use Utility Manager.

2.1, OVEIVIEW ceiiieeieetetee et ee ettt e e e e e sttt e e e e e s e s bbbttt e e e e e e s e annrbeeeeeeeesaa s baeeeeeeeeeenannnreeas 2-2
A 1 T I -{ o E TR 2-3
2.3, ANAIYSIS & TESHING ceeeeiei it e e e e s e e e e s e e e e e e e e a e nnnarees 2-4
2.4, PUDBIISN e e e e e areee s 2-6
D TR |V, 1= Y1 o 1 (T o = o [l < ST PP PP UOPPPUPPPPPPR 2-11
2.6, Data CONVEISION....ciiiiiiieieietttee e ettt e e e e e s ettt e e e e e s e abbbeeeeeeesesananrbeeeeeeeesennns 2-13
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2.1. Overview

After installing EasyBuilder Pro, double click [UtilityManagerEx] shortcut on the desktop to

start. Utility Manager is for launching several utilities and it is a stand-alone program. Please

select a model first and note that certain features may not work as expected if an incorrect

model is selected.

Utility Manager
> lloT Gateway Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

Data
Conversion

| Run ® \ Edit®

@0

TK Series
S
e ©
E P Series ,, the HMI screen

projects.

=z | IESeries
; /iewer
v eMT Series svices (or related
: isponding operable PLC

nats.

:}'il XE Series
c¢MT Series )y On-line Simulation @

mulation (without PLC).
cMT X Series - Standard

=107 oM X Series - Advanced

2-2

Utilities

Description

Minimize Utility Manager window.

Close Utility Manager.

v

Add the frequently used utilities to the toolbar at the bottom of
the window.

Run

Run the selected utility on the toolbar.

Edit

Delete the selected utility on the toolbar.

[\& WE!NTEK
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2.2. Design
EasyBuilder Pro @
- Launch EasyBuilder Pro, the HMI screen

Design composer/editor, to edit projects.

Analysis &

Testing .
EasyAddressViewer @
Show supported PLC devices (or related

Publish devices), and their corresponding operable
PLC address ranges and formats.

Maintenance g 3
Simulation
Simulate a HMI on PC by On-line Simulation

Data (with PLC) or Off-line Simulation (without PLC).

Conversion

Run ® Edit® [
Utilities Description

EasyBuilder Pro

Launch EasyBuilder Pro to edit projects.

EasyAddressViewer

Review the address ranges and formats of supported PLCs.

Simulation

Simulate an HMI on PC by running On-line Simulation or Off-line
Simulation. Please select an .exob / .cxob file as source first.
Off-line simulation: Simulate project operation on PC without
connecting any devices.

On-line simulation: Simulate project operation on PC and PLCs
are directly connected with PC.

0 Note

B When using [On-line simulation] on PC, if the target device is
a local PLC (the PLC directly connected to PC), there is a one-
hour simulation limit.
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2.3. Analysis & Testing

Utility Manager ° °
> lloT Gateway Series

[ select Model > ]
cMT Diagnoser @

On-line monitoring and debugging tool. Diagnose
the connection status between PC/HMI and PLC.

Analysis &

Testing EasyWatch @

A debug/monitor tool that monitors HMI/PLC
addresses, or execute macro on HMI.

Publish

Maintenance Reboot @

Restart a HMI to its initial condition by Ethernet or
USB connection.

Data
Conversion

Utilities Description
cMT Diagnoser A diagnostic tool that can monitor data and status of all objects in

the current window when it is connected to a cMT Series HMI,
show the status of individual communication packet, show
communication status with MQTT server, and debug macros.

LA—?See “31 cMT Diagnoser”.

EasyDiagnoser Diagnoses the connection status between eMT/iE/XE/mTV HMI
and PLC.

C?See “33 EasyDiagnoser”.

EasyWatch Allows users to monitor or configure HMI or PLC address values

via Ethernet on PC.

C?See “35 EasyWatch”.

Reboot HMI Reboots the HMI without unplugging. After reboot, the system
returns to the initial state.

Serial Pass- Opens a local serial port (virtual/physical) and allow other PC

RWE!NTEK EasyBuilder Pro V6.10.01
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Through applications to connect to PLC via HMI.
The Serial Pass-Through feature provides two modes: Ethernet
and COM port.
Before using [Ethernet] mode, please check if virtual serial port

driver has been installed.

E?See “29 Pass-through”.

Ethernet Pass- When PC and PLC are respectively connected to different

Through Ethernet ports of a Dual-port HMI, this feature allows running the
application on PC to control PLC through HMI. This feature is only
supported on cMT / cMT X Series models.

E?See “29 Pass-through”.

Pass-through feature allows the PC application to connect PLC via HMI. In this case, the HMI
works like a converter.
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2.4. Publish

Utility Manager
> lloT Gateway Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

Data
Conversion

o | e (I

Download
Download given files from PC to HMI, such as

firmwares, project, recipes, data log, or startup
screen.

Upload
Upload data from HMI to PC, such as project,

recipes, event logs, operation logs, data logs, or
extended memory (EM).

2-6

2
Utilities Description

Download Downloads project file to HMI via Ethernet or USB cable.
Upload Uploads files on HMI to PC via Ethernet or USB cable.

Build Download Builds the data to be downloaded to HMI in an SD card / USB
Data for SD/USB drive. For cMT / cMT X Series, the data needs to be built in
Disk EasyBuilder Pro.

[\& WE!NTEK
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2.4.1, Download (PC->HMI)

Download files to HMI via Ethernet or USB cable.

eMT, iE, XE, mTV Series

cMT, cMT X Series

Download (PC->HMI)

[¥|Runtime (firmware) [VImQrT [~ Diagnostic tool

V| Project PLEASE INPUT EXOB FILE NAME !

VIRW PLEASE INPUT RECIPE FILE NAME !

V|RW_A PLEASE INPUT RECIPE_A FILE NAME !
[V|Recipe database PLEASE INPUT RECIPE DATABASE FILE NAME !

[¥] startup screen PLEASE INPUT LOGO FILE NAME !

[] System settings PLEASE INPUT A SYSTEM SETTINGS NAME !

2-7

Download (PC->HMI)

[7]usB audio driver Connection

@) Ethernet

Browse...

4 P | HMIName
Browse...
B -

[] Project
RW PLEASE INPUT RECIPE FILE NAME !
RW_A PLEASE INPUT RECIPE_A FILE NAME !

Recipe database

Startup screen

Use system settings file

Connection
@ Ethernet USE cable

4| /1P’ HMIName

[ ] pelete existing user accounts
["] pelete existing e-Mail contacts and SMTP settings

Reset recipe (RW, RW_A) Reset recipe database

| Delete existing user accounts, e-Mail contacts and SMTP settings

Port No. Setting...

Password : 111111 [TMask

PLEASE INPUT RECIPE DATABASE FILE NAME !
PLEASE INPUT START-UP SCREEN FILE NAME !

[ Reset operation log

HMI: v [192.168.2.142 (HMI-0396) [] Reset event log [] Reset data log [ Reset string table
192.168.2.223 (HMI-EDFA) .
192.168.2.231 (MTS0S0XE-FAE) Reset startup screen [ "] Reset OPC UA history (HDA) [ Synchronize HMI dlock with PC
Search Al ["IReset FRW en HMI and all cMT Viewers
CODESYS
= — = [Tl Project
|Reboot HMI after download | Synchronize HMI dock with PC [ Delete startup screen
["]Reset recipe (RW, RW_A) [¥]Reset data log [7]Reset eventlog
[ |Reset recipe database V| Reset operation log [V|Reset string table

Password : 111111 [ Mask

Port No. Setting...

Setting

Description

Project

Select an .exob or .cxob project file. For a cMT /
cMT X project, the Project Checksum will be
shown under the directory of the project for
users to check whether the project file has been

tempered with.

Runtime (firmware)

Update HMI kernel programs. The firmware
must be downloaded at the first time

downloading data to HMI.

MQTT

If MQTT is used in the project and HMl is the
broker, this checkbox must be selected before

download.

Diagnostic tool

Enable the diagnostic tool to send diagnostic
data to the developers when an error occurs for

quick troubleshooting.

USB Audio Driver

Enable audio output on HMI so it can
immediately emit a sound when a USB sound

card and a speaker are connected.
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RW /RW_A

Select an .rcp recipe file.

Recipe database

Select a .db file of Recipe Database.

Startup screen

Download a .bmp file to the HMI, which will be
displayed after the HMlI is started, and then the
downloaded project is loaded. Please note that
when downloading a project to a cMT / cMT X
model, it is not possible to select both Project
and Startup Screen in the download window.

Use system settings file

Select a .conf system settings file.

Reboot HMI after
download

Automatically reboot after download.

Port No. Setting

Select the port by which to download the

project file via Ethernet.

Synchronize HMI clock
with PC

Synchronize HMI time with PC time when

downloading project file.

Reset recipe / recipe
database / event log /
data log / operation log
/ string table / OPC UA
history (HDA) / startup
screen / Delete existing
user accounts, e-Mail
contacts and SMTP
settings

Erase the selected files on HMI before
download.

CODESYS

Use Utility Manager to download CODESYS boot

project.
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2.4.2, Upload (HMI->PC)

Upload files from HMI to PC via Ethernet or USB cable. Click [Browse] and assign the file path

before uploading.
eMT, iE, XE, mTV Series

cMT, cMT X Series

Upload (HMI-»PC)

Port No. Setting. Password : 111111 [IMask Upload (HMI->PC)

Upload (HMI->PC) x
Connection

Project PLEASE INPUT EXOB FILE NAME !

(®) Ethernet (O USE cable
RW PLEASE INPUT RECIPE FILE NAME |
[@Rw_a PLEASE INPUT RECIPE_A FILE NAME | 4] P HMI Name
[9]Recpe database PLEASE INPUT RECIPE DATABASE FILE NAME | HMI : | cMT3090-FAE MBIl 192.165.2.220 (cMT3090-FAE) ~
Operation log PLEASE INPUT OPERATION LOG FILE NAME |

Search
Data log PLEASE INPUT DATA LOG FOLDER NAME |
Eventlog PLEASE INPUT EVENT LOG FOLDER NAME ! Search All
Use CSV (Comma Seprated Values) format to save data/event log fies Search and Change IP
Extend Memory (EM)  PLEASE INPUT EM FOLDER NAVE |
EM file location : () 5D card @ usB disk [“Project
| c:\usersiuser \Desktop\eMT3090.cxab [ ]
History

Redpe Recipe database

Comnection Event log Data log Operation log
(@ Ethernet () USB cable
C: kol
4| TP HMIName B [Cesersserfpeskiop [E5]
HMI : -
Search All

Port No. Setting... Password : [ 111111 [IMask Upload Exit

Setting

Description

Event log

Upload the .evt file on HMI to PC.

Extended Memory
(EM)

Upload the .emi file saved in SD card or USB disk
to PC.

or For information about [Project], [RW / RW_A], [Recipe database] or [Data log], see “2.4.1

Download” in this chapter.

@ Note

B The file will be uploaded to PCin .

exob / .cxob format. Please decompile it into

editable .emtp / .cmtp file first and open the .emtp / .cmtp file in EasyBuilder Pro.

B To upload the historical files saved in the external device, please use FTP. See “32 FTP

Server Application” for more information.
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2.4.3.

A W NR

Build Download Data for SD/USB Disk

Build Download Data for SD/USE Disk (=25

Select the folder to save download data :

PLEASE INPUT DIRECTORY NAME !

Sources

Project

PLEASE INPUT EXOB FILE NAME !
Recpe (RW)

PLEASE INPUT RECIPE FILE NAME |
Redpe & (RW_A)

PLEASE INPUT RECIPE_A FILE NAME !
Data log

PLEASE INPUT DATA LOG FILE NAVE !
User-defined startup screen

PLEASE INPUT START-UP SCREEN FILE NAME ! Browse...
E—R—

Insert an external device (SD card or USB drive) to PC.
Designate the directory to save data.

Browse for the directory of the source files.

Click [Build] to create download file.

Files will then be saved to the inserted device for users to download to HMI without having to
use a USB cable or Ethernet.

2.4.4,

Steps to Download Project to HMI via USB Disk or SD Card

To download data in a folder (e.g. a folder named “123” (K:\123)) in a USB disk.

1.
2.
3.
4

5.

6.
7.

Insert USB (in which the project is saved) to HMI.

In [Download / Upload] dialog box select [Download].

Enter Download Password.

In [Download Settings] dialog box, select [Download project files] and [Download history
files].

Press [OK].

In [Pick a Directory] dialog box, select directory: usbdisk\disk_a_1\123.

Press [OK].

Project will then be updated.

@ Note

If history data is downloaded but not the project file, please reboot HMI to update files.

I__| WE!NTEK EasyBuilder Pro V6.10.01
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2.5. Maintenance

Options in this tab may vary according to model.

Utility Manager
> cMT Series

@0

D Select Model >

Design

Analysis &

Testing Crr'T
A

[ &

Publish

Maintenance

Data
Conversion

Vieyver

|

Administrator Tools

Build user account and mail setting files in a USB
drive/SD card without modifying project file, and
then transfer them to HMI by USB/SD.

cMT Viewer
Connect to a cMT-SVR machine. PC acts as a

display terminal for cMT-SVR.

cMT-iV5/iV6 Firmware
Update
Update firmware on cMT-iV5/iV6 @

2-11

Utilities Description

Administrator Allows saving the data of [User Accounts], [USB Security Key], [e-

Tools Mail SMTP Server Settings], and [e-Mail Contacts] to USB.
C?See “36 Administrator Tools”.

cMT Viewer cMT Viewer can connect to a cMT / cMT X Series model. PC is the
display terminal for cMT / cMT X project.

cMT-iV5/cMT-iV6 o _ _

. Updates cMT-iV5/iV6 runtime (firmware) or OS.

Firmware Update

cMT-Server OS
Updates cMT-SVR/SVR-200 OS.

Update

cMT-

Gateway/CTRL OS Updates cMT-Gateway/CTRL OS.

Update

CODESYS Firmware )
Updates CODESYS firmware on cMT / cMT X HMI.

Upgrade

SSL/TLS Certificate Upgrades the built-in expired SSL/TLS certificate on HMI.

I__IVWE!NTEK
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Upgrade

FTP Server
Certificate Update

Update the certificate and private key for the FTP server on the
HMI.

HMI Information
Collector

Obtains a file with diagnostic information from HMI.

EasyPrinter /
Backup Server

Runs remote backup/printer server on PC.

Data/Event log

Information

Connects with HMI via USB cable or Ethernet to check the
number of history files on HMI. This feature is not supported on
cMT / cMT X Series.

Data/Event Log File Information \EI

B- sample_HMIL
: - 1.20130826.dtl

- 2,20130825.dt
-3.20130824.0H
- 4,20130822.d1
\..5.20130821.0t
[#]- GreenHouse

B event log

-1, EL_20130830.evt
-2, EL_20130826.evt
-3, EL_20130809.evt

EasyAccess 1.0

Supports access to remote HMI by connecting EasyAccess server

over Internet. You can find more information at: www.ihmi.net

0 Note

B HMI Information Collector is available only on cMT / cMT X Series models, and the

applicable OS version is 20210705 or later.

I__| WE!NTEK
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2.6. Data Conversion

Utility Manager
> iE Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

Data
Conversion

a. 4

Recipe Database Editor @

Modify recipe database (without modifying the
project directly).

EasyConverter @

Convert HMI-generated data logs (.dtl), event
logs (.evt) into Excel-compatible .csv files.

Recipe Editor @

Create/modify recipes (RW, RW_A) or extended
memory (EM).

2-13

Utilities

Description

Recipe Database
Editor

Edits recipe data.
A

Click the icon to download the document about Recipe

Database.

Easy Converter

Reads HMI-generated data logs, event logs, and operation logs
and converts the files to Excel (.xlsx) format.

C?See “25 EasyConverter”.

Recipe Editor

Creates new recipe data to be used on HMI and modifies the

existing recipe data.

L/jif’See “24 Recipe Editor”.
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Create an EasyBuilder Pro Project

3. Create an EasyBuilder Pro

Project

This chapter explains the basic steps to create an EasyBuilder Pro project.

N R O V=T oV =1 PP OO P PP PTPT PP 3-2
3.2, Create @ NEeW ProjeCt FIle ...ttt e e e e 3-2
3.3. Save and Compile the Project File ...t 3-4
3.4. Compile and QUICK COMPIIE c.oeveii e e 3-5
3.5. Run On-Line or Off-Line Simulation ........ccccovcuiiiniiiiiieeciecciecciee e 3-6
3.6, CIMIT VW ettt ettt e e e e e e ettt et e e e e e s et be et e e e e e se s bbeeeeeeeesesansnreeas 3-6
3.7. Download the Project File to HMI .......oviiieiiiiieeee et 3-7
3.8.  Upload the Project File from HMI.........ccooouiiiiiiiiiee e 3-14
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3.1. Overview

The following is the process of creating a project.

1.
2.
3.
4.

Create a new project file.
Save and compile the project file.
Run On-line or Off-line simulation.

Download the project file to HMI.

The following describes each process.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

3.2. Create a New Project File

1.
2.

3.

Launch EasyBuilder Pro and open a new project file.
Select a model and select [Use template] check box.

@ New

New Project

Open

Model: | 4 I8 iP Series
MT80S1iP (480 x 272)
MT8051iP (480 x 272)
MT6071iP/MT8O71iP (800 x 480)
MT6103iP (1024 x 600)
MT8102iP (1024 x 600)
MT6102iQ (1024 x 600)

4 @ eMT Series
eMT3070 (800 x 480)

£eMT3105 (800 x 600)

eMT3120/eMT3150 (1024 x 768)
4 B iE Series
MTB8050iE (480 x 272)
MT6070iE (800 x 480)
MT6071iE (800 x 480)
MT8070iE/MT8100iE (800 x 480)
MT8071iE/MT8101iE (800 x 480)
MT8073iE (800 x 480)

m

[¥] Use template (template_800x600.emtp)

[Un(cmpress Projé:t] [.L, Demo Projectl

eMT3105

Orientation :

[ Portrait

Click [New] button in the Device tab and select a device.
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Create an EasyBuilder Pro Project

System Parameter Settings =]
Printer/Backup Server l Time Sync./DST | e-Mail | Recipes | Cellular Data Network
Device | Model | Gemeral | SystemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's my IP ?
Name Location ~ Device type Interface IIF Protocol

(3 Local HMI Local HMI lLocal  [em73105(800..[- |- |

<« w »

[ New... ][ Delete ][ Security... ]

4. Configure parameters.

Device Properties

Name : | Mitsubishi FX0S/FXON/FX1S/FXLN/FX2
) HMI @ PLC

PLC type : [ Miteubishi FEO3/FXON/FL L 3/FH 1 N/FES | » ]

[\l’.l.‘-ﬂ], MITSUBISHI_FX0OM.230

PLCUF : [Rs-485 4W -

* Support communications between HMI and PLC in pass-through mode
* Gt LW-9903 to 2 to enhance the speed of download/upload PLC program in pass-through mode

COM : (COM1 (9600,E,7,1) Settings...

PLC default station no. : o

[C] Default station no. use station no. variable

[T use broadcast command

Interval of block pack (words) :

Max. read-command size (words) @ 22

Max. write-command size (words) : |32

I 0K ] [ Cancel
5. A new device is added to the [Device List].
(= > =
System Parameter Settings
|  Printer/Backup Server | TimeSync/DST | eMail | Recipes |  Cellular Data Network
Device | Model | Genersl | SystemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's my [P ?
No. Name Location Device type Interface I/F Protocol
il Local HMI Local eMT3105 (800 ... -
» Local PLC1 |Mitsubishi FXO... Mitsubishi FX0... |COM 1 (9600,E... |RS485 4W

6. Create an object, for example, a Toggle Switch, and then set the address.
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7.

[New Toggle Switch/Bit Lamp Object @
General | Security | Shape | Label |

Comment :

() Bit Lamp @ Toggle Switch

[V] ReadMrite use different addresses

Read address
PLC : [Mitsubishi FXOS/FXON/FXIS/FXIN/FX2 <[ Settings...
Address: (g -] 0 i
[ Invert signal
Write address :
PLC : [Mitsubishi FXOS/FXON/FX I S/FE1N/FR2 - | Settings..
Address : [Y v] 0 \
[ Write when button is released
Attribute

Place the object in the edit window. A project is now created.

EasyBuilder Pro : EBProjectl - [10 - WINDOW_0101 fo &=
File B &= « » ;: BEEUEE Project  Object Data/History View  Tool - 8 X &
= Y v 3] | O8] | ~ - > ] i ~ |5 -

@ % A-D 9@ @ 5 i : AdobeDevanagari 5 Bl s> <3 4l
— fore) BEE--EEE- A A7 A T
Paste System = £ o3 ¥ s 1
Parameters e eoncit o B 8 === A L1/L2 13 L4
Clipboard Editing Object Arrange Font State/Language

Windows v X dq 10 - WINDOW_ 010 X 3

jobjkal '! ‘|I|I|I|I|I|I|I|I|IP|C1|I|I|I|I|I|I|I|I3Pﬁxl|l|l|||l|l|l-l|;ID|C||l|I|I|IxI|I|I|I|AP|01|I|I|I|I|I||I|I|||5IO|0||I|I|I|I|||I|I|Ixﬁlonol|I|||I|I|I-I|I|I|.IO|OI|I|I|I|I|I|I|I|I|I|!

| 3 : Fast Selection - 1

4 : Common Window @
5:PLC Response

6 : HMI Connection

7 : Password Restriction

8 : Storage Space Insufficient
9:Backup

*10: WINDOW_010

00

00

00

|.|.|JP.l.l.|‘.|.|.|‘.|‘.|‘.|Jl’.u|‘.|.|-|J|‘.|.:.|JF.|.|.|‘.|.|.|.|‘.1.|.|‘]‘.|,|‘.|.|‘.|J|‘.|.|.|‘.|

00

3.3. Save and Compile the Project File

1.
2.

RWE!NTEK

In EasyBuilder Pro toolbar click [File] » [Save] to save the .emtp file.

In EasyBuilder Pro toolbar click [Project] » [Compile] to compile .emtp file as .exob file,

which could be downloaded to HMI. This also checks if the project can run correctly.

EasyBuilder Pro V6.10.01
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0 Note

B  For cMT / cMT X Series models, the project file e
extension is .cxob.

3. To use multiple languages, all languages must be

xtension is .cmtp, and the compiled file

configured in Label Tag Library first.

When downloading the project to HMI, select the needed languages only. A successful

compilation is shown in the following figure.

Compile
Project name : C:\Jsers\Janecheng'Desktop\EBProjectl.cmtp

CX0B file name : C:\Users\Janecheng\Desktop\EBProject1. cxob

CXOB password : Settings. .. (uzed in decompiler)

[ becompilation is prehibited [ Disable HMI upload function

Select the languages used on the HMI
Startup language after red

Language 1

Treat the use of unsupported tags as @ |Error -

X5

ownloading the project : Language 1 -

Double-dlidk a message to modify the attributes of the object in question

Font Management...

| [C1Build font files

Close

3.4. Compile and Quick Compile

The [Compile] and [Quick Compile] modes can be selected in the Compile window. To compile

a relatively large file in which only a few windows are
be used to save compilation time.

Compile:

Compile the whole project file.

Quick Compile:

modified, the Quick Compile mode can

Only compile the modified window or event log. When one of the records in the event log is

changed, the whole event log will be compiled.

I__| WE!NTEK
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@ Note

B [f the project file is compiled for the first time, the Quick Compile mode is not supported.

B I|n a project file, when its system settings, picture library, sound library, or label library is
modified, then Quick Compile mode is not supported for the first compilation after
modification.

B The whole project file must be compiled before it is downloaded to HMI.

B Utility Manager does not support the project file compiled using Quick Compile mode. To

download a project file using Utility Manager, please compile the whole project file first.

3.5. Run On-Line or Off-Line Simulation

FII!

s
— Off-line simulation: Simulate project operation on PC without the need for connecting

any device.

FII!

h— On-line simulation: Simulate project operation on PC without downloading the project
to HMI. The PLC is connected to PC, please set correct parameters.

@ Note

B (iE/XE/eMT Series) When using On-line Simulation on PC, if the target device is the PLC
directly connected to PC, there is a 10-minute simulation limit.
B (cMT/cMT X Series) When using On-line Simulation on PC, the monitoring time is limited

to one hour and a prompt window pops up every 15 minutes.

3.6.cMT Viewer

This program connects to cMT Series models via network. To run this program, execute
cMTViewer.exe under installation directory. Or, in EasyBuilder Pro toolbar, click [Tools] » [cMT
Viewer].

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

I__| WE!NTEK EasyBuilder Pro V6.10.01
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2, <M Viewer (=@ =]

2017-02-09 19:21:24

3.7. Download the Project File to HMI

The following explains four ways to download the project file to HMI.

@ Note

B For cMT-SVR, only the way described in 3.6.1 is available.
B When download project file to HMI using mini USB cable, please do not connect PLC
simultaneously, in order to avoid noise from PLC interfering with HMI.

m Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
3.7.1. Configure in EasyBuilder Pro

1. In EasyBuilder Pro toolbar, click [Project] » [Download]. Make sure that all the settings are
correct.
2. Select [Ethernet], set password and HMI IP.

’__IbWE!NTEK EasyBuilder Pro V6.10.01
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eMT, iE, XE, mTV Series

Download (PC->HM)

)

Password/Port no. of download/upload :

@ Ethernet

4 7 P HMIName b
IP: 10.7.139.86 -
Font files Use EasyAccess 2.0 What's my [P7

Diagnostic tool

Runtime = Necessary if update runtime or execute download first time.

[] Use user-defined startup screen

[] Use system settings file

Synchronize HMI clock with PC

[T] Delete user-defined startup screen

[T] Reset recipe (RW, RW_A) [T Reset event log

[C] Reset recipe database [] Reset operation log

[T] Reset data sampling
[C] Reset string table

Reboot HMI after download
[] Automatically using current settings to download after compiling

cMT, cMT X Series

Download (PC->HMI)

@) Ethernet

4 7 P HMI Name

IP: 1071

Froject Checksum : 9ee5836¢3331ab23569a5a011d7e5h7

[ Runtime = Necessary if update runtime or execute download first time.

[ Use system settings file

Synchronize HMI clock with PC
[] Reset recipe (RW, RW_A)
[ Reset recipe database

["] Automatically using current settings to download after compiling

39.86 -

[] Reseteventlog
[C] Reset operation log
[] Reset PRW on HMI

Password/Port ne. of download/upload :

3

What's my [P7

["] Reset data sampling
[C] Reset string table
and all eMT Viewers

o e bomioss || swp
Setting Description

Font files

Download the font used in the project to HMI.

Runtime Select the check box to update the HMI kernel
programs. If this is the first time downloading file or
EasyBuilder Pro version is updated, please download
the firmware before downloading files to HMI.

EasyAccess 2.0 Download EasyAccess 2.0 driver to HMI. (This option

is available only for MT8000iE models. For other

models, EasyAccess 2.0 will be automatically

downloaded.)

Use user-defined
startup screen

Download the specified .bmp image file to the HMI

as the startup screen. For cMT/cMT X HMI, please

see chapter 5.4 General Settings in this user manual

for more information on updating the startup screen
on the HMI.

Use system settings
file

hardware settings.

Download the system settings file to update

Synchronize HMI
clock with PC

downloading project file.

Synchronize HMI time with PC time when

Delete existing user
accounts, e-Mail
contacts and SMTP
settings

Select the check box to delete existing user
accounts, e-Mail contacts or SMTP settings before

downloading the project. This setting is only

effective when one of the following settings is

I__| WE!NTEK
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enabled:

1. [System Parameters] » [Security] » [Enhanced
security mode] » [Use existing user accounts on
HMI first (if existed), Othrewise, use settings
below].

2. [System Parameter s] » [e-Mail] » [Use existing
user accounts on HMI first (if existed),

Othrewise, use settings below].

Reset recipe/
event log/

data sampling/
recipe database/
operation log/
string table/
user-defined
startup screen

The selected files will be erased before
downloading.

Reboot HMI after
download

HMI will reboot after the downloading process is
done.

Automatically
using current

The system will compile the project and download it

settings to to the latest target HMI. The way to enable this
download after L . . .
compiling function is described in the following part.

[Automatically using current settings to download after compiling]

If this check box is selected, EasyBuilder Pro will compile the project and download it to the

latest target HMI.

1. In EasyBuilder Pro toolbar, click [File] » [Preferences].

2. Select [Automatic save and compile when download and simulate] check box.

I__| WE!NTEK
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Preference
Project
Display [¥] Automatically save and compile the project when download and simulate
Grid [7] Generate backup of project file before save
Library [] Automatically make used pictures and shapes into the project library

[] Save AutoRecover information

[ OK J [ Cancel

3. In EasyBuilder Pro toolbar, click [Save] and then [Download].

4. Inthe dialog box, select [Automatically using current settings to download after
compiling] check box.

5. Click [Download].

6. When finished, next time when [Download] is clicked, EasyBuilder Pro will automatically

compile and download the project to the latest target HMI.
3.7.2, Use HMI Name

1. Go to [System settings] on HMI and then set HMI name first.

.Systern settings

Network\ Time,"Date‘| Securit  HMI name\gietting\wg‘\

HMI namel

i Cancel | : Apply | 0K “~ ¢
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2. On PC, select the HMI name and start downloading. To use [Search], enter the HMI name

first to search for the HMI. [Search all] searches for all HMIs in the same subnet network.

[]use user-defined startup screen

[]Use system settings file

[¥] synchronize HMI dock with PC

|| Delete user-defined startup screen
[V Reset recipe
[¥|Reset recipe database

[7] Reboot HMI after download
A

[¥|Runtime * Necessary if update runtime or execute download first time.

[V|Reset event log
[V Reset operation log

utomatically using current settings to download after compiling

Download (=3
©) Ethernet Password/Port no. of download/upload :
‘ 4 /s I/' HMI Name 3
HMI: je7 v
Search All
[¥]Font files [V] Use EasyAccess 2.0 What's my IP?

[V|Reset data sampling
[V|Reset string table

I__| WE!NTEK
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3.7.3. Use USB cable

Download (=3

@ USB cable Password : | Settings... ’

[V]Font files
[¥|Runtime *Necessary if update runtime or execute download first time,

[ Use user-defined startup screen

[ Use system settings file

[ Delete user-defined startup screen
[¥]Reset recipe [V|Reset event log V|Reset data sampling
[¥] Reset recipe database [¥]Reset operation log [V]Reset string table

|¥|Reboot HMI after download

[7] Automatically using current settings to download after compiling

| Download ] Stop Exit ’

Select USB cable to download project to HMI. The way of setting is same as “3.6.1 Configure in
EasyBuilder Pro”. Before downloading via USB cable, please make sure the USB driver is

installed. Go to [Computer Management] » [Device Manager] to check if USB driver is installed.

If it is not installed, please refer to to install manually.

3.7.4. Use USB Drive or SD Card

The following explains how to download project file by using USB drive or SD card.
1.  On EasyBuilder Pro toolbar click [Project] » [Build for SD card / USB disk download].

Browse for the project file and then click [Build], the file for download will be generated in
the connected external device.

I__| WE!NTEK EasyBuilder Pro V6.10.01
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USE Disk/CF Card/SD Card Data (=3

Select the folder to save download data :

i

Use system setting (OS5 version 20131106 or later supports only)
System setting file location =

[ Build ] [ System Settings...
2. Insert an external device to HMI.
3. Select [Download] on HMI and enter password.
Download/Upload
S Powniosd settngs I
Upload Password: ||
Restart project and exit ‘
M Download project files
Load System Setting |7 Download history files
cancel l_ Clear history files
Stop after download/upload
Time remaining 4

4.  After password is confirmed, it will show the directories in the external device. (pccard: SD
Card; usbdisk: USB Drive)

[Pick abirectory P4
Directory: Jusbdisle/disk_a_1

=¥ pecard
usbdisk

OK "r Cancel

5. Select the directory that contains project, and then click [OK] to start downloading.

I__| WE!NTEK EasyBuilder Pro V6.10.01
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@ Note

B Please select the parent directory of the generated files when downloading. For the
structure above, please select disk_a_1, not mt8000ie.

B You may click [System Settings] to save the hardware settings configured in EasyBuilder
Pro into SD card or USB disk, and then download the settings file to HMI. See “4 Hardware
Settings” for more information.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
3.8. Upload the Project File from HMI

1. On EasyBuilder Pro toolbar click [File] » [Upload].
2. Set HMI IP, HMI model, project location and project name, and then click [Upload)].

Upload @I
@ Ethernet ) USB cable Password/Port no. of download/upload :
4 P Name I
IP: 192.168.1.100 -
W hat's moy TP 2
HMI model : | eMT3070 >
Project location : C:\EMTP1.excb
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4. Hardware Settings

This chapter explains HMI settings.

4.1, OVEIVIEW .eiiieieiiiiiiiieiteeee ettt e e e e e s ee e e e e e e s enreeeeeas
By B 1 L @ 1 >o Y o £ RO
4.3, LED INAICALOrS ..evveeiiiiieeeeiieee ettt
4.4,  SystemResel....ccccciiiiiiiiiii
4.5.  System Toolbar.....ccceeeeeiiiece e
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4.1. Overview

4-2

This chapter discusses the HMI settings.

4.2.1/0 Ports

The I/0 ports may vary between models; please see the datasheet for more information.

The I/O Ports include:

® SD card slot: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. and also allows recording history data and data backup.

® COM Port: Connects PLC or other peripheral devices. The type of serial port include: RS-
232, RS-485 2W, RS-485 4W, and CAN Bus.

® Ethernet: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. Connects to Ethernet devices, such as PLC, laptop.

® USB Host: Supports USB devices, such as mouse, keyboard, USB disk, printer, or barcode

device.

® USB Client: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. and also allows recording history data and data backup.

For the first time operating HMI, please complete the following system settings. When

finished, the project files designed using EasyBuilder Pro can be used on HMI.

4.3. LED Indicators

The LED indicators on the HMI indicate:
Models: MT8121XE, MT8150XE, MT8121iE, MT8150iE

LED

Description

PWR (Orange)

Indicates power status.

CPU (Green)

Blinks when read/write Flash Memory.

COM (Blue)

Indicates COM port communication status, blinks
during communication. When communication is
good, it may stay on. (Not including network

communication)

Other Models:

LED

Description

PWR (Orange)

Indicates power status.

CPU (Green)

Indicates CPU status. If it blinks or goes out, there
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may be a CPU error.
COM (Blue/Red) Indicates communication status, blinks during
communication. When communication is good, it

may stay on.
4.4. System Reset

Certain HMI models are equipped with a reset button and a set of DIP switches. When using
the DIP switches to change modes, the corresponding functions will be triggered. If system
password is lost or forgotten, see the following steps to restore factory default.

1. Flip DIP Switch 1 to ON and the rest to OFF, and then reboot HMI. HMI will switch to touch
screen calibration mode.

2. A “+” sign appears on the screen, touch the center of the sign, after all 5 signs are
touched, “+” disappears and the touch screen parameters will be stored in HMI system.

3. After calibration, confirm to restore the default password, select [Yes].

4. Confirm to restore the default password again by typing [yes] and clicking [OK]. The
project files and history records stored in HMI will all be removed. (The default Local
Password is 111111. However, other passwords, such as Download/Upload passwords
have to be reset.)

The following lists the DIP switch settings of different models. Please see the relevant

installation instruction.

cMT / cMT X / eMT / i

Dip Switch OFF OFF OFF Touch Screen Calibration Mode
AN OFF ON OFF OFF Hide HMI System Setting Bar
HHHH OFF OFF ON OFf  Update OS
: OFF OFF OFF ON Reserved

OFF OFF OFF OFF Normal

@ Note

B The state of DIP Switch 4 on each unit may be different. If it should be ON when out from
factory, the Dip Switch 4 would be set ON and cut off. If it should be OFF, the Dip Switch 4
would be set OFF but the switch is not cut.

ON ON Restore factory default
ON OFF Hide system setting bar
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mTV OFF ON Update OS
Dip Switch OFF OFF Normal mode

1]

cMT-SVR

Dip Switch ON ON Restore factory default
H B ON  OFF Restore Ethernet IP Settings
= OFF ON Update OS
ON

OFF OFF Normal mode

4.5. System Toolbar

After rebooting HMI, you can set the system with [System Toolbar] at the bottom of the screen.
Normally, this bar is hidden automatically. Only by touching the arrow icon at the bottom-right
corner of the screen will the System Toolbar pop up. From left to right the icons are: System

Settings, System Information, Text Keyboard, and Number Keyboard.

How to hide HMI System Setting Toolbar:

® When [DIP Switch 2] is set ON, the system setting toolbar is disabled. When set OFF; the
system setting toolbar is enabled. Please restart HMI to enable/disable the toolbar.

® For mTV Series, flip DIP Switch 1 to ON to hide system setting toolbar.

® System register [LB-9020] can also enable/disable system setting toolbar. When [LB-9020]
is set ON, the toolbar is displayed, and set OFF to hide the toolbar.

4.5.1. System Setting
cMT/cMT X Series

Starting from OS version 20231201, the system settings interface of the cMT X Series has been
revamped. This section demonstrates the different interfaces before and after this OS version.
Password is required for configuration and modification of system parameters for security. The
default password is 111111.

OS versions after 20231201:

Setting @3 REhleR Themes

Light and dark themes available for
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Setting €» Bare

System Properties

Model / HMI Name / O...
0 CODESYS

Activate CODESYS / Re...

Project
Clear History / Restart ...

Network
Ethernet / Configure /1...

0 Security
Admin / Update Projec...

I__| WE!NTEK

System Properties

Model cMT2078X
HMI Name cMT2078X-FAE-4892 >
OS Version 20240328

Hardware Key  SJECK|QM-AAZFQ-|GBQ-AAA... >

LANT MAC Address

LAN2 MAC Address

Date

Time 11:23:22

choice based on its intended
surrounding.

System Properties

[Model]

The HMI model.

[HMI Name]

Set the HMI name for easy identification
when downloading/uploading project
files.

[OS Version]

The current OS version.

[Hardware Key]

The hardware key of the HMI.

[LAN1 MAC Address]

The MAC address for LAN 1.

[LAN2 MAC Address]

The MAC address for LAN 2.

[Date]

Set the local date on the HMI.

[Time]

Set the local time on the HMI.
[Brightness]

Adjust the screen brightness.

[Sound]

Adjust the system volume.

[Language]

Select the system interface language.
[Input Method]

Select the input method for the system
keyboard, multiple selections allowed.
[Show Start Button]

Enable to display the Start button. If not
enabled, the button's position can be
set, and it will appear by long-pressing
for 1.5 seconds.

[Show Download Popup Window]
Enable or disable the download popup

window.

EasyBuilder Pro V6.10.01
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Setting @» s

System Properties
Model / HMI Name / O...

® CODESYS
Activate CODESYS / Re...

Project
Clear History / Restart ...

Network
Ethernet / Configure /L.

0 Security
Admin / Update Projec...

I__| WE!NTEK

CODESYS

Activation Status
CODESYS Status
Application Status
Login Status

Version

Configure

IP Address

,,,,,,

[Show Mouse Cursor]

Enable or disable the mouse cursor.
[System Keyboard Sound]

Enable or disable the system keyboard
sound.

[Direction]

Select the display orientation, options
include 0 degrees, 90 degrees, 180
degrees, or 270 degrees.

[System Metrics]

View CPU, memory, eMMC, and network
usage.

[Reset HMI to Default]

Reset the HMI to factory settings.

[OS Upgrade]

Select the OS file from SD card or USB
drive to begin upgrading system
firmware. During the upgrade, do not
turn off the power. For detailed upgrade
steps and precautions, please refer to
the OS upgrade instructions for each
model.

[Third-party Licenses]

View and manage third-party licenses.
CODESYS

[Activation Status]

View the activation status of CODESYS.
[CODESYS Status]

View the status of CODESYS.
[Application Status]

View the running status of the
application.

[Login Status]

View the login status.

[Version]

View the version number of CODESYS.
[Ethernet (LAN1)]

Set the IP Address, Subnet Mask, and

EasyBuilder Pro V6.10.01
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Setting @ v

System Properties
Model / HMI Name / O...

o CODESYS
Activate CODESYS / Re...

. Project
Clear History / Restart ...

Network
Ethernet / Configure /1..

e Security
Admin / Update Projec..

Setting €» BaT@

System Properties
Model / HMI Name / O...

0 CODESYS

Activate CODESYS / Re...

Project
Clear History / Restart ...

@ Network
Ethernet / Configure /L.

e Security
Admin / Update Projec..

Setting €» Bare

System Properties
Model / HMI Name / O...

0 CODESYS

Activate CODESYS / Re...

Project
Clear History / Restart ...

Network

Ethernet / Configure /1...

2 Security
Admin / Update Projec...

I__| WE!NTEK

Project

Clear History

Restart EB Project

Network

Configure

1P Address
Subnet Mask
Gateway
DNS

Enable CODESYS Login

Automatic

192.168.2.211

192.168.1.254
168.95.1.1

| @)

Security
Admin
Manage everything on this HMI
Update Project
For updating project via external devices or web
History
For history backup via external devices and web
User

For cMT Viewer/Diagnoser

Gateway.

Project

[Clear History]

Clear the historical data related to
project files, such as recipes, event logs,
data sampling, etc.

[Restart EB Project]

Restart the EasyBuilder Pro project file.
Network

To download project files to the HMI via
Ethernet, the HMI's IP address needs to
be correctly configured. Choose to
automatically assign an IP address or
enter it manually.

[Ethernet LAN1]

Typically used for external network
connections, requiring the configuration
of a gateway and Domain Name System
(DNS).

[Ethernet LAN2]

Typically used for internal network
connections, such as connecting to a
PLC. To avoid network conflicts, LAN1
and LAN2 should be set in different
subnets.

[Network Bridge]

For dual Ethernet port models, bridge
mode can be enabled to allow LAN1 and
LAN2 to be in the same network
segment, achieving the function of a
switch.

Security

Manage passwords for different users.
[Admin]

Highest level of access, capable of
operating all functions and settings,
including file upload and download,

historical data backup, and password

EasyBuilder Pro V6.10.01
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Setting @» s

Y Ethernet / Configure /1...

e Security

Admin / Update Projec..

& EasyAccess2.0
Version / Activation Sta...
VNC
Enable / Multiple Conn...

g FTP
Enable / FTP Port (defa...

O Printer

Printer Name / Printer ...

Setting @» e
e Security

Admin / Update Project / .

e EasyAccess 2.0
Version / Activation Statu...

o CODESYS
Activate CODESYS / Resto.

. VNC
Enable / Multiple Connec...

o
Enable / FTP Port (defaul...

O Printer
Printer Name / Printer Dr

I__| WE!NTEK

EasyAccess 2.0

Version
Activation Status

Region

Connect
State

Error Code
Domain

Session ID

VNC

Enable
Multiple Connection
Require Password

VNC Password

Enable
Timeout

Status Bar Style

Activatec

Global >

2 (Connected)
0
WEINTEK_FAE

0

| @
| @]

modification for all permission levels.
[Update Project]

This password is used for file upload and
download and historical data backup.
[History]

This password is used for FTP Server
login and historical data backup.

[User]

Used for logging into cMT
Viewer/Diagnoser. The passwords for the
above three permission levels can also
be used in cMT Viewer.

EasyAccess 2.0

Information page for EasyAccess 2.0.

= Click the icon to download the demo
project. Please confirm your internet
connection before downloading the
demo project.

VNC

[Enable]

When VNC function is enabled, VNC
client devices can connect to the HMI.
This allows remote users to view and
operate the HMI.

[Multiple Connection]

Allows multiple VNC client devices to
connect. Please note that the more VNC
client devices connected simultaneously,
the more it may impact the
communication speed of the HMI.
[Require Password]

To protect system security, a password
can be set so that only VNC clients
entering the correct password can
connect to the HMI.

VNC Interlock:
[Enable]

EasyBuilder Pro V6.10.01
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Setting €» ear@

& Ethernet / Configure /1..
Enable

0 Security
Admin / Update Projec... FTP Port (default:21)

B EasyAccess 2.0
Version / Activation Sta..

VNC
Enable / Multiple Conn...

m FTP
Enable / FTP Port (defa...

e Printer
Printer Name / Printer ...

Setting & BaT@

e Security
Admin / Update Praject /.

e EasyAccess 2.0 Name

Version / Activation Statu

() copesys Version
Activate CODESYS / Resto...

NG URL  hpynet/H
Enable / Multiple Connec

Print a Test Page

FTP -

© vt s e por (defaul Backup PPD File

s Printer Install Printer

Printer Name / Printer Dr...

I__| WE!NTEK

FTP

FTP Client Can Modify USB/SD Data

Printer

Enable VNC interlock function to
enhance system security and
management.

[Timeout]

Set the timeout period for VNC interlock.
If there is no operation within the set
time, the session will be automatically
disconnected.

[Status Bar Style]

Choose the display mode of the status
bar, which can be adjusted as needed.
FTP

[Enable]

Enabling FTP service allows users to
access files on the HMI via FTP clients
over the network.

[FTP Port (default:21)]

Set the port number for FTP service. The
default port number is 21.

[FTP Client Can Modify USB/SD Data]
This option allows FTP clients to modify
files on the USB drive or SD card
connected to the HMI. When enabling
this feature, ensure appropriate security
measures are in place to prevent
unauthorized access.

Printer

[Name]

The name of the printer connected to
the HMI.

[Version]

The current version of the printer driver.
[URI]

The URI of the printer, used for locating
the printer.

[Print a Test Page]

Clicking this option will print a test page
to check if the printer is functioning
properly.

[Backup PPD File]

EasyBuilder Pro V6.10.01
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OS versions before 20231201:

—

@ Information

li CODESYS

i General

© Network

® Time/Date

& HMIName

CODESYS Activation Code:

Restore CODESYS License

@ Information

lii CODESYS

22 General

© Network

® Time/Date

& HMIName

Direction

Brightness ——ns

Popup download window

FTP Port (default: 21)

FTP client can modify USB/SD data

Show Start button

I__| WE!NTEK

Back up the PPD (PostScript Printer
Description) file, which describes the
printer's capabilities.

[Install Printer]

Configure the settings for the printer
installation.See Chapter 23.3 in this user
manual for more information on printer
installation.

CODESYS
Enter the activation code to activate
CODESYS.

General

General settings including FTP settings.
[Direction]

Select the display orientation, options
include 0 degrees, 90 degrees, 180
degrees, or 270 degrees.

[Brightness]

Adjust screen brightness.

[Popup download window]

When enabled, the download window
can pop up.

[Show Start button]

When enabled, the Start button is
displayed.

[Show mouse cursor]

When enabled, the mouse cursor is

displayed.

EasyBuilder Pro V6.10.01
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e

1% Setting 4« Cancel Ethernet1 ok |

System setting

MAC address 00:0c:26:14:47:3e

(",

@ Information
Obtain an IP address automatically
li CODESYS
1P address

i General

(® Time/Date

Subnet mask

Gateway

DNS
£ HMIName

o) Setting Time/Date

System setting

Date 2020-05-18 )

@ Information
Time 13:49:45 )
li CODESYS
22 General

® Network

m—

&£ HMIName

AAAAAAA —— = == = =T =

s S Samm T T I T T R, TR RS RS

HMI Nam

System setting

HMI name CMT-473E )

@ Information
li CODESYS
22 General

® Network

@® Time/Date

-

I__IVWE!NTEK

Network

To download project files to the HMI via
Ethernet, the HMI's IP address needs to
be correctly configured. Choose to
automatically assign an IP address or
enter it manually.

To use Email or EasyAccess 2.0, the DNS
needs to be set correctly. For models
with two Ethernet ports, associate two IP
addresses with different domains to
avoid network conflict.

[Enable Bridge Mode]

For dual Ethernet port models, bridge
mode can be enabled to allow LAN1 and
LAN2 to be in the same network
segment, achieving the function of a

switch.

Time/Date
Set the local date and time on the HMI.

HMI name
Set the HMI name for easy identification
when downloading/uploading project

files.

EasyBuilder Pro V6.10.01
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Clear History

Setting Clear History

Clear historical data stored on HMI.

System setting Clean Recipe

Clean Recipe Database

[ Project Management

Clean Event Log
A System Password
Clean Data Log

&2 Enhanced Security
Clean Operation Log
© VNC Setting
T4 EasyAccess 2.0
Setting Project Management Proje‘:t Management
system setting et — HMI can be rebooted by clicking the
& : C—
ceertsteny Restart button.
Al System Password
&R Enhanced Security
@ VNC Setting
3 EasyAccess 2.0
@ Setting System Password SYSte m Passwo rd
System setting By default the password is 111111. User-
System setting >
B Gl b o0y defined passwords can be used after
Update project >
D Project Management verification.
. History b
e .. :
&R Enhanced Security
© VNC Setting
"4 EasyAccess 2.0
Setting Enhanced Security Enhanced Securlty
System setting ) Add or delete user accounts and manage
—~ Start edit user account Start
Bty user privileges.

[ Project Management

Al System Password

@ VNC Setting

3 EasyAccess 2.0

’__IbWE!NTEK EasyBuilder Pro V6.10.01
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Setting VNC Setting
System settin,
. S senwn [ -
[ Project Management
VNC multi connection
A System Password i:)
VNC login password >

2% Enhanced Security

Mg EasyAccess 2.0

@ Language

wm Inout Method

System settin,
e = EasyAccess 2.0 Connection »)

® Clear History
Proxy >
[ Project Management
A System Password

&% Enhanced Security

@ VNC Setting

Printer

System setting

Printer name Not installed
3 EasyAccess 2.0 URI
O Language Install network printer 5

8 [nput Method

X 0S Upgrade

O Reset options

[\& WE!NTEK

VNC Setting

When enabled, VNC can be used to
monitor a remote HMI over an Ethernet
network.

[Start VNC]

Allows connections from VNC client
devices.

[VNC multi connection]

Allows multiple VNC client devices to
connect. Note that the more VNC client
devices connected simultaneously, the
more it may impact the communication
speed of the HMI.

EasyAccess 2.0

Activate EasyAccess 2.0 service.

in Click the icon to download the
demo project. Please confirm your
internet connection before downloading

the demo project.

Printer
See Chapter 23.3 in this user manual for
more information on printer installation.

EasyBuilder Pro V6.10.01
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= OS Upgrade

- .
. 5 Wl Select the OS file from SD card or USB
g EasyAccess 2.0 : drive to begin upgrading system
o8 Lagiiage firmware. During the upgrade, do not
o 1 o turn off the power. For detailed upgrade
& Printer steps and precautions, please refer to
% 05 Upgrade the OS upgrade instructions for each
O Reset options mOd e I .

= Reset options

o

) 5 ——— Restore HMI to factory settings.
4 EasyAccess 2.0
O Language

8 [nput Method
é Printer

X 0S Upgrade

O Reset options

eMT/iE/XE/mTV Series

Network

Network\ T\me/Date‘\ Securltv\v‘\me‘\‘\r settmq\o

When downloading project file to HMI via Ethernet,

(€ Obtain an IP Adcress Automatcaly set the correct IP of the target HMI. You can obtain
@ IP address get from below an IP address automatically or enter the IP address
Paddressi  [102[[168 [t |64 manually. To use Email and EasyAccess2.0, please set

Subnet Mask: [5es  |oss  [bee o | .
i 255 {255 4255 {0 correct DNS address. For models with two Ethernet

GateWay: 192 .[168 |1 .|254
DNSaddress: [g |[g |[s s ports, please associate two IP addresses with
different domains to avoid network conflict.
Prev | Next | Cance\l Apply | oK /"l
Time / Date

Network' Time,/Date\ Securitv\[v‘\ame\sett\ng\wq\
8 §i Day: |8 éi
Week: I@

12 gj Sec:

Set HMI local time and date.

2013 & Mon

Year:

Min:

285

Prev | MNext | Cance\l Apply | oK /"l
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Security

Network' Time/’Date\ Securitv\n‘\ame\sett\ng\wq\

Password protection, the default is 111111. Please

Local Password | click the buttons to set the passwords, and finish

| password confirmation.

Upload Password

[Password for entering system]

Download Password |

[Password for uploading project]

Upload (History) Password

[Password for downloading project]

[Password for uploading history datal]

Prev | MNext | Cance\l Apply | oK /"l
Froomseng P History

Network' T\mE/DatE\ Se Hlstorv‘\me‘\‘\r settmq\o

Clears history data in HMI.

[ Clear Recipe

" Clear Operationlog

" Clear Eventlog

[ Clear Data Log

Clear |

Prev | Next | Cance\l Apply | oK /"l
Sstom settings HMI name

Metwork! Tlme/DatE\ Sec HMI mame\semnq\wq\

Set HMI name to be used when download/upload
project.
HMI name: | Default HMI
Prev | Next | Cancel | Apply | oK ”l
rstomsettngs 4 OS setting
Network' T\mE/DatE\ Se 0OS semng‘\r settmq\o
Upgrade [Upgrade OS]
porade 0% Upgrade firmware. Please do not turn off or unplug
HMI during OS upgrade process. For more details,
Portrait Mode see the instruction about OS upgrade of the model
0 C 90 C 180 270 used.
(It will take effect at next reboot) [PO rt ra|t |V|Od e]

- Set screen orientation mode. After changing the
Prev | Next | Cance\l Apply | oK |

mode, reconnect HMI to power supply, for the
setting to take effect. That is, disconnect all power

from HMI, and then connect again. If portrait mode

I__| WE!NTEK EasyBuilder Pro V6.10.01
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is used (90 or 270 degree), the project must be
designed for portrait mode, otherwise it cannot be
correctly displayed.

VNC server setting

Network' Time/’Date\ Sec  \NC server setting\

Remote HMI monitoring and controlling via
Ethernet.

Start VNC single-connection

[Start VNC single-connection]

Start VNC multi-connection

Allows connection with one VNC client.

Stop WNHC ‘

[Start VNC multi-connection]

VMNC login password |

Allows connection with multiple VNC clients.

Connecting more VNC clients may slow down the

Prev || Next | cancel| | Apply | ok <7
communication speed.
Please see the settings steps in the later part.
El Click the icon to watch the demonstration film.
Please confirm your internet connection before
playing the film.

Misc 1

eswerc Timemat;:l:.:mwc assleneers Rotary switch for adjusting LCD brightness.

[Popup download window]
| Ugum If selected, after inserting USB disk or SD card to

HMI, the Upload / Download dialog box shows.

Download setting

[Restart after download/upload]

¥ Popup download window

¥ Restart after download/upload If selected, restarts HMI automatically after
uploading / downloading project.
Prev | MNext | Cance\l Apply | oK /"l
[Systemsattings P4 Misc 2

Network' Time/Date’ Secur’ _ VN( Misc Z\'cess 2.0\

[Hide mouse cursor]

" Hide mouse cursor

If selected, the mouse cursor will be hidden.
reion moce. [Enable [Reset HMI to default] button in calibration

i FTP client can modify USB/SD data

Enable [Reset HMI to default] button

mode]
| If selected, when the operator presses and holds
anywhere on the screen for more than 2 seconds
during HMI startup, the touch screen calibration
Prev | Next | Cancell Apply | OK /"l

mode will start. After calibration, [Reset HMI to

default] option shows.

[FTP client can modify USB/SD data]

If selected, USB/SD data can be modified using FTP.
[Modify HMI ports]

I__| WE!NTEK EasyBuilder Pro V6.10.01
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Eystomestings
Network' T\me/Date\ Se VN EasyAccess 2.0

EasyAccess 2.0 is activated

ECCEUTE ‘

passwornd | ‘

HWkey =YCTSB500-S5BN-JOWB
-WSH7-42A4-NVBMEe WHH

REfrest ‘ Activate ‘

Prev | Next | Caﬁce\l Applvl oK /"l

4-17

Change the port number for Upload/Download and
FTP,
EasyAccess 2.0

Activate EasyAccess 2.0 service.

r.!: Click the icon to download the demo project.
Please confirm your internet connection before
downloading the demo project.

The following steps explain how to set VNC server.
1. Enable HMI VNC server, set password.
2. Install Java IE or VNC Viewer on PC.

3. Enter remote HMI IP in Internet Browser. Or, in VNC Viewer enter remote HMI IP and
password.

=i
S Qox -

REAL

Ve

VNG Viewer Free EoBon 4.1
Copyight (C) 2002- 2008 RealVNC LY
S0 105 Swewi reane COM 3¢ MISMABon 6N VNG

LR

© lavcet

4.5.2. System Information

Network: Displays network information & HMI IP address.

System information (Default HMI)

IP Address: 192.168.1.56

Met Maslk: 255.255.255.0
Route Address: 192.168.1.254

Mac Address:  00:0C:26:04:70:AC

Networki\!ersion;.

X

Version: Displays HMI firmware version and model type.

D\QWE!NTEK
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n (Default HMI)
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5. System Parameter Settings

This chapter introduces the system parameter settings.

5.1.
5.2.
5.3.
5.4.
5.5.
5.6.
5.7.
5.8.
5.9.

5.10.
5.11.
5.12.
5.13.

OVBIVIBW ...ttt et ettt e e e e ettt e e e e e e st e et e e e e e e s e anb et e eeeeaesesnssbbeeeeeeeesannnraeeeaaenns 5-2
DIBVICE .eeeeeee ettt ettt e ettt et e e e e e s b bt e e e e e e e s e rr e et e e e e e e s e nnrreeeeeeeeaeaann 5-2
1 oo 1] D PP PP PP PPPPRO 5-12
(CT=T 1= - | PO UPPTROPPPPRRUPPPPPRIN 5-16
SYSTEM SELHING oo 5-23
REMOTE ...ttt ettt ea s ebebsbebseesabebanesenennsnnnnnnnnnne 5-26
L =To{ U1 g1 1Y P 5-27
[ T=T Yo [=Te Y/ =T ' o] VU RUPRR 5-30
PriNter / BaCKUP SEIVEN........uvi ettt ettt e e eare e eeaae e eneeas 5-34
THMIE SYNC./DST ettt e et e et e e et e e e te e e s be e e e beeeeabeeesabeeeeaseeeeaseesnseeenrens 5-35
[ 1V T D PP PSP UPPRROPPPTRRUPPPPRIN 5-37
Cellular Data NETWOIK ...ccoeiiiieeeiee e e s e e s eiee e 5-39
o I PP PP UPRTPPPRRRO 5-41
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5.1. Overview

Launch EasyBuilder Pro, in the

[System Parameter Settings] dialog box. System Parameter Settings are divided into several

main menu select [Home] » [System Parameters] to open the

tabs, these tabs will be introduced respectively in this chapter.

5.2. Device

Parameters in this tab determine the attributes of each device connected with HMI. The device
PLC. A default device "Local HMI" exists when creating a new

can be a Local / Remote HMI /
project. This device is the HMI

that will be updated and programmed.

5.2.1. Local HMI Configuration
Device Settings @
Name : Local HMI
(@) HMI
Location : | Local - Settings.
Enab\e secure communication
LW protection
Prohibit remote-write operation of remote HMI or MODBUS client
LW range : g ~ 1000
RW protection
Prohibit remote-write operation of remote HMI or MODBUS client
RW range : 0 ~ 1000
Data Security...
Setting Description

Enable secure
communication

With this option selected, the HMI encrypts the
communication to ensure the security of data
transmission. This feature is supported only on cMT X
Series HMls, and it can only communicate with other

I__| WE!NTEK
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devices that also support secure communication.

LW protection, o ) ) )

. For specific instructions on data protection settings, see
RW protection, | e

. Chapter 39 Data Security" in this manual.
Data Security

5.2.2. How to Control a Local PLC

i, | PLC Device

HMI
“Local Device” is a device connected to the local HMI. To control/connect a Local Device, add
this type of device first. Click [System Parameters] » [New] to open [Device Properties] dialog
box. For example, when connecting MODBUS RTU as a Local Device:

Device Settings @
Name : MODBUS RTU

(0 HMI 9 Device

Location ! || ocal v Settings...

* Select Local for a device connected to this HMI, or Remote for a device connected through another HMI.

Device type : [ MODEUS RTU, RTU over TCP | » ]
Device ID : 4, V.5.00, MODBUS_RTU.e30

IF: [RS*BZ vl Open Device Connection Guide...

* Support off-ine simulation on HMI (use LB-12358).
* Support communications between HMI and device in pass-through mode.

*Set LW-9903 to 2 to enhance the speed of download/upload device program in pass-through mode.

COM : [COM1 (3600,E,8,1)
Open HMI pin assi nt gvide...

Device default stationno. : 1
[ Use broadcast command
[ Default station no. use station no. variable

How to desismate the station no. in object's address?

Interval of block pack (words) : [5 V] [ Address Range Limit... ]

Max. read-command size (words) : [120 v] [ Data Conversion... ]

Max. write-command size (words) :

=]
Setting Description
Name The name of the device.
HMI / Device In this example a device is used, so select [Device].
Location Select [Local] or [Remote]. In this example the device is

connected to the Local HMI, so select [Local].

Device type Select the type of the device.

I/F The available interface: [RS-232], [RS-485 2W], [RS-485
4\W], [Ethernet], [USB], and [CAN Bus].
® |[f the interface used is [RS-232], [RS-485 2W], or [RS-
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485 4W], configure communication parameters by
clicking [Device Properties] » [Settings] and then

[Com Port Settings] dialog box opens.

Device Settings @I

COM Port Settings

COM: |COM1 - Data bits : |8 Bits =
Baud rate : | 9600 >~ 0 Parity
Stop bits: |1Bit =

g
A

Communication Settings
Timeout (sec) : [3.0 -

Turn around delay (ms): 0

Resneding commands : |0 -

o

K I I Cancel

Timeout

If the communication has been disconnected for more

than preset time limit configured in [Timeout] (in sec),

Window No. 5 will pop up and show “Device No

Response” message.

Turn around delay

While sending the next command to the device, HMI will

delay the sending according to the time interval set in

[Turn around delay]. This may influence the efficiency of

the communication between HMI and the device. Default

value is “0”.

Note: If the device used is SIEMENS S7-200 Series, it is

recommended to assign “5” to [Turn around delay] and

“30” to [Send ACK delay].

® |[f the interface used is [Ethernet], click [Device
Properties] » [Settings] and the [IP Address Settings]
dialog box opens. Please set correct device IP address
and port number.
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Device Settings @
IP Address Settings
IPaddress: | 192 . 168 . 1 . 100
Portno.: 502

Communication Settings

Timeout (sec) : |1.0 .

Turn around delay (ms) : 0

Resneding commands : |0 v

L oK ][ Cancel ]

® |[f the interface is [USB], no further setting is
required. Please check the settings in [Device
Properties].

® |If the interface is [CAN (Controller Area Network)
Bus], please see “Device Connection Guide” for

“CANopen” and import the .eds device file.

Device
default

station no.

Set the default station number for device address if the
device station number is not included in the address.
Device station no. can be set in its address. The address
format: ABC#Addr

ABC stands for device station number and ranges from 0 to
255. Addr stands for device address. And the “#” sign
separates the station number and the address. As shown
in the following figure, the data is read from device station
number 1, and address 0x-20.

Device : [MODBUS RTU v]

Address type : [Ox v]

Address: 1220 | User-defined tag

Address format : DDDDD [range : 1 ~ 65535]
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( New Bit Lamp/Toggle Switch Object
| Genersl | Security | Shape | Label |
Comment:
© Bit Lamp ) Toggle Switch
Read
Device : (MODBUS RTU | e e
Address: [0x v | 1420 [
[ Invert signal
Default Use the station number variables as the default device
station I:IO. station number. Select one from LW-10000 to LW-10015
use station _ .
no. variable (var0 to varl5) as the station number variables. If the
station no. is not specified in device address, the station
number will be determined by the station no. variable.
For example, if var3 is set for default station no:
PLC default station no. : [Lw_lgggg (16bit) : var3 v]
Default station no. use station no. variable
["] Use broadcast command
The followings demonstrate some examples:
® The device station number is “5”.
Read address
PLC name i[MODBUS RTU v] Setting...
Address :[4!( v] 5#111
® The device station number is determined by var7
(LW-10007)
Read address
PLC name i[MODBUS RTU v] Setting...
Address :’4,( v] var7#111
® Device address is set to “111”, since device station
no. is not specified, and the default station no. is
var3, the device station no. is determined by var3
(LW-10003).
Read address
PLC name i[MODBUS RTU v] Setting...
Address :[43( v] 111
i Click the icon to download the demo project. Please
confirm your internet connection before downloading the
demo project.
Use When [Use broadcast command] check box is selected,
broadcast please fill in [Broadcast station no.] according to the
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command

broadcast station number defined by the device. When
HMI sends a broadcast command to the station number
set here, the device will only receive the command and

not reply to HMI.

PLC default station no. : o
[Tl Defautt station no. use station no. variable

[¥] Use broadcast command Broadcast station no. : [255 -

As shown in the following figure:

Read address

PLC name : [MODBUS RTU vJ Setting...

Address :I4x v‘ 255%200

When HMI sends a command to address 255#200, all the
devices will receive this command and will not reply.
Only devices that support broadcast command can use

this feature.

Interval of
block pack
(words)

If the interval between read addresses of different
commands is less than this value, the commands can be
combined to one. The combining function is disabled if
this value is set to “0”.

For example, the interval value is set to “5”, to read 1 word
from LW-3 and 2 words from LW-6 respectively (read from
LW-6 to LW-7), since the interval of addresses between
LW-3 and LW-6 is less than 5, these two commands can be
combined to one. The result is to read 5 consecutive words
from LW-3 to LW-7.

Note: The maximum size of command combination data

must be less than [Max. read-command size].

Max. read -
command
size (words)

The maximum data size to read from the device at one

time. Unit: word

Max. write -
command
size (words)

The maximum data size to write to the device at one time.

Unit: word.

After all settings are completed, a new device named “Local Device 1” is added to the [Device

list].
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System Parameter Settings @
| Cellular Data Network | PrntoBackup Server | Time SyncDST | eMail
Device | Model | Generl | System | Remote | Security | Extended Memory
Device list: What's my [P?
Name Location Device Type Interface I/F Protocol - Stati
Local HMI |~ Local HMI _ Local  MTBO73E (300 x 480) - d 0
Tocal Device 1} MODBUS RTU Local  MODBUS RTU, RTU over TCP COM I (G600,ES,1) RS232  vaid

0 Note

B When using a cMT / cMT X Series model, select “Local HMI” in [System Parameter

Settings] dialog box and then click [New Device] to add a “Local Device 1” under “Local

HMI”.
System Parameter Settings @
Extended Memory |  CellulsrDataNetwork |  TimeSyneDST | e-Mail |  FIP
Device l Model I General l System | Remote I Security
Device list: What's my [P?
Name Location Device Type Interface I/F Protoc
ocal HMI Local HMI Lol cMT072XHEMTI072KHZEMT - -
| \Local Device 1| MODBUS RTU Local ~ MODEUS RTU, RTUover TCP  (COM I (9600,E,8,1) {RS232

El Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

5.2.3. How to Control a Remote Device

m Ethernet e Ethernet
.s:—,‘ ﬁ
HM

I
Desktop HMI

bog NOD
Bog WOD

|PLC Device IPLC Device

“Remote Device” is a device being connected to a remote HMI. To control a remote device, add
this type of device first. Please click [System Parameters] » [New] to open [Device Properties]

dialog box. For example, use MODBUS RTU as the Remote Device:
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Mame :  MODBUS RTU
) HMI @) Device

Location : |Remote + || Settings... | IP:0.0.0.0 (Port = 8000)

= Select Local for a device connected to this HMI, or Remote for a device connected through another
HML,

Device type : ’ MODETE BT, RTU over TCP | » ]

PLCID : 4, V.3.30, MODBUS_RTU.230

IfF: [RS—485 W ~ | Open Device Connection Guide. .

com: i

Device default station no. @ 1

|| Default station no. use station no. variable

How to desizmate the station no. in abject’s address™

Interval of block pack (words) : E
Max. read-command size (words) :
Max. write-command size (words) :

Setting Description
HMI or
Device In this example, a device is used, so select [Device].
Location Select [Local] or [Remote]. In this example the device is
connected to Remote HMI, so select [Remote]. Set the IP
address and port number of the Remote HMI by clicking
[Settings] next to [Remote].
IP Address Settings
@ Ethernet ) COM port (use master-slave protocol)
P address: 192 . 168 . 1 . 10
Port no. : 8000
ok ][ cancel
Device Type Select the type of the device.
I/F The interface used for Remote Device. If the remote device
uses a COM port, select [RS-232], [RS-485 2W], or [RS485
4W].
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coM Set the correct COM port used by the Remote Device.
Device

default Set the station number of Remote Device.

station no.

After all settings are completed, a new device named “Remote Device 1” is added to the

[Device list].
System Parameter Settings @
[ Cellular Dats Network | Printer/Backup Server | Time SyneJDST | e-Mail
Dievice Model I General | Swstern I Eemote | Security I Extended Memory

Dievice list: W hiat's o [E?

JUET] Location  Dewice Type Interface I'F Protoco &

Local HMI Local HMI Lacal MTBO72E (200 x 480} - 0

RE485 2W 1

@ Note

B When using a cMT / cMT X Series model, select the defined “Remote HMI 1” in [System
Parameters] dialog box and then click [New Device] to add a “Remote PLC 1” under
“Remote HMI 1”.

System Parameter Settings @
| Extended Memory |  CelllarDataNetvork |  TimeSwme/DST |  eMail |  FIP
Device | Model General | System [ Remote | Security
Device list: What's my IP?
Name Location  Device Type Interface I/F Protocaol
Local HMI Local HMI Local cMT3072XHicM T3072EH2/c - - -
Remote HMI 1 HMI Remotess* HMI Ethernet TCPIP
Remote *=+ i MODBUS RTU Remotes- MODBUS RTU, RTU over TCP  COM 1 {9600,E,7,1) RS4852W

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

5.2.4, How to Control a Remote HMI

d | Ethernet - Ethernat -
. _—
HMI HMI HMI

Deskiop
“Remote HMI” is the HMI other than “Local HMI”, and PC is also a “Remote HMI”. To control a
Remote HMI, add this type of device first. Click [System Parameters] » [New] to open [Device

Properties] dialog box as shown in the following figure:
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Device Settings

Name :

Location :

* Select Local for a device connected to this HMI, or Remote for a device connected through another HMI.

Remote HMI 1
@ Device

1P : 192.168.1.100 (Port = 8000)

Remote

Setting Description
HMI or . . .
. In this example, the device used is a HMI, so select [HMI].
Device
Location Select [Local] or [Remote]. In this example Remote HMI is

used, select [Remote]. Set the IP address and port number
of the Remote HMI by clicking [Device Properties] »
[Location] » [Settings].

IP Address Settings
@ Ethernet

IPaddress: 192 . 188 . 1 . 10

Port no. : 8000

Cancel

) |

After all settings are completed, a new device named “Remote HMI 1” is added to the [Device

list].
System Parameter Settings @
| Cellulsr Data Network | PrintoBackup Server | Time SyncDST | eMai
Device | Model | Genersl | System | Remote | Secwity | Extended Memory
Device list: What's my [P?
Name Location  Device Type Interface I/F Protocol Station No.
Local MT8072E (800 x 480) - - 0
* Remotersr eMT/HEAEAP/mTV ==+ Ethemet TCPP Ni&

@ Note

B When using a cMT / cMT X Series model, in [Device list] click [New HMI] to add a “Remote

HMI 1”.
System Parameter Settings @
| Extended Memory |  CelularDataNetwork |  TimeSync/DST | eMail | FIP
Device | Model General [ Systemn Remote | Security
Device list: What's my IP?
Name Location Device Type Interface  I/F Protocol
LocalHMI Local HMI Local cMT3072XHicMT3072EH2eMT307 - - -
Remots HMI 1 i HMI Remoter HMI Ethernet  TCPAP |
|

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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5.3. Model

Configure the [HMI model], [Timer], [Printer] and [Scroll bar] settings, and more.
eMT, iE, XE, mTV Series

System Parameter Settings @
| CelulDataNetvork |  PrinteBackupServer | TimeSyneDST | eMal |
| Deviee Model | Gemersl | Sysem | Remote | Secwity | Extended Memory |
HMI model : [ iE Series - MT8073iE (800 x 480) +| |Landscap -
HMI station no. :
Portno. : 8000
[V] Support cM T/eM T X communication protocol
Portno.: 8010
Printer
Type : |None -
Secroll bar
Defult Style - |« »
Width
@ Small () Middle () Large
Pass through (Virtual COM port)
Partno. : 2000 (2000~2100) [] Enable RSLinx broadcast response

[ OK ][ Cancel H

Help J
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cMT, cMT X Series
System Parameter Settings @
| Extended Memo Celllar DataNetvork |  TimeSynedDST | eMal | FIP |
| Device Model Genersl | System | Remot | Secwity |
HMI model : [ cMT X Series - Advanced - cMT3072XH/cMT3072XH2... o] | Landscape
HMI station no. :
Portno.: 8000
[V] Support TKAPAE/XE/eM TAmTV communication protocol and EasyWatch
Portno.: 8010 (used as MODBUS server's port no.)
Printer
Type : | HP Business Inkjet 2230... lw] StatusiControl... )
[V] Use printer on HMI first (if existed). Otherwise, install the printer with the settings.
Interface
) Ethemet © USB @
Pass through (Virtual COM port)
Portno.: 2000 (2000~2100) [] Enable RSLinx broadcast response
OK ] l Cancel } [ Help ]
Setting Description
HMI model Select an HMI model.

The [Resize pop-up windows / objects] dialog box will pop
up when changing to a model with a different resolution.

Select required adjustment and click [OK]. In most cases,

select all options.

Resize pop-up windows/objects
General windows
Resize pop-up windows
Resize objects

Keyboard windows
Resize keyboard windows
Resize function key objects

sl

[ OK | ’ Cancel

Landscape/Portrait

Change the orientation of the project.
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HMI station no. Set the station number of current HMI. The default value is
IIOII.

Port no. Set the port number of current HMI. The default value is
“8000".

Support cMT Supports communication with cMT / cMT X Series models

communication PP :

protocol cMT / cMT X Series project file should use the same

communication port.

Printer (eMT, Type
iE, XE, mTV A printer can be connected with the HMI. The HP PCL Series
Series) printer is connected through USB interface while other

printers through a COM port.

& For more information, see “23 HMI Supported
Printers”.

If the printer is connected through [COM], configure the
parameters correctly. If the printer type is [SP-M, D, E, F],
the [pixels of width] has to be set accurately, i.e. the set
pixel(s) cannot exceed printer’s default setting, or the HMI

will fail to print data.

Printer (cMT, The printer driver can be installed on HMI.
cMT X Series) Type

Select printer type.

Status address

Shows printer status.

LW-n Status

0 Printer driver is not installed yet.
1 Installing printer driver.

2 Printer is ready.

3 Printer is printing.

4 Print job is canceled.

LW-n+1 Error

0 None

1 Printer is not found.

2 Unknown error.

Control address

Updates printer connection parameters.

LW-n Command

0 None

1 Update connection parameters.
2 Restart printer driver.
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LW-n+1 I/O
0 Ethernet
1 USB

LW-n+2 IP address (Total: 4 words)
LW-n+6 Port (Default port number: 9100)

Please note that using only the ppd file for a printer may

not be able to run the printer since the corresponding
driver is absent. Using tested models is recommended.

Scroll bar Set the width of Scroll Bar, when the size of the object is too
small to display the contents, a scroll bar is displayed in the
object. This feature can be applied to objects that allow
scrolling, such as Alarm Display, Event Display, History Data
Display, and Option List.

Pass through
(Virtual COM Set the port number for Pass-through communication.

port)

I__| WE!NTEK EasyBuilder Pro V6.10.01



System Parameter Settings

5.4. General

Configure the properties related to screen display.
eMT, iE, XE, mTV Series

I__I"WE!NTEK

=)

System Parameter Settings
Cellular DataNetwork | Printr/BackupServer | TimeSymeDST | eMail |
Device Model General | System l Remote | Security | Extended Memory ‘
Options
[7] Enable fast display mode when change window RW_4 enabled
Windows
Startup window no. : (10, WINDOW_D10 -

Commen vindow : (Above beso vindow m|  Obiectiout:
0

[ Enable window layers (This can be used to oxganize/show/hide objects)

Screen saver
Back light saver : yninute(s)
[V Ensble back light when alarm occurs
Screen saver: (25 | minute(s)
Saver window no. : [30_ Screen Saver .]
Fast selection button
Attibute : (Enable v [ Settings.. |
Position : [ Hide button when HMI starts
Event
[V] Use LW9450-9455 as time tags of event logs
Time tag format : [BCD =
External keyboard layout (L W-9199)
B Type : |QWERTY (D) -
- Caret color :

I

Selection color :
Project key
[¥] Enable Projectkey: 000000 ;)

(range : 0 ~4294901750)

EasyBuilder Pro V6.10.01
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cMT, cMT X Series

[¥] Trigger release actions anyway if touch moves out of the button

" |Set value when leaving focus

CSV delimiter : [Comma() v @

Windows

[ |Enable window layers (This can be used to organize/show/hide objects) (i ]

System Parameter Settings \F
Cellular Data Network | 802.1X (WiFi) | WiFiHotspot | TimeSync/DST | eMal | FTP |
Device Model General | System I Remote I Security I Extended Memory |

Options i
[VIRW_A enabled Fast display mode...

Startup window no. : |10, WINDOW_010 ']

Screen saver

Monitor mode

|Enable

Event

Keyboard

50. Keypad 10 - Integer(translucent
11 Middle(translucent)

56. Keypad 7 - HEX

57. Keypad & - Floating

83, System Standard ASCII

. Keyp
66, ASC

Common window : [Above base window |

Back light saver : |30 ¥ | minute(s)

Saver window no. : |80. Screen Saver P

1

V| Enable back light when alarm occurs

Sereen saver : [25 v | minute(s)

e

| Use LWO450~9455 as time tags of event logs

External keyboard layout (LW-9199)

Type : [QWERTY(©) > @

mf »

1

[ ad. | [ Debete
Project key -
oK [ cancel ][ Hep
Setting Description
Options Fast display mode

In this mode, selected objects will cache the most recently
read data and display it quickly after window is changed,
achieving a faster display speed.

Controllable objects: Objects that allow variable input, such

as Toggle Switch, Numeric Input.

Uncontrollable objects: Objects that only display states,
such as Bit Lamp, Word Lamp.

The objects that support the fast display mode include: Bit
Lamp, Word Lamp, ASCII, Numeric, Function Key, Option
List, Direct / Indirect Window, Bar Graph, Meter Display,
Animation, Moving / Rotating Shape, PDF Reader, Picture
View, Energy Demand Display.

RW_A enabled

Enable or disable recipe data RW_A. Enable this, the
objects can then control RW_A The size of RW_A is 64K.
Trigger release action anyway if touch moves out of the
button. (cMT / cMT X Series)

With this option selected, releasing the finger after
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touching the button and then sliding the finger out of the
button area is still considered as button release; its release
action(s) will be triggered.

Set value when leaving focus (cMT / cMT X Series)

With this option selected, values will be written upon
leaving the input mode of an object (e.g. Numeric object),
even if not by pressing the ENTER key. For example, data
entry for the current numerical object is considered
completed and value is written when one selects another
object to enter value. An alert message shows when an
invalid value is entered.

@ Note

1. Values will not be retained after pressing the ESC key to
leave.

2. When the system keyboard is used, values will be
directly written after closing the keyboard.

3. With [Input order] enabled, the sequential input is
performed after leaving the object by pressing the
ENTER key. The sequential input will be stopped if
another object is touched during the input process.

CSV delimiter (cMT / cMT X Series)

Save the CSV file generated from Backup or Import/Export

with Comma (,) or Semicolon (;) delimiter.

Windows

Startup window no.

Designate the window shown when start up HMI.
Common window

The objects in the common window (Window No. 4) will be
shown in each base window. This determines that the
objects in common window are placed above or below the
objects in the base window.

Object layout

If [Control] mode is selected, when operating HMI,
[Animation] and [Moving Shape] objects will be displayed
above other kinds of objects neglecting the sequence that
the objects are created. If [Nature] mode is selected, the
display will follow the sequence that the objects are
created, the first created will be displayed first.

Enable window layers (This can be used to
organize/show/hide objects)

With this option selected, layers within a window can be
created in the window tree.
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At most 10 layers can be added to a window.
As shown in the following figure, right-click on a window
number and then select [Add layer].

= 3 : Monitor Mode

= 4 : Commaon Window [
= 5:Device Response

= 6:HMI Connection

7 : Password Restriction

: Storage Space Insufficient

: Backup

Windows Tree v X
-

[l

New
Open
Close
Delete
Settings

Add layer

The following is an example of creating a layered window:
Place a Bit Lamp object in Layer 1 and a Numeric object in
layer 2.

FFL0WINDOW 010
Layer 1 (Eottom)
BL_O (LE-0) (Bottom)
F [# Layer 2
ME_O (LV-0)

Selecting Layer 1 shows only the Bit Lamp object in the

editing window.

Selecting Layer 2 shows only the Numeric object in the
editing window.

F*10 - WINDOW 010
Layer 1 (Bottom)
BL_0 (LB-0) (Bottarm)

P e

ME_D (LW-0)

D\QWE!NTEK
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Selecting window 10 shows all objects.

*10 - WINDOW_010
[# Layer 1 (Bottom)
BL_0 (LBE-0) (Bottom)
[# Layer2
NE_0 (LW-0)

Screen saver

Back light saver

If the screen is left untouched and reaches the time limit
set here, the back light will be turned off. The setting unit is
minute. Back light will be on again once the screen is
touched. If [none] is set, the back light will always be on.
Screen saver

If the screen is left untouched and reaches the time limit
set here, the current screen will automatically switch to a
window assigned in [Saver window no.]. The setting unit is
minute. If [none] is set, this feature is disabled.
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Saver window no.

Specify a window to be displayed when HMI goes to screen
saver mode.

Note: In a saver window, the [Return to previous window]
option of a Function Key can be used to wake up HMI from
screen saver mode; therefore, please avoid editing the
project in the way shown as the example below, to prevent
the HMI from going to screen saver mode repeatedly.
Example: A Function Key used to “Return to previous
window” is placed in Window no. 11, and the HMI goes
into screen saver mode when Window no. 11 is displayed.
In this case, the HMI can wake up from screen saver mode
when any point on its screen is touched, and Window no.
11 will be displayed again. At this moment, if the Function
Key in Window no. 11 is touched, the HMI goes into screen
saver mode again.

Solution: 1. When a Function Key with “Return to previous
window” selected is placed in the saver window, please use
“Change full-screen window” for all other windows.

2. When “Change full-screen window” is used for the saver
window to change to a specific window (e.g., home page),
please make sure that “Return to previous window” is not
used in this destination window. The “Return to previous
window” option can still be used for other windows.

Fast
selection

buttons

This setting is applicable for eMT, iE, XE, mTV, and iP Series.
Setting the attributes for fast selection button for Window
No. 3. To use the fast selection button, create Window No.
3 first.

Attribute

Enable or disable fast selection window. Select [Enable] and
click [Settings] to set the attributes, including color and text
of the button.

Position

Select the button position on the screen. If [Left] is chosen,
the button will show at bottom left side of the screen; if
[Right] is chosen, the button will show at the bottom right
side of the screen.

Settings

Set the shape and label font of the Fast Selection Button.
Hide button when HMI starts

The Fast Selection Button will be hidden, calling it out
requires system registers LB-9013~LB-9015.
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Monitor
Mode

This setting is applicable for cMT / cMT X Series.
Window no. 3 in the project is monitored in this mode in
cMT Viewer. The user can select up to 50 cMT / cMT X
Series HMIs to monitor in cMT Viewer, and in 3x3 or 5x4
tile view.

Event

Use LW9450~9455 as time tags of event logs

When this option is selected, Event Log will use the
following time tags to show the time that the event is
triggered.

LW-9450: time tag of event log — second (range: 0~59)
LW-9451: time tag of event log — minute (range: 0~59)
LW-9452: time tag of event log — hour (range: 0~23)
LW-9453: time tag of event log — day (range: 1~31)
LW-9454: time tag of event log — month (range: 1~12)
LW-9455: time tag of event log — year (range: 1970~2037)
Please note that the system will not be able to use these
time tags when one of them exceeds acceptable range.
= Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Keyboard

The window number in which the keyboard is placed.
When using Numeric Input or ASCII Input objects, the type
of keyboards can be selected. Up to 32 keyboards can be
added. To design a keyboard, a window should be
designated for creating it. Press [add] after creating and
add the window to the list.

[:?See “12 Keyboard Design and Usage”.

External keyboard layout

The available USB keyboard layouts are QWERTY, AZERTY,
and Cyrillic. System register LW-9199 allows switching
keyboard layouts on HMI.

Caret color / Select color

This setting is applicable for eMT, iE, XE, mTV, and iP Series.
Set the color of caret that appears when entering data in
Numeric Input and ASCIl Input objects or change the
selection color.

Project
protection

Projects can be restricted to be executed by a specific HMI.
& See “30 Project Protection”.
)

Update
startup
screen on
HMI

This setting is only available on cMT / cMT X Series.
Default

If an image is already used as startup screen on the HMI,
the image will be cleared when this mode is selected.
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Customized
A .bmp file can be selected as startup screen.

5.5. System Setting

[System Setting] is used to configure different features of EasyBuilder Pro.

System Parameter Settings @
Extended Memory | Cellular Data Network Time $ync/DST | eMail |  FIP |
Device I Model ] General i System | Remote I Security [
Startup language after redownloading the project : (LW 1 v]

Delay time of device communication after HMI starts second (s)

* Use this option to prevent communication exrors when HMI starts faster than PLC.

Execute mit. macro when power on
Auto logout

[¥] Enable 1 v | minute(s)

* When a vser does not operate the HMI for longer than the setting time, the system will automatically logout,

[¥] Hide mouse cursor Mouse cursor size : {Default v]
[ Hide start button
* Use LB-9062 to open hardware setting dialog
Sound control
() With each touch on a button, & sound is emitted .
@ With each operation from a button, a sound is emitted.

[¥] Disable sound output {or use LB-9019 to disablefenable sound output)
[¥] Play next sound after stopping previous. (i)

[] Disable upload function (effective after rebooting HMI)(or set LB9033 on)
[V] Display disconnection icon on already shown objects after communication fails
[¥] Enable watch dog (LB-9049) Reboot HMI v|  Timeout (LW-11456) : second (s)

[¥] Enable font preloading (optimize performance but HMI may start slower)

[¥] Display timer for min. press time Timer location :

[¥] Adaptive DPI scaling )

[ OK ” Cancel H Help ]

Some features are duplicated from system registers, such as, [Hide system setting bar (LB-
9020)], [Hide mouse cursor (LB-9018)], [Disable buzzer (LB-9019)], and [Disable upload
function (LB-9033)]. Users can also set these features via system tag.

To select a system tag, select [Address] » [System tag] check box when adding a new object and
then select the [Address Type].

To browse all the system tags, Select [Project] » [Tag] » [System] from the main menu of

EasyBuilder Pro.
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Setting

Description

Startup language after
redownloading the
project

Set the language to use when HMI starts after
the project is re-downloaded.

Delay time of device
communication after
HMI starts

Certain PLC models need relatively longer
startup time. In order to prevent
communication error that occurs when HMI
attempts to communicate with a PLC that has
not yet started, a delay time can be set.
Include delaying the execution of all init.
Macros when HMI starts.

With this option selected, the macros that
have [Execute one time when HMI starts]
enabled will also be delayed.

Execute init. MACRO

when power on

Designate the macro to be executed when HMI
power on.

Auto logout

If leaving HMI untouched for longer than the
set time, the objects protected by security
classes will not be able to operate. The user ID
and password must be entered again to unlock
it.

Hide system setting bar /
Start Button

Hide the system setting bar from HMI screen.

Hide mouse cursor

Hide the mouse cursor in HMI screen.

Mouse cursor size

Set mouse cursor size.

Sound control

With each touch on a button, a sound is
emitted: With sound enabled in object
settings, a sound is emitted when the object is
touched.

With Each operation from a button, a sound is
emitted: When sound is enabled in object
settings and the [Min. press time] is specified,
there may be a time gap between touching the
object and the action of the object. With this
option selected, the sound is emitted when
the object actions.

Disable sound output: Mute HMI. (Not
including the sound played when tapping
system setting button on HMI.)

Play next sound after stopping previous:
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(cMT / cMT X Series only) When the next
sound is triggered at the time the current
sound is playing, the current sound will stop,
and the next sound will start.

Disable upload function

(effective after rebooting
HMI) (or set LB9033 ON)

Disable HMI to upload project.

Use a disconnection icon

or relative objects when
device communication

fails

If selected, a disconnection icon is

displayed on relevant objects %’g
when failing to communicate with ﬁ
the device.

This icon will be shown in the /\ﬂ
lower right corner of the :\\\hﬁg,
object. B

This icon will only show for
disconnection after successful connection.

Enable watch dog (LB-
9049)

Watchdog automatically reboots the system
after the HMI stops functioning for a specified
period of time.

Enable font preloading
(optimize performance
but HMI may start

slower)

(cMT / cMT X Series only)

With this option selected, the speed of
changing windows that contain more texts is
optimized. Please note that using this feature
may slow down HMI boot time.

Display timer for min.

press time

(cMT / cMT X Series only)

With this option selected, a countdown timer
is shown when an object with min. press time
set is being pressed.

Adaptive DPI scaling

With this option selected, the system will
automatically adjust text size, position, and the
spacing between Y axes based on the screen
DPI of the connected device.

This setting is applicable to Trend Display,
Circular Trend Display, Mail Contact Editor,
Option List, Media Player, Alarm Display, and
Event Display.

If this option is disabled, certain length-based
configurations may not accurately reflect on
different screens.
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5.6. Remote

Parameters in this tab configure remote connections. Certain functions can be carried out

using system registers.

System Parameter Settings @
Extended Memory |  CellbsrDataNetwork |  TimeSync/DST | e-Mail FIP
Device I Model I General I System I Remote Security
[¥] Prohibit remote HMI connecting to this machine
[¥] Prohibit password remote-read operation {or sst LB9053 on)
[¥] Prohibit password remote-write operation {or set LB9054 on)
YNC server
[ Password free
[ Password from project
[ Monitor mode
Easylccess server
Location of EasyAccess 2.0 sexver : |Global v

[7] Start EasyAccess 2.0 after updating project.

Diagnoser
[¥] Enable
[7] Password free
Password : - @
cMT Viewer
Max comnectcount: 3 5 (count: 1~ 10}
Warmning : too many connect count will affect performance.
[ OK ] [ Cancel ] [ Help I
Setting Description

Prohibit remote HMI
connecting to this
machine

Prohibit the connection with a remote HMI or
cMT Viewer. The remote HMI will not be able
to control the local HMI.

Prohibit password
remote-read operation
(or set LB9053 ON)

Prohibit Remote HMI to read Local HMI’s

project password and user password.
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Prohibit password
remote-write operation
(or set LB9054 ON)

Prohibit Remote HMI to write to Local HMI’s
project password and user password.

VNC Server

If [Password free] check box is selected, the
client can connect with HMI via VNC without
entering the password.

If [Monitor mode] check box is selected, the
HMI connected via VNC can only be monitored
but not controlled.

If [Password from project] check box is
selected, set the password for VNC login.

Easy Access server

Location of EasyAccess 2.0 server:

Current location includes Global and China.
Click the icon to watch the demonstration

film. Please confirm your internet connection

before playing the film.

Diagnoser

Enable

When selected, cMT Viewer will allow
diagnostic operations when connecting to a
cMT / cMT X model. System register LB-12656
can also be used to control Diagnoser.
Password free

Enabling Disgnoser will not require password
login. System Register LB-12657 can also be
used to set whether a password is required.
Password

Enter the password for logging in Diagnoser.
System register LW-11756 (4 words) can also
be used to set this password.

cMT Viewer

Max connect count

Allows specifying the allowable number of cMT
Viewer connections for a local cMT / cMT X
HMI.

5.7. Security

Parameters in this tab configure the user passwords and security classes. There are two

authentication modes: General Mode and Enhanced Security Mode.

& For more information, see “10 Security”.
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5.7.1. General Mode

System Parameter Settings @
Cellular Data Network | PrintrBackup Server | Time Syne/DST e-Mail
Device Model | General | Sysem | Remoe | Securty Extended Memory
@ General mode ") Enhanced security mode External Server
* Password range : 0 ~ 4204967295
Enable Password ClassA ClassB ClassC ClassD ClassE Clas #
1 @ e Ble v @ 5 # ® ®
: @ eee Ble 2 = 8 8 8 O
3 @ eee Ble 2 # 5 8 8 ©
s H |® . e m B B B B B
5 B = BECRERE:
6 F Ble 2= 8 8 B B B
< — Ll »

Up to 12 sets of user and password are available. Password should be one non-negative
integer. Once the password is entered, the objects that the user can operate are classified.
There are six security classes available: Ato F.

If [None] is selected for an object, every user can access this object.

For example, when the security class of User No. 3 is set as the preceding figure, User No. 3
could only access objects of classes A, B, C and “none”.

5.7.2. Enhanced Security Mode

At most 11 users can be set here. An [Administrator] user is provided in this mode. An
[Administrator] has all privileges and can operate all object classes. User passwords must be

alphanumeric, and each user can have up to 12 classes: A to L.
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System Parameter Settings
| CellulwDataNetwork |  Printer/BackupServer | Time SyncDST e-Mail
| Deviee Model | Gemersl | Sysem | Remote | Secuity Extended Memory

() General mode @ Enhanced security mode External Sexver Editable...

[7] Use existing user sccounts and sdministrator settings on HMI first (if existed). Otherwise, vse settings below.

Enable Secretuser User name Password ClassA Cl »
1 ™ ] userl ° ®
2 [ = user2 ° & £
3 ] E user3 L ] &
4 | ] userd L ] ™
5 ] [ users ° ®
6 [ = userb ° &
<[ m )
Class Comment 25
Class & L
ClassB
ClassC -
Administrator
[ Secret user User name : |admin
Pasword: 000000 B
Control
Device : |Local HMI
Address: | LW 8950 16-bit Unsigned  pgaee

Execute auto logindogout when insert an USBE key into HMI

(7] Ensble i
EMTP file password
[7] Check password when open EMTE fils
(o J[ concel J[ o ]
Setting Description
Editable Determines whether other users can change the

password settings or see passwords.

Read-only Settings

==

[¥]Enable read-only

Password: 000000
(1 ~4294967295)

medium @

[¥] Mask password

Enable read-only

Under this mode, the settings can be viewed but not
changed.

Mask password

Passwords are masked by asterisks (*).

Select operable
classes for each
user

When [Use existing user accounts on HMI] check box is
selected, the user accounts existing on HMI will not be
erased after downloading the project file to HMI.
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Administrator

Default administrator account, cannot be deleted, has
all privileges, and cannot be changed. Enhanced
Security Mode can be used with Option List object. It
displays the account names and privileges. If [Secret
user] is checked, the account names and privileges
will be hidden in Option List.

Control address

An address for users to manage the accounts directly
on HMI.

Project password

When this password is enabled, it has to be entered
before editing the project file.

Select [Enable] and then click [Settings] to set the
password.

Execute auto.
Login/logout
when insert an
USB key into HMI

This feature allows automatic login / logout using an
USB security key. The login / logout status will be
written into a designated address. Insert the USB disk
to HMI to log in, and remove the USB disk to log out.
The result codes of login / logout: 0x00: No action,
0x01: Login succeeds, 0x04: Login fails, 0x08: Logout
succeeds, 0x10: Logout fails.

5.8. Extended Memory

Parameters in this tab determine the location of the extended memory.
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System Parameter Settings @
Device Model General System Remot: |  Secwity |
Extended Memory | Cellulax Data Network Time Sync./DST | e-Mail |
EMO
File name :  emf) i © USBdisk 1 () USBdisk 2
EM1
File name :  eml emd © USBdisk 1 D USBdisk 2
EM2 -
File name : em?2 emi @ USBdisk 1 () USBdisk2
EM3
File name : em3 emd © USBdisk 1 () USBdisk2
EM4
File name : emd i © USBdisk 1 T USBdisk2
EMS
File name : em5 emi @ USB disk 1 () USBdisk2
EM6
File name :  emf i © USBdisk 1 () USBdisk 2
EM7
File name : em? i © USE disk 1 D USBdisk2
EM8 ‘
File name :  em@ emi © USBdisk 1 () USBdisk2
EM9
File name : em9 emi @ USB disk 1 (O USBdisk2
EM10
File name : em10 i © USBdisk 1 () USBdisk2
EMI11
File name : eml1 emi © USBdisk 1 T USBdisk2
EM12
File name : emi?2 emd © USB disk 1 (O USBdisk2
EM13
File name : eml3 emi @ USBdisk 1 () USBdisk2
EM14
File name : eml4 emd © USB disk 1 O USB disk 2
EM15
File name : eml15 emi © USB disk 1 (O USBdisk2
|| Enable dynamic file name (not including filename extension) Usage..
[ ox ][ cancel ][ Hep |

Extended Memory is numbered from EMO to EM15. It works in a way similar to other device
types (i.e. LW or RW address). Users can simply select from EMO to EM15 in the [Address]

setting while creating a new object. Maximum allowable data size for each Extended Memory

is 2G words.
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LW
PL\WW
RW
RVV_A
RWI
EMO
EM1
EM2
EM3
EN4
EMS
EME
EM7
EME
EMS
EM10
EM11
EM12
EM13
EM14
EM15

a3

Data in the extended memory is saved as a file into [SD card] or [USB disk]. By default, the files
in [EMO] to [EM15] are with the file names “em0.emi” to “em15.emi” respectively, although
users are free to change the file names. To open these files and edit the data in the extended
memory, RecipeEditor.exe may be used.

Data in the extended memory will not be erased when HMI power is cut, which means data in
the extended memory remains the same as before power off when HMl is started again. This is
a behavior similar to recipe data (RW, RW_A).

When the device used as extended memory does not exist, reading the data in the extended
memory will get “0”, and writing data to the extended memory will display "Device no
response" message on HMI.

Cutting HMI power is not necessary for inserting or removing the external device to or from

HMI, making it easy for users to immediately update or obtain data in the extended memory.

Setting Description
Enable dynamic With this option selected, the file names of
file name EMO~EM15 can be changed dynamically. Select “EM

file name index (0~15)”, enter “EM file name”, set
“Control” to 1, and then see the “Result”. After
successfully changing the file name, the new file name
will immediately be the data source of EM address.
Please note that after changing the EM file name
dynamically, the new file name is retained after
rebooting HMI, which may be different from the file
name specified in the project file.
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Address Usage... @

Control - LW-12650
EM file name index (0~15): LW-12651
EM file name : LW-12652~12701 (50 words)
Result: LW-12702
0 success
1:fail (not support)
2 : fail {invalid file name index)
3 : fail (the same file name)

4 - fail {invalid file name)

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
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5.9. Printer / Backup Server

Configure remote printer / backup server. This feature is not supported on cMT / cMT X Series

HMI.
System Parameter Settings @
|  Device Model l General | System [ Remote I Security l Extended Memory
| CellularDatsNetvork |  PrinterBackupServer |  TimeSwe/DST | e-Mail
[¥] Usz Remote Printer/Backup Server
* Use EasyPrinter to configure PC for printing screen hardcopy and storing backup data.
Output settings
Orientation @) Horizontal Vertical
Printer size © @ Original size () Fit to printer margins
Margin : 0 & mm
0 & mm 0 £ mm
0 S mom
Communication settings
IPaddress : 192 . 168 -1 - 100 |
Portno.: 8005
User name :  admin Password: 000000 ®
Setting Description
Output Orientation
settings Set how will words or pictures be printed out, [horizontal]

or [vertical].

Printer size

Set to print out in [Original size] or to [Fit to printer
margins].

Margin

Set the top, bottom, right and left margin width.

Communication

settings

IP address

Assign the IP address of the printer via network.
[Port], [User name], [Password]

Specify the data to log in server.

Port can be set from 1 to 65535.
Maximum length of user name or password is 12
characters.

r For more information, see “26 EasyPrinter”.

&

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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5.10. Time Sync./DST

Configure HMI time synchronization and daylight saving time.

System Parameter Settings @
Device l Model l General l System ] Remote ] Security ] Extended Memory
Cellular Data Network I Printex/Backup Server | Time Syne /DST 1 e-Mail
HMI time zone : {JTC+08:00) -
* [HMI time zone] setting will also be vsed for timestamps of OPC U4 and MQTT.
[7] Enable time symchronization with the external device when HMI starts
Device : Locsl HMI - )
Address: [LW |0 [16-bit Unsigned
[¥] Enable time symchronization via NTP (Network Time Protocol) server
[V] Execute time synchronization when HMI starts
[ Sexver response time has been adjusted in accordance with DST
Server response time :  (JTC+00:00) GMT Standard Time v
Network time server 1 © 0.poolntp.org {e.g. wwv nist.gov or 24.56.178.140 )
Network time server 2 :  1.poolntp.org
Network time server 3 2.poolntp.org
Network time server 4 3 poolntp.org
Update interval {10 ~86400) : 1800 sconds
*Use LW-11273 ~ 11294 to modify settings on HMI.
*If failed to execute time synchronization, the status of LB-12055 is set to ON.
[V] Automatically set daylight saving time (DST)
Stert : [March v [Second | [Sunday ~| o200 £ 2
End : [November ~| [First v [Sunday ~| 0300 b ¢
Daylight bias: p1:00 3 (00:30 ~ 12:00)
* HMI enters into DST period when LB-12355 (read only) is ON.
*Use LW-11260 ~ 11272 to modify settings on HMI.
*DST is not supported in on-line simulation.
[ oK ] [ Cancel ] l Help ]

Setting

Description

HMI time zone

Select HMI time zone.

Enable time
synchronization
with the external
device when HMI
starts

Automatically synchronizes HMI time with the designated
source address when HMI starts. As shown in the settings
above, the time source is set to D address of the device
Mitsubishi FX5U, so 6 consecutive word addresses starting
from D-0 will be the source addresses and each of them

should contain time information as follows:
D-0 - Second (range: 0~59)
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D-1 - Minute (range: 0~59)
D-2 - Hour (range: 0~23)

D-3 - Day (range: 1~31)

D-4 - Month (range: 1~12)
D-5 - Year (range: 1970~2037)

Enable time
synchronization
via NTP (Network
Time Protocol)

server

Execute time synchronization when HMI starts
Automatically synchronizes HMI time with the designated
NTP server when HMI starts.

Server response time

Select NTP server time zone.

Network time server

Provides four fields to fill in Network Time Servers for user’s
device. If the synchronization with server 1 fails, the system
will try to synchronize with server 2, and so on. If HMI time
cannot synchronize with any of the Network Time Servers,
the system register LB-12055 will change to ON status.
Update interval

The frequency of synchronization, the range is from 10 to
86400 seconds.

Automatically set
daylight saving
time (DST)

Start / End

Set the start/end of Daylight Saving Time.

The option [Last] may refer to the 5% or 6! week depending
on the selected month.

Daylight bias

Set the time zone's offset during DST.

@ Note

B When the Network Time Server is configured with a static IP address, write/control
operations can be performed using addresses LW-11278 to LW-11293. However, if the

Network Time Server is configured with a domain name, modifying the IP address of the

Network Time Server via addresses LW-11278 to LW-11293 is not supported.

B When DST ends, and the time falls back, the Trend Display object in Real-time mode will

stop refreshing for the overlapping hour(s) when it just going back to standard time.
However, historical data will not be affected.

B When DST ends, adjusting HMI time (manually or by network) back to the DST period will

not be effective to the system. The system register LB-12355 stays OFF.

B When DST ends, and the time falls back, the system will not start DST for the overlapping

hour(s). The system register LB-12355 stays OFF.

B Before DST starts, adjusting HMI time (manually or by network) into the DST period will
start DST. The system register LB-12355 will be set ON. The HMI time will be the specified
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time without adding the offset.

B During DST, adjusting HMI time (manually or by network) to a time that is not within DST
period will end DST. The system Register LB-12355 will be set OFF. The HMI time will be
the specified time without subtracting the offset.

B This feature does not yet support the DST in Southern Hemisphere.

C?For more information on system registers relevant to DST, see “22 System Registers”.

5.11. e-Mail

Select [Enable e-Mail function] check box to configure the parameters.

When [Use existing contact settings on HMI] check box is selected, the system will use the
contact settings in HMI after downloading the project to HMI, or use the following settings
when no contact is found in HMI.

System Parameter Settings @
Device Model | General l System [ Remote | Security I Extended Memory |
Cellular DataNetvork | Printe/Backup Server | TimeSyneDST | e-Mail

V] Enable e-Mail function
|| Use existing contact settings on HMI first {if existed). Otherwise, use settings below.
* Set the right [HMI time zone] to have correct email sending time.

SMTP settings
Server : Portno.: 0
User name :
Password : ®
Confirm Password : Q
[T]SMTP server requires anthentication
[71Use the following type of encrypted connection
TLS
Sender information
Name : |Use local HMI name in "Device list" v
Local HMI
Mail address :
Error message
[7]Enable

* Failed step and error code are stored to LW-11444~11445.
Error notification

*LB-12053 or LB-12054 is ON when failed to send an e-Mail.

("] Turn OFF LB-12053 or LB-12054 before sending an e-Mail,

Recipient... Test SMTP Settings...

l oK J{ Cancel H Help
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Setting

Description

SMTP Settings

Server: Set SMTP Server.

Port: Set communication port.

User name: Set e-mail address.

Password: Set e-mail password.

Confirm Password: Confirm e-mail password.

SMTP server requires authentication:

Decide whether Secure Password Authentication is needed
when log in e-mail.

Use the following type of encrypted connection:

Decide whether an encrypted connection (TLS, SSL) is
required when sending e-mails. Please note that TLS support
is limited to TLS 1.0.

Sender

Information

Name:

Enter the sender name or use the local HMI name in the
device list, or the name specified using system register LW-
10884 (HMI name).

Mail Address:

Setting e-mail address.

Error message

When an error occurs in email delivery, the error message
sent from SMTP server can be shown in the designated

address.
C?For more information on system registers relevant to

mail delivery, see “22 System Registers”.

Error Turn OFF LB-12053 or LB-12054 before send an e-Mail

notification When enabled, system registers LB-12053 or LB-12054 will
be turned off before sending e-mail, otherwise, when an
error occurs in email delivery, the register remains ON.

Test SMTP Verify SMTP settings in advance by sending a test email to

Settings the specified e-mail address.

Click [Recipients] to open the following dialog to edit contacts:
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Contacts @
Mo. of groups : 1 Z
Contacts list Group information
Contact Haime Madl Address Contact Haime Mail Address
p NewContact MewContart@d omain com NewContact NewContact@d omain.com
Current group : IGroup A ']
Add H Remove Comment :
Import... “ Export... ‘ ’ OK ” Cancel ‘
Setting Description
Contact list Add or remove contacts from the list.
Group Group up contacts.
Information No. of groups:

Set no. of contact groups, according to the number, the
groups are named from A to P and up to 16 groups can be
set.

Current group:

Displays the group that includes the contacts above.
Comment:

Enter a description for the current group.

or For more information on sending Event Log, see “7 Event Log”.

& For more information on e-mail related system registers, see “22.3.40 e-Mail”.

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

in Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
5.12. Cellular Data Network

This tab is for setting cellular data. Cellular data network settings may differ from one model to
another.

Applicable models:

cMT X Series models

cMT-SVR (OS ver. 20151127 or later)

cMT3071/cMT3072/cMT3090/cMT3103/cMT3151 (OS ver. 20180723 or later)
cMT-HDM/cMT-FHD/cMT-FHDX (OS ver. 20190130 or later)
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MT8051iP/MT8071iP/MT8102iP (OS ver. 20201007 or later)
iE Series models (OS ver. 20231215 or later)
Attaching a 3G/4G USB dongle to the USB port enables the cMT-SVR to connect to 3G/4G

networks.
System Parameter Settings
| Deviee | Modd [ Gemd | Sywm | Remoe [ Sewiy |
|  Extended Memory |  CellularDataNetwork |  TimeSyneDST | e-Mall | FIP ;
=
3G/4G Dongle | usscavie [N
Tetherina
3G/4G Dongle
[7] Use existing settings on HMI Supported 3G/4G dongles.
PN code: 000® e APN @ internet
Username : username Password : password (@)
Dial number :  #09%
Setting Description

Use existing contact
settings on HMI

If this check box is selected, the cellular data currently
in HMI will be used. When no specific settings are
required, generally, [PIN code] is “0000”, [APN] is
“internet”, and [Username], [Password], [Dial number]
are optional.

The relevant registers:

LW-11297: (16 words) : PIN code of SIM card (cellular network)
LW-11313: (16 words) : Access Point Name (cellular network)
LW-11329: (16 words) : username (cellular network)

LW-11345: (16 words) : password (cellular network)

LW-11361: (16 words) : dial number (cellular network)

LW-11377:  (16bit) : stop (set 0)/start (set 1) connection (cellular
network)

LW-11378: (16bit) : last error code (0:success, 1:incorrect PIN code,
2:no SIM, 3:no device, 4:puk locked, 5:other) (cellular
network)

LW-11379:  (16bit) : connection status (0:no device, 1:disconnect,
2:connecting, 3:connected) (cellular network)

USB Tethering

By connecting an Android® mobile phone with HMI using a micro USB cable, or any USB data

cable that is compatible with the phone, the internet connection of the phone can be shared

with HMI. On the Android mobile phone please enable USB Tethering.

I__| WE!NTEK
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5-41

Tethering or hotspot active

(= Tethering & portable hotspot

USB tethering
Te ed

Portable Wi-Fi hotspot

Set up Wi-Fi hotspot

AndroidAP WPA2 PSK portable Wi-Fi hotspot

Bluetooth tethering

ng this phone's Internet

When successfully connected, the following registers can be used to monitor and control the

connection status.
LW-11380:

LW-11381:

(16bit) : stop (set 0)/start (set 1) connection (USB
tethering)

(16bit) : connection status (0:no device, 1:disconnect,
2:connected, 3:fail, 4:0S not support, 5:HMI not
support) (USB tethering)

il Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

5.13. FTP

Device

Server

Client

System Parameter Settings @

Model General Swstem Remote Security
Cellular Data Network

Keep HMI settings Defanlt certificate (@) Custom certificate
Certificate: None
Import |
Private kev: None
[mport |
* 08 20240308 or later support explicit FTF over S5L/TLS and can update custem certificate.

| Enable FTP function ifor screen hardeopy and historical data backnp)

Extended Memory
Time Sync./DST o-Mail FTP

FTF connection

FTF connection : |1, FTP connection : 0.0.0.0:31

Naming convention for HMI folder
@) Use [F address
Use HMI name (LW-10834-LW-10899)

Prefix: IP_
(Ex : IP_192.165.1.25)

I__| WE!NTEK
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5.13.1. FTP Server

Starting from OS version 20240308, the cMT/cMT X series HMlIs support explicit FTPS. Users

can configure the HMI FTP server certificate with the following options:

1. Keep HMI settings: Continue using the current certificate settings on the HMI.

2. Default certificate: Use the system-provided default certificate.

3. Custom certificate: Users can import their own certificate and private key to meet specific
security requirements.

5.13.2. FTP Client

The FTP client function enables users to back up screen hardcopies and historical data. Once
enabled, users can backup files from the HMI to the FTP server. This feature is similar to the
eMT/iE/XE/mTV series, which uses EasyPrinter for historical data backup.
Please note that this feature is only supported on the cMT/cMT X series.

Setting Description

Enable FTP With this option selected, backup files (screen hardcopy or
Function historical data) can be transferred to FTP server.

FTP Connection FTP server’s information.

Naming Use IP address, backup folder name, or HMI name to name
Convention for the HMI folder.

HMI Folder Prefix: Add a prefix to the beginning of the folder name.

@ Note

B When the FTP function is enabled without any configured FTP connections, the system
will direct users to the [Data/History] » [FTP Connection] settings to configure FTP server

connection parameters.

5 | EasyBuilder Pro @

Mo FTP server exists. Do you want to create one?

oK Cancel
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6. Window Operations

This chapter describes different types of windows and how to create, set and delete a window.

6.1.
6.2.
6.3.
6.4.
6.5.

OVBIVIBW ...ttt et ettt e e e e ettt e e e e e e st e et e e e e e e s e anb et e eeeeaesesnssbbeeeeeeeesannnraeeeaaenns 6-2
WINAOW TYPES evveeeeeeeeeiccitrteee e e e eeretrrre e e e e e e s e tare e e e e e e sesssasataeeeeeeeesssnssanneeeesesessannsnens 6-2
Create, Set, and Delete @ WINUOW.......cviv it 6-4
WiINAOW TranSParENCY ....uuueeiiieieeeeeieeiiieeeeeeeeseiieetreeeeeeseesssserseeeaeesessssnssanseeeesssessnnsssens 6-8
o T oY= T o L3S PRUPR 6-10

I__| WE!NTEK EasyBuilder Pro V6.10.01

6-1



Window Operations 6-2

6.1. Overview

A window is a basic element in a project. With a window, all kinds of information like objects,
pictures, and texts can be displayed on HMI screen. In total, 1997 windows numbered from 3 ~
1999 in EasyBuilder Pro can be built and edited.

6.2. Window Types

There are 4 types of windows, each with different functions and usages:
® Base Window

® Fast Selection Window

® Common Window

® System Message Window

6.2.1. Base Window

The most frequently used window, except for main screen, it can also be:
® A background of other windows.

A keyboard window.

A pop-up window of Function Key object.

A pop-up window of Direct Window and Indirect Window objects.
A screen saver.

0 Note

B Base Window should be in same size as the HMI screen. Therefore, the resolution of the
base window should be set to the resolution of HMI.

6.2.2. Fast Selection Window

Window no. 3 is the default Fast Selection Window. This window can co-exist with base
window. Generally, it is used to place the frequently-used buttons on the lower-left side or the
lower-right side on the screen. Please create window no. 3 first, and set the relevant properties
in [System Parameter Settings] » [General] tab. Apart from showing or hiding fast selection
window with the button on the screen, there are system registers to do so:

[LB-9013] hide (set ON)/show (set OFF) Fast Selection window

[LB-9014] hide (set ON)/show (set OFF) Fast Selection button

[LB-9015] hide (set ON)/show (set OFF) Fast Selection window/button

@ Note

B cMT/cMT X Series does not support Fast Selection Window.
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6.2.3. Common Window

6-3

Window no. 4 is the default Common Window. Objects in this window will be displayed in

other base windows, not including pop-up windows. Therefore, the common objects in

different windows are often placed in common window.

When operating HMI, select [Function Key] » [Change common window] to change the source

of common window.

In menu [File] » [Preferences] » [Display] select whether or not to [Display Common Window

objects on Base Windows] when editing a project. This can avoid overlapping objects in base

window with objects in common window.

Preferences @
Display Object 1D Display Object Address
Font size : Text color : I ¥
[¥] Background Background color : ﬂ
The number of displayed addresses :
Display Common Window objects on Base Windows
[] Display Underlay Window objects on Base Windows
|| using function key to make shape lbrary object
Automaticaly save and compile the project when download and simulate
[C] Generate backup of project file before save
[T Automatically make used pictures and shapes into the project library
Save AutoRecover information
Every minutes

6.2.4. System Message Window

Windows No. 5, 6, 7, 8 are the default System Message Windows:

E@EO Device No Response

Close

& railed Connection to
D Remote HMI

Close

' Password Protected!
Access Denied!!

Close

I__| WE!NTEK

Window No. 5: Device No Response

When the communication between device and HMI is
disconnected, this message window will pop up
automatically right on the base window currently opened.
This window can be disabled by system registers.
Window No. 6: HMI Connection

When failing to connect HMI with a remote HMI, this
message window will pop up automatically.

Window No. 7: Password Restriction

When attempting to control an object without
authorization, this window may pop up as a warning
depending on the settings of the object.
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Window No.8: Storage Space Insufficient
» When HMI flash memory, USB disk or SD card run out of
Storage Space Insufficient !! . . .

storage space, this message window will pop up

@ automatically. (When the memory space is under 4 MB)

The following system registers can be used to check the free memory space in HMI, USB disk,
or SD card:

[LW-9072] HMI current free space (K bytes)

[LW-9074] SD current free space (K bytes)

[LW-9076] USB disk current free space (K bytes)

To check if there is sufficient storage in the devices, the following system registers can be used.

These addresses will set ON when the space is under 4 MB.
[LB-9035] HMI free space insufficiency alarm (when ON)
[LB-9036] SD card free space insufficiency alarm (when ON)
[LB-9037] USB disk free space insufficiency alarm (when ON)

|:)?For more information, see “22 System Registers”.

The text shown in windows no. 5 ~ 8 can be edited for easier reference.

@ Note

B For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT/cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window (including overlay windows) with
two Direct / Indirect Windows in one base window.

B  Windows no. 3 to 9 are used by the system only, and windows no. 10 to 1999 can be
edited based on actual usage.

6.3. Create, Set, and Delete a Window

Check the existing windows in [Windows Tree].

[Windows Tree] displays window numbers and window names. Opened windows are marked
with T icon. Press the (+) sign to see the object ID, address and description of the objects
used in this window.

[Window preview] displays the thumbnails of windows.
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Windows Tree v

™ 3: Monitor Mode

™ 4 : Common Window
[ 5: Device Response
[ 6: HMI Connection

[ 7 : Password Restriction

] 9:Backup
-] 10 : WINDOW_010
- FK_0 (Back)
- FK 1
- FK 2
L FK 3
11
12
13
14
15
16
17
18
19
20
21
22
23

[T 8: Storage Space Insuffici...

6.3.1.  Creating and Setting a Window

In windows tree right click on a window number then select [New].

RWE!NTEK

Windows Preview
0003

Monitor Mode
0004

Commeon Window
0003

Device Responss
0006

HMI Connection
0007

Password Rastriction

0008

Storage Spacs Insufficient

0008

Backup
0010

WINDOW_010

7]
| X

m
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Window Settings

Name @ WINDOW_010

Window no. : 10

Size
Width : 800

Background

Color : v

[T Filled

Height : 480

Color : G ~

Frame

Underlay window

Bottom : 11, Window_D11 -]

Middle : [None M ]

Top: [None - ]

Popup window
Start position

¥: 0 v. 0 [¥] Monopaly [¥] Title bar

Macro

Open : [[ID:UUO] macro_0 v]

Cyde : |Disable -

Close : [Disable T ]

Setting

Description

Name

The name appears on the title bar and also in windows tree.

Window no.

Can be 3 to 1999.

Size

Set the window size in accordance with the HMI resolution.

Underlay
window

Underlay Window can be seen as an extra Common
Window. When designing the project, some commonly
used objects are used in some windows but not all. These
objects can be placed in underlay window.

Each base window can set three underlay windows as
background, from [Bottom] to [Top]. The objects in underlay
windows are displayed in this order in base window.

Pop-up

window

Base window can also be used as a pop-up window. Use [X]
and [Y] to set the coordinates indicating where in the screen
will this base window pop up. The origin of the coordinates
is the upper-left corner of the window.

Monopoly

If the option is selected, when the base window pops up, no
operations of other pop-up windows and background
windows are allowed until the monopoly window is closed.
If a base window is used as a keyboard window, “Monopoly"
is automatically enabled.

Title bar

If the option is selected, a title bar appears on a system
message window. This feature is only available for system

I__| WE!NTEK
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message windows no. 5 to no. 8.

Macro Select the macro to be executed when the window opens or
closes, or the macro to be executed periodically (each 500
ms).

Please build the macro in advance.

@ Note

B The objects in underlay window cannot be edited from the base window that displays
them. To edit those objects, please open the underlay window where they are located.

B When the window number of the underlay window used by the base window is identical
to the pop-up window, the pop-up window is disabled.

B When base window and pop-up window use the same underlay window, the objects in
the underlay window cannot be displayed in pop-up window.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

Or, from the main menu click [View] » [Open Window] and then click [New] and select the type

of the window and click [OK].

Open Window
Nao. Window name Size
E] Fast Selection 100,450
4 Common Window 800,480
5 PLC Response 320,100
6 HMI Connection 320,100 Seitings:
7 Password Restriction 320,100
8 Storage Space Insufficient 320,100
*10 WINDOW_010 g800,480
50 Keypad 11 - Integer 275,280
51 Keypad 12 - Integer 275,280
52 Keypad 3 - Integer 200,170
53 Keypad 4 - Integer 304,213
54 Keypad 5 - Integer 160,230
55 Keypad 6 - Integer 241,331
56 Keypad 7 - HEX 306,223
57 Keypad 8 - Floating 198,220
58 Keypad 9 - Numeric 248,248
60 ASCII Middle 576,240
61 ASCII Srmall 480,200
62 ASCII Upper M 576,240
63 ASCII Lower M 576,240
64 ASCII Upper § 480,200
63 ASCII Lower 5 480,200
Exit

Ways to call up [Window Settings] dialog:

® Right click on the window number in the windows tree and select [Settings].
® In[View] » [Open Window] select the window then click [Settings].
® |nthe window, right click when no object is selected, and select [Attribute].

6.3.2. Open, Close, and Delete a Window

The ways to open an existing window:
® Double click on the window number in the windows tree.
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® Inthe windows tree, select the window number, right click, and then select [Open].
® |n[View] » [Open Window] select the window number and then click [Open].

The ways to close or delete an existing window:

® |nthe windows tree, select the window number; right click, and then select [Close] or
[Delete].

® |n[View] » [Open Window] select the window number and then click [Delete].

6.4. Window Transparency

The Opacity setting in the View tab is used to adjust transparency effect of the common
window, overlay windows, and window layers.

-

EasyBuilder Pro (=

[View] > [Layer Opacity] is set to 50% by default for window layers,
I % common window and underlay windows to enhance object
visibility in current window during editing.

Lo J

As shown in the following screenshots, greater Opacity makes the object in the relevant
window more visible.

\' Q () Zoomln Q' Q & Zoomln

: (2) ZoomOut e ©) ZoomOut
Opacity Zoom Center Opacity Zoom Center
30% »  75%. (i) FittoWindow  View » 70% -« | 75%. ciy FittoWindow  View .
i 0% 0%
10% - 10% J—
1 J,JJL['??{J,I,!J,l,!lfﬁjjI,I,I”I”IlI ) e 8 B
20% 20%
v 30% 30%
40% 40%
50% 50%
60% 60%
70% v 70%
80% 80%
90% 90%
100% 100%

Additionally, the cMT / cMT X Series models support setting window transparency. This setting
is applicable for popup windows, Direct / Indirect Windows, and keyboard windows. The

settings dialog box and the effect are shown in the following screenshots. Greater transparency
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can make the object on the base window more visible when it is covered by the popup

window.
W'lﬁowﬁeﬂings
Mame : WINDOW 010
wodonno. (1|
Size
Width : 1024 Height: 748
Backaground
Color : I:IIV|
Transparency : D 20%s
* [Transparency] is used only on popup, directfindirect and keyboard windows.
Underlay window
Bottom : [None -
Middle : [Nane -
Top:lm vl
Popup window
[¥] Monopoly
Macro
Open l vl
Cycle l vl
Close l vl
ok || cancel |
Example

Setting transparency to 40%:

Setting transparency to 90%:

[\& WE!NTEK
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6.5. Editing Tips

EasyBuilder Pro provides a user-friendly interface with which users can easily edit projects. The

following are some editing tips.
6.5.1. Non-display Area, Select Tool, and Hand Tool

As shown in the following screenshot, two areas can be found in the editing window: editing
area and non-display area. The non-display area refers to the area outside the editing area (the
one in the middle). Objects placed in the non-display area will not be visible on HMI, and
communication with devices continues. The invisible objects such as Meter, Time-based Data
Transfer, or Text objects used for comments can be placed in this area to avoid overlapping
with other objects in the editing area, which adds difficulty to project editing. The objects
placed in the non-display area remain effective.
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4 10 - WINDOW 010 %

| PYCTETEIRICE i YT TYPRICE, i P PPN YCIRICYyc AOPRPYAUYPCIYICYy c MPRIYRPRIURYTOYsci APRIYTRTRINININY;ci APEIRTLININIUINY c NTTTITIEIRAIO

h‘ Select Tool
Clicking this icon in the toolbar changes the cursor to the Select Tool. Select a

single object by clicking it, or select multiple objects by clicking on an empty
part of the editing screen and then drag a box around the objects.

4‘"}2 Hand Tool
Clicking this icon in the toolbar changes the cursor to the Hand Tool. The Hand

Tool allows moving through the project screen by simply left clicking the mouse

and dragging anywhere.

6.5.2. Ruler

| :1|I|I|I|I|I|Illllllpﬂllllllllllll|I|I|:F|:1|I|I|I|I|I|I|I|I|_:P|:1|I|I|I|I|I|I|I|I|49|:1|I|I|I|I|I|I|I|||5F|:4|I|I|I|I|I|I|I|I|59|:1|I|I|I|I|I|I|I|I|-P|:4|I|I|I|I|I|I|I|I|I|
Selecting [View] » [Ruler] adds rulers to the top and left of the editing screen. Guides can be
added from the ruler by right click on the ruler. Objects will automatically snap to the guides

when moved or resized.
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4 10-WINDOW010 x|

q|I|IlIlI|IbllI|lllmlllIllllllllllllmnllllt

Setting Description
Delete Delete the guide.
Edit

Settings

Add or delete multiple guides.

Selecting [File] » [Preferences] » [Grid] opens the following window for setting the color or style
of the Guides.
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Project

Display

Grid
Library

B
Grid
Spacing
X(4-600: 20 Y (4-600 1 20 =
[ Display [ snap [T Fix all objects
Guides
soie (=]

6.5.3. Quick Copy

Quick copy can be carried out by pressing and holding Ctrl key on the keyboard while an object

is selected, and then drag the cursor to a new location where the object will be created.

I__I"WE!NTEK
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/. Event Log

This chapter explains how to set and use Event Log.

7.0, OVEIVIEW cciieeietteee ettt e e e e e ettt e e e e e s e bt ettt e e e e e e s e nnnrbeeeeeeeesanannbreeeeeeeesesannnrees 7-2
VN A=Y o) oY=V - T o= T=0=T0 01T o) TSR 7-2
7.3, Creating a NeW EVENT LOG ...cooiiiiiiiiieiececececececece e 7-10
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7.1. Overview

The following are the basic steps to use Event Log:

1.
2.
3.
4.

Define event content and trigger condition.
Trigger event according to the condition.
Save the event log to the specified device.

View the process of event by using the relevant objects.

This chapter will explain how to set and use Event Log.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

7.2. Event Log Management

Firstly, define the event content then use Alarm Bar ?, Alarm Display ‘!', Event Display

objects to view the process of the whole event from triggering—waiting to be processed—

return to normal. The upper limit for the number of event logs is 10000.
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Event Log

7.2.1. eMT, iE, XE, mTV, iP Series

Al = =]

Category :

L Jo

<

No.| Category| Text

Mode | Condition| Read address Notification address | Buzzer | e-Mail | Sa\

|Event 0/ WORD| < 0.00 |Local HMI: LW-0|Disable | Disable| Disable | Ena

. b

[7] Enable back light when alarm occurs
History files
[7] save to HMI memory []save to USB disk
[¥] Preservation limit Days of preservation: 7 day(s)
Print
[¥] sequence no. Trigger time :  HH:MM - Trigger date : DDMMYY v
[ mew.. |[ insert.. ][ Delete ][ settings... [ Export.. |[ import.. |
[ Copy ] I Paste ] [ Paste (Add Mode) ]

Setting Description

Category Classifies events by dividing them into 0 ~ 255 categories.
Select one category to add or view event log. In the bracket
“['17, it shows the number of events are in this category.

History Saves event log files to the specified location. Once an event

files occurs, the HMI immediately saves the history file. When

executing On-line or Off-line Simulation on PC, the files will
be saved in the HMI_memory / SD_card / USB folder under
the installation directory.

Preservation limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is
set to 2; the two latest files excluding the file generated today
will be kept. The files that are not within the range will be
deleted automatically for saving the storage space.

[\& WE!NTEK
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Print In [System Parameter Settings] » [Model], select a printer and
set the printing format.
Copy Copy the selected item.
Paste Overwrites the selected item with the new items. A message
window will pop up to confirm this operation.
Paste
Appends as a new entry.
(Add Mode)
7.2.2. cMT, cMT X Series
Event | History/Control
Category :  All[1] +  Edit category name mapping. .. 1]
No. | Category | Text Mode | Condition| Read address Notification address | Buzzer | e-Mail New...
0 Event 0| WORD| < 000 |Local HMI: LW-0| Disable Disable | Disable
[ Paste
| Paste+
Enable back light when alarm occurs Number of event {alarm) log : 1 /10000
Setting Description
Category Classifies events by dividing them into 0 ~ 255 categories.

Select one category to add or view event log. The number of
events in this category is shown in the bracket “[ ]”.

Edit category name mapping... Opens a category name table
which allows editing corresponding category names.
Subcategories can also be added in this table in addition to
the exiting categories. The maximum allowable number of
entries in each subcategory is 256 (0~255) entries.

[\& WE!NTEK
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Category
Category | Subcategory 1

MName

Subcategory 2

Category

Subcategory 0

Delete

* Font frem [Language & Font] settings

o) (o

Copy

Copies the selected item.

Paste

Overwrites the selected items with the clipboard contents.

A message window will pop up to confirm this operation.

Paste +

Appends the clipboard contents to the end of the list.

Event (Alarm) Log

Historyw#Control

History
Enable

Save to

(@ USE disk 1

(O HMI memery ¢10000 limited)

(7)) HMI memory (until space full)
(O)USB disk 2

Swnc to databass

Enable

| Statns : LW-0+ |

Error : LW-0+2

Database : |1, 192.168.1.0

@ USE disk |

Preservation limit

Control
Enable

| Statns : LW-0 + 3

History sonice for display

|| Limit write frequency 1o HMI flash drive
[¥]Wrhen starting up, mark events triggered prior to shutdown as recovered

[¥] Auto sync, periedically

Error : LW-0 + 4

(7) Database

Draws of preservation : 7 day(s)

mins)

30

Enable status ontput

Address :

Device : [Local HMI

e ]G]

LW |0 16-bit Unsigned

Control command @ 1 [clear], 2 [svnc.], 3 [svac. and clear]
[clear and restore log index]
11 [update messages according to imported string tables]

FREA
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Setting

Description

History

Saves the Event Log data to HMI memory (10000 limited or
until space full), SD card, USB disk, or database (by
synchronizing Event Log file to database server).

The rules of saving the data are:

B When [HMI memory (10000 limited)] is selected, and
the number of events reaches 10000, the system will
delete the earliest 1000 events on HMI and keep on
saving the data to HMI memory. .

B When [HMI memory (until space full)] is selected, the
system will keep on saving data to HMI memory;, in this
case, the data may not be synchronized to database
server. When the cMT / cMT X HMI memory storage is
full, the system will delete the earliest 1000 records and
keep on saving data to HMI memory.

B When USB disk or SD card is selected, and the number of
events reaches 10000, the system will automatically save
the data to the external device and delete the earliest
1000 events on HMII.

B To synchronize the data to database server, select a
database that has been configured before.

B If the external device already contains some events, the
new data is appended without overwriting the original
data each time in synchronization.

B When the external device is removed from HMI, or HMI
is disconnected from database server, if the connection
is recovered before the number of events exceeds 9000,
the events occur during disconnection will be saved to
HMLI. If the number of events exceeds 9000 during
disconnection, the earlier data will be deleted, and

cannot be synchronized by recovering connection.

History
source for
display

Event Log displays the history data read from the designated

source.

Preservation
limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is

set to 2; the two latest files excluding the file generated today
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will be kept. The files that are not within the range will be
deleted automatically. The system checks the time of the files

and deletes earlier files only during synchronization.

Limit write When enabled, the system will store operation logs on the

frequency HMI at intervals of 10 seconds. To prevent the loss of

to HMI flash operation log data between two storage actions caused by

drive power-off, EasyBuilder Pro provides the system register LB-
9034. By sending an ON signal to this register, the system will
initiate a data storage process.

When

starting up,
mark events

When enabled, the system will automatically recover events

triggered )
) triggered before shutdown.
prior to )
Range: The last 10,000 events stored in the HMI memory.
shutdown
as
recovered
Auto sync. Data will be automatically synchronized to the designated
periodically external device in the specified time interval, regardless of
the rules explained above.
Unit: Minute(s)
Range: 1~1440
Control If select [Enable] check boxes under both [Control address]
address and [History files], entering a specific value in the control

address sends the corresponding command.

Value | Command

1 Clear the event log on HMI

2 Synchronize event log to the external device

3 Synchronize event log to the external device and then
clear the event log on HMI

4 Use the history data stored in USB disk / SD card /
database after changing HMI

6 Free unused storage space reserved for event logs
(*.db). This command can be used when historical data
is saved to HMI memory (until space full).

11 Update event log message contents by reading a new
String Table

12 Reset the event occurrence count displayed in the Event
Display and Alarm Display. This is effective only when
the event does not have the [Read and reset
occurrence] address enabled.
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If none of these values is entered, the system will synchronize
data in the same rules as [History] setting.
Status When LW-n is used as the control address, the four
Error consecutive addresses following LW-n (LW-n+1~LW-n+4) will

show status and error, please see the prompt in the settings
dialog box.

Control address
[V Enable

PLC: [Local HMI ~|[Settings... |
Address : [LW vl 0 16-bit Unsigned
Control command : 1 [clear], 2 [sync.], 3 [sync. and clear]
History files

V| Enable V| Enable status address

|| Sync. to SD card V] Sync. to USB disk

| Status : LW-0 + 1 Error : LW-0 + 2 |

[¥] Auto sync. periodically 10 min(s)

[¥] preservation limit Days of preservation : 3 day(s)

Sync to database

[¥] Enable [ Display history from database

| Status : LW-0 + 3 Error : LW-0 + 4 |

Database : [1. 192.168.1.0 VJ
Value | Status address: LW-n+1 and LW-n+3
0 Disconnected from external device or database
1 Connecting with external device or database
2 Connected with external device or database
3 Storing records into the archive. When this is done, the
value returns to 2.

Value | Error address: LW-n+2 and LW-n+4
0 None
1 Unknown error
2 Failed to connect with external device or database
3 Access denied
4 Wrong database name
5 Inconsistent data format
6 Failed to open table
7 Failed to create table
8 Failed to write table
9 Failed to open database
10 Database is corrupted

@ Note

B Before removing SD card / USB disk, or disconnecting from database server, please

synchronize event log data by using control address.

B When monitoring multiple HMls by using cMT Viewer, the Start Button on the current

HMI screen may flash to indicate that an error has occurred on another HMI that is also

being monitored, reminding the user to switch HMI and check the event.
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B The [When starting up, mark events triggered prior to shutdown as recovered] option
does not apply to events stored in the HMI memory exceeding 10,000 entries.

7.2.3. Excel Editing

Click on the Excel icon in Event Log setting dialog box to open the Excel template for a
reference of editing. This template is under the installation directory, the file name is

EventLogExample.xls. This template includes the ready-made dropdown lists and validation

mechanism.
b E C D E F &5 H I 1 K
1 Category |Priority level | Address type|PLC name Device type System tag |User-defined tag |Address  |Index Data Format Enable
2 0[Middle Word Local HMI LW False False 100|null 32-bit Signed Tiue
3 1|Low Bit Local HMI LB-O009 True False 9009|IDX 5 16-bit ECD > [se
4 330t BeD
5 16-bit Unsigned
16-bit Singed
(3] 32-bit Unsigned
32-bit Signed
7 32-hit Float

0 Note

B [System tag] and [User-defined tag] cannot be set to true simultaneously, otherwise, the
system will view the User-defined tag to be a System tag, and [User-defined tag] to be
false. If setting [Device type] to [User-defined tag], please set [System tag] to false.

B When setting [User-defined tag] to true, if the system compares the [Device type] with
the user-defined tag in the system, and no suitable tag is found, the system will set the
[User-defined tag] in event log to false

B [Color] format is R:G:B, each should be an integer form 0 to 255.

B Before importing Label Library / Sound Library, please make sure the library names exist in

the system.
7.2.4. Quick View of Errors

When compiling the project, the errors in Event Log will be displayed in the Compile window.

To open Event Log and view the errors, double click on the item in the Compile window.
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Compile

Project name : C:\EMTP1.emtp

EXOB file name : C:\EMTP1.exob

EXOB password = (used in decompiler)

Select the languages used on the HMI

Startup language after redownloading the project : | Language 1 -

[#] Language 1 [#] Language 2

|| pecompilation is prohibited
[~ pisable HMI upload function

@SR

rrortsi
Event (Alarm) Log 1 (Category 1)
Event (Alarm) Log 1 (Category 1)
Event (Alarm) Log 2 (Category 1)
Event (Alrm) Log 2 (Category 1)
Event (Alarm) Log 3 (Category 1)
Event (Alrm) Log 3 (Category 1)
Event (Alrm) Log 4 (Category 1)
Event (Alarm) Log 4 (Category 1)

: PLC name undefined (Rockwell DF1)
: incorrect device type
: PLC name undefined (Rockwell DF1)
: incorrect device type
: PLC name undefined (Rockwell DF1)
: incorrect device type
: PLC name undefined (Rockwell DF1)
: incorrect device type

[m]

Double click error messages to modify the attributes of relative objects !

Compile ] [ Font Management... ] Build font files

Close

7.3. Creating a New Event Log

General Tab

Click [New] in the [Event (Alarm) Log] dialog box.
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Event (Alarm) Log @
General | Message | Statisties |
Category : [U:Cahegoryﬂ v] Subcategory.
Priority level : [Low |
Delay time for event monitoring when HMI resets :
[¥] Save to history
[7] Push notification (Easyhccess 2.0)
Type
 Bit @ Word
Read
Device : Local HMI Y&
Address: [LW ~|0 16-bit Unsigned
Notification
[¥] Enable () SetON @ Set OFF
[ Follow {set ON when event recovered)
Device : [Local HMI D EEemn| e
Address: [LB v|0 [ '
Condition
Enable if value is :
[V] Dymamic condition value
[V] Read/Condition vse different addresses
Condition value
Device : [Local HMI -
Address: [LW v|0 [[6-bit Unsigned
[ oK ] [ Cancel ] I Help ]
Setting Description
Category Select event category, the range is from 0 to 255.
Subcategory Add this Event Log into the subcategories in the category
name mapping table.
Subcategory ==
Subcategory 1
Enable [0: Subcategory 0 ']
Subcategory 2
e [o-subesegoryd -]
Priority Events in Alarm Bar / Alarm Display are ordered by priority
level level first and then by time.
Save to In Event Log main settings, if [Save to HMI memory] check
history box under [History files] group box is selected, selecting [Save
to history] here determines whether each separate event
should be saved as historical file.
Push When an event occurs, EasyAccess 2.0 push notifications can

be sent to i0S®/Android® devices.
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notification

(EasyAccess

2.0)

Delay time This feature is used to set the delay time of Event Log after

for e}fce“f‘ HMI reboot, in order to avoid false alarm that occurs upon

:;ﬁ:r'\ glrlc;lg HMI re[ooot due tg uniniti_a!ized values. This featu.re is often

resets used with [Dynamic condition value]. The delay time only
occurs once upon HMI reboot.

Read The system reads data from this address to check if the event

address matches the trigger condition.

Notification When enabled, the system will set the specified address ON
or OFF when the event is triggered.
Follow
The notification bit will reset to its original state once the
alarm condition returns to normal. For example, when the
alarm is triggered, the state of the notification bit turns ON.
When the alarm condition returns to normal, and [Follow]
check box is selected, the state of the notification bit turns
OFF.

Condition When [Bit] is selected, Event Log will detect the state of a Bit

address.

When [Word] is selected, Event Log will detect the value of a
Word address to check if it is greater than, less than, or
equals to a specified value. See Example 1 and Example 2.
Dynamic condition value

Allows online change of the comparison value for trigger
condition when the condition is a Word address type. If
[Read/Condition use different addresses] is not selected, the
source of condition value will be the next consecutive address
from [Read address].

Read/Condition use different addresses

Allows selecting the Word address type to be the source of
condition value.
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Example 1
Condition
Ensble if value is: [— | 20

Drmaumic condition value

In tolerance © 1 Cut tolerance 2

The setting above indicates:
When [Read address] value is greater than or equals to 29 (=30 - 1)
Or less than or equals to 31 (= 30 + 1), the event will be triggered. The trigger condition:
29 < [Read address] value < 31
After the event is triggered, when [Read address] value is greater than 32 (= 30 + 2) or less than
28 (=30 - 2) the system will return to normal condition:
[Read address] value < 28 or [Read address] value > 32

Example 2
Cond ition
Enshle ifvalue is: [, o 20
Drmaumic condition value
In tolerance © 1 Cut tolerance 2

The setting above indicates:
When [Read address] value is less than 29 (=30 - 1)
or greater than 31 (= 30 + 1), the event will be triggered. The trigger condition:
[Read address] value < 29 or [Read address] value > 31
After the event is triggered, when [Read address] value is greater than or equals to 28 (=30 - 2)
or less than or equals to 32 (= 30 + 2) the system will return to normal condition:
28 < [Read address] value < 32
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Message Tab

Event (Alarm) Log @
[ General | Message | Statistos |
Text

Content :

Use label library [ LabelLibrary...
[¥] Use string table ( String Table... ]
Section : [ [1D.000] -]

String ID
[V] Dymamic
Device : (Local HMI
Address: LW |0

[V|Record string ID

B e

{16-bit Unsigned

conr: (NN Do Colr
Font : | Arial [Arial] [Droid Sans]
* Font from [Language & Font] settings

Language & Font...

Acknowled ge value for Event/Alarm Display object
Acknowledge valve : 11

Sound
["] Enable Sound Library

Addresses of WATCH1 ~ WATCHE

Multi-watch : Settings Symtax...

[ OK H Cancel H Help

Setting

Description

Content

The text content displayed in [Alarm Bar], [Alarm Display],

and [Event Display] objects. Use the formats in the
following two examples of WATCH addresses to use
register data in content. The content in Label Tag Library

and String Table can be used in the Event Log message.

String ID

[Event Display] and [Alarm Display] objects display
messages according to the String ID in the designated
register.

Record String ID

With this option selected, when an event occurs, the

string’s ID number will be recorded. Message of the event

triggered before can be retained.

Font / Color /
Background

The font / color / background color can be set respectively
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color

for each event. The font and color settings determine how
[Alarm Bar] shows the text, while The font, color, and
background color settings determine how [Alarm Display]
and [Event Display] show the text. These settings are not

available in the [Event Display] under History mode.

Write value for
Event/Alarm
Display object

When an event in the [Event Display] or [Alarm Display]
object is acknowledged, the acknowledge value is written
to the specified [Acknowledge] address. This feature can
be used with an Indirect Window object’s read address so
that when the acknowledge value is written, a window
pops up as a prompt about how to handle the alarm. As
illustrated below, when an event is selected and the
acknowledge value is set to 11, window 11 will pop up,
displaying the alarm handling prompt.

@ 11:Window_011

ll.’r 12:36 WARNING ‘ iy

¥

= Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Sound

Sound

[V] Enable Sound Library... Beep

Continuovs beep : | Disable continuous beep . ’
Disable continuous beep
Enable continuous beep until recovered I

Enable continuous beep until acknowled ged
Enable continuous beep wntil acknowled ged or recovered

If enabled, the selected sound will be played when an
event is triggered. Continuous beep can also be enabled,
which only stops when the event is acknowledged or
recovered.
For continuous beep, a delay time can be set between
triggering the alarm and the start of beeping.

[Acmededged |

[evn] _| L]

User defined |

<5
Sound II I |

e
10 seconds| |The time interval for beep sound
is once in each second
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¥

k= Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Address of
WATCH1~8

Users can set how the value is displayed in the designated
watch address when an event occurs. Up to 8 watch
addresses can be used simultaneously. Click [Syntax] to
see how to use the syntax to embed device data in the
content of an event log displayed in the watch address.
i. Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

e-Mail Tab

Please enable this function in [System Parameter Settings] » [e-Mail] first.

Event (Alarm) Log 3
| General I Message | e-Mail |Oocurrenoe|
Enable Condition Recipients
Send when event triggered
» Send when event cleared Giroup &
Recipients
[ As recipients of triggered mail settings
Group A
Subject
Use event content as subject
Subject : | Tank level low. level=":(WATCH1)d.0 -
4 F
Message
Opening : -
4 F
Use label library
Ending : -
4 F
Use label library
Label Library... ] [Language i -
o o

Setting Description

Recipients Select the [To], [Cc], and [Bcc] recipients.

Subject Enter the subject of the e-mail.

Message Enter the [Opening] and [Ending] content of an e-mail.
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Attach If the [Contains a screenshot of window] check box is

selected, the screenshot of the selected window will be
attached.

0 Note

B The priority level of an event determines its importance in e-mail delivery.

Event Priority Level Email Importance
Emergency High
High / Normal Normal
Low Low
Statistics Tab
Event (Alarm) Log *

| General Message Statistics Security

Read and reset occurrence

B Enable
Device:  Lacal HMI - [ e
Address: |LW - 0 16-bit Unsigned

Read and reset elapsed time

B Enable
Device: |Lacal HMI ~ [ <
Address: LW - 10 16-bit Unsigned
Unit of elapsed time : second
Setting Description
Read and reset If enabled, the number of occurrence of the event after
occurrence HMI startup will be written to the de5|gnateFJ word
address. The word address can be read / written.
Elapsed time If enabled, from an event occurs to its recovery, the
elapsed time (in seconds) will be written to the
read and reset )
designated word address. The word address can be read /
address written.

=

Click the icon to download the demo project. Please confirm your internet

connection before downloading the demo project.

Security Tab

With security settings enabled, an address and a condition can be set so that an event is

recorded only when the state of the specified address meets the preset condition.
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Event (Alarm) Log @

| General I Messags | Statis‘lics| Security |

Enable/Disable
sz re pister statusivalue

Device : [LocalHMI '][ <l ]
Address : [I,El—v] 101
Enable if bitis :

Setting Description

Use register With this option enabled, an event will be recorded only
when the state of the specified address meets the preset
condition.

status/value

@ Note

B When an event is triggered with the security settings enabled, the event can be

acknowledged on Event Display or Alarm Display even when the security settings are
disabled after the event is triggered.
B With security settings enabled, the event’s address will not communicate with the device

if the preset condition is not met.
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8. Data Sampling

This chapter explains how to set and use Data Sampling.

8.1.
8.2.
8.3.
8.4.
8.5.

OVBIVIBW ...ttt et ettt e e e e ettt e e e e e e st e et e e e e e e s e anb et e eeeeaesesnssbbeeeeeeeesannnraeeeaaenns 8-2
Data Sampling ManagemENt .......cceii i i e e e e e st e e e e e e e naaes 8-2
Creating a New Data SampPling .......uveeiieriiiiceeee et e e 8-2
Synchronizing cMT Viewer data and Saving to External Device......ccccocvveeeeeievcnnnneee. 8-15
Checking History Data of a Specific Date on cMT VIieWer. ........cceeeviveeeeeciieee e, 8-15

I__| WE!NTEK EasyBuilder Pro V6.10.01

8-1



Data Sampling 8-2

8.1. Overview

After defining how the data is sampled, by sampling time, address, or data length, the sampled
data can be saved to the designated location, such as HMI memory, SD card, or USB disk. Trend

Display and History Data Display objects can be used to display sampling records.

8.2. Data Sampling Management

Create a new Data Sampling object first by the following steps:
1. From the menu select [Data/History] and click [Data Sampling].

2. Click [New] to finish relevant settings.

No. | Description | Read address Sample mode | Trigger address | Control address | History file | Synchronous
Local HMI : LW-0 | Periodical Disable Local HMI: LWO | Disable

< m. »

[ New. || Delete | settings.. | [ Boot. [ mpot. |
[ Copy ]I Paste J[ Paste (Add Mode) Exit

8.3. Creating a New Data Sampling

The following introduces how to set a new Data Sampling.
eMT, iE, XE, mTV, iP Series
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Data Sampling Object
el PLC name : [Logal HMI -
Sampling mode Clear real-time data address
[ High priority (this may reduce refresh rate of screen components.) [C]Enable
@) Time-based _) Trigger-based
Sampiing tme interval : | 1 second(s) -
Hold address
[ Enable
Read address
PLC name : Lagal HMI - ][ settngs... |
———— History files
Address : | Ly ~|0
Save to HMI memory
=In prier to display or store the data log, you can use the conversion tag to check and [7save to Usa disk
modify the data log.
@) Each fil ts of all ds of a d
=When the Data record is converted by the user-defined conversion tag, the I SE SR R S
GetCnvTagArraryIndex() function of [Read conversion] subroutine can get the relative Customized file handling
array index. -
e — Folder name : Datalog
Max. data records (real-time mode) : 1000 [ Auto. stop File name example : | 20150727.dt
Datz Format ... Datalength : 1 word(s) Preservation limit 7 day(s)
ok || cancel

Sampling mode

High priority

Data sampling processes with this feature enabled will be
prioritized. Please note that too many priorities can slow
down update rate of other objects.

Time-based

Samples data in a fixed frequency. The [Sampling time
interval] can be set from “0.1 second(s) to 120 mins”.
Trigger-based

Triggers data sampling by the status of a designated bit
address.

Mode Conditions to trigger Data Sampling:

[OFF -> ON] Triggers sampling when the status of the
address changes from OFF to ON.

[ON -> OFF] Triggers sampling when the status of the
address changes from ON to OFF.

[OFF <-> ON] Triggers sampling when the status of the
address changes.

Set ON/OFF after triggered

If selected, after triggering Data Sampling, the system will
set the designated bit address back to ON/OFF state.

Read address

Specify an address to be the source of Data Sampling. To
convert a data record, please use a user-defined
conversion tag that allows [Read conversion]. For array
addresses, the GetCnvTagArraylndex function can get the

relative array index and then calculate.
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Data Record

(Real-time)

In Real-time Mode, when [Auto. stop] is not selected, the
max. number of data records can be saved on HMl is
86400. When the number of records exceeds 86400, the
earliest data will be deleted.

Data Format

Data of different formats in consecutive registers can be
sampled. For example, setting: LW-0 (16-bit Unsigned),
LW-1 (32-bit Float), and LW-3 (16-bit Unsigned). The

upper limit for the number of records is 1000.

Data Format

1. "16-bit Unsigned" 16-bit Unsigned
2. "32bit Foat" 32+bit Foat
signed” signed

ISl

[ New. ][ Delete ][ Settings... ][ Import.. ][ Export... ]

“When the [Read address] uses an user-defined conversion tag. it is suggested that each
item of the Diata Recond selects the same data length even in different data types. {.e.
16-bit BCD, 16bit Signed, 16bit Unsigned)

Auto. stop
Data sampling will automatically stop when the number

of records reaches [Max. data records].

C?See “8.3.1 Demonstration of Auto. stop”.

Clear real-time

data address

Set when the bit address status changes from [OFF -> ON]
or [ON -> OFF], clear the sampled data in Trend Display

Real-time Mode. The number of data records returns zero
but the data records that are already saved as history files

will not be cleared.

Hold address

If the status of the designated address is set ON or OFF,
sampling will be paused until the status of the designated

address returns.

History files

Save to HMI memory

Saves Data Sampling to HMI every 10 seconds. Or, use
system register [LB-9034] to force storing data. See
details on the restrictions of using LB-9034 in the Note
below.

Save to SD card / USB disk

Saves Data Sampling to the specified external device.

Each file consists of all records of a day
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1%

The data sampling file will be saved on a daily basis into
the specified folder, and the file name will be
yyyymmdd.dtl, indicating the date of the file.

Folder name

Specify Data Sampling file name which must be all in
ASCII characters. The folder name will be written as:
[Storage Location] \ [Folder Name] \ [File Name]
Preservation limit

Determines the number of data sampling files to be
preserved. Please note that the current .dtl file is not
included in this limit. That is, if this limit is set to 2, apart

from the current file, two latest files will be preserved.

Customized file This feature can be used to customize naming and

handling management of data sampling files (*dtl).

C?See “8.3.2 Customized File Handling”.

Note

A Data Sampling may include more than one type of records. Data Sampling can retrieve
different types of records at the same time. For example, if define three types of data, 4
words in total, the system retrieves a 4-word data each time from the designated address to
be the content in one Data Sampling.

When using [Each file consists of all records of a day] and set [Preservation limit] to 2 files,
the data of yesterday and the day before yesterday will be kept. Data that is not built in this
period will be deleted to prevent the storage space from running out.

When using [Customized file handling] and set [Preservation limit] to 2 files, not only the
currently sampled file, another 2 newest files (3 files in total) will be kept. The rest of the
data will be deleted to prevent the storage space from running out.

When running simulation on PC, all data sampling will be saved to the datalog folder in
C:\EBPro\[Storage Location]\datalog. If you change the data format of data sampling, delete
the previous data records in the installation directory to prevent the system from reading
the old records.

When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the
length of the file names. Fewer files can be saved when the file names are longer.

When using LB-9034, the shortest interval between two successful executions is 2 seconds.
That is, after LB-9034 is triggered, it can be effective again 2 seconds later.

[»] Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
cMT, cMT X Series

The settings are almost similar to eMT, iE, XE, mTV, iP Series. The following highlights the

settings that are different.
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Data Sampling Object

Comment :

Sampling mode

() Time-based

Mode @ | OFF->0N -

@) Trigger-based

|| High pricrity {this may reduce refresh rate of screen components.)

[ 5et OFF after sampling finished

Device : [Local HMI

JEE]E

History file
Enable

@ All records in one file
(7 Customized file handling

File name @ jogoon

Address : |LB |0
Data Record Save to
Device : Local HMI (7 HMI memary (10000 limited) () HMI memory (until space full)
(@) USB disk 1 (7 USB disk 2
Data length ¢ 1 word(s)
Sync. to database
Hold control
| Enable
Database : |1, 192,168.1.0 -
Device : [Local HMI - ][ {a ]
Address @ |LB -0 History source
(@) USB disk 1 (") Database
Control
V| Enabl
nanie [¥] Preservation limit (1 ~ 65535 days) 7 day(s)
- = o )
Device : [Local HMI '][ ] [¥] Auto sync. periodically 30 minute(s)
Add : 0 16-bit Unsigned
ress: | il T [V]Enable status address
*Control command : 1 [dear]
2 [sync] USB Sync. status : Lw-1
3 [sync. and dear] . .
4 [dear and restore log index] USE Sync. error : Lwv-2
5 [recover freeze state] Datahase Sync. status : LW-3
7 [delete oldest data]
Database Sync. error : L4
Setting Description

Data Record

Data of different formats can be sampled. The upper limit for

the number of records is 1000. Click the [Settings...] button to

set the read addresses of different data types. For selected PLC

drivers, sampling addresses of different sections is possible. For

the drivers that can only sample contiguous addresses, simply

set the data types. The display format settings may be used by

Trend Displays and History Data Displays which are set to

display the sampled data.

Next contiguous address

With this option selected when adding a new item, simply set

the data type and it will be put into the same section as the

previous read address. The following setting aims to read LW-
0~LW-17 at a time.
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Data =
Device : | Local HMI 5.0 ]
Section Description Read address Data type Size

1 16-bit Unsigned 16-bit Unsigned 1 word(s)

2 16-bit Signed 16-bit Signed 1 word(s)

31 32-bit Signed  LW-0 32-bitSigned 2 word(s)

4 32-bit Float 32-bit Float 2 word(s)

5 String String 11 word(s)

s
1

=

*When the [Read address] uses a user-defined conversion tag, it is suggested that each item have the same data
length. (Their data types can still be different, i.e. 16-bit BCD, 16-bit Signed, 16-bit Unsigned.)

54 32-bit Float REAL-PLC Bloc... 32-bit Float 2 word(s) L

Exit
When [Next contiguous address] option is not selected,
multiple addresses can be read at a time.
Data (EX3)
Device : | Siemens 57-1200/57-1500 ']
Section Description Read address Data type Size

11 16-bit Signed INT-PLC.Blocks... 16-bit Signed 1 word(s)

22 16-bit Signed INT-PLC.Blocks... 16-bit Signed 1 word(s) E]

3 16-bit Signed 16-bit Signed 1 word(s) @

3 INT-PLC.Blocks...
4 16-bit Signed 16-bit Signed 1 word(s)

65 String STRING-PLC.BL... String 11 word(s) -
=

*When the [Read address] uses a user-defined conversion tag, it is suggested that each item have the same data
length. [Their data types can still be different, i.e, 16-bit BCD, 16-bit Signed, 16-bit Unsigned.)

* As multi-read capability varies among devices, it is possible for different sections to be sampled at slightly different
times,

Exit

Click [New] and de-select [Next contiguous address] option.
The address setting shows, and a different address can be
selected.
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Channel (23]
Description : 16-bit signed
()
Address
Device : |Siemens 57-1200/57-1500
Tag ¢ [PLC.Blocks.Data_block_2.a - |
Data type : [16-bit Signed -]

Display format : [] Leading zero

Right of decimal Pt.: 0

Save to default Cancel

Please note that when contiguous address setting is used for

a tag-based PLC driver, only one-dimensional arrays are

supported.
Control Entering a value in the control address sends the
address corresponding command.

Value | Command

1 Clear the sampled data in HMI.
2 Synchronize data to the external device / database.
3 Synchronize data to the external device / database

and then clear the sampled data in HMI.
4 Use the history data stored in USB disk / SD card /
database after changing HMI.

5 As data sampling stops when HMI storage is full, this
command allows restarting of data sampling when

there’s free space.

6 Free up memory space reserved for data logs (*.db).
This command can be used when historical data is

saved to HMI memory (until space full).

7 Delete the oldest data (*.db).
Status & Error When LW-n is used as the control address, the four
address consecutive addresses following LW-n (LW-n+1~LW-n+4) will

show status and error, please see the prompt in the settings
dialog box.
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History file
Enable

MName: Datalog

|:| Sync, to SD card

Status: LW-10 =1
Error: LW-10 + 2

Sync to database
Enable

Enable status address

Sync. to USB disk

Display history from database

Database: |1,192.168.1.0

Status: LW-10 =3
Error: LW-10 + 4

Value | Status address: LW-n+1 and LW-n+3

0 Disconnected from external device or database

1 Connecting with external device or database

2 Connected with external device or database

3 Storing records into the archive. When this is done,
the value returns to 2.

Value | Error address: LW-n+2 and LW-n+4

0 None

1 Unknown error

2 Failed to connect with external device or database

3 Access denied

4 Wrong database name

5 Inconsistent data format

6 Failed to open table

7 Failed to create table

8 Failed to write table

9 Failed to open database

10 Database is corrupted

11 The Row ID from the external device is inconsistent
with the internal Row ID.

History files History data can be saved to HMI memory (10000 limited or

until space full), USB disk, SD card, and Database (by

synchronizing history data to database server.).

The rules of saving the data are:
® When [Save to HMI memory (10000 limited)] is selected
and the sampled data reaches 10000 records, the

system will delete the earliest 1000 records and keep on

saving data to HMI memory.
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® When [Save to HMI memory (until space full)] is
selected, the system will keep on saving data to HMI
memory, in this case, the data may not be synchronized
to database server. When the HMI memory storage is
full, the system will delete the earliest 1000 records and
keep on saving data to HMI memory.

® When USB disk or SD card is selected, and the number
of records reaches 10000, the system will automatically
save the sampled data to the external device and delete
the earliest 1000 records on HMI.

® To synchronize the data to database server, select a
database that has been configured before.

r See synchronization rules in “8.4 Synchronizing cMT

Viewer data and Saving to External Device”.

&

See Database Server usage in “13.44 Database Server”.

Customized file
handling

This feature can be used to customize naming and

management of data sampling files (*db). The current *db

file is saved in HMI memory. Please note the following two

points when Sync. Destination is USB disk / SD card:

1. When *db file name changes, the *.db file with the
former name will be synchronized to USB disk / SD card.

2. If anew *dbfile is generated when there’s no existing
USB disk / SD card on HMI, the earlier *db file will be
deleted. For example, if 20161218.db is the current file,
when 20161219.db is generated and no external device is
inserted to HMI, and then 20161218.db will be deleted.
When [Customized file handling] is used, enabling [Sync.

to database] is not possible.

&

“8.3.2 Customized File Handling”.

Find Customized File Handling settings dialog box in

Auto sync.
periodically

Data will be automatically synchronized to the designated
external device in the specified time interval, regardless of
the rules explained above. Please note that the timer will
reset when a control address is used.

C?See “8.4 Synchronizing cMT Viewer data and Saving to

External Device or Database Server”.
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All record in When Sync. Destination is USB disk / SD card, the
one file preservation limit is 1 to 65535 days.
Customized file When Sync. Destination is USB disk / SD card, the
handling preservation limit is 1 to 65535 files.

When Sync. Destination is HMI memory, the preservation
limit is 1 to 1000 files.

History source Data can be read from USB disk, SD card, or Database.

8.3.1. Demonstration of Auto. stop

This feature depends on the arrangement of different objects and modes. (Set [Max. data
records] to n.)

Object [Auto. stop] not selected [Auto. stop] selected
Trend Display- Deletes the earlier Stops after reaching the

. records and displays the specified number of
Real time latest number of records data records (n).

(n) in Trend Display. See
the following figure.

Trend Display- Keeps on sampling data Stops after reaching the
o and displays all history specified number of
Historical data in Trend Display. data records (n).
History Data Keeps. on samplin_g data Stop§ _after reaching the
. and displays all history specified number of
Display data in History Data data records (n).
Display.
Data Sampling Keeps on sampling new Stops after reaching the
data. specified number of

data records (n).

The figure illustrates how the data is sampled in Trend Display — Real Time mode when [Auto.
stop check] box is not selected. Set the number of data records to 10, when the 11t data is

generated, the earliest record is deleted and the newest record is added.
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Record Not selecting
Number Data [Auto. stop]
1 101 102
2 102 103
3 103 104
4 104 105
5 105 106
6 106 b 107
7 107 108
8 108 109
9 109 110
10 110 111

11 111

8.3.2. Customized File Handling

This feature can be used to customize naming and management of data sampling files (*.dtl,

*db).

I__| WE!NTEK

Customized Filename Handling

File creation
() Automatic mode (A new file will be created when the file name is changed.)
(@) Trigger mode (Use the trigger method to create a new file.)
Trigger method

Limit by number of data records
Max. data recordsin a file : 1000

Register status
Mode : | OFF-=0N « | [|Set OFF after triggered

Device : [Lgm| HMI v][ e ]

Address : |LB |1
File name

Dynamic format

Device : [Local HMI LG @
Address @ [Lw |1 10 word(s)

* Please configure the value of [Dynamic format] before any data sampling.
*Only ASCII is available. Unicode is not supported.

%Y Year (2000-2038)

Sy Year, last two digits (00-99)

e Month as a dedmal number (01-12)
oed Day of the month (01-31)

W Week number (00-53)

S Weekday, 0is Sunday (0-6)

oeH Hour in 24h format (00-23)

%M Minute (00-53)

%S Second (00-53)

%% %

* A filename cannot contain any of the following characters: \/: *?< = |

Sort

Order : |File modification tme | This option may affect performance.

EasyBuilder Pro V6.10.01
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Setting

Description

File creation

Automatic mode

A new file will be created when the name of an existing
file is changed.

Trigger mode

A new file will be created according to the [Trigger
method] settings.

Trigger method

Limit by number of data records

A new file will be created when the number of data
sampling records reaches the specified "Max. data
records in a file"

Register status

A new file will be created when the status of a designated
bit address meets the specified condition. The condition
is specified in Mode field.

Set ON/OFF after triggered

If selected, after the new file is created, the system will
set the designated bit address back to ON/OFF state.
Following HMI reboot, generate and write to a new file
only after trigger condition has been met.

When the trigger condition has not been met following
HMI reboot and therefore no new file is generated, the
new data will be written to the last file generated before
HMI is rebooted. Downloading a new project to HMI is

the same as rebooting HMI.

File name

The file name can be an alphanumeric name, and certain
half-width symbols are allowed. The file name can also be
specified by a file name syntax.

Dynamic format

The file names can be set by a designated word address,
or by a file name syntax indicating the current system
time. The file name syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

The following half-width characters are not allowed:
\/:*¥?2“<>|

Sort

This setting affects how the system determines the sort

order of historical files, which affects the file preservation
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8-14

and backup logic.

File name

Files are sorted by their filenames in descending order.
File modification time

Files are sorted by the actual timestamps of the contents.
(Because the system has to check the content of the files,
this option may affect performance negatively.)

Example:

Consider the case where files have been generated in this
order: filename_05--> filename_04--> filename_03-->
filename_02--> filename_01. The earliest file is
filename_05 and the latest file is filename_01.

With preservation limit set to 5 files, the two sorting
methods yield different results when the 6™ file is
generated:

Sorted by Filename: filename_05 is seen as the latest file;
therefore, filename_01 will be deleted.

Sorted by File Modification Time: filename_01 is seen as
the latest file; therefore, filename_05 will be deleted.
Note on naming convention:

When File Name is selected as the sorting method and
the filenames are: filename_1, filename_2, and
filename_10, filename_2 will be seen as the latest file,
followed by filename_10 and filename_1. To make
filename_10 the latest file, please zero-pad the numbers
and name the files to: filename_01, filename_02, and

filename_10.

@ Note

B |n Data Record settings, if the option [Next contiguous address] is not selected, the upper
limit for the number of sections is 8.

B [f both [Limit by number of data records] and [Dynamic format] check boxes are selected,
before startup HMI, please enter the name in the designated register for Dynamic Format,
otherwise, it is impossible the reach the “Max. data records in a file”, and the data sampling

file will not be generated.

B When a new file is generated, the system will first detect if the filename already exists. If the
file name does exist, the newly sampled data will be appended to the existing file.

i Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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8.4. Synchronizing cMT Viewer data and Saving to External Device or Database

History data in external device Real-time data

»

v

For other series, when displaying the sampled data in Trend Display object, it is necessary to
select from Real-time mode or History mode and the two modes cannot simultaneously be

displayed in one object.

cMT / cMT X Series allows displaying history data and at the same time updates real-time data

in one Trend Display or History Data Display object. The data saved in the external device can

be updated.
The rule of synchronizing the data saved in the external device:

1. When the sampled data reaches 10000 records, HMI will automatically save data to the

external device and deletes the earliest 1000 records in HMI.

2. If the external device is removed from HMI and inserted back again at the time when the

sampled data is under 9000 records, the data generated during the time the external
device is removed is saved in HMI and is not cleared. If the data exceeds 9000 records

during the time the external device is removed, the earlier data is cleared and cannot be

synchronized even to insert the external device back to the HMI.
3. If there already exists sampled data in the external device, the new data is appended

without overwriting the original data each time in synchronization.

8.5. Checking History Data of a Specific Date / File on cMT Viewer.
To check the history data, see the following steps (Use Trend Display object as example).

1. Tapthe icon in the upper-right corner of the Trend Display object.
2. The following dialog box appears.
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Cancel Option

Begin Date

Ended Date

TREND DISPLAY SETTING

Channel Visibility
Y Scale

Reset to project default

3. Specify the date or the file.

Cancel Option

Begin Date
2016-12-19

Ended Date

2016-12-19

Done

Off

Done

L

L

Cancel

FILE SELECTION
(Current)
20161228_115444
20161219_151520
20161219_151504
20161219_151454
20161219_151444

Option

TREND DISPLAY SETTING

Channel Visibility
Y Scale

Cancel

FILE SELECTION
(Current)
20161228_115444
20161219_151520
20161219_151504
20161219_151454
20161219_151444

4. Tap [Done] button to finish setting.

I__| WE!NTEK
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Option

8-16

Done

Off

Done
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9. Object General Properties

This chapter explains the basic settings of an object.

9.1.
9.2.
9.3.
9.4.
9.5.
9.6.

OVBIVIBW ...ttt et ettt e e e e ettt e e e e e e st e et e e e e e e s e anb et e eeeeaesesnssbbeeeeeeeesannnraeeeaaenns 9-2
Selecting PLC and Setting Read/Write AdAress ........ccouveeceeeecieeeciee e 9-2
Using Shape Library and Picture Library......cccccooocoiieeie e 9-3
SEttiNG Label TEXL.coeeii e e e e e e 9-7
AdJUSting Profile SiZ€ .......eeeeeeiiieee e e 9-9
Overlapping Objects (CMT / CMT X SEIES) ..ccveeeeirieeereeeeieeeereeeeree e e e s eaaeeseaae e 9-10
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9.1. Overview

The basic steps to create an object:

1.
2.
3.
4.

Selecting the PLC device and setting the read/write address.

Using Shape Library and Picture Library.

Setting label text.

Adjusting profile size.

This chapter explains the basic settings of an object.

9.2. Selecting PLC and Setting Read/Write Address

Most objects read data from PLC devices, so a properly configured PLC address is needed.

Select the PLC to control at [PLC name] which comes from [System Parameters Settings] »

[Device List].

Write address
PLC name =[Local HMI v] [ Setting... |

Address i[LW |0 IDX 0 |16-hit Unsigned

Address

PLC name : [L0C3| HMI ']
Device type : [LW ']

Address format : DDDDD [range : 0 ~ 10799]

Ca =

Address: 0 [ system tag

16-bit Unsigned -

Setting

Description

PLC name

Select the PLC type.

Device type

Different PLCs have different device types.

Address

Set the read/write address.

System tag

Address tags include [System Tag] and [User-defined Tag].
This option allows users to use [System Tag]. [System Tag]
consists of the preserved addresses by system for
particular purposes. The address tags include bit registers
or word registers (LB or LW).

After selecting [System tag], not only will the [Device type]
field display the chosen tag, but [Address] field will also

display the chosen register.
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Index register

Select this check box to use the [Index Register].

& For more information about System Tag, see “22 System Reserved Words and Bits”.

¢ Q@

9.3. Using Shape Library and Picture Library

For more information about Index Register, see “11 Index Register”.
For more information about Tag Library, see “16 Address Tag Library”.

In the settings dialog box of certain objects, “Shape” tab can be found. In this tab, Shape

Library and Picture Library can be used to add visual effects on objects. Select Shape tab to use

the libraries when creating an object.

9.3.1. Picture

New Bit Lamp/Toggle Switch Object

| General | Security | Shape | Label |

Picture :

Picture

( Picture Library... ]
[V] Set to original dimensions

(— v ]

Flat Button
STYLING_SVG
[106x106

More picture libraries...

[V Use picture

[ Duplicate these attributes to every state

Shape

[ Shape Library. . ]

(]
ree (I
=

Pattern type :

[¥] Tnner

[¥] Use shape

[ Duplicate these attributes to every state

Select [Use picture] and then click [Picture Library] button to open Picture Manager window

and select a picture from the window.
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Project | Library
| System Flat Button - @G
{System Flat Button |
0 1 a
flat Button Z] Flat Button Z «
ftates: 2 Frates: 2
m‘ :0 F'—i] m :0 {T_ﬂ
2 3
@) [latbuton (Z] Flat Button Z)
= = [ Bxport.. |[ Modify.. |[HHE )
Ftates:z ﬁ Ftatac:z
: — . = STYLING_SVG o
fobiects : 0 ) Pbjects : 0 5 0 ‘ 106x106
3817 bytes
4 5 | STYLING_SVG
flat Button Z] Flat Button 2) 1 . 106x106
L) &) 3651 bytes
ﬁ Ftahes:z ﬁ Ftates : 2 S
6 7 [+
Flat Button (2] Flat Button 2] =
Background : :I [ New.. H Delete H Clean
More picture libraries.. [ o J[ cancel |[ hep |

Setting Description
Picture Click [Picture Library] button in Picture group box to open
Library Picture Manager window.
Set to ) ] ] )
. When this checkbox is selected, EasyBuilder will return the

original . N, - .

. . picture to its original size to eliminate the redrawing step.
dimensions

Duplicate these
attributes to

every state

This button is available only when a system picture is used.
Clicking this button will duplicate the attributes of the
current picture to other states.

9.3.2. Shape

Select [Use shape] and then click [Shape Library] button to open Shape Manager window and

select a shape from the window.
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[System Frame | @R
iSyshemFrame [
Frame
1 -
objects :9 @ Pattern
- coor: I
3 —® —n
Porectsio ]
5
[ @ - Inner.Frame
T Tr L o
Poiects 0] @
7 (=)
= 2 -
Background : [ oeete |[ cemn
[ ok [ concel J[ b ]
Setting Description
Inner Select [Display] to show the inner color of the shape and
select a color as the inner color by clicking the drop-down
button.
] Default
ENEEEEEEEN
EEEEEEEENEN
ONEERECOSCmEC]
ERCECOOCOEOO
Recent
I ]
Custom...
Frame Select [Display] to show the frame color of the shape and

select a color as the frame color by clicking the drop-down
button.

Pattern color

Click the drop-down button to select a color for the

interior pattern of the shape.

Pattern type

Click the drop-down button to select a pattern.

[\& WE!NTEK
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9.3.3.

Set to all
states

Duplicate the attributes of the current state to other

states.

In Picture Manager and Shape Manager windows, the currently selected picture / shape is

Shape manager

highlighted yellow as shown below.

Shape manager

Project | Library

.
_u_

Shape2

IShapeB

Inner

[¥] Display
[button2 -]
IC:‘EBprC\‘Iibrary button2.plb l
Frame
—_— 2 7] Displ.
Shape0 lShapel L4 Sy
States: 2 I IStates 12
Objects : 0 IObjects 0
3

9-6

States: 2 lStates 42
Objects : 0 @] Iobjects 10 0 E]
[ i [shapes rhapes 1
IStates 12 States: 2 —
® Objects : 0 @ [Objects : 0
s — 7 =
I 1 Bropes @ [ 1 Broper 2 -

Lox Jf

Cancel ] [ Help ]

The information about the selected picture / shape:

Directory  The directory from which EasyBuilder searches for the pictures / shapes.
Shape5 Name of the shape.

States: 2 Number of states of the shape.

Objects: 1 This shape is used by 0 object in the project.

Inner The state 0 and state 1 of this shape contain only “inner” but not “frame.”

Ci_" For more information, see “14 Shape Library and Picture Library”.
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9.4. Setting Label Text

New Bit Lamp/Toggle Switch Object

| General | Security | Shape ]Label ‘

Content [ Duplicate this label to every state J

[7] Use label [ AddtoLabelLibrory |[  LabelLibrary.. |
e label library

see: v W) @@

[Z] Preview with sctual font size [ Tracking
Attribute
Font: Arial [Arial] [Droid Sans]
Size :

Color :

:

[ Ttalic [ Undexline
Textali t

Horizontal : | Centerx

I

Text area position

Horizontal : | Centex Vertical :

Duplicate these attributes to

I

Every state

o J[ concel J[ rep |

Setting

Description

Use label

Use a label for the object.

Add to Label Library

Add a new label containing the content for all states to the
Label Library.

Use label library

Use a label from the Label Library.

Label Library

View all the labels in the Label Library.
For more information, see “15 Label Tag Library and Multi

Language”.

Content

Set the content of the label. If [Use label library] is selected,
the content in the Label Library can be used.

Duplicate this
label to every
state

Copy the content of the current state to all states.

Tracking

With this option selected, changing the position of the text

I__|. WE!NTEK
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in one state will also change the text position in other

states.

Font Select a font from the list. EasyBuilder Pro supports
Windows True-type fonts.

Size Select a font size.
Color Select a font color.
Blink Specify the way the text blinks. Choose [None] to disable

this feature or set the blinking interval to [1 second] or
[0.5 seconds].

Italic .
Use Italic font. Italic Label
Underline .
Use Underline font. Underline Label
Text Alignment Multiline text is aligned within the label outline.
Below are the corresponding shortcut keys.
[Left] [Center] [Right]
111 111 111
222222 222222 222222
333333333 333333333 333333333
Text area Multiline text is aligned within the object outline.
position

Below are the corresponding shortcut keys.

IE%-A; L1|_2L3L4EA; L1 12 13 L4]1

|« Left Alignment T Top Alignment
#l¢ Center Alignment = Center Alignment
1

=| Right Alignment Bottom Alignment

Horizontal Vertical
Duplicate these
attributes to Copy the attributes of the current state to all states.
every state
More Convert labels to bitmap images (Use bitmap font)

Convert the label text into bitmap format. This setting is
only available for non-cMT models.

ON = OFF (use state 0)

The content displayed will not change due to state.
Movement:

Direction
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Set the direction of the marquee effect. The directions
include: [No movement], [Left], [Right], [Up], [Down].
Continuous

Specify how the marquee effect is displayed.

If this option is not selected, the next text appears only

when the previous text disappears completely.

If this option is selected, the text will be displayed

continuously.

Speed

Adjust the speed of the text movement.

0 Note

When Text/Comment object is used with Comment enabled, the text used as comment
will not appear on HMI.

When the texts of the fonts used in the editing window and on the HMI screen are not
properly aligned vertically, it is possible to correct it with the FontRules.xml file in
“%appdata%\Weintek\EasyBuilder” folder.

By adding the names of the fonts in question into the FontRules.xml file, their vertical

metrics can be adjusted in advance to avoid the misalignment problem.

=7uml version="1.0"%=
zFontRulez:
=Verzion data="1.1"/=
=Fule data="[‘w]*alegerian[.'\w]*"/=

=Fule data="[‘v]*caztellar[.\w]*"/=

Rule data="*Tingdingz}"/=

<Fule data="fix vertical metricg = “Gotham Pro Black}"/=

<Enle data="fix wertical metrics = Aiotham Pro Bold®"/=

<Enle data="fix wertical metrice = *iotham Prok"/=
=/FontRulez=

9.5. Adjusting Profile Size

When an object is created and placed in the editing screen, double click it and select the

[Profile] tab to adjust the position and size of the object.
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Bit Lamp Object's Properties (=23l
[ Generel | Security | Shope | Label | Profile |
Position
K217 < ¥oo208 z
Bize
[T Keep width/height ratio
Width : 50 < Height: 50 z
Width (%) : 100 = Height (%) : 100 =
Setting Description
Position Pinned

When this check box is selected, the position and the size
of the object cannot be changed.
[X] and [Y]
The coordinates of the position of the object in the editing
screen.

Size Adjust the [width] and [height] of the object.

9.6. Overlapping Objects (cMT / cMT X Series)

The following explains the ways to find the overlapping objects and convert them into a single
Combo Button. After conversion, the general settings of the Combo Button will follow the
settings of the frontmost object.

9.6.1. Enable Touch Area

1. Open View tab and select [Touch Area].

File H & « # ; Home Project Object Data/History IToT/Energy QRUEM

v] Common Window [v] Object Address v| Ruler Address Grid Web Wind

v] Underlay Window [v] Object Label Tag v] Grid | Windows Tree Shape

v| ObjectID v] Comment v| Snap  [v] Windows Preview [ ] Picture

2. All the touchable objects in the proejct will be highlighted in yellow, the overlapping areas
will be highlighted in pink, and the objects that are not touchable will remain the same.

SB_0 (LB-0)
SB_1(LB-0)
SB_2 (LB-0)

RWE!NTEK EasyBuilder Pro V6.10.01



Object General Properties

9.6.2. Find Overlapping Objects

objects in the project.

File H i « # : Home Project Object Data/History

lloT/Energy

9-11

Open Tool tab and click [Find Overlapping Objects] to find all the touchable overlapping

View

—n €= = =
5 P Em % O
Find Overlapping Data/Event Log Address Easy Administrator [System Setting] Recipe Database
Objects Com Converter Viewer Watch Tools Editor Editor

Upgrade

External

At the first time clicking [Find Overlapping Objects], the system will find the first group of

overlapping objects in the current window. To search for the next group, click this button

again. When all the overlapping objects in the current window are found, the system will

start searching for overlapping objects in the next window, and then open the window in

which overlapping objects are found.

@ Note

SB_0 (LB-0}
[SB_1 (LB-0)
|SB_2 (LB-0)

B All layers of a window must be editable before clicking [Find Overlapping Objects].

9.6.3. Convert to Combo Button

When the overlapping objects found are Set Bit, Toggle Switch, Set Word, Multi-State Switch and

Function Key, they can be converted to a single Combo Button by the following ways.

Way 1. Open Tool tab and click [Convert to Combo Button].

viewer  wvan

Fle HE« +:

L
:

Home  Project

o=

Object  Data/History  lloT/E

—

] 010 x
E= B

Find Overlapping | Convertto Data/Event Log Address Easy Administ 8l L
Objects Combo Button Converter  Viewer Watch  Took
Upgrade
Windows Tree v X 49 10 - WINDOW_ 010 X
T3 Monitor Mode A | [ S
3 3: MontorMode IR, FRANRRN. - R
[ 5: Device Response
—[ 6: HMI Connection [l [l (]
i—[1 7: Password Restrict... .CBJ (LE-2) e

[ 8: Storage Space In

[ 9: Backup

=1 10: WINDOW_010
|- BL.O (LB-0) (Back)

. .
%B_0 (LB-0)

[SB_1B-1m
—BL1 (LB-0)
- BL_2(LB-0)
TS 0(LB-0)

[Se_2 124
= TS_1 (LB-0) o O o
— TS 2 (LB-0)
—SB_O(LB-0)
—5B_1 (LB-1)
- SB_2 (LB-2)
- 11

o B MR P

Combo Button Object's Properties.

General Security Shape Font  Profile

Comment

Lamp
Mode: None “

Down actions

Action Graup 1 Action Group 2

Set Bit (Toggle, LB-2)
Set Bit (Toggle, LB-1) } [+]
Set Bit (Toggle, LB-0)

Q

Way 2. Select the overlapping objects together, click the right mouse button, and then select

[Conver to Combo Button].
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Combo Button Object'’s Propertics

cut General Security Shape Font  Profile
e Copy
o = Mt Cay Comment
Paste Lamp
Delete Mode . None -
Greup

Ungroup PE_0 (Lw-0)
Convertto Combo Butten I 7 =
e

Attribute

Security settings Down actions
Goto desti. window

Jump to selected shape/picture libraries ctd +G Action Group 1 Action Group 2
£B00E-0] (Back) Popup Window [70. Login & Log
SW_0(LW-0)
Set Word (Write constant value : 0. [+]
FX_0 (Fron)
Set Bit (Set ON, LB-D)

[+)

After [Convert to Combo Button] is clicked, a review window shows for users to review the
actions that can be triggered by the Combo Button. Actions that are not highlighted can be
merged; actions that are highlighted in yellow will be automatically adjusted to meet merging
condition; and actions that are highlighted in red cannot be merged. The user can move the

mouse cursor to the yellow or red area to see explanations.

Review your merged actions IEI

Down actions Up actions

Modify or delete invalid actions.

Action Group 1 Action Group 2
Unable to convert the objecttoa.. kg [+]
Lo O
SetWeord (Write constantvalue: 0., —» o
SW._0 °
Change common window (30.Ke.. —# [+
FICO

)

OK ] [ Cancel

@ Note

B The Comment of the generated Combo Button will follow the setting of the frontmost

object that has a Comment.
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B The Security settings of the generated Combo Button will follow the settings of the
frontmost object. If the Security settings of the objects layers down are different from the
frontmost object, an alert is shown after conversion.

B The Sound settings of the generated Combo Button will follow the settings of the
frontmost object that has Sound settings. If the Sound settings of the objects layers down
are different from the frontmost object, an alert is shown after conversion.

B The Picture or Shape, and the Label settings of the generated Combo Button will follow
the settings of the frontmost object that has these settings. When there’s no object using
a picture or a shape, the Combo Button will follow the Label settings of the backmost
object that is mergeable.

B The generated Combo Button will have the Vibration setting enabled if any of the
overlapping objects has Vibration setting enabled.

B The generated Combo Button will follow the Operation Log settings of the overlapping
object that uses Operation Log. When Operation Log is used for multiple overlapping

objects, an alert is shown after conversion.
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10.User Password and Object

Security

This chapter discusses the protection for operations provided by setting up user passwords and

security classes.

10.1.
10.2.
10.3.
10.4.
10.5.
10.6.
10.7.
10.8.

OVBIVIBW ...ttt e ettt e e ettt et e e e e e sttt e e e e e e se s anbrbeeeeaeeeesannnreeeeeaeessesannnnnees 10-2
User Password and Operable Object Classes ......cccouvvrreieeiiricciiiieeeee e cecinree e 10-2
Enhanced Security Mode and Control Address..........ueeeeeeeeeccciiieeeee e ccccireeee e 10-6
Enhanced Security Mode USQBE .....cccoeieiriiiiieee et e e e e cnaree e e 10-10
Object SECUNItY SETEINGS. . ovviiii e e e e 10-25
Example of Object Security SEtiNGS......ccccuiiiiiiiiiie e 10-30
Protecting Password Settings from Unauthorized Editing .........cccoveeeeiiieeiiiiiienens 10-33
Bulk Changing of Security Settings of Multiple Objects .........cccceccvieeiiiiieeeeciieeen, 10-34
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10.1. Overview

This chapter discusses the protection for operations provided by setting up user passwords and
security classes. Authentication modes are:

® General Mode

® Enhanced Security Mode

In addition, cMT / cMT X series allows the use of LDAP protocols for user authentication.

To set up the protection system, please:
1. Set user password and operable classes.
2. Set object class for objects.

An object belongs only to one security class. Setting the object class to “None” means any user
can operate this object.

10.2. User Password and Operable Object Classes

The security parameters can be found in [System Parameter Settings] » [Security].

10.2.1. General Mode

Up to 12 sets of user and password are available. A password should be one non-negative
integer. There are six security classes: Ato F.

Once the password is entered, the objects that the user can operate are classified. As shown
below, “User 1” can only operate objects with class A or class C.

@ Note

B General Mode is not used for cMT / cMT X Series.

System Parameter Settings @
| Cellular Data Network | 802.1X (Wi-F) | Print-wBackup Server | Time Syme/DST | e-Mail | Recips Database
| Dievice I Model I Greneral I Bystem I Remote | Security Extended Memony

(@ General mode hanced security mode LDAF... Editable...

Select operable classes for each vser
Paszword range ;0 ~ 4294957205

0. Ensble  Passwond
111111

222222

333333

]

|
]
]
]
]

m

N
1
2
3
4
5
6
7
g

IDoDOOREE
IEEEEEEE
ID0EEEEEE
IEEEEREESE
ID0EOOOOD
IEEEEEEEE

| [T ’
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&

- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
10.2.2. Enhanced Security Mode

Up to 11 users can be set here. In addition, [Administrator] setting is provided. Administrator
has all privileges and can operate all object classes. A username can contain Chinese
characters, letters, and numbers, and a password can only contain letters and numbers. Each
user can have up to 12 operable classes: Ato L. (Up to 127 users can be set in Administrator
Tools. Please see “10.4 Enhanced Security Mode Usage” for more details.)

Enhanced Security Mode provides a [Control address] for users to manage the accounts
directly on HMI. Please see “10.3 Enhanced Security Mode and Control Address” for more
details. Alternatively, use USB Security Key to log in automatically. Insert the USB disk in which
the key is saved to log in. Please see “10.4.3 Login / Logout Automatically with USB Security
Key” for more details. Login can also be achieved using fingerprint or RFID. Upon successful
fingerprint recognition or RFID card scanning, the linked account will be automatically logged
in, see “10.4.7 Login / Logout with Plugins” for more details.

System Parameter Settings @
[ Cellular Data Network | Time Sync./DST I e Mail [ FTP |
| Device | Model | General | System | Remote | Security Extended Memory |
|
General mode @) Enhanced security mode [ External Server... \ [ Editable...
|| Use existing user accounts and administrator settings on HMI first Gif existed). Otherwise, use settings below,
Enable Secret user User name Password Class A Class B Class *
1 v = userl (1 1] . @ @ vl ]
2 v [ user2 000000 . ® ] (72}
3 4 = user3 ° . @ ] =
4 i ] user4 ° . ® £
5 © o user5 [ ] . @ [E 0 e
6 | [ user6 o . ®
7 [ user7 ( 1] . @
8 | [ user8 (1] . @ L
< 1l )
[ Plugin... J[ Class Comment...
Administrator
|| Secret user User name : |admin
Password : 000000 | B
Control
Device : [Local HMI Y EallE)
Address : [PLW ] 8950 16-bit Unsigned Usage...
‘ Execute auto.loginflogont when insert an USB key into HMI
["|Enable Setting (i ]
‘ CMTP file password
" |Check password when opea CMTP file Setting
oK [ cancel |[ hep |
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0 Note

B In Enhanced Security Mode on a cMT / cMT X model, the Control Address can only be
assigned to a word register of Local HMI. Please note that security features will work only
on HMI when the control address is LW. Remote login on cMT Viewer will not be possible.

B EasyAccess 2.0’s HMI Viewer on a eMT/iE/XE/mTV model doesn’t support Enhance
Security Mode, please use VNC Viewer instead.

B Usernames that contain Chinese characters cannot be changed by using EasyWeb or HMI

system settings; they can only be edited in EasyBuilder Pro.

&

- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
10.2.3. LDAP Mode

LDAP (Lightweight Directory Access Protocol) enables applications to access Directory server
providing database-like data structure, and here, the primary use of LDAP is to enable
centralized user account management. When using LDAP mode, user account management is
up to the Directory server, with HMI validating user login via the LDAP protocol. To have LDAP
set up on HMI, users only need to provide necessary information about the directory server
and set the operable classes for each group, without the need for managing

username/password for each user.
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LDAP

Enable

General Error

Directory type

Host:

192 . 168 . 1

100

Port:
Base DM :
Users base DN :

Groups base DN :

389 =

DC=test,DC=0rg

CMN=users, DC=test, DC=0rg

CN=builtin,DC=test, DC=0rg

* LDAP is only supported on Active Directory

| [[] Use domain name

Group Mame ClassA ClassB ClassC ClassD ClassE ClassF Class G ClassH Class] (
1 Engineer v 7 v
2 Management v v v v v v v
FISales %
1| m +
[ MNew... ] [ Delete ] [Import from Server

QK

] [ Cancel

10.2.4. Remote HMI Mode

In this mode, user accounts can be managed on a remote HMI, instead of the local HMI. The

accounts on a remote HMI can be used to log in the local HMI; therefore, managing the

accounts on the local HMI is not necessary.

I__| WE!NTEK
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External server @

) Mone ) LDAP @ Remote HMI
General
Remote HMIIP: 182 . 168 . 2 . 158 |
Result address
Device : |Local HMI

Address : |PLW 1} 15-hit Unsigned

Result address PLW-0
1: Succeeds

8: Account not exists
16: Password error

1024 : Remote HMI cannot be connected

10.3. Enhanced Security Mode and Control Address

The control address is used for login and account management, with 20 consecutive addresses
designated for parameter settings. When employing a cMT/cMT X Series model, LW and PLW
registers are available for selection. LW refers to local addresses on the HMI itself, while PLW
refers to addresses on the client side, such as cMT-iV5, cMT-iV6, iOS, and Android devices. As
each cMT/cMT X series can connect to multiple client devices, the system registers for login
and account management operate independently on each client device.

To log in using the control address, select either [user name] or [user index]. Ensure to set

[user name] and [password] in advance under [System Parameter Settings] » [Security] »
[Enhanced security mode].

10.3.1. Control Address Settings

When control address is set to LW/PLW-n, where n is an arbitrary number, the following
addresses will be designated:

Address Tag Name Description

LW/PLW-n (1 word) command Commands to be executed: Login, Logout,
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Add/Setting/Delete Accounts, etc.

LW/PLW-n +1 (1 command Displays the result of command
word) execution execution.
result

LW/PLW-n + 2 (1 user index The index of accounts (used with Option
word) List Object).
LW/PLW-n + 3 (1 user Binary value. Level A = bitO, Level B =
word) privilege bitl, ...
LW/PLW-n + 4 (8 user name Account name (Case-sensitive and only
words) allows Chinese characters, letters and

numbers).
LW/PLW-n + 12 (8 password Account password (Case-sensitive and

words)

only allows letters, numbers, or special
characters).

After setting the [Control address], the relevant addresses can be found in [Address Tag
Library] » [User-defined tags].For example, setting [Control address] to LW/PLW-0: (UAC stands

for User Account Control)
LW/PLW-0 = [UAC command]

LW/PLW-1 = [UAC command execution result]

LW/PLW-2 - [UAC user index]

LW/PLW-3 - [UAC user privilege]

LW/PLW-4 ~ LW/PLW-11 - [UAC user name]
LW/PLW-12 ~ LW/PLW-20 - [UAC password]

@ Note

B In Enhanced Security Mode on a cMT / cMT X model, the Control Address can only be

assigned to a word register of Local HMI. Please note that security features will work only

on HMI when the control address is LW. Remote login on cMT Viewer will not be possible.

B EasyAccess 2.0’s HMI Viewer on a eMT/iE/XE/mTV model doesn’t support Enhance

Security Mode, please use VNC Viewer instead.

10.3.2. Commands

Setting different values in LW-n [command] enables different commands:

Set Value Command

Corresponding Address

1 Log in by user name

Set [user name] and [password] first. After
entering the user name and password, the
system will check if they are valid in
[System Parameter Settings] » [Security] »
[Enhanced security mode].

2 Log in by user index

Set [user index] and [password] first.
Please refer to 10.4.4 Enhanced Security
Mode with Option List Object.

I__| WE!NTEK
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3 Log out

Change the password
of current logged-in

Set [user name] and [password] first.
Please fill in the original password in [user

user name] and new password in [password].
5 Add an account Set [user name], [password] and [user
privilege] first.
6 Add a temporary Set [user name], [password], [user

account (minutes)

privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. If O is specified, this account stays
valid until the HMI is powered off.

7 Delete an existing Set [user name] first.
account by user
name
8 Delete an existing Set [user index] first.
account by user index
9 Setting the privilege Set [user name] and [user privilege] first.

of an existing account
by user name

10 Setting the privilege
of an existing account
by user index

Set [user index] and [user privilege] first.

11 Setting the password
of an existing account
by user name

Set [user name] and [password] first.

12 Setting the password
of an existing account
by user index

Set [user index] and [password] first.

13 Read the privilege of
an existing account
by user name

Set [user name] first. If the command
succeeds, [user privilege] can be displayed.

14 Read the privilege of
an existing account
by user index

Set [user index] first. If the command
succeeds, [user privilege] can be displayed.

15 Add a temporary
account (days)

Set [user name], [password], [user
privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. If 0 is specified, this
account stays valid until the HMl is
powered off.

16 Add an expiring
account (minutes)

Set [user name], [password], [user
privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. O is an invalid value for this setting.

17 Add an expiring

Set [user name], [password], [user

I__| WE!NTEK
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account (days) privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. 0 is an invalid value for this

setting.
18 Remaining minutes Set [user name] first. If succeeded, the
for user name remaining time (in minutes) will be
displayed in [user index].
19 Remaining minutes Set [user index] first. If succeeded, the
for user index remaining time (in minutes) will be
displayed in [user index].
20 Remaining days for Set [user name] first. If succeeded, the
user name remaining time (number of days) will be
displayed in [user index].
21 Remaining days for Set [user index] first. If succeeded, the
user index remaining time (number of days) will be

displayed in [user index].

0 Note

B Add atemporary account / expiring account: The difference between temporary accounts
and expiring accounts is that temporary accounts are not stored in the system and will be
invalid after HMI is turned off. Both temporary accounts and expiring accounts will be
automatically deleted when they are expired.

B Delete the existing account: The currently logged in account cannot be deleted.

B Offline/Online Simulation: Simulate using the account settings in the program. Any
modifications of the account during simulation will not be reserved for next simulation.

B admin: Default administrator account, cannot be deleted, has all privileges and cannot be
changed.

B System Register PLW-10754: Displays current user name. (Only available for cMT / cMT X
Series)

B The [user privilege] address does not display the privileges assigned to current user
account, please use system register LW-9222 to display the privileges.

B LDAP mode does not support login with [user index].

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
10.3.3. Command Execution Results

After the command is executed, the system will store the result code to control address LW-n +

1. The listed result codes below are shown in hexadecimal format.

Result Codes Command execution result
(0x001) Succeeds
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(0x002) Invalid command

(0x004) Account exists (when adding a new account)

(0x008) Account not exists

(0x010) Password error

(0x020) Deny command

(0x040) Invalid name

(0x080) Invalid password character exists

(0x100) Invalid import data

(0x200) Out of validity range (when log in by USB Security Key).

The [Effective Time] can be set in Administrator Tools.

@ Note

B Users can add a new event in Event (Alarm) Log, and designate the [Read address] to LW-n

+ 1 [command execution result]. Open [Message] tab » [Text] » [Content] and specify the

message to be displayed in Event Display Object for showing command execution result.

10.4. Enhanced Security Mode Usage

10.4.1. Importing User Accounts

The user accounts can be set using other tools we provide, apart from the settings in [System

Parameter Settings] » [Security] tab. Administrator Tools can also be used to set user accounts.

Administrator Tools can be found in the installation directory. After the program starts, select

the [User Accounts] check box. Up to 127 accounts can be added.
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3 Administrator Tools @
Bave Contents of the TSB data
L
= e-Mail SMTP Server Sethings
=} e-Mail Contacts
User Account Settings
No.  Recret  Tser nsime Pagzword Class & Class B Clas C Class D Clas=E ClaF Clas
1 [C]  oo1001 001001 =] ] ] ] L |
2 [C] 002002 002002 =] [} ] L I
3 [T] 002003 0032003 E [} [} E [} |
4 [C1 004004 004004 = [l = [l |
b5 ] 005005 005005 & 5] G =] |
] O] 006006 006006 ] =] [=] ] 0 I
4 [ | +
Add l l Remove Import. l l Export... l
Effective Time
[ Restrict the using terms
201% +H 251727 w2017 B 51T v ‘ Save to folder ‘ -
Help Topics

& For more information, see “36 Administrator Tools”.

The added accounts can be stored in USB disk or SD card and imported in HMI by a Function

Key Object. To do so, create a Function Key Object, and select [Import user accounts].
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Mew Function Key Object &J

General | Seourity | Shape | Label |

Cormment ;

[ Activate after button is released

Function mode

@ Import user accounts
) Use [USB Security Key] to Login
n Data position

) 5D card @ USB disk
Account import mode

_ Dverwrite @ Append

[[] Delete file after importing user accounts

0K ] ’ Cancel ]

|8

@ Import vzer dateUze [TEE Security Keyv]

When finished, insert the external device to HMI, and press Function Key to import accounts. If
[Overwrite] is selected, the existing accounts will be overwritten with new accounts and
automatically log out after importing. If select [Delete file after importing user accounts] check
box, the system will delete the account data saved in the external device after importing. If the
[Effective Time] in Administrator Tools is specified, the importing can only be done in the time

limit specified. The imported accounts will not be deleted by system when the effective time
ends.

10.4.2. Login with USB Security Key

Instead of entering user name and password to login, a key can be used to do so. In EasyBuilder
Pro installation directory, launch Administrator Tools, select [USB Security Key] check box. The

account information uses the predefined data in [System Parameter Settings] » [Security].

I__| WE!NTEK EasyBuilder Pro V6.10.01

10-12



User Password and Object Security

5] Administrator Tools

e-Mail Contacts

USB Security Key

Effective Time

Restrict the using terms

017 +8 25173

Help Topies

Save Contents of the TSE data
Taer Accounts
» 3B Security Key

e-Mail SM TP Server Settings

User name :

Password :

Confirm :

admin

017 +8 25173

Save to folder ‘ - ‘

@ Note

B Please note that the user accounts used for USB Security Key must already exist in HMI.

C?For more information, see “36 Administrator Tools”.

USB Security Key can be stored in USB disk or SD card, and create a Function Key to log in by

USB Security Key as shown below:
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Mew Function Key Object [é]

Genersl | Security | Shepe | Label |

Cormment :

[T Activate after button is releszed

Function mode

) Import user accounts
@ |Use [USB Security Key] to Login
L Data position

_) 8D card @ USB disk

[ oK | ’ Cancel l

@) Import vser data/Tse [TRE Security Kew]

When finished, insert the external device to HMI, and press Function Key to log in using USB
Security Key. If the [Effective Time] in Administrator Tools is specified, the login can only be

done in the time limit specified. The system will log out automatically when the key expires.
10.4.3. Login / Logout Automatically with USB Security Key

As shown below, in [System Parameter Settings] » [Security], select [Enable] check box for

[Execute auto. login/logout when insert an USB key into HMI].
Execute anto logindogout when insert an TEE key into HMI

Enable
Statog address

PLC : [Loca.l HI v] Settings...
Addres - [LW .] 1000

* Bimulation does not suppart this fonction and LW-11165z display expiration time of USE ke,

This function allows automatic login / logout using an USB security key. Insert the USB disk in
which the key is saved to HMI to log in, and remove the USB disk to log out. The login / logout
status will be written into a designated address, the result codes of login / logout:

0x00: No Action

0x01: Login Succeeds

0x04: Login Fails

0x08: Login Succeeds

0x10: Logout Fails

& For more information about USB Security Key, see “36 Administrator Tools”.
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B When Auto Login / Logout is enabled, log in by [Function Key] object is not possible, but it
is still possible to log in / out with a designated control address.

B This function does not support On-line / Off-line simulation.

B Only the USB Security Key saved in USB disk is valid.

¥

= Click the icon to download the demo project that explains how to use USB Security Key to

log in / out. Please confirm your internet connection before downloading the demo project.

10.4.4.

Enhanced Security Mode with Option List Object

Enhanced Security Mode uses Control Address LW-n + 2 as account index. With Option List

Object, account names and privileges can be displayed. Users can select whether or not to

display the account privileges and secret users in Option List. Secret users are set to be hidden

in [System Parameter Settings] » [Security] » [Enhanced Security Mode]; their account names

will be hidden in Option List if [Secret user] check box is not selected. If the control address is

set to LW-0, the monitor address for index of Option List is designated to LW-2.

Mew Cption List Object

Option list |Ma1:u1:ui:|1g | Security | Shape | Label |

=

Comment ;
B ttribute

Mode [Dmp-dnwn List

=
~]

Direction : [ann

Background : |

[+]

Selection ;||

=]

Sonrce of item data [T_Tser acconnt

Sort
Agending

Monitor addres:

[] Descending

Dizplay
Privilege

[ Zecret uzer

PLC : | Lol HMI

v] Settings...

Address : [Lw v] 2

10.4.5. LDAP Mode

LDAP (Lightweight Directory Access Protocol) enables applications to access Directory server

providing database-like data structure, and here, the primary use of LDAP is to enable

centralized user account management. When using LDAP mode, user account management is

up to the Directory server, with HMI validating user login via the LDAP protocol. To have LDAP

I__| WE!NTEK

EasyBuilder Pro V6.10.01


http://www.weintek.com/Download/eMT3000/Project/2011SPSdemo/Enhanced_Security.zip

User Password and Object Security 10-16

set up on HMI, users only need to provide necessary information about the directory server
and set the operable classes for each group, without the need for managing

username/password for each user.

. dc=net ‘ dc=com . dc=org

‘ dc=example
ou=people ‘ ‘ ou=group
uid=userA ‘ ‘ uid=userB

The control addresses used by LDAP Mode are the same as the control addresses used by
Enhanced Security Mode. Please see chapter 10.3 in this user manual for more information on
the control address. Please note that obtaining LDAP user name using Option List object is not

possible; therefore, [Log in by user index] is not supported.

0 Note

B A user may be a member of multiple groups; in this case, the user has permission to
operate all classes assigned for all the groups the user is in. As shown in the following

figure, if a user is a member of both Engineer and Sales groups, the user can operate

classes A~F.
Group Mame ClassA ClassB ClassC ClassD ClassE ClassF
1 Engineer v % %
2| Sales v v v

B The credentials in the list in Enhanced Security Mode can also be managed and validated
in LDAP mode. Please note that when a username exists in the lists of both modes, the
system will only validate user using Enhanced Security Mode. As shown in the following
figure, in the case where username Angela exists in the user list in both LDAP server and

Enhanced Security Mode, the HMI will validate user under Enhanced Security Mode.

LDAP Server Enhanced Security Mode
Marne Type No. Enable  Secret user Username  Password
1 [ Lngela 1
Angela User
%B ’ . 2 F i 2
= o 3 ] Helen 3
% Cindy User
% Dora User
& Elly User
& Fanny User
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Search for user in Enhanced Security Mode

\.ll/ Mot Found

Search for user in LDAP Server Found

Validate User

|

B LDAP Mode does not support login with [user index].

LDAP is only supported on Active Directory.
B HMI cannot change user’s password; therefore, when adding a new user in LDAP server,

please do not select [User must change password next logon].

MNew Object - User X

& Createin: | 0 org/employee

Password: | |

Confirm password: | |

[] User must change password at next lagon
[] User cannot change password

[] Password never expirss

[J Account is disabled

<Back |[ Mei> | | Cancdl

10.4.5.1. General Tab

Set LDAP server and operable classes for each group.
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Enable

General SSL

LDAP (Lightweight Directary Access Protacal)

Error

Host |

132 168 1 100 | [7] use domain name

Port :
Base DN :
Users base DN :

Groups base DN :

Directory type

* LDAP is only supported on Active Directory

389 = # Default port of LDAP is 389
DC=test,DC=0rg
CMN=users, DC=test, DC=0org

CN=bulltin,DC=test,DC=0rg

Group Mame ClassA ClassB ClassC ClassD ClassE ClassF Class G ClassH Classl
IT‘Engineer 7 v
2 Management [~ v v v v v v v
3 Sales v
O m )
[ New. |[ Delete | [importfrom Server
ok || cancel
Setting Description
Host Set the IP address of the host or use domain name.
Port By default the port number is:
LDAP: 389
LDAPS: 636
Base DN LDAP server’s domain name (DN).
User base DN Organizational units (OU) that hold users.
Group base DN Organizational units (OU) that hold groups.
New Add a new group.
Delete Delete a group.
Import from Log in LDAP server using user credentials to import all
Server allowable groups.
Group Name Select the operable classes for each group. The group
and Class name can be 64 words in maximum, case-sensitive, and
allows letters / numbers / symbols / Unicode.

D‘pWE!NTEK
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10.4.5.2. TLS/SSL Tab

Enable settings in this tab for LDAPS (LDAP over SSL) connection with the AD server.

LDAP (Lightweight Directory Access Protocol) @
[¥] Enable
TLs/ssL | Emor |
[¥] Enable
[¥] Server verification
se certificate on HMI first (if existed). Otherwise, use imported files below
CA certificate : None
ok | cancel
Setting Description
Enable Enable TLS/SSL security for secured LDAP
communication.

Server When establishing connection, the HMI will verify
verification whether the certificate supplied by the server matches

the one stored on HMI.

Use certificate
on HMI (if
existed)...

Use current certificate on HMI or import a new

certificate.

10.4.5.3. Error Tab

When LDAP server cannot be connected, an error code shows in the designated address.
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LDAP (Lightweight Directory Access Protocal) (==
Enable

General SSL Error

Error address

Device ! |Local HMI

Address : |PLW 1} 16-hit Unsigned

Error : PLW-0

(0:none, 1ormore: error)

oK ” Cancel

Setting Description

Error address The result of login is output to this address.

Value | Description

0 No error

1 Error on LDAP server or no password is

entered.

2 Unknown error

257 | Remote LDAP server cannot be connected.

258 | Wrong username or password.
259 | Verification failed
512 | Unknown TLS

513 | Domain name does not match CN.
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10.4.5.4. LDAP Settings (Import from Server)

Get group information from LDAP server.

LDAP

Username : administrator

Password: 00000000

Fetch all groups

Group Name
1 [7] Engineer
2 [7] Management
3 [@] Sales
Checkall | [ Uncheckall |
(Add groups | [Replace all groups| [ Cancel
Setting Description
Username Log in LDAP Server using username.
Password Log in LDAP Server using password.
Fetch all Fetch all groups of the DN in LDAP server.
groups Error Message Description
Can’t contact LDAP server LDAP server cannot be
connected.
Invalid Credentials Wrong username or
password used for login
LDAP server.
Unknown Error on LDAP server or no
password is entered.

@ Note

B The maximum number of groups allowable in LDAP mode is 128 groups. When importing
from LDAP server, the system will check the number of groups in LDAP server first,

exceeding 128 groups will result in unsuccessful import.
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B Importing duplicate group name will not clear the operable classes of that group.
10.4.6. Remote HMI Mode

In this mode, user accounts can be managed on a remote HMI, instead of the local HMI. The
accounts on a remote HMI can be used to log in the local HMI; therefore, managing the

accounts on the local HMI is not necessary.

External server @
) Mone ) LDAP @ Remote HMI
General
Remote HMIIP: 182 . 168 . 2 . 158 |
Result address

Device : [Local HMI
Address : |PLW 1} 15-hit Unsigned
Result address PLW-0

1: Succeeds

8: Account not exists
16: Password error

1024 : Remote HMI cannot be connected

Setting Description

Remote HMI IP The IP address of the remote HMI that holds the user
accounts.

Result address When an error occurs while trying to authenticate the

account or connect to the remote HMI, the

corresponding error code will be output to the

designated result address.

@ Note

B The accounts can be authenticated via both local and remote HMI. When the same
account exists on both local and remote HMI, the authentication is done via the local HMI,

instead of the remote HMI. As shown below, user Angela will be authenticated via local
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HMI.

Accounts on Remote HMI

Accounts on Local HMI

Enable Secret user User name

1 = Angela 111
2 ] Bella 222
3 ] Gigi 333

10.4.7.

Login / Logout with Plugins

Password

Enable Secretuser

User name

Password

-

na

1 ] Angela
2 ] Amy
3 | Allen

w

J/ Not Found

J, Found

Found

After enabling the plugin, users have the option to log in either through a fingerprint

recognition device for accounts linked to fingerprints or via a USB scanner for accounts linked

to RFID cards or barcodes.

P &= | [ruor =
Fingerprint | _USBScanner Fingerprint | USBScanner
Enable @ Enable
General General
Enable auto login @ Enable auto login @
Control Control
Device : (Local HMI - Device : [Local HMI -
Usage Usage
Settings
VID 16C0 PID 27DB 0 | Scan USB Devices

When configuring the USB scanner, to prevent interference from other USB devices during
login, it's necessary to first set the VID and PID of the USB scanner. After clicking [Scan USB
Devices], the system will prompt a message "Please insert your USB Device". Once the USB
scanner is inserted into the PC, the system will obtain a unique VID and PID for the USB

scanner. Click [Save], and the system will automatically incorporate this VID and PID into the

settings.

[Enable auto login]: Select the [Enable auto login] option to keep the fingerprint/USB scanner
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in a state where it is always ready for login, without the need to activate the scanner through a

command. To revert to the default state where the scanner is activated via command, use

command 7 (Pause auto login) or command 8 (Resume auto login) to pause/resume the auto

login status.

Control Address Settings

When control address is set to PLW-n, where n is an arbitrary number, the following addresses

will be designated:

Address Tag Name Description

PLW-n (1 word) Command Commands to be executed: Login, Add
Fingerprint / RFID Card, Remove
Fingerprint / RFID Card, etc.

PLW-n + 1 (1 word) Result Displays the result of command
execution.

PLW-n + 2 (1 word) Status The initialization status of the plugin
server.

PLW-n + 3 (1word) Error The error code from the device server.

Commands

Setting different values in PLW-n [command] enables different commands:

Set Value Command Corresponding Address
1 Log in by fingerprint /
RFID / barcode
2 Add fingerprint / RFID Set [user name] first.
/ barcode by user
name
3 Add fingerprint / RFID Set [user index] first. Please refer to 10.4.4
/ barcode by user Enhanced Security Mode with Option List
index Object.
4 Remove fingerprint / Set [user name] first.
RFID / barcode by
user name
5 Remove fingerprint / Set [user index] first.
RFID / barcode by
user index
6 Remove all
fingerprints / RFID /
barcodes
7 Pause auto login
8 Resume auto login
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Command Execution Results

After the command is executed, the system will store the result code at control address PLW-n
+ 1.

Result Codes Command execution result
0 Succeeds

1 Unknown error

6 Canceled

101 Account not linked

115 Authentication failed
Others System error

Error Codes

When the plugin server initializes, the system will store the result code at control address PLW-

n+3.
Error Codes Command execution result
0 Initialization succeeds
1 Unknown error
2 or more System error

10.5. Object Security Settings
Settings in the Security tab allow users to configure conditions so that the object is operable

when the condition is met. The sound emitted when operating the object can be selected.
cMT, cMT X Series eMT, iE, XE, mTV Series
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New Combo Button New Set Word E
|General | Security [Shape | Font | General | Security |Shape | Label
Safety control Safety control
Min. press time Min. press time
" Display confirmation request T
Enable/Disable
V! Use register status/value Enable/Disable
Mode : |Bit -~ | Use register status/value
— Mode : |Bit v
Device : (Local HMI - =)
Address : (LB ~]o Device : [Local HMI - £
— Address : LB v 0
Enableif bitis: [ON v/
B s conii ik © Enable if bitis : [ON__+]
ol ke’ R L Token Libm, Action : | Do nothing when disabled 7
Enable if token 15 : | Acquured ; i
User restriction
Action : | Do nothing when disabled x| Object class : lChss:A ',‘ )
User restriction Disable protection permanently after initial activation
Object class  |Clasaialy AL Display warning message if access dented
Disable protection permanently after initial activation Make invisible while protected
Display warning message 1f access denied
Make invisible while protected Feedback
Feedback Sound
Sound
) G [pee ) ok J[ concel J[ o
10.5.1. Security Tab
Setting Description
Min. press Press and hold the object for longer than the [Min. press
time (sec) time] set here to activate the object.
Display After pressing the object, a dialog appears for operation
confirmation confirmation. If the response to this dialog comes later
request than the set [Max. waiting time (sec)], this dialog
disappears automatically and the operation will be
canceled.
Please confirm the aperation
0K Cancel
10.5.2. Enable/Disable

When [Use register status/value] or [Use control token] is selected, whether the object is

operable is determined by the status of the designated address or acquisition the control

token, respectively. As shown in the following figure, only when LB-0 is in OFF state and “2:

Control Token” is acquired will this object be operable.
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Enable/Disable
Use register status/value

Mode : [Bn =

Device : (Local HMI e )G
Address : |LB T

Enable if bitis :

Use control token @

Control token : [1: Control Token - Local Only v] Token Library. .,

Enable if token 15 : [Acqulred ']

Action : |Do nothing when disabled
Do nothing )Je
Hide when disabled

abled

User restriction

Grayed label when disabled

(biect

The following table describes the action this object will take when it’s token is not acquired.

Setting Description

Do nothing When the control token is not acquired, the object is still
when disabled displayed.

Hide when When the control token is not acquired, the object is
disabled hidden.

Grayed label
when disabled

When the control token is not acquired, the label of the
object turns gray.

o ]

10.5.2.1. Use Register Status/Value

When selected, the status of the designated bit/word address determines whether the object

is operable.
Mode Description
Bit The object is operable when the designated bit is in
On/Off state.
Word When [Use Register Status/Value] and [Word] are both

selected, the status of a designated word address
determines whether the object is operable.
Enable if value is: >, <, ==, <>, >=,<=

When the value in the word address reaches the
condition specified here, the object is operable.
Tolerance: This setting is available for <> and ==.
<>: The object will be operable when:

value in address > [value in address + tolerance]
or

value in address < [value in address - tolerance]

==: The object will be operable when:

value in address is between [value in address + tolerance]
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and [value in address - tolerance] (including value in
address * tolerance)
For example:

Enable/Dusable
Use register statusfvalue

Mode : [Word i

Device : [Local HMI 'H <d ]
Address : [LW -0 16-bit Unsigned
Enable if value is : E jul Tolerance : |

When the value in the designated word address is

between 9~11, the object is operable.

Condition When [Use Register Status/Value] and [Condition object]
object are both selected, whether the object is operable is
determined by the On/Off state output by the specified
Condition object.

0 Note

B Word objects supported on cMT/cMT X Series include: Set Word, Numeric, ASCII, Combo
Button.

Word objects supported on iE/XE/eMT/mTV Series include: Set Word, Numeric.

10.5.2.2. Control Token

Contrl Token
cMT cMT
viewer viewer

One cMT / cMT X HMI can be simultaneously controlled by multiple cMT Viewer clients. To

ensure system safety by preventing an object to be controlled by multiple clients
simultaneously, a control token can be set. Only one cMT Viewer client can acquire the control
token at a time, and only the ctMT Viewer client that acquires control token can operate the
object. The rest of the clients can acquire the token one by one when the token is not
occupied.

The applicable objects include: Combo Button, Numeric, ASCII, Direct Window, and Indirect
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Window.

Setting

Description

Control Token

Select a control token for the object.

Token Library...

Add/delete control token.
For more information, please see “Chapter 34 Control

Token” in this user manual.

Enable if Token is

When [acquired] is selected, only the device that
obtains the control token can operate the object.
When [unacquired] is selected, only the devices that
do not obtain the control token can operate the
object.

10.5.3. User Restriction

Set the security class of the object to be operated by an authorized user.

Tzer restriction

Cibject clags : [Class ., ~

[ Disable protection permanently after initisl activation

[ Display warning message if arcess dended
[ Make invisble while protected

Setting

Description

Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object

class.

Disable
protection

permanently

Once the permitted class of the user matches that of the
object, the system will stop checking the security class

permanently, that means, any user can operate this

after initial object freely after it is unlocked.

activation

Display When an unauthorized user attempts to operate the
warning object, a warning dialog (Window no. 7) appears. The
message if content of the message in the dialog can be modified.

access denied

Make invisible
while
protected

When the user's privilege does not match the object

class, the object will be hidden.
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10.6. Example of Object Security Settings
The following shows an example of setting object security class:

1. Create a project, go to [System Parameter Settings] » [Security] » [General] to enable 3
users:

User 1 = Operable class: A

User 2 = Operable class: A, B

User 3 = Operable class: A, B, C
2. Design Window no. 10 as shown:

User name : rEﬁ#ﬁ#&‘# | Lwezig
NE_T
Password : | HHE# | Lwszzg

bit 75 bt
Currentstatus : A1 1111111111111 | cwezzz

" Logout LB9050

56 0

Class A Buiton |
5B_1

‘Class B Burton

5B_2
‘Class C Button |

Create two [Numeric Input] objects:

[LW-9219] User no. (1~12), Length = 1word

[LW-9220] For entering user password. Length = 2 words

Create a [Numeric Display] object:

[LW-9222] Displays the operable object class of current user. (16-bit Binary)
Create a [Set Bit] object

[LB-9050] logout

Create three [Set Bit] objects:

Each set to different classes but all select [Made invisible while protected].

3. After setting, please save and compile the project and execute off-line simulation. The
below shows how it works when simulating.
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Before entering the password, it displays

Lser mame - ’17| Lwzrs “0000000000000000”, which means that
Password: [0 | |LW522:7 the user operable object class is “None”.
bi1s 610 [Class A Button] ~ [Class C Button] objects
Current status - | 0000000000000000 I Lwezzz
, are classified from “A” to “C” and selected
ogout LEIGS0

[Made invisible while protected]; therefore

they are hidden at this moment.

Enter User 1 password “111”.

Username: [ 1| ez Since User 1 is only allowed to operate class
P d- | 111 | ewezzo . .
seword: [111] A objects, [Class A Button] object appears for
bit 15 bitd
Currentsistus : |_0000000000000001 | ez operating. [LW-9222] bit O turns to “1”
Logout | t&0 means that user can operate class A objects.

Class A Bution

Enter User 3 password “333”.

Username: | 3 | |mm Since User 3 is allowed to operate class A, B,
Password - | 333 | wwezzo C objects, [LW-9222] bit 0 ~ bit 2 turns to “1”,
i i means that user can operate classA~ C

|

Current status : | 0000000000000111 | cwezzz

Logout (59050

objects.

Class A Button

Class B Bution

Class C Button

i

Click [Logout] button to log out, the

Username: | 3 | e system will return to the initial state, and

Password : | 333 | Lwez0

current user can only operate class “None”
bit0

Current status - | 0000000000000000 | Lwezzz ObjeCtS.

L DgDUI LB9050

g
&

L
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@ Note

B Password input: If the password is incorrect, [LB-9060] will be ON; if the password is
correct, [LB-9060] will be OFF. All user passwords (User 1 to User 12) can be obtained
from system registers [LW-9500] ~ [LW-9522], 24 words in total.

B Changing password directly on HMI: When [LB-9061] is set ON, the system will read data
in [LW-9500] ~ [LW-9522] to update user password. The new password will be used in
future operations. Please note that the user operable object classes will not be changed

due to the change of password.
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10.7. Protecting Password Settings from Unauthorized Editing

Before sending the project to others who may edit the project afterwards, it is recommended

to click [Editable] button in Security settings tab to open read-only mode. This mode can

protect password settings from unauthorized editing.

System Parameter Settings =]
Cellulax Data Network l Printer/Backup Server [ Time Syme [DST l e-Mail l Recipes
Device | Model | General | SysemSetting | Security | Non-ASCIIFonts | Extended Memory

() General mode @ Enhanced security mode Editable...
Select operable classes for each user
[ Use existing user accounts on HMI first (if existed). Otherwise, use settings below.
No. Enabl Secret user User name Password Class 4 ClasB 2
» 1 # F uzerl 1 ¥ = (4
2 0 o 2 5 m |3
3 [ ] user3 3 ] [
4 ] ] userd 4 @ [
5 5] ] userS 5 2] [E]
3 = [ uer 6 [¥] [l x4
4 )
~| Read-only Settings ==
Class -
Class & [¥]Enable read-only i |
ClassB
ClassC -
— Password : 111111 (1 ~ 4284967295)
Administrator
[F] Secret usd [| Mask password
Control addre
e [ ok ][ concel
Address: [Lw 8950
Project password
@ Bl
Execute auto logindogout when insert an USE key into HMI
[V] Enable
Status address
PLC : (Local HMI ~ |[Setiings...
Address: [LW = ] 0 [16-bit Unsigned
* Simulation does not support this function and L W-11165s display expiration time of USE key.
r OK ] [ Cancel J Help

When [Enable read-only] is selected, a password will be required for changing security settings

in the project.

When [Mask password] is selected, passwords will be masked by asterisks (*).

0 Note

B The protected projects cannot be decrypted since they are encrypted by users, therefore,

please remember your password.
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10.8. Bulk Changing of Security Settings of Multiple Objects

Selecting multiple objects in a group and then selecting [Security settings] in the right-click

menu can open an Objects’ Security Properties window that allows users to change the

security settings of all the selected objects at a time.

A@ Note

B When the selected objects have different security settings pages, Objects’ Security
Properties will automatically adjust and show the settings that users are allowed to

change. The rest of the settings will be hidden or greyed out. The following is a window

Objects' Security Properties
Security ‘

Safety control
[V] Display confirmation request Max. waiting time (sec) : 10

Enable/isable
[V] Use register statusivalue
o Bit © Word
Device : |Local HMI | Setings.._|

Address: LB v |0 ‘

Ensble if bitis :
[7] Use control token
* For environment of using multiple clients (cMT Viewers).

m

Action : Do nothing when disabled

User restriction
Objectclass: |Class: &

[ Disable protection permanently after initial activation
[7] Display warning message if access denied
[ Make invisible while protected
*If the user tries to operate on an object without authorization, LB-12056 will be set to ON. |

Sound
[¥] Enable  |Sound Library...| Beep

Play

[ OK ] [ Cancel E

that shows when selecting a Bit Lamp and a Numeric object.
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Objects' Security Properties @

Security
Enable/Disable
s register statustvalue
@ BEit Ward

Device:[LgcalHMI v][ Settings. .. ]

Addresz: |LE -| 0
Enable if bitis :

Action : [Hide when dissbled

zer restriction
Obect class : fClass: &
[E] Make invisible while protectsd
#If the vser tries fo operate on an object without authorization, LB-12056 will be st o ON.
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11.Index Register

This chapter explains how to use Index Register.

11,0, OVOIVIBW ..ueiiiiieiee ettt e e e ettt e e e e e et e e e e e e e s anr ettt e e e e e s e anbebeeeeeeeeesannnreeeeaaenns 11-2
11.2. Examples of INdeX REGISTOI ......cceicuiiiiieieee et 11-3
11.3. Examples of Using Tag-Based PLC and Index RegISters .......ccccecveeeevcvieeeeecveeeeeeeneen. 11-5
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11.1. Overview

EasyBuilder Pro provides Index Registers for changing addresses flexibly. With Index Registers,
user can change the object’s read/write address directly on HMI without changing its settings.
There are 32 Index Registers, divided into 16-bit and 32-bit. cMT / cMT X models offer 32
Private Index Registers, also divided into 16-bit and 32-bit.

Address @
PLC niame : [L0C3| HMI ']
Device type : |LW-2002 (32bit-float) : input high limit b

Address & ||\ 5501 (16bit) : address index 1

LW-5202 (16bit) : address index 2
LW-9203 (16bit) : address index 3
LW-9204 (16bit) : address index 4

Address format :

LW-3205 (16bit) : address index 5
L\W-3206 (16bit) : address index &
LW-5207 (16bit) : address index 7
LW-9208 (16bit) : address index 8
LW-3209 (16bit) : address index 9
LW-3210 (16bit) : address index 10

- L'W-3211 (16bit) : address index 11
Tag Library... 1w-9212 (16bit) : address index 12

m

L}

LW-9213 (16bit) : address index 13

L'W-3214 (16bit) : address index 14

LW-9215 (16bit) : address index 15

L'W-3219 (16bit) : user no. {1~12)

LW-59220 (32bit) : password

LW-2222 (16bit) : classes can be operated for current user (bit 0:A, bit 1:B,bit
L\W-3230 (32bit) : address index 16

LW-3232 (32bit) : address index 17

L'W-9234 (32bit) : address index 13

LW-59236 (32bit) : address index 19

LW-9238 (32bit) : address index 20

L\W-9240 (32bit) : address index 21

LW-3242 (32bit) : address index 22

L\W-3244 (32bit) : address index 23

L'W-5246 (32bit) : address index 24

LW-9248 (32bit) : address index 25

LW-3250 (32bit) : address index 26 &2

The corresponding address of 16-bit Index Register 0 to 15: LW-9200 (16bit) to LW-9215 (16bit)
The maximum offset range is 65536 words.

The corresponding address of 32-bit Index Register 16 to 31: LW-9230 (32bit) to LW-9260
(32bit)

The maximum offset range is 4294967296 words.

The corresponding address of 16-bit Private Index Register 0 to 15: PLW-9200 (16bit) to PLW-
9215 (16bit)

The maximum offset range is 65536 words.

The corresponding address of 32-bit Private Index Register 16 to 31: PLW-9230 (32bit) to PLW-
9260 (32bit)

The maximum offset range is 4294967296 words.

When using [Index register], the address is designated by the following equation:

The constant set in [Address] + the value in the chosen Index Register.

The way to use Private Index Registers is the same as that of Index Registers. The difference is
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that Private Index Registers work for objects in cMT Viewer app, which runs independently on
each client device; therefore, operations in this app will not make the HMI show the same
screen.

@ Note

B Index Registers work for the Word registers. For Bit registers, adding 1 to the value in the
Index Register, the offset is 16 bits.
B Index Registers do not work for PLB and PLW registers.

11.2. Examples of Index Register
The following explains the way to designate the register while Index Register is used.

If not selecting [Index register] check box and set address to [LW-10]. The system will directly
read / write LW-10.

Address @
PLC name : [LOCE| HMI ']
Device type : [LW v]
Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

[T index register

) [ s

If select [Index register] check box and set [Index] to [INDEX 0 (16-bit)], the system will read /
write [LW(10 + value in Index Register 0)].
If the data in [LW-9200] is “5”, the designated address is [LW(10+5)] = [LW-15].

Address @
PLC name : [LOCE| HMI ']
Device type : [LW v]
Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

Index : |INDEX 0 (16-bit) v | [¥]Index register

) [ s

Here’s a demo project shown as an example:
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Demo Project - Index Register

Index Function of Word

Example 1
The following shows an example of using a Word register and select [Index register]. If the
value in [LW-0] is O, in [LW-10] is 3, and in [LW-20] is 6, the result is:

Index Function of Word

[ ] (o> ]

Index O (LW-9200) LW-0 + Index O (LW-9200)

Index Function of Word

(o]

Index O (LW-9200) LW-0 + Index O (LW-9200)

If the value in Index 0 (LW-9200) is 10, then [LWO + Index 0] = read [LW-10] = 3.

Example 2

The following shows an example of using a Bit register and select [Index register].
If the state of [LB-16] is ON, and the state of [LB-32] is OFF.

Since 1 Word equals to 16 Bit, adding 1 in Index Register, the offset is 16 bits.
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Index Function of Bit

If Index 6 (LW-9206) is set to 2, then switch [LB-0 + Index6] reads LB-32 which is in OFF state.

@ Note

B When using Index Registers for Bit register, the offset is 16 bits. For example, if the Bit
register is LB-0, and set the value in Index Register to 1, then LB-16 will be activated. If set

the value in Index Register to 2, then LB-32 will be activated.

&, Click the icon to download the demo project. Please confirm your internet connection.

11.3. Examples of Using Tag-Based PLC and Index Registers

Index Registers only support one-dimensional array variables.

Example 1: INT
If [Index register] is enabled and [Index] is set to [Index 0 (16-bit)], the system will read / write

“Application.PLC_PRG.TestInt[0 + value in Index Register 0]”.
If the data in [LW-9200] is “5”, the actual address is “Application.PLC_PRG.TestInt[5]".
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Device : [Weintek Buiitn CODESYS v]
Tag: [Appiicaﬁon.PLc_PRG.Tesunt[o] v]
Data type : INT
Address format : |Application.PLC_PRG.TestInt[0 + INDEX 0]
Index : |Index 0 (16-bit) v | [¥]index register
e

Example 2: Bit

If [Index register] is enabled and [Index] is set to [Index 1 (16-bit)], the system will read / write
“Application.PLC_PRG.TestBool[0 + value in Index Register 1]”.

If the data in [LW-9201] is “7”, the designated address is “Application.PLC_PRG.TestBool[7]".

Device : | weintek Buitin CODESYS -
Tag: [Applicaﬁon.PLC_PRG.TestBooI[O] ']
Data type : BitArray
Address format : [Application.PLC_PRG. TestBool[0 + INDEX 1]
Index : |Index 1 (16-bit) v | [¥]index register
=]

Note that, unlike its non-tag counterpart, the 16-bit offset is not necessary for Bit array tags.
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12.Keyboard Design and Usage

This chapter explains how to design and use keyboard in EasyBuilder Pro.

12.1.
12.2.
12.3.
12.4.
12.5.

OVEBIVIBW ...ttt e ettt e e ettt et e e e s e st et e e e e e s s e anbrbeeeeaeeeesannnreeeeeeeessesannnnneens 12-2
Steps to Design a Popup Keyboard...........cooviiiieeei e 12-2
Steps to Design a Keyboard with Direct WindOW .........coecuviiiiieeiii e 12-5
Steps to Design a Fixed Keyboard on SCreen.........eeeveieecccviieeeee e 12-6
Steps to Design a Unicode Keyboard.........coooiiieeeeii e 12-7
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12.1. Overview

Numeric Input and ASCII Input objects need keyboard as an input tool. Both numeric keyboard
and ASCII keyboard are created with Function Key object. Apart from the keyboards provided
by EasyBuilder Pro, you can create the keyboard if needed. System keyboard is available on
cMT / cMT X Series models.

The types of the keyboards are:

® Popup Keyboard (with or without title bar)

® Fixed Keyboard

® Unicode Keyboard

® System Keyboard (available on cMT / cMT X models)

12.2. Steps to Design a Popup Keyboard

1. Create and open a window for the new keyboard. For example, set to “window no. 200”.

Windows 4
| Object fist -
.. 199 ~
Mew (i
o0l Open
.. 202
203 Close
204 Delete
- 203 Settings
. 206 -

2. Adjust the height and width of “window no. 200” and create a variety of Function Key
objects in [ASCIl/Unicode mode].

GP_0

_J_]ZJ

Set one of the Function Key objects as the [Esc] key.
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Keyboard input
© [Es:] v
Set another Function Key object as the [Enter] key.
Keyboard input
@ [[Enter] v]

The rest are mostly used to enter numbers.
Keyboard input

© [[ASCI)/ [Unicode] v/ 1

3. Select a suitable picture for each Function Key object.

ddde
ddda
dddd
e

4. Select [System Parameter Settings] » [General] » [Keyboard] » [Add] to add “window no.
200”. Up to 32 keyboards can be added.

Add a keyboard window

Window no. :  200. Keyboard v

o] (o]

5.  After the keyboard window is added, when you create Numerical Input and ASCII Input
objects, “200. Keyboard” can be found in [Data Entry] » [Keyboard] » [Window no.]. The
[Popup position] is for designating the display position of the keyboard on the HMI
screen. The system divides the screen into 9 areas.

I__I‘WE!NTEK EasyBuilder Pro V6.10.01



Keyboard Design and Usage

12-4
Keyboard
Use a popup keypad
() System keypad @ Custom keypad
Window no. : (200, Keyboard -)
Arimaton: I
Hide title bar
Popup position
[Relative to HMI sereen v
| |-
Hint : If the keybos = the
in wjmow,yp ]2: @ @ g ow, or on the same
E H &
E E 5]

6. Select “200.Keyboard”. When you press Numerical Input or ASCII Input objects on the

screen, “window no. 200” will pop up. You can press the keys on the keyboard to enter
data.
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12.3. Steps to Design a Keyboard with Direct Window

1. Create a Direct Window object and set a read address to activate it.
In [General] » [Attribute] select [Title bar] and the correct [Window No.].

New Direct Window Object

General | Position | Security

Comment :
Attribute

Window No.: (300, Keyboard =

Style {Popup window v

[¥] Title bar

Read
Device : | Logal HMI JEEIE
Address: |LB v |0

2. Open the [Position] tab and select [Auto. adjust window size].

| General | Position | Security |

[V] Auto. adjust window size

Alignment :
{relative to object display region}

3. Create a Numeric Input object, and don’t select [Use a popup keypad] check box.
Mumeric Input Object's Properties @
General | Dats Entry | Numerio Format | Security | Shepe | Font | Pofile |

Input order
[] Ensble

Kevhoard

| ] Use & popup keypad |

4. Create a Set Bit object, set address to [LB-0] and set [Set style] to [Set ON]. Overlay it on
the Numeric Input object. Pressing the Numeric Input object will open the keyboard

window.
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New Set Bit Object (=23

Genersl | Security | Shape | Label |

Commment :
Tl rite addres:

PLC name : [Local HMI v] Setting...

Address : [LB v] 1]

[] Wrrite after button is relessed

Attribute
Setstle : [3et ON -

5. Add Set Bit objects on the [Enter] and [ESC] Function Key objects respectively. Set address

to [LB-0] and [Set style] to [Set OFF]. In this way when pressing either [Enter] or [ESC] key
will close the keyboard window.

12.4. Steps to Design a Fixed Keyboard on Screen

You can also place a fixed keyboard on the screen instead of popup keyboard or Direct
Window. This type of keyboard can’t be moved or closed.

1. Create a Numeric Input object, in [Data Entry] » [Keyboard] don’t select [Use a popup
keypad] check box.

2. Use Function Key objects to design the keyboard and place it on the screen.

3. Press the Numeric Input object and enter a value with Function Key objects directly.
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12.5. Steps to Design a Unicode Keyboard

The following steps explain how to create a Unicode keyboard with Function Key objects.
1. Place an ASCII Input object on the window and select [Unicode].
2. Create Function Key objects as shown in the following figure. A simple UNICODE keyboard

is created.

New ASCI Object

General | Data Entry | Security | Shape | Font |

Comment :

[¥] Allow input

AE O (LWA .
*Set value after leaving focus can be setup in genersl system setting page — U Keyboard input
0 © |[ASCII]/ [Unicode] | &
P a —
|7 Multi-line display Keyboard input
* ASCII value of line feed (LF) character : 10 (Ox4) s B —)  © |[ASCI]/[Unicode] | B
P Mosk EIR X ¥ B v Keyboard input
[ [[IReverse w —
highllow byte = o (Cm i Tade] ]
Data format - s :
Bt =
© |[ASCII]/ [Unicode] v | &
Read/Write
Device : (Lacal HMI B x|t
Address: [LW v|0 T word (8

@ Note

B You can group up the elements of the designed keyboard and save to Group Library for future
use.

&

s Click the icon to download the demo project. Please confirm your internet connection before
downloading the demo project.
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13.0bjects

This chapter explains how to use different objects.

13.1.
13.2.
13.3.
13.4.
13.5.
13.6.
13.7.
13.8.
13.9.

13.10.
13.11.
13.12.
13.13.
13.14.
13.15.
13.16.
13.17.
13.18.
13.19.
13.20.
13.21.
13.22.
13.23.
13.24.
13.25.
13.26.
13.27.
13.28.
13.29.
13.30.
13.31.
13.32.

2T 1= o1 o PP PPPPPPPPRS
WOrd Lamp et
ST Bit.eiiiiiiiieieee e
SEtWOId ...
FUNCLION KEY .eevvrivviiiiiiiiineeeeeeeeeeeeeeeeseeeseeeeeseseseeseene
Toggle SWItCh .....eeeeiieieeii e,
Multi-State SWItch ......coovviiiiiiiiieee e
SHABE et

Direct WindOW .....oocuvieeeiiiiieeieiieeeeeiieee e
Moving / Rotating Shape ........ccccceeeveeecieeccneeenee,
ANIMAtion ...
Bar Graph...ccco oo
Meter Display.....ccccoveeeeeeiieiccieeeeee e
Trend Display «.cccccevveeeeeeii e
History Data Display.....cccccoeecvviiveeeeeieccciiieeeeeeee,
Data Block Display .....ceeeeeeevcciviieieeee e,
Q2 1o |
Alarm Bar and Alarm Display.......ccccecvvvveeeeeeeeiecnnns
Event Display.....ccccovvieeeeeiiecceeeeee e
Data Transfer.....ooiieeieiiiiee e
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13.33.
13.34.
13.35.
13.36.
13.37.
13.38.
13.309.
13.40.
13.41.
13.42.
13.43.
13.44.
13.45.
13.46.
13.47.
13.48.
13.49.
13.50.
13.51.
13.52.
13.53.
13.54.
13.55.
13.56.
13.57.
13.58.
13.59.

RECIPE VIBW ettt re e e e e e e ettt e e e e e e e e e e et e e s e e eeesaeannaeeaeas 13-244
FIOW BIOCK ...ttt ettt e e e e s s e e seareeeeenas 13-252
(0] o= -1 { (o] o o= S TP 13-257
COMDBO BULEON. ...ttt ettt e e s snne e e e s saneee 13-272
Circular Trend DiSPlay ....uueeeeeiee it e e e e e e e e e e s ennnanees 13-281
PICEUNE VIBW ... ettt e e e e e st e e e e s e e s nanr e eeeeens 13-291
FIlE BIOWSE ...ttt e sttt e e s st e s ettt e e s sabeeeessnreeeesnns 13-294
e oo a0/4 5o Yo ] o PP 13-298
T @ g - | o P PP PP P RUPPPPRRUPTPPPRI 13-303
BaArCOTE ...ciiieiee e e s e e s eareeeeeaas 13-307
) T 0T - o U= SRS 13-319
DAtADASE ettt e st e e st e e st e e e s b e e e e s nareeeeaaas 13-321
(D3 =Y o o Lo Yot | P 13-339
DYNAMIC DIAWING ..utiiiiiiiiiiiieieieiereiererererererererererererererer——————————————————.....—.—.——. 13-342
PDF REAEN ...ttt ettt ettt ettt sttt e e sttt e e s st e e s sabe e e e s sabeeeessanneeesanns 13-348
L o 11T PO UPPPPPPRRUPPRPRNt 13-350
VINC VIBWET ...ttt ettt ettt e e e e e s ettt e e e e e e e s abebbeeeeeeeeseaannbbeeeaeeessennans 13-352
(6010 - [l K31 =T || {o ] N USSP PPPUPPRR 13-357
EVENT Bar Chart ..ottt e e s e e e e 13-360
JANo A o] o I K g T=4= L= SR 13-366
(67 170 T - SO PSP PPPUPPRPN 13-373
TOUCKN GESTUIE ettt ettt e e st e e s s bt e e e s sabeeeessasneeeenans 13-375
PLC WED BrOWSET «...vtiieiiiieeeeeiieee sttt ettt e sttt e e st e e st e s ssabae e e s sabaeeessannaeesenns 13-377
(603 Vo [} [ o USSP PUPPR 13-381
FTP CONNECLION ...ttt ettt e e e e e et e e e e e e e s eanreeeeeeee s 13-385
D A=Y A T2 11T TP TT T TP 13-388
=101 o] F= L <SR 13-390

I__| WE!NTEK EasyBuilder Pro V6.10.01



Objects 13-3

13.1. BitLamp

13.1.1. Overview

Bit Lamp object displays the state of a designated bit address. If the bit state is OFF, the State 0
shape will be displayed. If the bit state is ON, the State 1 shape will be displayed.

"OFF" State "ON" State

'State 0 | State 1

13.1.2. Configuration
o

L4

Click [Object] » [Bit Lamp] icon on the toolbar to open a Bit Lamp object property dialog box.

Set up the properties, press OK button, and a new Bit Lamp object will be created.

General Tab

New Bit Lamp/Toggle Switch Object ==

General | Security | Shape | Label |

Comment :

@ Bit Lamp ) Toggle Switch

Read address

PLC name : [Local HMI ~ | Settings...

[] Invert signal

Blinking

Mode : [None v

["|Hide picture/shape if no corresponding picture for current state

(o [ conel ]
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Objects
Setting Description
Comment User can describe the information of the object.

Bit Lamp / Toggle Switch
Switch between Bit Lamp and Toggle Switch features.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the [Bit
Lamp] object. Users can also set address in [General] tab while
adding a new object.

Invert signal

Reverses the display of ON / OFF states. For example, if [Invert
signal] check box is selected, when the designated bit is OFF, the
object displays ON state.

Blinking

The appearance of the object may alternate between states when
the bit is ON or OFF.

Mode:

None

No blinking.

Alternating image on state 0

The appearance of the object alternates between State 0 and 1
when the bit is OFF.

Alternating image on state 1

The appearance of the object alternates between State 0 and 1
when the bit is ON.

Blinking on state 0

The State 0 appearance of the object will blink when the bit is OFF.
Blinking on state 1

The State 1 appearance of the object will blink when the bit is ON.
Hide picture/shape if no corresponding picture for current state
If selected, when there are not enough pictures to represent all the

states, hides the picture. Otherwise, displays the last state.

0 Note

B In[Label] tab, if select [ON=OFF (use state 0)] check box, both state 0 and 1 follow the

settings of state 0.
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13.2. Word Lamp

13.2.1. Overview

Word Lamp object displays the state according to the value of a designated word register. Up to
256 states are available. When the value of the register is 0, State 0 appearance of the object is

displayed, and with the register value being 1 the object displays State 1, and so on.

Nurmeric Display (LW0) Word Lamp (LWO)
1 EZx3
Numeric Display (LW0) Word Lamp (L WO)
1 ExX

Numeric Display (LW0) Woerd Lamp (LWO0)

1 EBExX

13.2.2. Configuration

-H

Click [Object] » [Word Lamp] icon on the toolbar to open a Word Lamp object property dialog

box. Set up the properties, press OK button, and a new Word Lamp object will be created.
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General Tab

New Word Lamp/Multi-State Switch Object

General | Security | Shape | Label |

= |

Comment :

@ Word Lamp

Read address

() Multi-State Switch

Offset: 0

PLC name : [Local HMI

v] Settings...

Address : [LW v |0

Attribute

[V Hide pictore/shape if no corresponding picture for current state

116-bit Unsigned

o) )

13-6

Setting

Description

Comment

User can describe the information of the object.
Word Lamp / Multi-State Switch

Switch between Word Lamp and Multi-State Switch features.

Mode / Offset

Word Lamp object offers the following three modes:

Value

The state is displayed according to the value in the designated word

address and plus the [Offset].

As shown below, if the value within LW-200 is 3, since the offset is
set to 3, the shape of state 0 is displayed. (value 3 - offset 3)
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MNew Word Lamp/Multi-State Switch Object

General | Security I Shape I Label

Comment

@ Word Lamp

(7 bulti-State Switch

Mode : | Value

-

Offset: 3

Read address

PLC: [Logal HMI

v] Settings...

LSB

Convert the value from decimal to binary. The least significant

active bit in a binary data word selects the state displayed.

Decimal Binary Displayed state
0 0000000000000000 | State = 0 when all bits are 0.
1 0000000000000001 E‘teo"og’aetztgiﬁ-zero th fs
2 | 0000000000000010 E‘tel"og’aetztggﬁ-zero th fs
3 | 0000000000000011 E‘teo"og’aetztgiﬁ-zero th fs
4 | 0000000000000100 E‘tez"og’aetztggﬁ-zero bit is
7 0000000000000111 Eihteo'log’t"aetf::if_‘-zero bit is
8 | 0000000000001000 Eihte?"f:t"aet-g:?-zero bft !s
16 | 0000000000010000 Eihtezl'log’t"aetf::gf_‘-zero bit is
32 0000000000100000 Eihtes'log’t"aetj:g_‘-zero bit is
64 | 0000000001000000 H‘tes'log’t";zt:gf_‘-zero bit is
128 | 0000000010000000 H‘te;,o:t"aetzt:gf_‘-zero bit is
256 | 0000000100000000 E‘teg'los‘;"aetfgggﬁ-zero th fs
512 | 0000001000000000 E‘teg'los‘;"aetfggigjzero th fs
1024 | 0000010000000000 E‘tel'oo"";te;tte”fg-lz.ero th fs
2048 | 0000100000000000 E‘tel'f"";te;ttenfgzem th fs
4096 | 0001000000000000 E‘tel'zo"";te;tte”fg;ero bft fs
8192 | 0010000000000000 E‘tel's","gf;tte”:gzero bit is
16384 | 0100000000000000 Eg‘tel'él""’zfastten:g;ero bit is
32768 | 1000000000000000 Et‘tel'_r)""’zfastte”:g;ero bit is

Bit combination

Lamp state depends on the states of bit combinations, where PLC 1
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represents the least significant bit (LSB), PLC 2 represents the next
LSB, and so on. Maximum number of bit is 4, for a total of 16
states. Changing [No. of states] in Attribute group box changes the
number of read addresses.

(® Word Lamp () Multi-State Switch
Mode : | Bit combination v
Read address
PLC 1: | Local HML w | Settings...
Address 1: g v(0
PLC 2 | Local HMIL w | Settings...
Address 2: || w1
PLC 3: | Local HMI w | Settings...
Address 3: | V(2
PLC 4: | Local HMI w | Settings...
Address 4: || v|(3
Attribute
Mo. of states: |16 v

Change state by time

The state displayed changes on a time basis. The frequency can be
set.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
[Word Lamp] object. Users can also set address in [General] tab
while adding a new object.

Attribute

No. of states

The number of states is utilized by the object. The state is
numbered from 0, so the number of states minus 1 will be the state
number. If the value within the word register is > [No. of states]
defined in Attribute, the highest state will be displayed.

If the number of states is set to 8, the valid states will be 0, 1, 2, ...,
7. In this case if the word value is 8 or higher, the system will
display the state 7 shape.

Hide picture/shape if no corresponding picture for current state

If selected, when there are not enough pictures to represent all the
states, hides the picture. Otherwise, displays the last state.

@ Note

B In[Label] tab, Language 1 determines the relevant settings of the font. For Language 2~8,
only the font size can be changed and other settings follow Language 1.
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New Word Lamp Object

| General [ security | shape | Label |

New Word Lamp Object @

| General [ security | shape | Label |

[T use label
Use label library

Label tag : Label_0 -

Content

State ;[0 (o] (1]
Attribute
Font : | Arial
Color : G | ~ Size
Al i = Ak :
[ 1talic
Duplicate these attributes to
[ Every state ] [ Every language ] [ Al
Movement

[T use label
Use label library

Label tag : Label_0 -

| Language : I
State: |0 - (2]

Attribute
Font : | Arial
Color: [ l= Size
Align : | Left Blink : |Mone
Italic
Duplicate these attributes to
[ Every state ] [ Every language ] [ Al
Movement

Direction : | No movement

Content
text
[ Tracking Duplicate this label to every state [ Tracking T e

E Cancel Help.

G
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13.3. SetBit

13.3.1. Overview

The Set Bit object provides two operation modes: manual or automatic. Manual mode can
trigger a designated bit address to change the state between ON and OFF when the object is
touched. In automatic mode, the bit is automatically activated when a pre-defined condition
occurs; touching the button will not be effective.

13.3.2. Configuration

=2

Click [Object] » [Set Bit] icon on the toolbar to open a Set Bit object property dialog box. Set up

the properties, press OK button, and a new Set Bit object will be created.

General Tab

New Set Bit Object (==

General | Security | Shape | Label

Comment :

Write address

PLC name : | Local HMI ~| [ Setting...

Address : ’LB v] 0

[ wirite after button is released

Attribute

Setstyle ‘&tm "

Set OFF
Toggle
Macro Momentary

Periodic toggle

Execute maaSet ON when window opens
Set OFF when window opens
Set ON when window doses
Set OFF when window doses
Set ON when backlight on
Set OFF when backlight on
Set ON when backlight off
Set OFF when backlight off

Coc ) (o

Setting Description
Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the Set

Bit object. Users can also set address in [General] tab while adding
a new object.
Write after button is released

I__| WE!NTEK EasyBuilder Pro V6.10.01



Objects 13-11

If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is

pressed. This function does not work with momentary buttons.

Mode / Offset Set style Description
Set ON Set ON the designated bit of the device.
Set OFF Set OFF the designated bit of the device.
Toggle Alternates the bit state each time pressed.
Momentary Holds the bit ON only while button is
pressed.

Periodical toggle | Set a designated bit ON and OFF at a set time
interval. Time interval can be selected; the
range is from 0.1 to 25.5 seconds.

Set ON when Set ON the bit within the window when the
window opens window opens.

Set OFF when Set OFF the bit within the window when the
window opens window opens.

Set ON when Set ON the bit within the window when the
window closes window closes.

Set OFF when Set OFF the bit within the window when the
window closes window closes.

Set ON when Set the bit ON when the backlight is turned
backlight on ON.
(N/A for cMT-
SVR)
Set OFF when Set the bit OFF when the backlight is turned
backlight on ON.
(N/A for cMT-
SVR)
Set ON when Set the bit ON when the backlight is turned
backlight off OFF.
(N/A for cMT-
SVR)
Set OFF when Set the bit OFF when the backlight is turned
backlight off OFF.
(N/A for cMT-
SVR)
Macro Set Bit object can trigger the start of a Macro routine when the

Macro has been created in advance.
& For more information, see “18 Macro References”.

Trigger mode If [Set style] is set to [Toggle], there is a further selection to make of
whether the macro operates after Off to ON, ON to OFF transition,
or at both of the changes of state.

@ Note

B In[Label] tab, if select [ON=OFF (use state 0)] check box, both state 0 and 1 follow the
settings of state 0.
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B Using address types other than PLB or PLW_Bit for Set Bit objects with [Periodic Toggle]
attribute is not supported by cMT-SVR.

B The Set Style setting in the General tab determines which settings are available in the
Security tab. When the Set Style is [Set ON / OFF when window opens], there will be no
settings available in the Security tab.

B When [Execute macro] is selected, the sequence in which the object’s write operation and
the macro execution is determined by the HMI runtime. In order to exactly arrange the
write operation and the macro execution in the desired way, specify the sequence by
configuring a Combo Button instead.
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13.4. Set Word

13.4.1. Overview

The Set Word object provides two operation modes: manual or automatic. Manual mode can
change the value in a designated word address when the object is touched. In automatic
mode, the word register is automatically activated when a pre-defined condition occurs;
touching the button will not be effective.

13.4.2. Configuration

=

Click [Object] » [Set Word] icon on the toolbar to open a Set Word object property dialog box.

Set up the properties, press OK button, and a new Set Word object will be created.

General Tab

New Set Word Object (=23

General | Security | Shape | Label

Comment :

Write address
PLC name : Local HMI +| [ Setting...
Address : [LW - |0 16-bit Unsigned
[ wirite after button is released
Notification
Enable @ set ON () set OFF
Before writing [ After writing
PLC name : | Local HMI ~| [ Setting...
Address i[LB v] 0
Attribute
Set Style : [Wrihe constant value -7

Setvalue: 0

o) (o
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Setting Description

Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Set Word object. Users can also set address in [General] tab while
adding a new object.
Write after button is released
If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is
pressed.

Notification If this check box is selected, it will notify a designated bit address
(setting ON or OFF).
Before writing / After writing
Set the state of the designated bit address before or after the
manual operation.

Attribute Set Style
Select the button action from the drop down list, see Example 2.
Dynamic limits
Set the [Bottom limit] and [Upper limit] by a designated register,
see Example 1.

Example 1
Set the [Bottom limit] and [Upper limit] by a designated register. When Dynamic Address is LW-

n, where n is an arbitrary number, the rule of setting Upper / Bottom limit is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-n LW-n LW-n
Bottom limit LW-n LW-n LW-n
Upper limit LW-n+1 LW-n+2 LW-n+4
When Dynamic Address is LW-100, the rule of setting Upper / Bottom limit is:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-100 LW-100 LW-100
Bottom limit LW-100 LW-100 LW-100
Upper limit LW-101 LW-102 LW-104
Example 2

The available button actions are:

® Write constant value

Write a preset value. Each time the button is pressed, the value in [Set value] is written to the
designated register. Data format is as set by the [Write address] above; it can be 16-bit BCD,
32-bit BCD, ...64-bit Double. In the following figure, when the button is pressed, the number

12 is written to the designated register.
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Attribute
Set Style @ | Write constant value 7

Setwvalue: 12

® Write constant string (cMT / cMT X only)
Write a preset string. Each time the button is pressed, the string in [Set string] is written to the
designated register. The string format can be: UTF-8, Unicode, Latin-1...etc. In the following

figure, when the button is pressed, the string “abcd” is written to the designated register.

Attribte
SetStyle | Write constant string v
Set string © abed
String format | |[JTE-8 (Defanlt) -

® Increment value (JOG+)
Increase value in register by a set amount in [Inc. value], each time when the button is pressed,
up to the [Upper limit]. As shown below, each button press increases the value in the register

by 1 until the value is 10.

Attribute
Set Style IIncrement value (J0G+) w7
Inc. value : 1 Upper limit : 10

® Decrement Value (JOG-)
Decrease value in register by a set amount in [Dec. value], each time when the button is

pressed, down to the [Bottom limit]. As shown below, each button press decreases the value in

the register by 1 until the value is 0.

Attribute
Set Style IDecrement value (J0G-) -
Dec, value : 1 Bottom limit : 0

® Bounce (up->down->up) (cMT / cMT X only)
Each time when the button is pressed, the value in the register is increased by the [Inc.
value] until the [High limit] is reached, and then the value is decreased by the [Inc. value],
each time when the button is pressed, down to the [Low limit]. As shown below, the
system will increase the value in the register by 1 each time when the button is pressed,
until the value is 10, and then decrease the value by 1 each time when the button is

pressed, until the value is 0, and then increase the value again.
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A ttribte

Fet style : IBD'IJ.'HJ:E {up-=down-=up-=..)
Low limdt: High limit: 17

Inc. walve |

® Press and hold increment (JOG++)

When the button is held longer than a set time in [JOG delay], it will increase the value in a
register by a set amount :[Inc. value] at a set rate :[JOG speed], to the [Upper limit].

As shown below, when the button is pressed, it increases the value in the designated register

by 1. When the button is held longer than 1 second, it increases the value in register by 1 every
0.5 second, till the value is 10.

Attribute
Set Style : |Press and hold increment (JOG++4) -
Inc, value : 1 Upper limit: 10
JOG delay : Il.I:I second(s) v] JOG speed : II:I.E second(s) *I

® Press and hold increment (JOG--)

When the button is held longer than a set time in [JOG delay], it will decrease the value in a
register by a set amount: [Dec. value] at a set rate: [JOG speed], to the [Bottom limit].

As shown below, when the button is pressed, it decreases the value in the designated register

by 1. When the button is held longer than 1 second, it decreases the value in register by 1
every 0.5 second, till the value is 0.

Attribute
Set Style IPress and hold decrement (10G-) -
Dec, value: 1 Bottom limit : 0
I0Gdelay: 1.0 second(s)  v|  10Gspeed: [0.5 secondls) |

® Periodic JOG++

This automatic function increases the value in the register by a set amount: [Inc. value], at a set
rate: [Time interval], to the [Upper limit]. As shown below, the system will automatically

increase the value in the register by 1 every 0.5 second, till the value is 10. Then the value
returns to 0 and add 1 every 0.5 second again.
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Attribute
Set Style @ | Periodic J0G++ {up-=0->up-=...) -
Inc. value : 1 Upper limit : 10
Time interval : (0.5 second(s) TI

® Automatic JOG++
This automatic function increases the value in the register by a set amount: [Inc. value], at a set
rate: [Time interval], to the [Upper limit].then holds this value. As shown below, the system will

automatically increase the value in the register by 1 every 0.5 second, till the value is 10, and

then stop.
Attribute
Set Style : | Automatic JOG++ (up to high limit) -
Inc, value : 1 Upper limit: 10
Time interval : ID.E second(s) 'I

® Automatic JOG--

This automatic function decreases the value in the register by a set amount: [Dec. value], at a
set rate: [Time interval], to the [Bottom limit].then holds this value. As shown below, the
system will automatically increase the value in the register by 1 every 0.5 second, till the value

is 10, and then stop.

Attribute
Set Style ! | Automatic JOG— {down to law limit) -
Dec, value : 1 Bottom limit @ 10
Time interval : IU.E second(s) T]

® Periodic bounce

Increases the word address value to the [Upper limit] by a [Inc. value] at a set rate in [Time
interval], then decreases to the [Bottom limit] by the same value at the same rate. As shown
below, the system will increase the value in the designated register by 1 every 0.5 second, till
the value is 10, and then decrease the value by 1 every 0.5 second till the value is 0 whenever

the screen is active.
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Attribute
Set Style ! | Periodic bounce {(up-=down->up-...) -
Bottom limit : 0 Upper limit : 10

Inc, walue : 1

Time interval : |l.'.|.5 second(s) v|

® Periodic step up

Step up to the [High limit] by [Inc. value] at a set rate in [Time interval], then reset immediately
to the [Low limit]. The action repeats whenever the screen is active. As shown below, the
system will increase the value in the designated register by 1 every 0.5 second, till the value is

10, and then reset to 0 and increase again, and the action repeats.

Attribute

Set Style : | Periodic step up (low to high...) -

Low limit: 0O High limit : 10

Inc, value : 1

Time interval : ||:|.5 second(s) v|

® Periodic step down

Step down to the [Low limit] by [Dec. value] at a set rate in [Time interval], then reset
immediately to the [High limit]. The action repeats whenever the screen is active. As shown
below, the system will decrease the value in the designated register by 1 every 0.5 second, till

the value is 0, and then reset to 10 and decrease again, and the action repeats.

Attribute
Set Style © | Periodic step down (high to low...) -
Low limit: 0O High limit : 10

Dec, value : 1

Time interval : ||.‘.|.5 second(s) "|

® Set when window opens / Set when window closes

Automatic function occurs whenever the screen is active. The value entered in [Set value] is set
into the word address when the action occurs. If [Set value] is set to 5, when the window
opens / closes, the system enters 5 into the designated register.

® Set when backlight on / Set when backlight off (Not supported on cMT-SVR)

Automatic function occurs whenever the backlight is active. The value entered in [Set value] is
set into the word address when the action occurs. If [Set value] is set to 5, when the backlight
turns ON / OFF, the system sets 5 into the designated register.

® CyclicJOG+

Each time when the button is pressed, increases the word address value to the [Upper limit] by
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[Inc. value] then reset to the [Bottom limit]. As shown below, each time when pressing the
button, the system will increase the value in the designated register by 1, till the value is 10,

and then reset to 0 and increase again by pressing the button.

Attribute

Set Style @ | Cydic J0G+ -

Bottom limit @ 0 Upper limit: 10

Inc, value : 1

® CyclicJOG-

Each time when the button is pressed, decrease the word address value to the [Bottom limit]
by [Dec. value] then reset to the [Upper limit]. As shown below, each time when pressing the
button, the system will decrease the value in the designated register by 1, till the value is O,

and then reset to 10 and decrease again by pressing the button.
Attribute

Set Style : |Cydic J0G- -]

Bottom limit : 0 Upper limit: 10
Dec, value : 1

® CyclicJOG++

When the button is held longer than a set time in [JOG delay], it increases the value in a
register by a set amount in [Inc. value] at a set rate in [JOG speed], to the [Upper limit], then
reset to the [Bottom limit]. As shown below, when the button is held longer than 0.5 second,
increase the value in the designated register by 1 every 0.1 second, till the value is 10, and then

reset to 0 and increase again by holding the button.

Attribute

Set Style : | Cydic JOG++ -

Bottam limit: 0 Upper limit: 10

Inc. value : 1

J0G delay : [0.5 second(s) v| JOG speed : |D.1 second(s) ~

® CyclicJOG- -

When the button is held longer than a set time in [JOG delay], decrease the value in a register
by a set amount in [Dec. value] at a set rate in [JOG speed], to the [Bottom limit], then reset to
the [Upper limit]. As shown below, when the button is held longer than 0.5 second, decrease
the value in the designated register by 1 every 0.1 second, till the value is 0, and then reset to
10 and decrease again by holding the button.
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Attribute
Set Style @ | Cydic J0G— -

Bottam limit : 0 Upper limit : 10

Dec, value : 1

106G delay [D.E second(s) v] J10G speed : [0.1 second(s) v]

® Object Control Command (cMT / cMT X only)
Listed for selection are commands (with their corresponding command values) available for
the control address of various functions. For a given function, with write address set to its

control address, Set Word writes the command value and achieves function control.

Attribuge
SetStyle © [Objest Control Cammand - |

Object Type : [Database Server v
Commend [[1] Sart v]

® System Tag Command (cMT / cMT X only)
When a system tag is set as write address, for example, LW-9134: Language Mode, the

commands relating to the system tag can be selected.

Attribute
Ret Style [S}rstem Tag Conaind v]
Language : [Langu.age 1 "']
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Set Word Object’s Properties

General| Security | Shape |Label | Profile |

User restriction

Safety control
Min. press time (sec) :

|| Display confirmaticn request Max. waiting time (sec) : |10
Interlock

Use interlock function © Bit @ Word

|| Hide when disabled

Grayed label when disabled

Trigger if value is 1
PLC: [Local HMI v |[ Semings.. |
Address : [LW ~|1 16-bit Unsigned

Object class : [None

M
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Setting

Description

Interlock

Use interlock function

When this option is enabled and [Word] is selected, whether
the object is operable depends on the condition of a word
address specified in [Trigger if value is:]. In the settings above,
the object is operable only when the value in LW-1 is greater
than 1.

Hide when disabled

The object is hidden when the specified condition does not
occur in the specified word address.

Grayed label when disabled

The label of the object turns gray when the specified condition
does not occur in the specified word address.

[ ]

Trigger if value is:

This setting is for specifying a trigger condition. The available
options are: >, <, ==, <>, >=, and <=. A tolerance value can be
set for conditions == and <>.

For example:

Hide when disabled
[ ] Grayed label when disabled

Trigger ifvalug is: | == w

Tolerance : | 1 |

When the value is the specified word address is greater than
or equal to 11, or smaller than or equal to 9, the object will be

hidden and is not operable.

@ Note

B Using address types other than PLW for Set Word objects with automatic attributes such
as [Periodic set up], [Periodic set down], [Automatic JOG++], [Automatic JOG--], and
[Periodic JOG++]...etc, is not supported by cMT-SVR.
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13.5. Function Key

13.5.1. Overview

13-23

The Function Key object can be used for several tasks, such as switching between windows,

keypad design, Macro execution, screen hardcopy, and setting USB security key.

Function Keys with [Screen hardcopy] or [Import user data/Use [USB Security Key]] selected do

not work remotely on cMT Viewer.

13.5.2. Configuration

Fn

Click [Object] » [Function Key] icon on the toolbar to open a Function Key object property

dialog box. Set up the properties, press OK button, and a new Function Key object will be

created.
General Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
New Function Key Object (=) New Function Key Object
General [Security [Shape ] Label ‘ General LSecun'ty l Shape l Label [
Cofnsnts Comment :
Attribute [7] Activate after button is released
Type : | Window v
[T] Activate after button is released © [Change full-screen window v
Window
Function : (Change full-screen window V] )
Window no. : (50, Keypad 1 - Integer =
Window no. : [50. Keypad 1 - Integer ) Keyboard ingut
Animation : Settings... [Mone] D | [Entex]
Notification i
- () Execute macro
["] Enable
) Window title bar
Hard copy screen to USE disk, SD cexd or printer
*) Screen hardcopy
*) Import user data/Use [USE Security Key]
Notification
[] Enable
[ OK ] [ Cancel ] | Help [ OK ] [ Cancel 1 [

Help
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Setting

Description

Activate
after button

If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is

is released pressed.
Change Change full-screen window: Change to another base window.
window Change common window: Change common window.

Display popup window: A pop-up window displays in the base
window. If [Close this popup window when parent window is closed]
check box is selected, the pop up window will be closed when
change the base window to another window. Otherwise, a function
key in the pop up window is needed to close it.

Window
Function : [Display popup window v ]
Window no. : [50. Keypad 1 - Integer v ]
Title bar/Position...
Animation : Settings... [None, None]

—
|

/| Close this popup window when parent window is closed
[¥] Show close button

(cMT / cMT X Series) Animation Setting: cMT / cMT X Series allows
using transition effects for opening popup windows using Function
Keys. The settings can be opened by clicking [Animation Setting].\

7= =
Animation

Effect Duration

o fwpev] w0 (Hms

Direction

liloee

o ] [cme |

The effects are shown below. Different effects may be used for Start

(window appears) and End (window disappears).

Effect Name Transition

Fade
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i Z

Float

Wipe

Split B

Circle 3 -
»

- ]

Zoom !

Turn P
l' b

Push

[Duration] specifies how many milliseconds (ms) a transition effect
takes to complete.

[Direction] The direction of the transition.

Return to previous window: If this is selected, the Function Key will
change from the current screen to the previous one displayed. For
example, when window no. 10 is changed to window no. 20, press
the function key to return to window no. 10. This function is only
available for base window.

Close window: Close any active pop-up windows, message windows

I__I"WE!NTEK
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included.
Display calculator window(cMT / cMT X Series): If this option is
selected, clicking this Function Key can open a calculator with an
unchangeable appearance. This calculator allows operators to do
simple calculation and enter the result to a destination object by
pressing the Enter key.
X
g 5
e
vl s]o] ]~
p s ]+]-
ol + [ 2] s ] %]+
e o [ e |
Selecting this option opens [Keep calculation open after paste]
checkbox, which keeps the calculator displayed after the value is
entered to the object.
Window
Function : [ Display calculator v
Animation : Settings... [Fade, Wipe]
[ Keep calculator open after paste
E Click the icon to watch the demonstration film. Please confirm
your internet connection before playing the film.
Keyboard Configures the button as a keypad key, and the character it enters,
Input via [Numeric] or [ASCII] objects.

Enter: Same as the keyboard’s “Enter” function.

Backspace: Same as the keyboard’s “Backspace” function.

Clear: Clear the value in the word register.

Esc: Same as the [Close window] function; it is used to close the
keyboard window.

Delete: Same as the keyboard’s “Delete” function, deletes the
number or character on the right side of the text cursor.

Left: Same as the keyboard’s “<” key moves the text cursor to the
left side of the previous number or character.

Right: Same as the keyboard’s “=” key moves the text cursor to the
left side of the next number or character.

Line feed: Move the cursor down to the next line.
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Inc: Increment by 1.

Dec: Decrement by 1.

ASCII/UNICODE: Specify the character to be entered by this key.
Execute Select this check box to execute one of the Macros from the drop
Macro down list that has already been configured by users.

C?For more information, see “18 Macro References”.

(@) Execute macro Macro : [[ID:EJD[J] macro_0 v]

Window title Function Key defined can be used to move a pop-up window which
bar has no [window title bar] to a preferred position on screen. Select

the pop-up window and then click on a preferred position, the

window will be moved.

[ 1
—
FK-\T ~Alarn Status ] ‘
Select the window title bar firstty Touching the screen for the new positian
the popup window will be moved

in Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.
Hard copy Print the current window. Before using this function, choose a printer
screen to . . .

model in [System Parameter Settings] » [Model] » [Printer].
USB disk, SD [Sy gs]» [Model] » [ ]
card or If a monochrome printer is used, selecting [grayscale] can provide a
printer better print result, but the text may not be clearly printed. To

improve text printing, avoid using [grayscale].
Hard copy screen to USE disk, SD card or printer
(@) Screen hard copy Printer : [HP PCL Series (LISB) VI

|:| Rotate image 90 degrees Mode [mlnr 'l

Crop window
This option can be selected for taking a cropped screenshot.

I__| WE!NTEK

EasyBuilder Pro V6.10.01


https://dl.weintek.com/public/MT8000/Project/Part_Sample/Window_Title_Bar.zip

Objects

13-28

Crop Window

10. WINDOW_010 A

Trigger time Message

10:07:29 Event triggered!

x
wt:

:

oK Cancel

Acknowledge
all events
(alarms)
(cMT / cMT X
Series)

Acknowledge all events once by pressing the Function Key.

Import user
data / Use
[usB
Security Key]

A Function Key can be used to import the e-mail contacts or user

accounts set, also, to log in using USB Security Key.

Function mode

() Import e-mail settings and contacts
©{Import user accounts

() Use [USB Security Key] to Login
Data position

) 5D card @ 1sB disk
Account import mode

) Overwrite @ Append

[ Delete file after importing user accounts

=

Lo ]

Cancel

Data Position

Select the external device to store data from [SD card] or [USB disk].

Account import mode

If [Overwrite] is selected, the existing accounts will be overwritten

with new accounts in the external device after importing. If [Append]

is selected, HMI will append more accounts while the old accounts
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still exist.

Please note that when [Append] is selected, the accounts that
already exist in the project cannot be imported.

Delete file after importing user accounts

If select this check box, the system will delete the account data saved
in the external device after importing, this can prevent the account
data from leaking out.

Notification If this selection is enabled, it will notify a designated bit address to
set ON or OFF, each time the button is pressed.

@ Note

B [Overwrite] is the only option when importing the e-mail contacts. This means that all
existing contacts will be removed first, and then the new contacts are added.

o For more information, see “6 Window Operations”, “12 Keypad Design and Usage”, “36

Administrator Tools”.
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13.6. Toggle Switch

13.6.1. Overview

Toggle Switch object is a combination of Bit Lamp object and Set Bit object. The appearance of
the object is controlled by the ON / OFF state of the read bit address. As well, pressing the

button sets the value in the bit address according to the settings.

13.6.2. Configuration

Click [Object] » [Toggle Switch] icon on the toolbar to open a Toggle Switch object property

dialog. Set up the properties, press OK button, and a new Toggle Switch object will be created.

General Tab
New Toggle Switch/Bit Lamp Object @
General | Secusity | Shape | Label |
Comment :
Bit Lamp @ Toggle Switch

[T Read/Write vse different addresses

Read address

PLC name : [Local HMI v] Settings...
Address : [LB v ; 0

[ Invert signal

Write address :
[] Write when button is released

Attribute

Macro

Execute macio
[ OK ] [ Cancel Help
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Setting Description

Comment User can describe the information of the object.
Bit Lamp / Toggle Switch
Switch between Bit Lamp and Toggle Switch features.

Read/Write

use different Different addresses can be used to read data and write data.
addresses

Read address Click [Setting] to select the [PLC name], [Address], [Device type],

[System tag], [Index register] of the bit device that controls the
[Toggle Switch] object. Users can also set address in [General] tab
while adding a new object.
Invert signal
Reverses the display of ON / OFF states. For example, if [Invert
signal] check box is selected, when the designated bit is OFF, the
object displays ON state.
When [Read/Write use different addresses] option is not selected,
the title of this group box will be “Read/Write address”.

Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the

[Toggle Switch] object. Users can also set address in [General] tab
while adding a new object. The address can be the same or
different from [Read address].

Write after button is released

If this function is selected, the action is delayed till button is
released, otherwise, the action is executed once the button is

pressed. This function does not work with momentary buttons.

Attribute Set style Description
Set ON Set ON the designated bit of the device.
Set OFF Set OFF the designated bit of the device.
Toggle Alternates the bit state each time pressed.
Momentary Holds the bit ON only while button is
pressed.
Macro Toggle Switch object can trigger the start of a Macro routine when

the Macro has been created in advance.

& For more information, see “18 Macro References”.
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@ Note

B When [Execute macro] is selected, the sequence in which the object’s write operation and
the macro execution is determined by the HMI runtime. In order to exactly arrange the
write operation and the macro execution in the desired way, specify the sequence by

configuring a Combo Button instead.
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13.7. Multi-State Switch

13.7.1. Overview

Multi-state Switch object is a combination of Word Lamp object and Set Word object. The

appearance of the object is controlled by the value of the read word address. As well, pressing

the button sets the value in the word address according to the settings.

13.7.2. Configuration

Click [Object] » [Multi-State Switch] icon on the toolbar to open a Multi-State Switch object
property dialog box. Set up the properties, press OK button, and a new Multi-State Switch

object will be created.

General Tab

cMT / cMT X Series eMT, iE, XE, mTV Series
New Multi-State Switch/Word Lamp Object [3a]| | New Multi-State Switch/Word Lamp Object (=2
General | Secux{lyﬁ Shape | Label | i General | Secux{lyﬁ Shape | Label | i
Comment : Comment :
() Word Lamp © Multi-State Switch () Word Lamp © Multi-State Switch
[ Read/Write use different addresses [ Read/Write use different addresses
Read address Read address
PLC name :[Local HMI v] Settings... PLC name :[Local HMI v] Settings...
Address : 0 16-bit Unsigned Address : 0 16-bit Unsigned
Error handling...
Write address : Write address :
[7] Wrrite when button is released
Attribute Attribute
Cyclical :[Disable - Cyelicel : Disable v
[T User-defined mapping [T User-defined mapping
Send notification after writing sucessfully Send notification after writing sucessfully
[7]Enable [7]Enable
Cancel Help OK Cancel Help
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Setting Description
Comment User can describe the information of the object.
Word Lamp / Multi-State Switch
Switch between Word Lamp and Multi-State Switch features.
Model / Different modes can be selected: [Value], [LSB].
Offset & For more information, see “13.2 Word Lamp”.
Read/Write

use different

addresses

Different addresses can be used to read data and write data.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Multi-state Switch object. Users can also set address in [General]
tab while adding a new object.

When [Read/Write use different addresses] option is not selected,
the title of this group box will be “Read/Write address”.

Write address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Multi-state Switch object. Users can also set address in [General]
tab while adding a new object.

Write after button is released

If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is

pressed.

Attribute

Switch style
Select the object’s operation mode, see Example 1.

User-defined mapping
The value placed in the write register of each selection, the action

taken when an illegal value is entered, and error notification to a

designated bit address can be set.
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Mapping (sl
State Value
1} 1}
1 1
2 (eror)
Tnput illegal
@ Remain current state ) Jump to error state
Error notification
[¥] Enable ) Set QN @ Set OFF
PLC name : Local HMI ~|[setting... ]
ikt T—
Remain current state
If an illegal value is entered, Multi-state Switch will remain at the
current state.
Jump to error state
If an illegal value is entered, Multi-state Switch will jump to the
error state.
Error notification
If an illegal value is entered, automatically set the value placed in
the designated register.
Send

notification
after writing

successfully

After the system successfully writes data to PLC, the designated bit

address will be set On/Off.

Error handling

The action taken when an illegal value is entered or notify a

(cMT / cMT X designated bit address. This is similar to [User-defined mapping];
Series) the difference is the value corresponding to each state need not to
be preset.
Example 1
® JOG+

Increase the value of a designated register by 1 each time when pressing the button, till the

value equals to [No. of states]. A cyclic action can be enabled. As shown below, each time

when pressing the button, the state number will add 1 start from state 0, till state 4 ([no. of

state]-1), and returns to 0 and step up again.
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Attribute
Switch style : [JDG+ - Mo, of states : |5 v]
Cydical : [Enable v]
[ user-defined mapping

® JOG-
Decrease the value of the designated register by 1 each time when pressing the button, till the
value equals to 0. A cyclic action can be enabled. As shown below, each time when pressing the
button, the state number will minus 1 start from state 4 ([no. of state]-1), till state 0, and

returns to state 4 and step down again.

Attribute
Switch style : [JDG— v] Mo, of states : [5 vl
Cydical : [Enable v]
[T user-defined mapping
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13.8. Slider

13.8.1. Overview

Slider object is used to change the value in a designated word register address by moving the

slide on the screen.

13.8.2. Configuration

e

Click [Object] » [Slider] icon on the toolbar to open a Slider object property dialog box. Set up

the properties, press OK button, and a new Slider object will be created.

General Tab
cMT / cMT X
Slider @
[¥IBackground General | outline | Security | Shape |
[VIDynamic Scale Comment :
it
Direction : Reslution: 1
Low/High lmit : @ Congtant () Address
Low limmit: High Lirait: 100
[T Coarse increment
Write address
PLC : Locsl HMI v |[ Settings.
Lddress : [LW ~ |0
Hotification
[E]Enshle
Watch address
[ Enable
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eMT, iE, XE, mTV

New Slider Object (=22
Genersl | Outline | Security | Shape |
Comment :
Attribute
Direction : Resolution : 1
Low/High limit : @ Constant O Address
Low limit: Highlimit: 100
[7] Cosrse increment
Write address
PLC: [Local HMI v [ Settings...
Address : [LW <0 i 16-bit Unsigned
Notification
[¥] Enable () SetON @ Set OFF
[V] Before writing [ After writing
PLC : [Local HMI [ Seftings...
Address : [LB ,} 0
Watch address
[¥] Enable
PLC : |Local HMI
Address: (L ~|0 [ 16-bit Unsigned
o (oo
Setting Description
Attribute Direction
Select the direction of the slider. (Right, Up, Left, Down)
[1] =
right
left ;,
up down
Resolution

Sets the value change in the word register for each step of the
Slider. For example, if set to 10, the register value changes by 10
points for each increment or decrement on the Slider.

Constant

Sets the range of the Slider. For example, If set [Low limit] to 5, and
[High limit] to 100, the Slider will enter values between 5 and 100.
Address

Set the [Low/High limit] by a designated register, see Example 1.
Coarse increment

Apart from moving the roller to change the value as in [Resolution],
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if this option is selected, the word value will increase / decrease by

the [Increment] value each time the object is touched.

Write address

Click [Setting] to select the [Device], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Slider object. Users can also set address in [General] tab while
adding a new object.

Notification

If enabled, the state of a designated bit address will be set to ON or
OFF before or after writing.

Click [Setting] to select the [Device], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
notification settings. Users can also set address in [General] tab
while adding a new object.

[Before writing] / [After writing]

Change the state of a designated bit register before, or after the
slider is slid.

Watch address

When moving the roller, the new value written to the word register
address can be displayed in real time.

Example 1

Set the low or high limit by a designated register. When write address is LW-n, where n is an

arbitrary number, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-n LW-n LW-n

Low limit LW-n LW-n LW-n

High limit LW-n+1 LW-n+2 LW-n+4

When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-100 LW-100 LW-100
Low limit LW-100 LW-100 LW-100
High limit LW-101 LW-102 LW-104
Outline Tab

cMT / cMT X Seires
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Slider @
[¥|Background | General | Outline |S~=.c|.|rit5-I | Shape|
R |
Dymamc scil T —
Cotr . m—]
Elider button type

il |l@||@

eMT, iE, XE, mTV Seires

( New Slider Object =
| General | Outline | Secuity | Shape |
Slider button type

P 7] Transpavent
Bockground : [ ] (7] Transperent
Sk ] Transparent

Setting Description
Slider button ] )
Select slider button type, by default, a picture selected from the
type (cMT / . . .
Picture Library can be the slider button.
cMT X)
Slider button Four default styles are offered, and the width and color of the
type (eMT, iE, Frame, Background, Slot can be set.
XE, mTV)

Slider button type Slot

FLO ~

Frame Background

13.8.3. Combo Setting

cMT / cMT X Series HMI support combo setting for Slider, which allows setting of multiple

related objects at a time. Slider can be set with Background and Dynamic Scale.
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Background
‘Slider =
[¥IBackground General
iSider [ ox ]
Tick Mark | Scale Label
Main scale
Tiks ]
Sub scale
Toke: ()
Setting Description
Margin Specify the space between the background edge and
the objects.
Color/Style Customize
ColoxfStyle
@ Customize () Picture
Rownd : 10

Fane Bk
Pattern : [ | Patestle: [ ]

Select a suitable background pattern and color.

Picture
ColorStyle
() Customize @) Pictoe
Pictore Library...

Use the default picture or choose a picture from

Picture Library.

I__I"WE!NTEK EasyBuilder Pro V6.10.01



Objects

Dynamic Scale

Slider @
[¥Back d General |
wsider ——
MM 0 50 100 Style : | Vertical Cancel
Tick Mark | Scale Label |
Color: I -]
Main scale
Tiehi:
Sub scale
Ticks:
Setting Description
Style The scale style will follow the Slider.
Alignment The position of the scale bar along the Slider.
Tick Mark Configure the number of tick marks for main and
sub scales, and the color of tick marks.
Scale Label Configure the font, font color, font size and other

attributes of scale label.

In Slider settings if [Address] is selected for
Low/High limit, then Scale Label’s [Dynamic limits]
will be set automatically.

In Slider settings if [Left] is selected for Direction,
then Scale Label’s [Reverse (Left/Right)] will be set

automatically.
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Tick Mark | Scale Label
Use scale label
Font : [ Arial v]
Cotr: N - oo
Leftdecimal Pt.: 4 ~:: Rightdecimal Pt.: 0 —C—
[7] Dynamic limits
| Reverse (LeftRight )
Left: LW-1 Right : LW-0
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13.9. Numeric

13.9.1. Overview
Numeric object can be used to input or display the value of a designated word register.

13.9.2. Configuration

=

Click [Object] » [Numeric] icon on the toolbar to open a Numeric object property dialog box.
Set up the properties, press OK button, and a new Numeric object will be created.

General Tab

cMT, cMT X Series eMT, iE, XE, mTV Series
Lt Object's Properties ' ( New Numeric Object (23] '
| Shape | Font | Profile ‘ General {Daﬁ\ Entry ] Format lSeculity I Shape I Font ]
General | DataEntry |  Format Trigger Action Setting | Security | = i
Comment : ot
= [¥] Allow input
[¥] Allow input
* Set value after leaving focus can be set up in general system setting page
. . [V/] Read /Write vse different addresses
[7] Read/Write use different addresses
Ridd Read
Device : [Local HMIL v][ el P [Local Ml 7'];]\?
Address: [LW <o ‘ ' Addoess: |l )
Write Wi
Device : [Logal HM CE@ Devio: {gmaliRil ) etale)
Address: [LW ~|0 Address: (LB m)\0 ‘
Notification Notification
[V] Enable (V] Enable
OSetON @ SetOFF © Before writng ) After writing OSetON @ SetOFF @ Before wiiting: ~ © After wriing
Device : (Local HMI EEE Device : (L ocal HMI )]
Address: [LB ~|0 Address: |LB =)0
Notification on invalid input
[7] Enable @ SetON ) Set OFF
Device : (Local HMI ) e
Address: |LB ~|0
[ OK ] [ Cancel ] [ Help. ] [ OK ] [ Cancel ] [ Help ]
Setting Description
Allow input If selected, the input features and relevant settings are enabled.
Read / Write Different addresses can be used to read data and write data.
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use different
address

Read address

Click [Setting] to select the [Device], [Address], [Device type],
[System tag], [Index register] of the word device that displays the
value. Users can also select a tag defined in Address Tag Library.
When [Read/Write use different addresses] option is not selected,
the title of this group box will be “Read/Write address”.

Write address

Select the [Device], [Device type], [Address] of the word device
that system writes to.

Notification

With notification enabled, the state of the designated bit address
can be set on / off, before / after writing.

Notification works differently comparing cMT / cMT X Series with
eMT/iE/XE/mTV Series.

cMT/cMT X Series: Trigger the object to open a keyboard window »
Notification before writing » Enter a value and press ENTER » Start
writing operation » Notification after writing.

eMT/iE/XE/mTV Series:

Trigger the object to open a keyboard window » Enter a value and
press ENTER » Notification before writing » Start writing operation
» Notification after writing.

Notification
on invalid
input

If anillegal value is entered, automatically set the state of a
designated register.
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cMT, cMT X eMT, iE, XE, mTV Series
Numeric Object's Properties == New Numeric Object
| Shape f],. Font l Profile | | General | Data Entry [ Format I Secwrity | Shape | Font ‘
! General Data Entry I Format I Trigger Action Setting | Security |
= Mode : | Touch -
Mode : [ Touch v
Input order Input oxder
(7] Ensble [¥/] Enable
[7] $top sequential tnput function after input [7] Stop sequential input function after input
Inputorder: 1 < | Group Inputorder: 1 £ [7] Group
Keyboard Keyboard
[] Use a popup keypad [V] Use a popup keypad
[ Hide title bar
D System keypad ® Custom keypad || Restart the keypad if input value is out of range
Window no. : (50, Keyped 1 - Integer - Window no.: (50, Keypad 1 - Integer -
Animation : [Mone, None] Popup position :
Erriy g {relative to HMI screen}
[ Hide title ber E
Popup position
IRelaﬁve to HMI screen v
Hint : If the keyboard is an USB keyboard, on indirect/divect window, or on the same
window, please don't check "Use a popup keypad".
Hint : If the keyboard is an USB keyboard, on indirect/divect window, or on the same
window, please don't check "Use a popup keypad".
Other options
[ Display lower and upper limits
["] Display current value
[ ok ][ cancel [ hep | [ oc ][ cancel |[ hep
Setting Description
Mode Touch

Used when data entry is initiated by touching the screen object.

Bit control

Used when data entry is enabled by turning ON a designated bit,

and entry ends when the bit goes OFF.

Input control

Specify a bit address that enables or ends data entry. The order of

data entry is specified in [Input order] and an external USB

keyboard is needed for data entry. For cMT-SVR, use cMT Viewer’s

keyboard.

Input order

Perform continuous input by setting [Input order] and [Group].

The criterion of searching the next input object:

® The range of [Input order]: 1~ 511, range of [Group]: 1 ~ 15.

® |[f [Group] is not selected, its input order is O.

® The system only searches for the objects within the same
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Group.

® The lower number of order is entered before the higher
number of order.

® For multiple objects within the same group and with the same

input order, the object placed in the lower layer is entered first.

¥

4 Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Keyboard Use a popup keypad
If selected: A pre-designed pop-up keypad can be chosen by
selecting a check box and selecting the relative position on the HMI
screen. When data entry is enabled, the pop-up keypad displays in
the selected position, and closed when data entry ends.
If not selected: When data entry is enabled, the pop-up keypad is
not displayed. Users may:
® (Create a custom design on the same screen window.
® Use a USB keyboard.
System keypad
cMT / cMT X Series model has its own system keypad, select this
checkbox to use the system keypad, or select [Custom keypad] to
set up a customized keypad.
Animation Setting
When using a cMT / cMT X Series model with [Custom keypad]
selected, the transition effect of the keypad window can be

selected.

r See Chapter 13.5 Function Key in this manual for the list of
effects.

Hide title bar

Use a keypad without the title bar.

Popup position

When using a cMT / cMT X Series model with [Custom keypad]
selected, the position where the keypad pops up can be selected.
The position can either be relative to HMI screen or relative to
object.

Relative to HMI screen Relative to object
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B He He
ik B =
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Restart the keypad if input value is out of range
When entering data, if the value entered is not within the valid

range, the system will automatically restart the keypad.

Other options
(ForcMT/
cMT X Series)

Display lower and upper limits
If selected, when entering a value, the range

1234
is displayed near the object.

Display previous value Range: 0 to 9999
If selected, when entering a value, the value Current value: 5

before update is displayed near the object.

& To create a keyboard in current window, see “12 Keypad Design and Usage”.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

Example 1

This example demonstrates how to use [Input Order] and [Group] to perform continuous input

in several Numeric objects. After entering data in one object, entry will be passed to the next

input order object which is in the same group.

1. Create three Numeric objects, and set [Input order] to 1, 2, and 3 respectively. Include

the three objects in [Group 1] as shown in the following figure.

LW-0

LW-1
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[¥] Enable

[ 5top sequential input function after input

Inputorder: 1 = [¥]Group: 1
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Input arder

[¥]Enable

] Stop sequential input function after input

Input order : 2 = Group 1
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LW-2

Input order
| Enable

Stop sequential input function after input

Input order @ 3 = | Group 1

LW-0 —> W1 LwW-2

Orderl Order2 Order3

g

2.  When finish entering data in the last object, to end data entry of all objects, please select

[Stop sequential input function after input] check box.

Input order
| Enable

I | Stop sequential input function after input I

Input order ; 3 = | Group 1
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Format Tab
New Numeric Object @
‘General IDaw mey‘ Format \Trigger Action Setting ISecumy lShape | Font |
Display
Device data format : | 16-bit Unsigned v
Display format -
Type : |Customized = [ IMask
Left of decimal Pt. : 4 =
Truncated digits : 0 s
Format : *¥*% Usage...
Scaling
Method : {Imerpolation V]
lLJ <= Preview conversion result
[ Dynamic scales
Scaling low: 0 Scaling high : 9999
Limits
@) Direct ") Dynamic limits
Devicelow: 0 Inputlow : |0
Device high : 9999 Input high : 0000
[¥]Use alarm color Low limit : :} ["|Blink
High i () i
[ ok ][ cance ][ Hep
Setting Description

Device Data

Format

Set the data format of a designated word register. Options include:
BCD, Binary, Unsigned, Signed, HEX, and Float. 16-bit uses 1 word

where 32-bit uses two words.
Mask

If selected, any values entered will be hidden by displaying them as

“uxn

asterisks

Display

format

Default
General Numeric formats.

Customized

Each “*” sign represents each integer digit, and each “#” sign

represents each fraction digit that will be displayed in the Numeric

object. Float and Double formats are only supported on cMT / cMT

X models.
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“uxn

Apart from signs, extra texts can be entered in the [Format]
field, for example: kg. The available alignment options are: [Left],
[Center], [Right], [Leading zero].

“uskn

The numeric value represented by sign will be displayed from
the highest digit to the lowest in the Numeric object.

Truncated digits

Specify the number of digits to be truncated, from the lowest digit
to the highest.
The number of

[Right of decimal Pt.].

“uxn

signs = [Left of decimal Pt.] - [Truncated digits] -

The number of “#” signs = [Right of decimal Pt.] - [Truncated digits].

Please see the following examples:
Display Format @

Example 1

[Left of decimal Pt.] = 5, [Truncated digits] = 0,

50 5§ stars ™" must be used.

Use [Format] = "**kg***g" and [Align] = Leading zero”
=2 If read data is 12345, the result will be "12kg345g"
=2 Ifread data is 123, the result will be "00kg123g™

Example 2 : Change [Truncated digits]
[Left of decimal Pt.] = 5, [Truncated digits] = 2,
50 3 stars ™" must be used and last two digits will be truncated.
Use [Format] = "**kg*00g" and [Align] = "Leading zero"
=2 Ifread data is 12345, the result will be "12kg300g™
=3 Ifread data is 123, the result will be "00kg100g"

Example 3 : Use "Left™ Align
[Left of decimal Pt.] = 5, [Truncated digits] = 0,
50 5§ stars ™*" must be used.
Use [Format] = "Total : **kg®**g" and [Align] = "Left”
=2 Ifread data is 12345, the result will be "Total : 12kg345g"
=2 Ifread data is 123, the result will be "Total : 1239

Close

Display Format @

Example 1 : common case
[Left of decimal Pt.] = 3, [Right of decimal Pt.] = 3, [Truncated digits] = 0,
so three ™*" symbols and three "#" symbols must be used.
Suppose [Format] = ™*%g###g" and [Align] = "Leading zero™
=> If the data is 123.456, the result shown will be "123kg456g™
=2 If the data is 1.234, the result shown will be "001kg234g"

Example 2 : with truncated digits
[Left of decimal Pt.] = 3, [Right of decimal Pt.] = 3, [Truncated digits] = 4,
50 two "*" symbols must be used and the last four digits will be truncated.
Suppose [Format] = ™*0kg000g" and [Align] = "Leading zero™
=3 If the data is 123.456, the result shown will be "120kg000g™
=> If the data is 12.3, the result shown will be "010kg000g™

Example 3 : using "Left” align
[Left of decimal Pt.] = 4, [Right of dedmal Pt.] = 3, [Truncated digits] = 0,
so0 four **" symbols and three "% symbols must be used.
Suppose [Format] = "Total : =, ==*kg###g”and [Align] = "Left”
=3 If the data is 1234. 567, the result shown will be "Total : 1,234kg567g"
=3 If the data is 123.456, the result shown will be "Total : 123kg456g™

Close

“uxn

When leading zero is not used, the text enclosed in two signs
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will not show, for example:
[Left of decimal Pt.] =5, [Truncated digits] = 0, and Display Format
is “Total=**kg***g”
If the data read is 255, the result would be: "Total=255g"
If the data read is 1000, the result would be: "Total=1kg000g"
Scientific Notation (cMT / cMT X Series)
Express numerical data using scientific notation; for example,
number 100 is displayed as 1e+2. Scientific notation is not available
for device data formats: BCD, HEX, or Binary.

Number of Left of decimal Pt.

digits The number of digits before the decimal point.
Right of decimal Pt.
The number of digits after the decimal point.

Scaling Interpolation
If this check box is selected, [Engineering low] and [Engineering
high] boxes appear. Values entered in these boxes correspond to
the display range required. The setting also requires [Input low]
and [Input high] in the limits section. See Example 2.
Test: Preview the result of Interpolation. See Example 2.
Dynamic scales: Set the [Engineering low] and [Engineering high]
by a designated register. See Example 4.
Macro subroutine
The value read from or written to the register can be computed by
macro subroutines selected in [Read conversion] and [Write
conversion]. The macro subroutines should be defined in Macro
Function Library. To use this feature, see “13.9.2.1 The rule of using
Macro subroutine”.

Limits This section enables users to apply display limits to the values in

the input register and set the display color to be used when the
register value falls outside the specified limits.

Direct

Set the limits by entering values in [Device low] and [Device high].
If the value entered is outside the limits, the value in the register
cannot be changed.

Dynamic limits

Set the limits by specifying a register.

To use consecutive addresses, see Example 5.

On a cMT / cMT X model with the [Use different addresses] option
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selected, it’s possible to set the high and low limits by specifying
different addresses. If the scaling method used is interpolation,
both high and low limit addresses are required.
Use alarm Low limit
color When the value in the register is outside the [Low limit], the object

displays digits by using the set color.

High limit

When the value in the register is outside the [High limit], the object
displays digits by using the set color.

Blink

When the value in the register is outside either limit, the digits
flash.

Trigger Action Setting (cMT / cMT X)

Actions executed before/after writing can be classified into action groups. The groups are put
in sequence. The actions within the same group are executed at the same time. When all the
actions within the same group are completed, the actions in the next group are then executed.

Compared to the Notification actions selected in General tab, Trigger Action Setting offers

more flexible combination of actions. For more details about these settings, please also see

Action Trigger in Chapter 13.
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New Numeric Object
| General | Data Entry | Format | Trigger Action Setting | Security | Shape | Font |
Actions before writing
2
Action Group 1 Action Group 2
Set Bit (Set ON, LB-0) 7 r
\—’_’ Set Word (Write constant value : 0... —
Delay (50 ms) o
o ‘ ’ o,
<« | i »
Actions after writing
r”
Action Group 1 Action Group 2 Action Gro
| Wait Until (LB-Dison) (—» Set Bit Set ON, LB-1) }-» o
o L)
< I | ’
[ OK ] [ Cancel ] [ Help ]
Setting Description
Actions The predefined action groups will be executed once the write

before writing

operation starts, and will not wait for it to be completed.

Actions after
writing

The predefined action groups will be executed when the write

operation is completed.

13.9.2.1. The rule of using Macro Subroutine

® There must be a return value and exactly one parameter.

Examples:

sub char test (short a)
// (Incorrect, no return value.)

Su

sub char test (char a, char b)

RWE!NTEK

b test (char a)

// (Correct)

// (Incorrect, two parameters.)

EasyBuilder Pro V6.10.01



Objects 13-55

® Use the Macro data type that corresponds to the object’s data format.

The mapping is as follows:

Macro Data Type Numeric Object Data Format

short 16-bit Signed

Int 32-bit Signed

unsigned short 16-bit BCD, 16-bit HEX, 16-bit Binary, 16-bit Unsigned
unsigned int 32-bit BCD, 32-bit HEX, 32-bit Binary, 32-bit Unsigned
float 32-bit Float

long 64-bit Signed (cMT / cMT X only)

unsigned long 64-bit Unsigned (cMT / cMT X only)

double 64-bit Double (cMT / cMT X only)

For example, if the data format of the numeric object is 16-bit Unsigned, only the
corresponding Macro data type: unsigned short, is available.

Examples:

sub char test(unsigned short a) // (Correct)

sub char test(chara) // (Incorrect)

® Supports only the local HMI address.

Examples:
GetData(var, "Local HMI", LB, 0, 1) // (Correct)

GetData(var, "MODBUS RTU", 0x, 0, 1) // (Incorrect)

® The following system defined functions are unable to be invoked:

ASYNC_TRIG_MACRO, SYNC_TRIG_MACRO, DELAY, FindDataSamplingDate,
FindDataSamplingindex, FindEventLogDate, FindEventLogindex, INPORT, INPORT2, OUTPORT,
PURGE, TRACE

® The following statements are not supported:
For-Next, While-Wend

Example 2
If [Interpolation] is selected, the scaling equation is as the following:
If A indicates the original data and B indicates the displayed data:
B = [Engineering low] + (A - [PLC low]) x Ratio
where, Ratio = ([Engineering high] - [Engineering low]) / ([PLC high] - [PLC low])
As shown below, the original data is 15, after conversion, 40 will be displayed.
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Sraling

Method : | Interpolatinn

-

Test... «= Preview comversion resnlt

[] Dramde seales

Engineering low : 10

Limits
@ Direct O Dremnarmae limits
FLC low: g
Input low : |10

Engmeerng hugh : 50

PLC high : 20
Input high - | 50

13-56

Click [Test] button to preview the result of Interpolation. Enter a value in [PLC] field as shown in

the following figure, for example, enter value 15, and the result, which is 40, will be displayed.

Conversion Test @
Mumber of digits
Left of decmal Pt. : 4 = Right of dedmal Pt. : g =
Engineering high Engineering low
HMI Engineering low PLC PLC lowe 50} 10
40 = |10 +( 15 - [0 )x
20 - u]
PLC high PLC low
o 15
: ] |
PLC
Apply ] [ 0K I [ Cancel

Example 3
If the numeric format selected is not Float and decimal point is used, the decimal place of the

converted result will not be adjusted automatically, please adjust [Engineering high] to
correctly place the decimal point of the result gained in [Interpolation] mode. Please see the
illustration below.

1. Create two Numeric objects, set [Right of decimal Pt.] to 1 and select [Interpolation]

method for one of the objects as shown in the following figure.
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MNew Mumeric Object

Data Entry | Numeric Format | security | shape | Font

=

Engineering low : 0

Limits
(@) Direct () Dyniamic limits
PLClow : @ PLC high: 100
Inputlow : | o Input high : | 200

Display
Data format: 16-hitUnsigned = [FImask
Mumber of digits
Left of decmal Pt. : 4 = Right of dedmal Pt. :
Scaling
Method : | Interpolation -
] Dynamic scales

Engineering high :

200

2. Enter value “123”, the object set to [Interpolation] displays “246.0” instead of “24.6".

3. To move the decimal point one place to the left, adjust [Engineering high] as shown in the

following figure.

Example 4

If [Interpolation] is selected, set the [Engineering low] and [Engineering high] by a designated

Original Value

Converted Value

123

246.0

Mew Numeric Object

Data Entry | Numeric Format | security | Shape | Font

g

Display
Data format: 16-hitUnsigned = [Fmask
Mumber of digits
Left of decimal Pt. : 4 = Right of decimal Pt. :
Scaling

Method @ |Interpolation -

[ Dynamic scales

Engineering low : 0 Engineering high :

Original Value

Converted Value

1

20

123

24.6

register. When Dynamic Address is LW-n, where n is an arbitrary number, the rule of setting
[Engineering low] and [Engineering high] is:

I__| WE!NTEK
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Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-n LW-n LW-n

Engineering low LW-n LW-n LW-n

Engineering high LW-n+1 LW-n+2 LW-n+4

When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-100 LW-100 LW-100

Engineering low LW-100 LW-100 LW-100

Engineering high LW-101 LW-102 LW-104

Example 5
Set the limits by a designated register. When [Address] is LW-n and [Use consecutive

addresses] is selected, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-n LW-n LW-n

Low limit LW-n LW-n LW-n

High limit LW-n+1 LW-n+2 LW-n+4

When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-100 LW-100 LW-100

Low limit LW-100 LW-100 LW-100

High limit Lw-101 LwW-102 LW-104

Example 6

The following demonstrates how to use [Macro subroutine] for scaling when configuring
Numeric object.

The following two macros are used, one for [Read conversion] and one for [Write conversion].

1.

Read Conversion

Write Conversion

sub short read(short a)

sub short write(short a)

short b short b
b=a+10 b=a-10
return b return b
end sub end sub

Create two Numeric objects: NE_0 and NE_1 and use the same control address. Select

[Macro subroutine] for NE_1.

NE_O

(Without Macro conversion)

[

D‘pWE!NTEK

NE_1

(With Macro conversion)

=
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displays 70.

Mumeric Object's Properties

| General | Data Entry | Format | Secwity | Shape | Font | Profile |

Display

Mwmber of digits
Left of decimal Pt. : 4

Dizplay format
[ Enable

Sealing

Dievice dats format : [ 16-bit Sizned | [[]Mask

Method : [Macm subrouting

Read conversion : [read

Write converson [write

NE_O

(Without Macro conversion)

0

Read Conversion

Enter 0 in NE_O then NE_1 will execute [Read conversion]. The value gained will be 10.

NE_1

(With Macro conversion)

10

Write Conversion

sub short read(short a)
short b
b=a+10

return b

end sub

sub short write(short a)
short b
b=a-10

return b

end sub

NE_O

(Without Macro conversion)

70

Read Conversion

Enter 80 in NE_1, [Write conversion] is executed and the value gained will be 70. NE_O

NE_1

(With Macro conversion)

80

Write Conversion

sub short read(short a)
shortb
b=a+10

return b

end sub

sub short write(short a)
short b
b=a-10

return b

end sub
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B If executing [Read conversion] and [Write conversion] by the same numeric object, the
value entered in this object is computed by the Macro subroutine of [Write conversion]
first, and then the result is computed by the Macro subroutine of [Read conversion]. In
Example 5, if the subroutine of [Write conversion] is set to b=a-20, then entering 80 in
NE_1 will get 60 after [Write conversion] and then the object displays 70 after [Read
conversion].

Security Tab
cMT, cMT X eMT, iE, XE, mTV Series
Numeric Object's Properties @ Numeric Object's Properties
| Generml [ DetaBatty | Fommat [ Limits [ TrigeerActionSetiing | || [ Geneml | DamEary [ Fommat [ Limits [ Trigger ActionSetting |
Security | Shape | Font I Profile | Secuity | Shape Font Profile |
Safety control Safety control
[¥] Display confirmation request Max. waiting time (ssc) : 10 [¥] Display confirmation request Max. waiting time (sec) : 10
Enable/Disable Enable/Disable
[V] Use register statusivalue [V] Use register statusvalue
@ Bit 7 Word @ Bit 7 Word
Device : (Local HMI B e Device : (Lacal HMI B e
Address: LB v|0 Address: |LB v 0
Enable if bitis : Enable if bitis
[V] Use control token [¥] Use control token
Controltoken : [1: Control Token - Local Only ~ | [ Token Library... Control token : [1: Control Token - LocalOnly v | [ TokenLibrary... |
Enable if token is : | Acguired v Enable if token is : | Acquired “
* For environment of using multiple clients M T Viewers). * For environment of using multiple clients (¢MT Viewexrs).
Action : [Do nothing when disabled '] Action : [Do nothing when disabled ']
User restriction User restriction
Object class : [Nom V] Object class : [None vJ
;]qu the user tries to operate on an object without anthorization, LB-12056 will be set to *If the vser tries to operate on an object without authorization, LB-12056 will be set to
¥ ON.
Sound Sound
] Enable Sound Librery...| Beep ] Ensble (Sound Library...| Beep
Play Play
[ OK J [ Cancel | [ Help [ OK ] [ Cancel } | Help
Setting Description

Safety control

command.

Displays a confirmation request window before executing a

Enable/Disable

Use register status / value

With this option selected, whether an object is operable
depends on whether the specified condition occurs in the
designated address.

Use control token

With this option selected, whether an object is operable
depends on whether a control token is acquired or
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unacquired.
Action modes:
Do nothing when disabled
The object is not operable, and its status remains
unchanged when the specified condition does not occur in
the designated address.
Hide when disabled
The object is hidden when the specified condition does
not occur in the designated address.
Grayed label when disabled
The value in the object turns gray when the specified
condition does not occur in the designated address.

User Set the security class of the object to be operated by an

restriction authorized user.

Sound When enabled, the selected sound will be played when
the object is touched.

Font Tab
New Numeric Object @
‘ General | Data Entry | Mumeric Format | Security IShapel Font |
Attribute
Font: Arial -
Cobr : IE— | sie
Content
Setting Description

I__| WE!NTEK
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Color When the value is within the limits, display digits using color set in
this tab.
Align Left: Align the number to the left.

Center: Align the number to the center.

Right: Align the number to the right.

Leading zero: The number is preceded with leading zeros when the
number of digits is less than that set.

Left
Center
Right
Leading zero

Size Set the font size.
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13.10. ASCII

13.10.1. Overview

ASCII object can be used to input or display ASCIl or UNICODE characters held in designated

word registers.

13.10.2. Configuration

==

Click [Object] » [ASCII] icon on the toolbar to open an ASCII object property dialog box. Set up

the properties, press OK button, and a new ASCII object will be created.
General Tab

cMT, cMT X eMT, iE, XE, mTV Series

New ASCII X New ASCII X ‘

‘ General
General DataEntry Security Shape Font Trigger Action Setting enorl. [y i) Be I Ra

Comment : Comment :
@ Allow input ;) @ Allow input
O Mask @ Mask
([ Multi-line display [ Multi-line display

Data format Data format

Encoding:  UTF-8 (Default) v Encoding :  UTF-8 (Default) v
String termination :  Ignore null character v
[CJReverse high/low byte [[J Reverse high/low byte
Read/Write Read/Write
Device:  Local HMI @ [ Device :  Local HMI Vi @ @
Address: LW v o0 T [iwordls) Address: LW M) [ word(s)
Notification Notification
@Enable [JEnable
(O SetON O Set OFF © Before writing O After writing
Device:  Local HMI v @ QI
Address: LB v 0
o) [ ) [ep ) o J[ coneel J[ reb ]|
Setting Description
Allow input If selected, the input features and relevant settings are enabled.
Mask If selected, any values entered will be masked by asterisks (*).
Multi-line If selected, the ASCII object can display multi-lined text. If a line
display

feed character LF (OxA) is used in the string, a newline will be
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created.
Vertical When [Multi-line display] is enabled, the method to vertically align
alignment multiple lines of text can be selected.
Encoding Select encoding from UTF-8 (default), Unicode, or Latin-1.
String Ignore null character, or treat the first encountered \0 as the end of
termination the string.
Reverse Normally an ASCII code is displayed in “high byte”, “low byte”
high/low byte order. Reverse selection makes the system display ASCII characters

in “low byte”, “high byte” order.

ABCD BADC

The left object is in normal form, and
another is high/low bvte reversed.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that displays
characters. Users can select a defined address tag from Address Tag

Library, or set address in [General] tab while adding a new object.

X

Device : | ocal HMI
Addresstype : Lw
Address : 0 ([system tag () userdefined tag

Address format : DDDDD frange : 0 ~ 12900]

[)index regster

No. of word: 2

Tag Library... oK Cancel

No. of words

Select the maximum number of words to be displayed.
cMT / cMT X Series: max. 160 words

eMT/XE/mTV/iP: max. 64 words

Notification

With notification enabled, the state of the designated bit address
can be set on / off, before / after writing.

Notification works differently comparing cMT/cMT X Series with
eMT/IiE/XE/mTV Series.

cMT/cMT X Series: Trigger the object to open a keyboard window »
Notification before writing » Enter a value and press ENTER » Start
writing operation » Notification after writing.

eMT/IiE/XE/mTV Series:

Trigger the object to open a keyboard window » Enter a value and

press ENTER » Notification before writing » Start writing operation
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» Notification after writing.

0 Note

B A UNICODE character uses 1 word, and an ASCIl character uses 1 byte. Therefore 1 word

can be used as 1 UNICODE character or 2 ASCII characters. (1 word equals to 2 bytes)

Font Tab

cMT, cMT X

New ASCII

| General DataEntry Security Shape Font Trigger Action Setting

Content

eMT, iE, XE, mTV Series

New ASCII X

General Security Shape Font Data Entry

Content

AA...

8 Preview with actual font size
(0 Lock minimum size to content
Attribute

Font: | Arial v

Size: 16

Color: |
Text alignment

Horizontal : Center
Text area position

Horizontal : Center v Vertical : Center

* Please use "Droid Sans Fallback" font if the content of text is determined in run time. (This
font will increase HMI startup time.)

[ ok ][ concel ][ Hep

J

@ Preview with actual font size

Attribute

Font: [Arial v|

Size: 16

Color:
Text alignment

Horizontal :  Center
Text area position

Horizontal : Center v Vertical : Center v

* Please use "Droid Sans Fallback” font if the content of text is determined in run time. (This
font will increase HMI startup time.)

[ ok ][ cancel ][ Hep

Setting Description

Preview with
actual font

Preview in the Content field based on the font and size settings

specified in the Attribute.

size

Lock

If selected, the ASCII object's width automatically adjusts to the

minimum size

minimum width necessary to display all the text.

to content

Attribute The font, size, color, and alignment can be set.

Text Multiline text is aligned within the label outline. The method to
Alignment align multiple lines of text can be selected.

Text area Multiline text is aligned within the object outline.

position The label outline is highlighted by red dotted line and the object

outline is highlighted by blue dotted line. Please note that this
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feature is ineffective when [Multi-line display] is enabled in General

tab.
When object is selected. When text is selected.
| | ] n u u
n AAAA ] sAAA A=
| | [ ] =

Trigger Action Setting (cMT / cMT X)

Actions executed before/after writing can be classified into action groups. The groups are put
in sequence. The actions within the same group are executed at the same time. When all the
actions within the same group are completed, the actions in the next group are then executed.
Compared to the Notification actions selected in General tab, Trigger Action Setting offers
more flexible combination of actions. For more details about these settings, please also see
Action Trigger in Chapter 13.

| New AsCIl X |

General DataEntry Security Shape Font TriggerAction Setting

Actions before writing

Action Group 1 Action Group 2 Action G
Set Bit (Set ON, LB-0) | - —
—}» Set Word (Write constantvalue... —» 0
Delay (50 ms) — O
[+
Actions after writing
Action Group 1 Action Group 2 Action Group 3

Wait Until (LB-0is on) 14> Set Bit (Set ON, LB-1) —» O

) L)
[ OK ][ Cancel H Help
Setting Description
Actions The predefined action groups will be executed once the write
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before writing operation starts, and will not wait for it to be completed.
Actions after The predefined action groups will be executed when the write
writing operation is completed.
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13.11.

13.11.1. Overview

Indirect Window

13-68

Indirect Window object opens or closes a pop-up window assigned by a designated word
register. There are two ways to use Indirect Window object: The first is to use the profile of
Indirect Window object, and let the pop-up window be resized and displayed in the defined
profile; the second is to automatically resize the window according to the size of the pop-up
window to be displayed. To close the pop-up window, assign 0 to the designated word register.
The difference between Direct Window and Indirect Window is that Direct Window is
controlled by a bit register, while Indirect Window is controlled by a word register.

13.11.2. Configuration

Click [Object] » [Embed Window] » [Indirect Window] icon on the toolbar to open the object
property dialog box. Set up the properties, press OK button, and a new Indirect Window object

will be created.

General Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
New Indirect Window Object New Indirect Window Object
General | Position | Security | | General | Position|
Comment : Comment :
Attribute Read address
Style : |Embedded in parent window | \ Device : (Local HMI v [ Settings...
Address: LW |0 16-bit Unsigned
Read Attribute
Device : [Local HMI | e it Style : | With title bar v
Address: [LW ~|0 16-bit Unsigned
Animation
Effect Duration Direction
Start : | Float v 100 & ms From Left -
End: [Fy v 100 S ms [ToLeft -]
. ) [V] Use window no. offset Otfeet: @
[¥] Use window no. offset Offset: [.10 v
[ OK J [ Cancel ] I Help [ OK J [ Cancel ] | Help
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Setting Description
Style This setting is available only on cMT / cMT X Series. When a base

window contains an underlay window, this setting determines the
display style of an Indirect Window placed in the underlay window.
Please see Example 2 below.

Embedded in parent window

The Indirect Window is displayed in its parent window. When an
Indirect Window is placed in an underlay window, the Indirect
Window is displayed in the underlay window when it is called in the
base window.

Popup window

The Indirect Window is displayed in the base window. When an
Indirect Window is placed in an underlay window, the Indirect
Window is displayed in the base window when it is called in the
base window.

Title Bar Setting

When [Enable title bar] is selected, a field shows for entering the
caption in the title bar. The caption can be selected from Label Tag

Library.

Attribute

Style : [Popup window ']
Tille Bar Sefting... |

Resd| Popup Window Property
Title setting
[¥] Enable title bar

Aniny
[V] use label library Label_1: text 7

o) (o)

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
pop-up window. Users can also set address in [General] tab while

adding a new object.

Attribute

Style
Set the display style of the pop-up window. There are two styles:
® No title bar
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The pop-up window has no title bar and cannot be dragged.

® With title bar

The pop-up window has a title bar that can be dragged to move the

window.
Animation Effect
(cMT / cMT X Different effects may be used for Start (window appears) and End
Series) (window disappears).
Effect Name Transition
Fade
Fly I
Float
Wipe
Split B S
Circle 3 -
[ 4 l b
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Clock
Zoom _j
Turn 2
" 4 l &
Push
Duration

Specifies how many milliseconds (ms) a transition effect takes to

complete.
Direction
The direction of the transition.

Use window

no. offset

Sets the offset of the window number for selecting the pop-up

window. The window number of the pop-up window is calculated

by the value in the word register added to the offset. For example,

assume the value in the register is 20 and offset is 5, the pop-up

window number will be 25.

EWE!NTEK
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Position
cMT / cMT X Series eMT, iE, XE, mTV Series
New Indirect Window Object New Indirect Window Object
[ Genexal | Position | Security | [ General | Position |
[¥] Auto. adjust window size [¥] Auto. adjust window size
9 s )
Alignment: Alignment:
{relative to object display region} {relative to object display region}
[¥] Dymamic position
Device : Local HMI [ Settings..
Address: LW v|0
¥ Address: LW-0
¥ Address: LW-1
[7] Enable shift window animation: Duration: 1
< I 13 < m 13
[ OK l [ Cancel ] [ Help [ OK J [ Cancel I [ Help
Setting Description

Auto. adjust
window size

Automatically resizes the Indirect Window and align the pop-up
window to the preset region.

Alignment

Sets a reference point of the pop-up window from one of the five
positions on the screen; for example, if the lower-right region is
selected, the lower-right corner of the pop-up window is aligned to

the lower-right region of the Indirect Window. See Example 1.

Dynamic With this option selected, the position of the window on the screen
position can be changed dynamically by the values in the designated
address.
Enable shift window animation
With this option selected, the window changes position with
transition effect.
Example 1

Here is an example of using Indirect Window. The setting is shown in the following figure, set

the address to LW-0 which assigns the window number. Create window no. 11 and 12 first.

1. Create an Indirect Window object, set address to LW-0, and select [Auto. adjust window
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size].
2. Select the region where the window is to be displayed.

New Indirect Window Object

‘Gemm]]‘ Position |

[V] Anto. adjust window size

Alignment:
{relative to object display region}

3. Enter value 11 in LW-0, the pop-up window displayed is window no. 11.
4. Enter value 12 in LW-0, the pop-up window displayed is window no. 12.
5. Enter value 0 in LW-0, the pop-up window is closed.

Popup Window No. 11| Popup Window No. 12|

<- The frame of Indirect Window <- The frame of Indirect Window

Window11

To close the pop-up window, apart from entering 0 in the designated word register, another

way is to place a Function Key object in the pop-up window, and set the key to [Close window].

Example 2
Here is an example showing the difference between these two styles: [Embedded in parent

window] and [Popup window]. The style setting determines how an Indirect Window placed in
an underlay window is displayed when it is called in the base window.
1. Addtwo base windows: Window no. 10 and Window no. 11. Add an underlay window in

Window no. 10 and set Window no. 11 as the underlay window.

Window Settings

Mame :  WINDOW_010

Window no. : | 10

Size
Wwidth: 800 Height: 480

Background
) S—

Transparency : D 0%

* [Transparency] is used only on popup, directfindirect and keyboard windows.

Underlay windaw

I Bottom : |11, Window_011 | hd

2. Create several objects in Window no. 10.
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Window 10

3.  In Window no. 11 create an Indirect Window object and a Numeric Input object. Set both

read addresses to LW-0.

4. By entering a window number in the Numeric Input object, the Indirect Window is

displayed according to the selected style.

Embedded in parent window
*, cMT Viewer ( Simulation ) "

MAX (0 MN[0 )

WindoYV 11 r : —} lﬂj

® 0 0 ux o
TR
TR
o [o] -] Enter
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Popup window
™ eMT Viewer ( Simulation ) EI@

Window 10

macl o Imn[ 0 )
Window 11 ( | 50

@ Note

B  For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT / cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window with two Direct (or Indirect)
windows in one base window.

B If the pop up window has monopoly property enabled, then when the window pops up,
all background windows may not be operated until the monopolizing window has been
closed.

II' Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.12. Direct Window

13.12.1. Overview

13-76

Direct Window object opens or closes a pop-up window assigned by a designated bit register.

When the state of the bit register changes, the pop-up window appears at the predefined

location. The display area for the pop-up window is limited by the size of predefined location.

Returning the state of the bit register closes the pop-up window. The difference between

Direct Window and Indirect Window is that Direct Window is controlled by a bit register, while

Indirect Window is controlled by a word register.

13.12.2. Configuration

is]

Click [Object] » [Embed Window] » [Direct Window] icon on the toolbar to open a Direct

Window object property dialog box. Set up the properties, press OK button, and a new Direct

Window object will be created.

General Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
New Direct Window Object New Direct Window Object (=
General | Position | Security | General | Position
Comment : Comment :
Attribute Attribute
Trigger: [ON = Trigeer: [ON -
Window No. : (3 Monitor Mode v St [No title bar -
Style : [Embedded in parent window v Window No. : [3. Fast Selection VJ
Read address
Read Device : D,ocalHMI v][ Seftings.. |
Device : [LocalHMI v][ = & Address: LB |0
Address: |LB v 0
Animation
Effect Duration Direction
Start - 100 4| ms  [FromLeft =
End : [split v 100 & ms | Vertical Out -
P -
}lll"‘ Iilees |
OK ] ] Cancel 1 [ Help [ OK ] [ Cancel l [ Help
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Setting Description
Style This setting is available only on cMT / cMT X Series. When a base

window contains an underlay window, this setting determines the
display style of a Direct Window placed in the underlay window.
Please see Example 2 in Chapter13.11 in this manual.

Embedded in parent window

The Direct Window is displayed in its parent window. When a
Direct Window is placed in an underlay window, the Direct Window
is displayed in the underlay window when it is called in the base
window.

Popup window

The Direct Window is displayed in the base window. When a Direct
Window is placed in an underlay window, the Direct Window is
displayed in the base window when it is called in the base window.
Title Bar Setting

When [Enable title bar] is selected, a field shows for entering the
caption in the title bar. The caption can be selected from Label Tag
Library.

Attribute

Window No. 3. Monitor Mode )

Style : [Popup window v]

[ Title Bax Setting... J

Read|  Popup Window Property @

Title setting

V] Enable title bar
Aniny

[¥]use label library [Label_l : text ']

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
pop-up window. Users can also set address in [General] tab while

adding a new object.

Attribute

Style
Set the display style of the pop-up window. There are two styles:
® No title bar

The pop-up window has no title bar and cannot be dragged.
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® With title bar
The pop-up window has a title bar that can be dragged to move the
window.

Window no.

Set the pop-up window number.

Animation Effect
(cMT / cMT X Different effects may be used for Start (window appears) and End
Series) (window disappears).
Effect Name Transition
Fade
Fly I
Float
Wipe
Split B S
Circle 3 -
[ 4 l b
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Clock
Zoom
Turn 2
Push
Duration
Specifies how many milliseconds (ms) a transition effect takes to
complete.
Direction
The direction of the transition.
Position
cMT / cMT X Series eMT, iE, XE, mTV Series
(" New Direct Window Object (" New Direct Window Object =
General | Position | Security Greneral | Position
Auto. adjust window size Avuto. adjust window size
@. z‘?,\
Alignment: Alignment:
{relative to object display region} {relative to object display region}
Dymamic position
Device : [Local HMI v |( Settings...
Address: [LW v|0 [
X Address: LW-0
Y Address: LW-1
Enable shift window snimation: Duration: 1 ‘:7‘
< m ] <| (1] ] 3
L J [ concel |[ el o J[ cancel J[ hep |
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Setting
Auto. adjust

window size

Dynamic
position

Example 1

13-80

Description

Automatically resizes the Direct Window and align the pop-up
window to the preset region.

Alignment

Sets a reference point of the pop-up window from one of the five
positions on the screen; for example, if the lower-right region is
selected, the lower-right corner of the pop-up window is aligned to
the lower-right region of the Direct Window. See Example 1.

With this option selected, the position of the window on the screen
can be changed dynamically by the values in the designated
address.

Enable shift window animation

With this option selected, the window changes position with
transition effect.

Create window no. 11 which can be controlled by a Toggle Switch with address LB-0.

1. Create a Direct Window object and set read address to LB-0.

2. Inthis example, the reference point for alignment is set to the lower-right region.

New Direct Window Object @

General | Position

V| Auto. adjust window size

@
Alignment:
{relative to object display region}

3.  When LB-0’s state is ON, window no. 11 will show.

ou

Fast Sel

4. When LB-0’s state is OFF, window no. 11 will be hidden.
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Fast Sel

@ Note

B For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT / cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window with two Direct (or Indirect) Windows
in one base window.

B |f the pop up window has monopoly property enabled, then when the window pops up, all
background windows may not be operated until the monopolizing window has been closed.

I:l Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.13. Moving / Rotating Shape

13.13.1. Overview

Moving / Rotating Shape is an object that changes its state, moves, and/or rotates according to
the user-defined parameters. The state, moving distance, and rotation direction/angle are

determined by values in consecutive registers.

13.13.2. Configuration

i

Click [Object] » [Animation] » [Moving / Rotating Shape] icon on the toolbar to create the
object, set up the properties, press OK button, and a new Moving / Rotating Shape object will

be created.
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General Tab
[ New Moving / Rotating Shape Object ==
General | Security | Shape | Label |
Comment :
Device : (Local HMI v
Read address
Device : [Local HMI (3] +
e — e
Usage...
Attribute
Position
Mode : [X&.Yaxis -
Rotate
Mode : [Rome v
Direction : @ Clockwise () Counterclockwise
Limit address
[] Limit from register
Device : [Local HMI -
" — [ fowtmed
Usagze...
o ) [ ana ][ oo |
Setting Description
Read address Click [Setting] to configure the [Device], [Device type], [Address],
[System tag], or [Index register] of the word devices that control
the display of object’s state and moving distance. Users can also set
the address in [General] tab while adding a new object.
Attribute Select the object’s movement mode and range. See “13.13.2.1
[llustration of Modes” in the following part.
Display ratio The size of shape in different states can be set individually as
shown in the following figure.
Ratio : 1 Ratie : 12 Ratie : 1.4 Ratie : 16
Rotate Select Clockwise or Counterclockwise for Direction and define the
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angle range (unit in degree) within which the object may rotate.
The allowable range is 0~360 degrees, and the Max. angle should
be greater than Min. angle.

For more information please see “13.13.2.2 Rotation Modes”.

Limit address The object’s moving range can be set by adjusting the data in the
designated register, see Example 1.

Example 1
Supposed that the object’s moving range is limited by register LW-n, the addresses in the
following table are used to limit the moving / rotating range.

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)

Position - [Min. X] address LW-n LW-n LW-n

Position - [Max. X] address LW-n+1 LW-n+2 LW-n+4

Position - [Min. Y] address LW-n+2 LW-n+4 LW-n+8

Position - [Max. Y] address LW-n+3 LW-n+6 LW-n+12

Rotate — Input Low LW-n+4 LW-n+8 LW-n+16

Rotate — Input High LW-n+5 LW- LW-n+20
n+10

Rotate — Scaling Low LW-n+6 LW- LW-n+24
n+12

Rotate — Scaling High LW-n+7 LW- LW-n+28
n+14

13.13.2.1. lllustration of Modes

Available modes are: (Assume Read Address is LW-n)

® Xaxisonly

The object is only allowed to move along the X-axis. The moving distance ranges from [Min. X]
to [Max. X].

Attribute
Mode : |X axis only v
No. of states : |8 -
Min. X: 0 Max. X : 600
Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2 LW-n+4
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® Y axisonly
The object is only allowed to move along the Y-axis. The moving distance ranges from [Min. Y]
to [Max. Y].

Attribute
Mode [‘f axis only v]
Mo. of states : [3 -
Min.Y: 0 Max.Y: 480
Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on Y-axis LW-n+1 LW-n+2 LW-n+4

® X&Yaxis
The object is allowed to move along the X-axis and Y-axis. The moving range in Xand Y
directions is defined by [Min. X], [Max. X] and [Min. Y], [Max. Y] respectively.

Attribute
Mode : [x &Y axis -
Mo, of states : [3 v]

Min. X : 0 Max. X : §00

Min. ¥ 0 Max. ¥ : 480
Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2 LW-n+4
Moving distance on Y-axis LW-n+2 LW-n+4 LW-n+8

For example, if the object’s read address is LW-100 and the data format is [16-bit Unsigned],
LW-100 is used to control the object’s state, LW-101 is used to control the object’s moving
distance on the X-axis, and LW-102 is used to control the object’s moving distance on the Y-
axis. The following figure shows that the object’s read address is LW-100 and initial position is
(100, 50). To move the object to the position (160,180) and change its state to State 2, assign 2
to LW-100, 160-100 = 60 to LW-101, 180-50 = 130 to [LW102].
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(100. 50) Lwi1o0 Lwi1o1 Lwioz
state 0 [N J 2 D

State X Offset Y Offset

I Lwioo Lwio1 Lwioz

== [z |le |10 |

(160, 160),_restpostion State X Offset Y Offset

® Xaxis w/ scaling

The object moves in X-axis only with scaling. Suppose that the value of the designated register
is DATA, the system uses the following equation to calculate the moving distance on the X-axis.
[Scaling high]-[Scaling low]

Displ =(D -1 1 X
isplacement=(Data-[Input low]) [Input high]-[Input low]

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2 LW-n+4

® Y axis w/ scaling

The object is for Y axis movement with scale, and the equation to calculate the moving
distance on the Y-axis is the same as the one in [X axis w/ scaling].

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on Y-axis LW-n+1 LW-n+2 LW-n+4

® X axis w/ reverse scaling

This works in the way as [X axis w/ scaling], but the moving direction is in reverse.

® Y axis w/ reverse scaling

This works in the way as [Y axis w/ scaling], but the moving direction is in reverse.

13.13.2.2. Rotation Modes

The addresses that control the moving / rotating shape are consecutive addresses starting
from Read Address (LW-n), and they may vary depending on the selected mode. Please click

[Usage...] to open the window that shows the control addresses relating to rotation
parameters.
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Moving / Rotating Shape Object's Properties [==7]
Genersl | Security | Shape | Label | Profile |
Comument :
Device : | Local HMI -
Read addres
Device : | Local HMI 7
Address: [LW ~| 100 Ba-bit Signed
aage. ..
Address Usage

Control
Chject state :LW-100
Moving distance on X axis :Lw-104
Rotating angle :LwW-108

® Rotate
Select rotating direction from clockwise or counterclockwise and set the Min. and Max.
angle range.
When rotation animation is enabled, two modes can be selected: Default and Shortest.
e.g. When the angle measure is set to clockwise and the rotating angle is changed from 10
degrees to 350 degrees, these two modes give different results:
Default: rotates 340 degrees clockwise (linear interpolation between the two numbers)
Shortest: rotates 20 degrees counterclockwise (in the direction that produces the shortest

animation path)

Rotate
Mode : [Rome vl
Angle Measure : @ Clockwise ' Counterclockwise
Animation : @ Default ) Shortest
Min. angle : 0 Max. angle : 359

® Rotate w/ scaling
Select rotating direction from clockwise or counterclockwise. The angle of rotation is
calculated by the formula as shown below.
[Scaling high]-[Scaling low]

Angle of Rotation =(Data-[Input low])x
ngle of Rotation =(Data-[Input low]) [Input high]-[Input low]

® Rotate w/ reverse scaling
Similar to [Rotate w/ scaling] but reverses the object from clockwise to counterclockwise

and vice versa.
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13.14. Animation

13.14.1. Overview

Animation object is defined by a pre-defined point set and states. Animation object will then
move to a given point in a given state defined by designated registers. The object state and
position depend on current value of two consecutive registers. The first register controls the

state of the object and the second register controls the position along the predefined path.

13.14.2. Configuration

—

né

Click [Object] » [Animation] » [Animation] icon on the toolbar. First, create the pre-defined
path. Move the mouse to each moving position, and click the left button to define positions
one by one. When it is done, right click on the screen, set up the properties, press OK button,
and a new Animation object will be created.

AN 0 position & g

pasitign i $

pasitign 4 8

position 3 ¢
pasition £ 2

To change the object’s attributes, double click on the object to open Animation Object’s
Properties dialog box.
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General Tab
Animation Object's Properties @
Comment :
Attribute
Position : @) Controlled by register (7 Based upon time interval
Read address
PLC name : | Local HMI v | [ Setting...
Address : 0 16-bit Unsigned
e
Setting Description
Attribute No. of states

Configure the number of states for this object.

Controlled by register

Use the designated registers to control the object’s state and
position. See Example 1.

Based upon time interval

The object’s state and position will change from time to time. [Time

interval attributes] is used to set the time interval for states and

positions.
Time interval atiributes
Position speed : 10 *0.1second(s)
Image state change [ﬁme—based v] Backward cyde
Image update time @ 5 *0.1second(s)

Position speed: The speed of movement. The unit is 0.1 second.
Supposed that [Speed] is set to 10, the object’s position will change
each second.
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Image state change: Determines how state changes, either
[Position dependent] or [Time-based]. If [Position dependent] is
selected, the object state will change when position changes. If
[Time-based] is selected, the object position will change based on
[Position speed] and the object state will change based on [Image
update time].

Backward cycle: Assumed the object has four positions: position 0,
position 1, position 2, and position 3, and [Backward cycle] is not
selected. When the object moves to the last position (position 3),
the next position will be back to the initial position 0, and repeat.
The moving path is shown as follows:

position 0 - position 1 - position 2 = position 3 - position 0 >
position 1 - position 2...

If [Backward cycle] is selected, when the object moves to the last
position (position 3), it will move backwards to position 2, position
1 and then the initial position 0, and start over again. The moving
path is shown as follows.

position 0 - position 1 - position 2 = position 3 = position 2 >
position 1 - position O...

Example 1
The object’s state and position are determined by the registers, and the addresses must be

configured correctly, as in the following table:

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Object position LW-n+1 LW-n+2 LW-n+4

For example, if the designated register is LW-100 and the data format is [16-bit Unsigned], then
LW-100 represents object’s state, LW-101 represents position. In the picture below, LW-100 = 2,
LW-101 = 3, so the object’s state is 2 and position is 3.

pasitian &
pasitian 4

pasitian i pasitian 4

pasitian 3
State 2.

Lwioo @ 2 | Ltwiwor | 3 |

pasitian 2
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Profile Tab

13-91

ion Object's Prop

General | Shape | Label | Profile

Position
[T Pinned X
Size
[T Keep width/height ratio
Width :
Width (36) :
Shape rectangle size
Width :

Trajectory

r 191 ~

191 ~

aRER

100

a4 ~

Position 0

Height :

Height (%) :

Height :

1 56

100

1147

aRER

[ ook

| [ Cancel

Setting

Description

Shape rectangle size

Set the size of the shape.

Trajectory

Set the position of each point on the moving path.

0 Note

B Since multiple pictures might be used by an [Animation] object, [Set to original

dimension] will not return all pictures to the original size.
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13.15. Bar Graph

13.15.1. Overview

Bar Graph object displays data as a bar graph for visualization.

13.15.2. Configuration

Click [Object] » [Chart] » [Bar Graph] icon on the toolbar to open Bar Graph dialog box. Select

properties, click OK button, a new Bar Graph object is created.

General Tab

| Bar Graph

X |

@ Background General Qutine Range Security Shape
[ Bar Graph
B Dynamic Scale Comment :
Cancel
Read
Device: Local HMI ~ & fon}
Address: LW 0 16-bit Unsigned Help
Setting Description

Read address

Click [Setting] to Select the [Device], [Device type], [Address],

[System tag], and [Index register] of the word devices that controls

how the bar graph displays.
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Outline Tab
Bar Graph x
B Background General Outline Range Security Shape
Bar Graph oK
a ic Scal
Dynamic Scale Style:  Default v Cancel
Type
O Bar () Circular
Help
Attribute
Mode . Mormal “ Direction:  Up v
Bar width ratio (%) : 100 =
Background
Frame calor Transparent | Background color: .
Bar
Interior color: | AR EEEEEEEI . Pattern color: [N .
Style | I ~
Dynamic color
(J Enable
)
Setting Description
Type Choose either [Bar] or [Circular].
Attribute Mode

Choose either [Normal] or [Offset]. If [Offset] is selected, an

original value [Origin] must be entered for reference.

Direction / Degree

Bar: Determine the bar graph direction. Available options are [Up],
[Down], [Right], and [Left].

Circular: Determine the circular bar graph direction. Available

options are [Clockwise] and [Counter clockwise].

Degree
Direction
(@ Clockwise
Degree
Full circle
Start:

() Counterdockwise

==l

[

oK ] [ Cancel

)

If [Full circle] is selected, set the start degree.

If [Full circle] is not selected, set the start and end degree.

Bar width ratio (%)
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The ratio of bar to object width. The figure below shows two ratios,
100% and 50%.
100% 50%
Hole Radius (%)
The ratio of the radius of the hole to the radius of the whole
circular bar graph. The figure below shows two ratios, 0% and 50%.
0% 50%
Color/Style Set the bar’s frame and background color, bar style, and bar color.
See the picture below.
Frame
Frame
Background
Background Bar style
Bar
Bar style
Dynamic (For cMT / cMT X Series models only) With this option selected, the
color interior color of the bar is determined by the value in the

designated address.

Bar
Tnterior : | LW-0 Pattern : :]
S —
Dvmamic colox
Enable
Device © | Local HMI B e
Address: (LW -|0 I [T6-bit Tnsigned
Index  Color -
0 1l 000000
1 [ Eiisiis
2 ] fnfin |
3 O el 3
4 Bk
5 [ s080£f
] [ {10000 i
7 ] $tt00 L He
< | i I 3 Delete
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Range Tab
Bar Graph x
B Background General Outline Range Security Shape
Bal Graph P
@ Dynamic Scale rodte
Minvalue: 0 Maxvalue: 100 Eancd
Target indicator Help
B Enable
Color: |
Targetwvalue: Ly/-2 Tolerance: 0
Alarm indicators
Low limit - LWW-0 High limit: LW/-
Low calor: L High color: |G
Dynamic target/alarm/min(ma:x)
@ Enable () Dynamic min/max
[[J Use different address for ranges
Device: Local HMI ~ [ [
Address: LW > 0 16-bit Unsigned
)
Setting Description
Min value / The percentage of filling can be calculated by the formula, see
Max value Example 1.
Target When the register value meets the condition, the color of filled
indicator area will change to the target color, see Example 2.
Alarm If the register value is larger than [High limit], the color of filled
indicators area will change to [High color]. If the register value is smaller than
[Low limit], the color will change to [Low color].
Please note that when [Dynamic color] is enabled, the Target
indicator and Alarm indicator settings will not be present and their
colors are determined by the designated addresses.
Dynamic When enabled, the [Low limit] and [High limit] of [Alarm indicators]

taget/alarm
/min(max)

and the [Target Value] of [Target indicator] will use designated
registers, which is shown in their respective fields, see Example 3.
When [Dynamic min/max] is enabled, the [Min value] and [Max
value] of [Attribute] will use designated registers, which is shown in
their respective fields.

When [Use different address for ranges] is enabled, the addresses

mentioned above can be configured independently and read from
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different registers. This option is only supported on cMT / cMT X.

Example 1
The percentage of filling in a Bar Graph can be calculated using the following formulas:
Percentage of filling (Normal) = Register value — [Min. Value] X 100%
[Max. Value] — [Min. Value]
Percentage of filling (Offset) = Register value — [Origin] X 100%
[Max. Value] — [Min. Value]

Assume [Offset] is selected. If (Register value — [Origin]) is greater than 0, the bar will fill

upwards from the [Origin]. If (Register value — [Origin]) is less than 0, the bar will fill
downwards from the [Origin].

The following diagrams demonstrate the filling behavior of the Bar Graph when the origin is set
to 5, the max. value is 10, and the min. value is 0, using different data sets.

If the value at read address is 4: If the value at read address is 8:
— 10 —1w0
Max. Value =10 _8 Max. Value = 10 e
T —_— —5
Origin=5 ------ 5 origin=5§ ----- _—
—_—1 —y
Min.Value=o —1__ , Min.Value=0 — —

Example 2

When the register value meets the following condition, the color of filled area will change to
the target color.

[Target Value] - [Tolerance] < Register value < [Target Value] + [Tolerance]

Assume [Target Value] is 5 and [Tolerance] is 1. As shown below, if the register value is equal to
or larger than 4 (=5-1) and equal to or less than 6 (=5+1), the filled area’s color of the bar will

change to the target color.

Target value = 5
Tolerance = 1
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Example 3
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The high and low limits for alarm indicators can be set by designated registers. When the write

address is LW-n, the limits and related setting addresses will be automatically determined

based on the following rules (assuming [Dynamic min/max] is enabled).

Data Format 16-bit 32-bit 64-bit (cMT / cMT X only)
Low Limit LW-n LW-n LW-n
High Limit LW-n+1 LW-n+2 LW-n+4
Target Value LW-n+2 LW-n+4 LW-n+8
Min Value LW-n+3 LW-n+6 LW-n+12
Max Value LW-n+4 LW-n+8 LW-n+16
Origin LW-n+5 LW- LW-n+20
n+10

13.15.3. Combo Setting

cMT / cMT X Series HMI support combo setting for Bar Graph, which allows setting of multiple

related objects at a time. Bar Graph can be set with Background and Dynamic Scale.
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Background
Bar Graph x
[-]Background (NG
@ Bar Graph
ic Scal
@ Dynamic Scale Margin: 12 : e
Color/Style
© Custom () Picture
Help
Round: 10 =
Frame: Transparent . Background : L
Pattern : . Patternstyle: [ | =
Setting Description
Margin Specify the space between the background edge and
the objects.
Color/Style Customize
ColoxfStyle
© Customize °) Picture
Round : 10 ~e":

Foms: [ Tongn 5] Bokgoun:
oen: [ Pk

Select a suitable background pattern and color.

Picture
ColorStyle
() Customize @) Pictoe
Pictore Library...

Use the default picture or choose a picture from
Picture Library.
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Dynamic Scale

Bar Graph x

B Background General
B Bar Graph
o namc scae |
Style: Circular Cancel
Angle: (7 Full, 0°

Help

Tick Mark  Scale Label

Color: | N Radius : |
Main scale
Ticks: 3 - Length : I
Sub scale
Ticks: |4 ~ Length: I
Setting Description
Style The scale style will follow the bar type.
Tick Mark Configure the number of tick marks for main and

sub scales. If the style is circular, the radius and tick

mark length can be specified.

Scale Label Configure the font, font color, font size and other

attributes of scale label.
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13.16. Meter Display

13.16.1. Overview
Meter Display object displays the value of word register with a meter.

13.16.2. Configuration

A
Click [Object] » [Chart] » [Meter Display] icon on the toolbar to open the Meter Display dialog

box. Set the object’s attributes and then click OK to create a new Meter Display object.

13.16.2.1. eMT, iE, XE, mTV Series

General Tab
Mew Meter Display Object [==3a]
General | Qutline | Limits | Security | Shape |
Comment :
Read address
PLC name : | Local HML ~| [ Setting...
Address :[LW ~|0 16-bit Unsigned
Setting Description
Read address Click [Setting] to select the [Device], [Device type], [Address],

[System tag], and [Index register] of the word devices that controls

the Meter Display object.
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Outline Tab
Meter Display Object's Properties
[ General | Outline | Limits | Secusity | Shope | Profile |
Degree
Ange: [() 07~350°
Background
Begond () Potie: [
(V] Full circle [ Transparent
Tick marks
[] Enable
Color : [ N . [¥] Coordinate
Main scale : 4 s Sub. scale: 2 £
Length: 10 E
Pointer
[dmab. ] P [
o [
Width : B Length: 50 =
Pin point
@ Circle () Rectangle
Radivs: 7 &
e () P [
L OK J { Cancel ] [ Help J
Range mark Tick mark
Corrdinate
Setting Description
Degree Set the pointer to go around the meter clockwise or

counterclockwise.
Sets the object’s start degree and end degree measured clockwise
from the 12 o’clock position. The angle range is 0 to 360 degrees.

The following shows meters of different settings.
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® [Start degree] =290° ® [Start degree] = 120°
[End degree] = 70° [End degree] = 240°
® [Start degree] = 40° ® [Start degree] = 225°
[End degree] = 140° [End degree] = 315"

Background

Sets the object’s background color and profile color.

Full circle

When selected, the object will display the whole circle. Otherwise, the
object will only display a partial circle in the defined degree range, as

shown in the following figure.

Full eirele non-full eirele

Transparent
When selected, the object will not display the background and profile

color.

Tick marks

Configures the number of tick mark and color.

Pointer

Configures pointer’s style, length, width, and color.

Pin point

Configures the style, radius, and color of the pin point.
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Limits Tab

New Meter Display Object @

[ Genexal | Outline | Limits | Secusity | Shape |
Value

Min.: 0 2 Max.: 100 Y

Range limits
[V] Enable

tov - (I
N S—
o [
Width: 3 z
[7] Use vser-defined radivs
[ Dymamic limits
Low limit: 30 A High limit: 60

Scale label
[V] Use scale label

Font: Arial v

Right of decimal point: 0

[ OK ][ Cancel ][ Help

Setting Description

Value Sets the object’s display range. Meter Display object will use the
value of [Zero] and [Span] and the value of register to calculate the

pointer’s position. See Example 1.

Range limits Configures the values of [Low limit], [High limit], their

corresponding display colors, and the width.

7\

Use user-defined radius
Configures the radius to display range limits.
For example, set to 80: Set to 30:
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0.0 0.0
75,00 ! 25.00 75.00 ! 25.00

Dynamic Limits

The low limit and high limit are set by registers. See Example 2.

Scale label Select the attribute of scale label on Meter Display.
M0_0
Seale label
[¥]se scale label
Font: Aral -
No. of decimal : 0

Example 1: Pointer position calculation

Set object’s display range. Meter Display object will use the value of [Zero] and [Span] and the
value of register to calculate the pointer’s position. For example, supposed that [Zero] is O,
[Span] is 100, when the value of register is 30, [Start degree] is 0, and [End degree] is 360, then
the degree indicated by the pointer is:

{ (30 —[Zero]) / ([Span] — [Zero]) } * ([End degree] - [Start degree]) =

{(30-0) /(100 - 0)} * (360 —0) = 108

Pointer will be pointing at 108 degrees.

Example 2: Dynamic Limits
The low limit and high limit are set by the register.

Suppose the address is LW-n, the following table shows the read address of low limit and high

limit:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Low limit LW-n LW-n LW-n
High limit LW-n+1 LW-n+2 LW-n+4

For instance, when address is LW-100, the rule of setting limits is:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Low limit LW-100 LW-100 LW-100
High limit LW-101 LW-102 LW-104
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13.16.2.2.

General Tab

[\& WE!NTEK

cMT / cMT X Series

General Secu:titylShape
P — = Style : |Custom
P 1 &
/A 1 G\ Ange: [ (D240
1y
V& 3\
( (W | | [ Ensble animation
| / |
\ / Value
.\. s @) ‘/‘
/ Min.: 0
N — 4 Max.: 80
Read address =
Device : [LocalHMI v] ${a &
Address: |LW ~|0 [ [16-bit Unsigned
Indicator | Rangelimit | Scale
Pointer Pin point
St || s [ne
Image : Picture lib
e —
e 2 = Radivs: |3
Fixed aspect ratio :
Width: (3% v W
Length: |72% v -
< J »
(o J[ cancel |[ teb |
— Scale
K 1
/ 40 £\
/ =, Tick Marks
~ \
/(3¢ )
Low Limit k,’ = o
\ / High Limit
\'P» N
\ /
\,~ /
\ /4
\ /
0 =
Indicator
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Setting Description

Style Select a style from the drop-down list. Available options include:
[Custom], [Style 1], [Style 2], and [Classical]. If [Custom] is selected,
properties such as the width / length of the pointer or the radius of
the pin point, etc must also be manually set.

The following background-related settings are available using [Style
1], [Style 2], or [Classical]:

Color

Sets the color of the background picture of meter.

Outline

The following is the outline of Style 1 when [Full circle], [Half
circle], or [Quarter circle] is selected.

The following is the outline of Style 2 when [Full circle], [Half
circle], or [Quarter circle] is selected.

Rotation
Rotates the background picture clockwise according to the angles
set.

Angle Direction
Sets the range to label the scale, using twelve o’clock direction as
the 0° reference.
Degree
Available options include: [Predefined] and [Custom]. With
[Predefine] selected, pick from the thumbnails configure directions
and angle ranges with ease.
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Counterdockwise

Start: 225 End: 135

—

Degree [=]

Degree
© Predefine Custom

A

Direction : i E |

@Wh\ﬁ@gg

20 @ D2( w D
. dBCvIACY
92000000

Full circle

If selected, the full circle is drawn according to the selected
direction and the start angle. The limits are determined by the
value set in [Minimum] and [Maximum] field under [Value].

Enable

animation

If selected, the pointer slides to the designated position when the
read value changes; if not selected, the pointer directly points to
the designated position when the read value changes.

Value

Sets the lower and upper limits of the meter.

Read address

Displays the value in meter according to the value in the designated
word register.

Indicator

Sets the style of pointer and pin point. If [Custom] is selected, the
direction of the pointer must points upward to correctly display.

Range limit

Sets the values for low and high limits and the colors for alert
indications.

Dynamic limits

The low and high limits are determined by specified registers. See
Example 2 in the previous section.

If the option to use different addresses is selected, the limits can be
configured to read from different registers.

Scale

Sets the number of main and sub scale, the color of tick marks and
scale label.

=

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.17. Trend Display

13.17.1. Overview
Trend display objects draw curves of the data recorded by Data Sampling object.

13.17.2. Configuration

A

=

Click [Data/History] » [Trend Display] icon on the toolbar to open a Trend Display object
property dialog box. Set up the properties, press OK button, and a new Trend Display object

will be created.
13.17.2.1. eMT, iE, XE, mTV Series

General Tab

17:32:41 12/03/06

Description

Go to the earliest sampling data.

Go to the previous time interval.

i Click to stop auto-scrolling. When the new sampling data is
generated, the display does not scroll, nor is the new data outside

the display range displayed.

Click to start auto-scrolling. The display scrolls as the new sampling

data is generated.

Go to the next time interval.

ol

Go to the latest sampling data.
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Objects
New Trend Display Object @
| General | Trend | Channel | ¥ Scale | Secusity | Shape |
Comment :
Data Sampling Object index : 1 1. = j
Trend type : [History v
*If no. of channels is changed, you must reset HMI's data samplings.
[¥] Refresh data antomatically
[] Mo line connection between records if the next record is esulier (slower refresh speed)
H aodis time range © () Pixel © Time
Default distance : 100 second (5)
[V] Dynamic ¥ axis time range
Device : [Local HMI | [ Settines..
Address |LW v|0 16-bit Unsigned
History control
Device : (Local HMI [ Settings...
Address: [Lw | 100
Watch line
V| Enable
Device : [Local HMI v [ Seftines...
Addess: Ly 4|50
Time stamp output
[V]Enable
Device : [Local HMI - ] Settings...
Addess:Lw |0
oK Cancel Help
Setting Description
Data
Sampling Select a Data Sampling object as the source data.
Object index

Refresh data
automatically

In history mode, when this option is selected, Trend Display will be
automatically refreshed every 10 seconds. If this option is not

selected, Trend Display can only be refreshed by changing window.

No line
connection
between
records if the
next record is
earlier

When HMI time is adjusted to an earlier time, and data sampling
keeps going on, selecting this option can prevent the system from
drawing a line to connect the gap between current trend curve
(earlier in time axis) and former trend curve (later in time axis). This

can slow down refresh speed.

Trend type

Select the mode of data source, either [Real-time] or [History].
Real-time

In this mode, the display object shows all sampled data since the
HMI started. The maximum number of records that can be sampled
is set in [Max.data records] (Real-time mode) of the Data Sampling
object. When the sampling data exceed this setting, the earlier
data will be deleted. To show older data, use [History] mode.

[Hold control]: Suspends the update of Trend Display. However, it
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does not stop the sampling process of Data Sampling object.
History

In this mode, the data comes from the history data files stored on
HMI. The history data files are sorted by dates, and each is given an
index. The system uses [History control] to select the history data
files that are created on different dates.

The system sorts the history data of sampling data by date; the
latest file is record O (typically the data sampled today), the second
latest file is record 1, and so on. If the value of designated register
in [History control] is n, the Trend Display object will display data
record n.

Here is an example to explain [History control]. If the designated
register is LW-0, and the sampling data files available are
pressure_20061120.dtl, pressure_20061123.dtl,
pressure_20061127.dtl, and pressure_20061203.dtl, and it is
2006/12/3 today, based on the value of LW-0, the sampling data

file which will be selected by [Trend Display] is shown as follows:

Value of LW-0 Selected sampling history data
0 pressure_20061203.dtl
1 pressure_20061127.dtl
2 pressure_20061123.dtl
3 pressure_20061120.dtl

If use with Option List object and select data source as [Dates of

historical data], the history data will be sorted by date and
displayed in Option List object, see “13.29 Option List”.

Pixel

[Distance] is used to set the distance between two sampling points,

as shown in the following figure.

12/03/06

- F—ZO pixels
| /
\ /( N /

\\/ point 0 point 1

b | | wn | e | e |

Time

[Distance] is used to set the X-axis in unit of time, as shown in the

following figure.
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L 20 seconds
K

12103/06 /\

/\ 1\ AL A
W AR VAV =

VA ST ]V \
Vv T\ V

| - | |

Select [Time] for [X axis time range] and go to [Trend] » [Grid] and

enable [Time scale]. Please refer to [Time scale] in the later section.

g_vrt\amic Designate a 32-bit word register for adjusting the distance between
istance

between data two sampling points (select Pixel), or the time unit represented by

sample_s/ X-axis (select Time). If no value is entered, the default value will be
Dynamic X

axis time used.

range i- Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Refresh data

- If selected, every time when opening the window on which the
automatically

Trend Display object in history mode is placed, the display is

automatically refreshed every 10 seconds. Please note that:

® The refresh status can be observed from the control button of
Trend Display object.
Showing At button: The automatic refresh feature is
enabled.
Showing ®1 button: The automatic refresh feature is
disabled.

® \When scrolling to the previous data, the automatic refresh
feature is disabled, the 1 button is shown.

® If [Refresh data automatically] check box is selected, when
change back to the window, the display is refreshed, ignoring
the control buttons. For example, select [Refresh data
automatically], and scroll to the previous data, the automatic
refresh feature is disabled. In this case, changing to another
window and then change back will still refresh the display.

® If [Refresh data automatically] check box is not selected when
building the project, the feature can still be enabled by
pressing =1 button on HMI. In this case, the automatic
refresh feature is disabled, that is, even when change back to

the current window, the display will not be refreshed.
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Hold control

When the register is set ON, suspend the update of Trend Display. It
does not stop the sampling process of Data Sampling object. This

setting is available only in Real-time mode.

Watch line

Use the [Watch line] function to display a “watch line” when user
touches the Trend Display object. It will also export the sampling
data at the position of watch line to the designated word device
and use Numeric objects to display the results, as shown in the

following figure.
Wateh line
/

12/03/06

AN .
[ 1\ AW

|/ \y\/\/\/
N/

| | o | | |

| 4 | LWw300

[Watch line] can also export sampling data with multiple channels.

The system will consecutively write each channel to the specified
address and the following addresses, in the same order as in [Data
Sampling] object. The address assigned to [Watch line] is the start
address, and sampling data for each channel will be exported to
the word devices starting from “start address.” If the data format of
each channel is different, the corresponding address of each
channel is arranged from the first to the last. If the watch register is
LW-300, watch function will export each channel’s data to the

following addresses:

Register | Channel Data format
LW-300 0 16-bit Unsigned (1 word)
LW-301 1 32-bit Unsigned (2 words)
LW-303 2 32-bit float (2 words)
LW-305 3 16-bit Signed (1 word)

4

= Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Time stamp
output

Time stamp output
Suppose the address is set to LW-n, then:
If enabled, the system will use the time of the first sampling data as

“time origin”, and write the time stamp of the most recent sampled
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data (relative to “time origin”) to [LW-n+2].

When clicking on the curve, the time stamp of the closest sampled
point will be written to [LW-n].

Clear real-time data address (Data Sampling object) will clear the
time origin as well.

Time stamp is recorded in seconds.

Trend Tab
New Trend Display Object @
[Genexal | Trend | Channel | ¥ Scale | Secusity | Shape |
[ Transparent
Frune : N |~|  Backeround
[¥] Show scroll controls
Grid
7] Enable Color : |G |~ |
X axdis
@ Interval () Division
Interval : 4 2 second(s)
¥ axis
Division(s) : 4 2
Time scale
[¥] Enable
I C—
Time/Date
[¥] Relative time mode
e © HHMM:S8 () HHMM () SSSSS
[V] Time
() BRS8N (Leading zero)
[V] Date © MM/DDNY ) DDIMMAYY (O DDMMYY ) YYMMDD
Color : | |~
[ OK ] [ Cancel Help
Setting Description
Transparent /
Frame / Select the color of frame and background.
Background
Show scroll Enable or disable the scroll control as shown in the following figure.
controls
M | - e | M|
Grid Set the number of dividing lines and the line color. The number of

divisions depends on the setting in General tab » [Distance
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between data samples] / [X axis time range].

X-axis interval

The number of vertical grid lines.

® Select [Distance between data samples] in General tab:
Select how many sampling points will be included between two
vertical grid lines.

® Select [X axis time range] in General tab:

Select the time range between two vertical grid lines.

X-axis division

The number of vertical grid lines.

Y-axis division

The number of horizontal grid lines.

Time scale

Select [Time] / [Date] check box to display the time scale along the

X axis.
v

“MMDDAYY

M
/ \V4

HH: MM HH:MM HH:MM HH:MM HH:MM HH:MM HH:MM HH:M!

Font / Color / Size
Select the font, font color, and font size of the time scale.
The default font size is 8.

Time / Date

Relative time mode

When this mode is selected, the time of the earliest sampling data
will be the start time from which to count a relative time. This
mode works with time scale [SSSSSS] and under this mode, time

scale [Date] cannot be used.
¥ acds
Divizion(s) : 4
Time scale
[¥] Time Sas8s e
Diate

Color: [ I .|

TimeDrate
Eelative time mode

Time HH:MM SR -
Drate TYMMDD -
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The time of the latest sampling data will be marked on the top left
corner of the object. This group box is used to set the time / date
display format and font color.

Channel Tab
Mew Trend Display Object @
| General | Trend | Channel | shape |

Data sampling object
Channel Display Description Data. type ¥ wale
p O 16-bit Unsgned 16-bit UTnsigned Hone
Channel
Pen property
Color : GG ~ Widiﬁ:
 —
[ Dynamic limits
Zero: 1 Span: 100
Channel visibility contral
[¥]Enable
PLC name : [Logal HMI =] [ Setting...
Display channel when the corresponding bit is :
o @ OFF
Setting Description
Y scale Set Y-axis to be Main Axis or Aux. Axis. See “Y Scale Tab” for more
information.
Channe] Duphy Desxopbon (BN T wale
| Tiroe chosurel & - bt W s Am Az
3 Tree chaz] B Dbk U pus gt Basn Ko
3 Teem chazel C Li-tet Unngred Aee gz
Channel Configure each sampling line’s format and color.

Dynamic limits

® Not selected:

[Zero] and [Span] are used to set the low limit and high limit of
sampling data. If the low limit is 50 and the high limit is 100 for one
sampling line, [Zero] and [Span] must be set as [50] and [100], so
that all the sampling data can be displayed in the trend display
object.

® Selected
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The low limit and the high limit are read from the designated word
devices, as shown below. When address is LW-n, the register’s
address:

Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-n LW-n LW-n
High Limit LW-n+1 LW-n+2 LW-n+4
For example, if LW-100 is used here, the low limit and the high limit
will be read from:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-100 LW-100 LW-100
High Limit LW-101 LW-102 LW-104
A typical usage of this is to zoom in and zoom out of Trend Display.
(Not available for cMT / cMT X Series). See Example 1.
i- Click the icon to download the demo project. Please confirm
your internet connection before downloading the demo project.
Channel If [Enable] is selected, the bits of the assigned word register will be
visibility used to show/hide each channel. The first bit controls the first
control channel, and the second bit controls the second channel, and so

on. For example, suppose there are 5 channels and LW-0 is used,

channels which will be shown given the states of the control bits

are:
Channel Control Bit State Displayed
1 LW_bit-000 OFF YES
2 LW _bit-001 ON NO
3 LW _bit-002 ON NO
4 LW _bit-003 OFF YES
5 LW _bit-004 OFF YES

Note on using this feature: Each control bits are not reserved for
the channel. If a particular channel is not displayed, the control bit
is assigned to the next displayed channel. For example, if the third
channel of the 5 channels is not displayed, only 4 channels will be
displayed in Trend Display, and the used control bits will only be:
LW_bit-000~003.

A

Click the icon to download the demo project. Please confirm
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your internet connection before downloading the demo project.

@ Note

B A Trend Display can display up to 64 channels simultaneously.

B ATrend Display can only display channels with serial number < 256; therefore, channels

with serial number greater than 256 cannot be selected.

Y Scale Tab
rTrend Display Object's Properties @‘
| General | Trend | Channel | ¥ Scale | Security | Shape | Profile |
Data sampling object
Channel Display Description Data type Y scale
1 Troe channel & 16-bit Unsigned Aux. Axis
2 Troe channel B 16-bit Unsigned Main Axis
3 Troe channel C 16-bit Unsigned Aux. Axis
Scale font
Font:
Color: GG v Size:
Dymamic ¥-scale visiblity
PLC name : [Local HMI ~|[_settings...
address . x]® '
Display channel’s ¥-scale when the corresponding bit is :
() ON @ OFF
Dynamic main axis
[7] Enable
PLC name:[Lod HMI v] Settings...
Address : 80 | 316—bit Unsigned
[
Setting Description
Y scale Show whether Y-axis is Main Axis or Aux. Axis.
Y-axis will not be displayed when [none] is selected for Y scale in
Data Sampling Object group box. At most 32 Y axes can be
displayed, including one main axis and multiple aux. axes.
Scale font Select the font, font color, and font size of the scale.
Dynamic Y- To show or hide Y-scale. If the control address is LW-50, then the

scale visibility

first axis is controlled by LW _Bit 5000, and the second axis is

controlled by LW_Bit 5001, and so on.

Dynamic
main axis

To change the main axis. If writing 1 into LW-80, the main axis will
be Channel 1; if writing 2 into LW-80, the main axis will be Channel,

and so on.
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@ Note

B A Trend Display on an eMT/iE/XE/mTV model can display 6MB of data in maximum.
E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
13.17.2.2. cMT, cMT X Series

General Tab

The Trend Display on cMT / cMT X Series combines Real-time mode and History mode. Drag
left to scroll the Trend Display to view history data and drag right to view the latest sampling

data. Pinch two fingers together to zoom out Trend Display or spread them apart to zoom in.

Zoom In Zoom Out

C?For more information about how sampling data is saved, see “8 Data Sampling”.
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Objects
New Trend Display Object \
General | Display | Trend | Channel | ¥ Scale | Data Format | Secusity | Shape |
Comment :
Data Sampling Object index : [1, v}
*If no. of channels is changed, you must reset HMI's data samplings.
Distance between data samples : [Mil]imeher v]
Default distance : 100 mm
[V] Dymamic distance between data samples
Device : (Local HMI D e«
Address: [LW |0 [16-bit Unsigned
Watch line
[¥] Enable
Device : [Local HMI
Address: LW v |0
Time stamp output
[¥] Enable [¥] Enable day output
Device : [Local HMI e
Address: |LW v|0 [22-bit Tnsigned
History control
[¥] Enable
Device : [Local HMI | e mn| e
Address: [LW = [[6-bit Unsigned
[ Enable reading multiple histories
[ OK ] [ Cancel 1 [ Help
Setting Description
Data
Sampling Select a [Data Sampling] object as the source data.
Object index
Millimeter Same as eMT, iE, XE mTV Series. The upper limit is 500 mm.
Time Same as eMT, iE, XE mTV Series.
Pixel Same as eMT, iE, XE mTV Series. The upper limit is 1920 pixels.
Dynamic Same as eMT, iE, XE mTV Series.
distance
between data
samples
Watch line Same as eMT, iE, XE mTV Series.
Time stamp When enabled, the number of seconds passed from the first
output

sampling data can be calculated.

Suppose the address is set to LW-n, then:

[LW-n]: The number of seconds passed from the first sampling data
to the closest sampled point.

[LW-n+2]: The number of seconds passed from the first sampling
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data to the most recent sampling data.

Enable day output

With this option selected, the number of days passed since
1970/1/1 can be calculated.

Suppose the address is set to LW-n, then:

[LW-n+4]: The number of days passed since 1970/1/1 to the closest
sampled point.

[LW-n+6]: The number of days passed since 1970/1/1 to the most

recent sampling data.

History
Control

Same as eMT, iE, XE mTV Series.

Enable reading multiple histories:

In the following two modes, days are calculated backward.

Number of days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The total number of days before the start day.

Specific days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The end day index, the specified value must be greater
than that of the start day index. For example, if start is 4 and end is

7, the specified days will be 4 days before to 7 days before.
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Display Tab

New Trend Display @

General | Display | Trend | Channel | Y Scale | Data Format | Security | Shape |

Option button
Q) Predefined () Dynamic
[¥] Enable

V| Show option "Channel visibility"

[¥] Show option "Y Scale"

[¥] Show option "Enable Y -axis scrolling”

Zoom button visibility

[¥] Enable

Display option

[¥] Connect data gaps

Touch

[¥] Enable Y -axis scrolling with swiping up/down

[¥] Enable X-axis zoom

[¥] Enable Y -axis zoom

13-121

Setting

Description

Option
button
visibility (cMT
Series)

Show or hide the option button of the object.

Predefined

Select [Enable] to show the option button.

Dynamic

Choose a bit address to control option button visibility.

COption button visbility

() Predefined @ Dymarnic

Device © (Logel M &)
Address : [La—v] 0

Show option “Channel visibility”
With this option selected, the [Channel Visibility] setting will be
displayed.
Show option “Y Scale”
With this option selected, the [Y Scale] setting will be displayed.
Show option “Enable Y-axis scrolling”
With this option selected, the [Enable Y-axis scrolling] setting will
be displayed.

TREND DISPLAY SETTING

Channel Visibility

Y Scale Off

Enable Y-axis scrolling (@)
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Zoom button
visibility

Show or hide the zoom button of the object.

Display
option

Show custom file name

This option appears when [Customized file handling] is selected in
Data Sampling. With this option selected, the customized file name
is shown as caption in Trend Display.

Connect data gaps

Data sampling stops when PLC is disconnected, and after PLC is
reconnected, the trend curve of the disconnected period is plotted
with a gap. With this option selected, the system will draw a line to
connect the gap between the former trend curve (before
disconnected period) and the current trend curve (after

disconnected period).

Touch

Disable Y-axis scrolling with swiping up/down

With this option selected, dragging the object with your finger will
only scroll X-axis range while Y-axis remains being placed in the
middle of the object even if it is zoomed in/out.

Disable X axis zoom

With this option selected, dragging the object with your finger will
only scroll Y-axis range.

Disable Y axis zoom

With this option selected, dragging the object with your finger will

only scroll X-axis range.

I__| WE!NTEK

EasyBuilder Pro V6.10.01



Objects

Trend Tab

Trend Display Object's Properties (=

[ General | Display | Trend | Channel | ¥ Scale | Data Format | Security | Shape | Profile |

[ Transparent

Frae cor |
L I—

Font : [pm',,] v]

Grid
[#]Enable

Cobor: [ )

Interval : 4 4 second(s) Y-axis: 4

Time scale
V] Time
[V] Date MMDDAYYY v

Time/Date
[ Relative time mode

& division(s)

[7] Time

[V] Date MMDDNYYY v
Coler [

[ OK ][ Cancel H Help

13-123

Setting

Description

Transparent /

Frame / Select the color of frame and background.
Background
Grid Set the number of dividing lines and the line color. The number of

divisions depends on the setting in General tab » [Distance
between data samples] / [X axis time range].

X-axis interval

The number of vertical grid lines.

® Select [Distance between data samples] in General tab:
Select how many sampling points will be included between two
vertical grid lines.

® Select [X axis time range] in General tab:

Select the time range between two vertical grid lines.

X-axis division
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Objects
The number of vertical grid lines.
Y-axis division
The number of horizontal grid lines.
Time scale Select [Time] / [Date] check box to display the time scale along the
x axis. The position of the time scale can be selected.
The default font size is 8.
Time / Date Relative time mode
When this mode is selected, the time of the earliest sampling data
will be the start time from which to count a relative time. This
mode works with time scale [SSSSSS] and under this mode, time
scale [Date] cannot be used.
The time of latest sampling data will be marked on the top left
corner of the object. This group box is used to set the time / date
display format and font color.
Channel Tab
Mew Trend Display Object |E|
| General | Trend | Channel | shape |
Data sampling object
Channel Display Description Data. type ¥ wale
p O 16-bit Unsgned 16-bit Unsigned  None
Channel
Pen property
Color : | ~ Width :
C—
[ Dynamic limits
Zero: 1 Span: 100
Channel visibility contral
[¥]Enable
PLC name : [Logal HMI ~| [ Ssetting...
Display channel when the corresponding bit is :
o @ OFF
Setting Description
Y scale Set Y-axis to be Main Axis or Aux. Axis. See “Y Scale Tab” for more

information. At most 32 Y axes can be displayed, including one
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main axis and multiple aux. axes.
Chonne] Duplsy Desogbon D e T sl
1 T chamred A& Dé-bat Uningred Awe oz
o Tree chanel B Dbk 1 pusi s B, e
3 Tewe ehazemd C bt Urngred e Aaas
Channel Configure each sampling line’s format and color.
Dynamic limits
® Not selected:
[Zero] and [Span] are used to set the low limit and high limit of
sampling data. If the low limit is 50 and the high limit is 100 for one
sampling line, [Zero] and [Span] must be set as [50] and [100], so
that all the sampling data can be displayed in the trend display
object.
® Selected
The low limit and the high limit are read from the designated word
devices, as shown below. When address is LW-n, the register’s
address:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-n LW-n LW-n
High Limit LW-n+1 LW-n+2 LW-n+4
For example, if LW-100 is used here, the low limit and the high limit
will be read from:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-100 LW-100 LW-100
High Limit LW-101 LW-102 LW-104
Channel If [Enable] is selected, the bits of the assigned word register will be
visibility used to show/hide each channel. The first bit controls the first
control channel, and the second bit controls the second channel, and so

on. For example, suppose there are 5 channels and LW-0 is used,

channels which will be shown given the states of the control bits

are:
Channel Control Bit State Displayed

1 LW_bit-000 OFF YES

2 LW_bit-001 ON NO

3 LW_bit-002 ON NO

4 LW_bit-003 OFF YES
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5 LW_bit-004 OFF YES
Note on using this feature: Each control bits are not reserved for

the channel. If a particular channel is not displayed, the control bit
is assigned to the next displayed channel. For example, if the third
channel of the 5 channels is not displayed, only 4 channels will be
displayed in Trend Display, and the used control bits will only be:
LW_bit-000~003.

0 Note

B A Trend Display can display up to 64 channels simultaneously.
B ATrend Display can only display channels with serial number < 256; therefore, channels

with serial number greater than 256 cannot be selected.
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Y Scale Tab
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Mew Trend Display Object

| General | Display | Trend | Channel | ¥ Scals | Dats Format | Secusity | Shape |

Y scale
None
None

Data sampling object
Channel Display  Description Diata type
1 True 16-bit BCD 16-bit BCD
2 16-bit BCD 16-bit BCD
-soale
Hide channel ¥ seale when channel dats. i fnvisible
Value alignment : [Center on tick

)

The scale along the Y axis of a specific channel can be displayed. To enable Y Scale, [Grid]
should first be enabled in [Trend] tab.

Setting

Description

Y Scale

Hide channel Y scale when channel data is invisible

This option is selected by default. With this option selected,

whether channel Y scale is shown or hidden is determined by the

settings in Channel Visibility Control.

Value alignment

Set the alignment of Y axis tick values.

Center on tick

Full text

| 09/07/2022 | ‘

50

100

09/07/2022

50

16-bit BCD
18-bit BCD ——

Y Scale can be configured on the in cMT Viewer as shown in the following steps.

1. Tapthe

button on the upper right corner of Trend Display object.

2. Tap [Trend Display Setting] » [Y Scale].
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Cancel Option Done
Begin Date -
Ended Date -

TREND DISPLAY SETTING

Channel Visibility

Y Scale On

v

Disable Y-axis scrolling

Reset to default

3. Set channel visibility.

Option Channel Visibility

Channel 1
Channel 2

Channel 3

Channel 4

peees

Channel 5

Data Format Tab

| General | Trend | Channel | ¥ Scale | Data Format | Security | Shape | Profile |

Chamnel : [Channel 1 ~Channel 8

Channel 1 [16-bit Unsigned ]

Follow settings in the Data Sampling Right of decimal Pt. : |2

Channel 2 [16-bit Unsigned ]

Follow settings in the Data Sampling Right of decimal Pt. : |2

[ o J[ concel |[ e |
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Setting Description

Follow

settings in the ] ] o ]
Use the [Right of decimal Pt.] setting in Data Sampling.

Data
Sampling
Right of The number in this field determines the number of decimal places
decimal Pt of the value displayed; for example, when 1 is entered in this field,
and the original value obtained by Data Sampling is 45, then 4.5
will be displayed in Trend Display as a result.
Example 1

The example explains how to zoom in or zoom out Trend Display. The feature described is not
available for cMT / ¢cMT X Series.

In Channel tab select [Dynamic limits] check box. If the [Address] is set to LW-n, then LW-n
controls the low limit where LW-n+1 controls the high limit.

Dynamic limits

PLC narme : [Luca| HMI - ] Setting...

Address [LW v] 0

Set [Address] to LW-0 and create two Numeric objects for entering the low / high limit. The
address that controls the low limit is LW-0; the address that controls the high limit is LW-1.
Let’s suppose the data is between 0 and 30; set the [Low limit] to 0 and the [High limit] to 30,

the trend curve is displayed as shown in the following figure.

17:01:50 08/12/13

Low limit

9|

High limit

To zoom out the Trend Display, enter a value greater than 30 in [High limit] as shown in the

following figure.
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17:01:50 0812113

Low limit

[o |

High limit

W e

To zoom in the Trend Display, enter a value less than 30 in [High limit] as shown in the following

figure.

17:01:50 081213

Low limit

]

High limit

H

&

Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.18. History Data Display

13.18.1. Overview

History Data Display object displays data stored by Data Sampling object. It differs from Trend
Display in that History Data Display object uses a table to display data. The following is an

Ch_zﬂ
0

example of a history data display object.

o
P
] ] ] ] ] o] ] e L] ] e

e e e ) i ) i ) e ] e | e ) i
w
Lu

—

MNo. | Time| Date |C
3277 |21:52 |16/09/07
3276 |21:52 |16/09/07
3575 |21:52 |16/09/07
3274 |121:52 | 16/09/07
3273 |21:52 | 16/09/07
3572 |21:52 |16/09/07
3571 |21:52 |16/09/07
3270 |21:52 | 16/09/07

3969 |21:92 [16/09/07

‘?tll:.ﬂﬂ 1-R2 M ARINQinT
4

o) ) e} e | ) ] o ] ] s s

A History Data Display on an eMT/iE/XE/mTV model can display 6MB of data in maximum. The

data will not be displayed after exceeding the limit.

13.18.2. Configuration

{ L‘._\
o

Click [Data/History] » [History Data Display] icon on the toolbar to open a History Data Display

object property dialog box. Set up the properties, press OK button, and a new History Data

Display object will be created.
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General Tab

cMT, cMT X eMT, iE, XE, mTV
" New History Data Display Object [ || NewHistory Data Display Object ==
General | Display | Display Format | Title | Edit | Secusity | Shape | General | Display | Display Format | Tifle | Edit [ Secusity | Shape |
Data Sampling Object index : [1‘ v] Data Sampling Object index : [L v]
Style : @ [V] Refresh data antomatically ‘
Grid Grid - \
[V] Enable [¥] Auto fit short column [ Enable
Color: i} Column interval : 5 s
Color : :} Colwnn interval : 5 -4
| Profile color
Profile color [7] Transparent
[ Transparent Frame : :] Backgrownd : [ ]
Frame color : [:] Background color : :] Text
— | Font : [Axial v] Size : m 1
Font: [Arial Bold [Arial] Droid Sans]  v|  Size:[12 | ‘ ‘
() Time ascending © Time descending !
© Time ascending © Time descending Histpry comizol ‘
Waich Device : |Local HMI - ][ <d ]
7] Enable Address: |[LW v |0 &
Device : [Local HMI '][ g ]
Address: |[LW ~|0 ~ [[6-bit Unsigned
History control
[¥] Enable Usage
Device : (Lacal HMI | e
Address: [LW v|0 ‘ [[B-bit Unsigned
[¥] Enable reading multiple histories
Mode : [Nu.mberof days vl
[ OK ] [ Cancel } [ Help J LOK ] [ Cancel ] [ Help ]
Setting Description
Data
Sampling Select a Data Sampling object as the source data.
object index
Refresh Data The system will refresh data every 10 seconds. When this option is
Automatically not selected, data can be freshed only by changing windows.
Style Select History Data Display object’s style.

Shows grids between rows and columns.
Color

Change the color of grids.

Column interval

Change the width of each column. The figures below are the

. examples.
Grid
Mo, [Time| Date [ChO]Ch1 Ch,Eﬂ Mo Time Date i‘
3667 |21:57|16/09/07| 1 0 0 3667 21.57 16/09/07
3666 |21:57|16/09/07] 1 0 0 3666 21.57 16/09/07
3665 |21:57|16/09/07| 1 0 0 3665 21:57 16/09/07
3664 |21:57|16/09/07| 1 0 0 3664 21:57 16/09/07
3663 |21.57 [16/09/07[ 1 0 0 3663 21:57 16/09/07
3662 2157 [16/09/07[ 1 0 0 3662 21:57 16/09/07
3661 [21:57 [16/09/07[ 1 0 0 3661 21:57 16/09/07
3660 [21:56|16/09/07[ O 0 0 3660 21:56 16/09/07
3659 [21:56|16/09/07[ 0O 0 0 3659 21:56 16/09/07
{‘RiRRsl 21-ER [TRMOMTT 0 n‘ n_”ﬂ ; 2RER 21ER TRINGINT ﬁ
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Objects
. Change the color of frame and background. Use [Transparent] to
Profile color
hide frames and background.
Text Change the font and font size.
Time ascending
. Put earliest data at the top and the latest data at the bottom.
Time / Date ) .
Time descending
Put the latest data at the top and the earliest data at the bottom.
Hist The history files are sorted by date and each file is given an index.
istory
Control The latest one is assigned index O (in most cases: today), the
(eMT, iEr,XEr second latest file is assigned index 1, and so on. [History Control] is
mTV Series)

used to specify the history data to be shown.

Watch (cMT /

By tapping on a record in History Data Display object, data in the

cMT X Series) selected row can be output to the designated addresses.
History Same as eMT, iE, XE mTV Series.

Control (cMT Enable reading multiple histories:

é:m;)x In the following two modes, days are calculated backward.

Number of days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The total number of days before the start day.

Specific days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The end day index, the specified value must be greater
than that of the start day index. e.g. start: 4, end: 7, the specified
days will be 4 days before to 7 days before.

@ Note

B When using cMT / cMT X Series, use the gear icon in the upper-right corner of History

Data Display object in cMT Viewer to select the date and display the data.
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Begin Date

2020-02-10

Ended Date &

2020-02-10

El Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

RWE!NTEK EasyBuilder Pro V6.10.01


https://www.youtube.com/watch?v=8gBxEqiomm4

Objects 13-135
Display Tab
cMT, cMT X eMT, iE, XE, mTV
New History Data Display Object New History Data Display Object
| General | Display | Display Format | Tile | Edit | Security | Shape | | General | Display | Display Format | Tile | Edit | Security | Shape |
Time \ Time \
] Time Color : _; ] Time HEMM ~ Color : _;
Date ‘ Date ‘
[V Date DDMMYYYY v Color: | [ [¥] Date DD/MMYY v Color: | [N
[7] Move column [Date] to the front of colwmn [Time] [7] Move column [Date] to the front of column [Time]
Sequence no. Sequence no.
[¥] Sequence no. Color: | [N [¥] Sequence no. Color: | [N
Display charts : |5 v
Row
[¥] Multi-line display Number of lines: 5
Option button visibility
@ Predefined () Dynamic
[¥] Enable
< m | 3 < m »
L OK J [ Cancel ] [ Help [ oK J [ Cancel ] [ Help. ]
Setting Description

Time / Date

Enable or disable showing the time and date and configure its

format and color.

Move column [Date] to the front of column [Time]

Swap the position of column [Date] and column [Time].

Sequence no.

Show the sequence number of all records.

Multi-line display

Row Display a specified number of lines of data. Data will be displayed
as specified regardless of the actual number of lines of data.
Show or hide the option button
Predefined

Option Select [Enable] to show the option button.

button Dynamic

visibility (cMT

/ CMT X Option button visibility

Series) () Predefined @ Dymamic

Device : [Losal HMI &)

Address: |LB -0

Designate a bit address to control option button visibility.
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Data Format Tab
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cMT / cMT X Series eMT, iE, XE, mTV Series
New History Data Display Object New History Data Display Object
[ Genersl | Display | Display Format | Tite | Edit__| Secusity | Shape | [ General | Display | Displey Format [ Title | Edit | Seouriy [ Shape |
Channel : | Channel 1 ~ Channel 6 - Channel : | Channel 1 ~ Channel 6 v
Channel 1 [16-bit Unsigned ] [ Channel 1 [16-bit Unsigned ]
[V] Display [] Follow settings in the Data Sampling [V] Display
tigiin  — L —— T ) C—
fd 0 Right of decimal Pt.: 0 2
Channel 2 [16-bit Unsigned ] Channel 2 [16-bit Unsigned ]
[T Display [T Display
Channel 3 [16-bit Unsigned ] Channel 3 [16-bit Unsigned ]
["| Display ["| Display
Channel 4 [16-bit Unsigned ] [ Channel 4 [16-bit Unsigned ]
|| Display [¥] Follow settings in the Data Sampling || Display
Leading zero Center v [ .| [ Leading zero Center E
y 0 2 Right of decimal Pt. : 0 é
[ oK J [ Cancel ] | Help [ 0K J [ Cancel ] [ Help
Setting Description
Channel

Each History Data Display object can display up to 64 channels. Check
[Display] to select the channels to be shown on the screen. In the
figure above, there are 4 channels (channel 1 to channel 4) in the
Data Sampling object, and only Ch.1 and Ch.4 are selected. The data
formats are shown next to channel name. The data format of each
channel is decided by the corresponding Data Sampling objects. The
result is shown below:

MNo. Time Date |ch1|cha
12 |09:50:16[10/03/17] 0O i
11 [09:50:15[10/03/17] 0O i
10 [09:50:14[10/03/17] 0 i

9 [09:50:13[10/03/117] O i

8 [09:50:12[10/03M17] 0 0

7 [09:50:11[10/03/17] 0O i

6 [09:50:10[10/03/M17] O i

5 [09:50:09[10/03/17] 0 j:[
4] | >

When using cMT / cMT X models, Data Sampling’s Data Format
settings can be applied to History Data Display object.

Two display modes are available when displaying [String] format in
History Data Display object:
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Channel 1 [Btring - 11 word (z)]
Diizplayr [ Follow settings in the Data Sampling

] Reverse highflow borte Left -

e o0 22 1 String format ; |JTF-8 (Defaul) - |

® Follow settings in the Data Sampling.
® Reverse high byte and low byte data and then display.

Title Tab

New History Data Display Object

| General | Display | Display Format | Title  |Edit | Secusity | Shape |

Headers
Use headers

[ Transparent Color : [:]

Background

Column Header text =

| m

(o J[ ol J[ reo |

Setting Description
Use headers Enable or disable title, which is marked as shown below:

€. [Time| Date [ch1 [chZbAl

1 UF BT TOTOSTTT | | #HH

Background Transparent
When selected, hide the background for title area.
Color
Set the background color of title.

Setting Defines the text to be shown on the title.
The text can be edited in Label Tag Library. Build the Label Tag
Library first, and in History Data Display settings dialog select the
checkbox in the Label Library column, and then select the label tag.
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Lobalz: [ iabeltng | Tifke

Title name

Labe1=1

Time
Date
ch.l
ch2
ch.3

m

0 Note

After running simulation on PC, to run simulation again using the same project that

|
contains some changed data, please find the HMI_memory, SD_card, or usb1 folder in
EasyBuilder Pro installation, and then delete the old data sampling records in it, to prevent
the system from reading old data in the second simulation.
Edit Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
7New H;mygm DIS;&)’ Object 7 }wlew H;mygata Dis;ay Object :
| General | Display | Display Format | Title | Edit | Secuuity | Shape | | General | Display | Display Format | Tile | Edit | Secuuity | Shape |
[/] Ensble [] Enable
*For data saved in an external device (USE disk/SD card), editing commands work only
when the device is plugged in.
Control Control
Device : [LgcalHMI v] {a Device : [LocalHMI v] {a
Address: [LW |0 [[6-bit Unsigned Address: [LW v|0 [f6-bit Tnsigned
Enable control result
Command : LW-0 Command : LW-0
1 : Overwrite log data. 1 : Overwrite log data.
2 : Delete the sslected log
Result: LW-1
0 : Success
1 : External device not connected
2 : Command not supported
3 : Record not found
Data Data
Device : [Local HMI @ Device : [Local HMI b e
Address: [LW |0 [[6-bit Unsigned Address: [LW -] 0 [ [f6-bit Tnsigned
Select Select
Device : [Local HMI B e Device : Local HMI D e
Address: LW ~|0 16-bit Unsigned Address: (LW ~|0 \ [16-bit Unsigned
Selection color : :} Selection color : :]
(o J[ concel J[ rep | ok J[ concel J[ e |
Setting Description
Control LW-n: Command
address —
Value Description
1 The data in Data Address will
overwrite the data in data log.
2 The selected data log will be deleted.

LW-n+1: Result (cMT / cMT X Series)
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Value Description

0 The command is executed
successfully.

1 The external device is not connected.
2 The command is not supported.
3 The record cannot be found.

Data address The system will start reading row by row from the selected one in

History Data Display, and change the data log accordingly.
Please note that the settings in this address must be identical to

that in Data Sampling.

Select

By changing the value in Select Address, the corresponding row in
address

History Data Display can be selected.

Please note that:

1. When the value in Select Address is 0, no row will be selected,
and the value in Data Address will stay the same as that of the
previously selected row number.

2. When the value in Select Address exceeds the total number of
rows in History Data Display, the last row (the one with largest

row number) will be selected.

@ Note

B When an external device is used to save data log, removing the external device will make
Edit function ineffective. Editing can keep on when the external device is inserted again
and the system starts reading historical data.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.19. Data Block Display

13.19.1. Overview

Data Block is a combination of several word devices with continuous address, where the X axis
of Data Block Display object represents the address and the numbers on the Y axis represent
the data values in the corresponding address. Data Block Display object can display multiple
data blocks. For example, it can display two data blocks LW-12~LW-15 and RW-12~RW-15 in
trend curves simultaneously. It is very useful to observe and compare the difference of trend

o [T )
twit | 4] /
twiz | 10 ] N e VA
twiz | 20

twis | 5] 10 Y

Lwts | | W12 LW1 LWis LW | e | >

curves.

The display result

13.19.2. Configuration

Click the [Object] » [Chart] » [Data Block Display] icon on the toolbar to open the property
dialog box. Set up the properties, press OK button, and a new Data Block Display object will be

created.
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Objects
General Tab
New Data Block Display Object »
Genersl | Display Area | Secusity | Shape |
Comment :
No. of channel : 1 =
Watch line
[V] Enable
[¥] Allow input Color : [:
Device : [Local HMI -G &S
Address: [LW v| 0 bit Unsign
Control
Device : [Logal HMI | eI e
Address: |[LW v |0 [[6-bit Unsigned
No. of data address: | W-1
Data storage start address
[T]Oftset to control address
Device : |Local HMI B e
Address: LW v 2 [16-bit Unsigned
Limit
Min.: 0 Max. : 32767
[ OK ] [ Cancel ] 1 Help
Setting Description
Comment Description of the object.
No. of Set the no of channel for this object. Each channel represents one
channel data block. The maximal number of channels is 12.
Watch Line If enabled, when user touches the [Data Block Display] object, it
will display a vertical cursor line on it, and store the data on the line
to the designated registers. See Example 1.
Allow input (cMT / cMT X Series)
With this checkbox selected, entering a value in the specified
address for watch line can move the verticle watch line to the
desired position.
Channel Select the channel to be configured.
Control Specify the control address also the data source.
address Control address is used to control and clear the drawn curve. After

executing the operation below, the system will reset the control
word to zero.

Enter “0” = No action (default)

Enter “1” = Draw (Without clear first)

Enter “2” = Clear
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Enter “3” = Redraw

No. of data address

If control address is LW-n, then LW-n+1 stores the number of word
devices in each data block, i.e. the number of data. The maximum
value is 1024.

Data storage start address

If [Offset to start address] is enabled, the [Offset value storage
address] will be set as [Control address] + 2.

If select 16-bit data format, the address for each data will be start
address, start address + 1, start address + 2 and so on.

If select 32-bit data format, the address for each data will be start
address, start address + 2, start address + 4 and so on.

For more information about control address, see Example 2 to 5.

Limit Set the minimum and maximum limit for the curve.

@ Note

B Without clearing the drawn lines, Data Block Display can be drawn a number of times by

entering value 1 in the control address repeatedly. The way to calculate the maximum
number of times is: 32 divided by the number of channels.
1 channel=>» 32 times
2 channels=»16 times
16 channels=>»2 times
Example 1
How to use watch (Cursor Line) feature
Use “Watch” function to check the value of any point of the curve. When the user touches
[Data Block] object, it will display a “cursor line”, and the system will write the index and value

of that data on the cursor line to the designated address.

Data Format Index Value Channel 1 Value Channel 2 Value
16-bit Address Address + 1 Address + 2
32-bit Address Address + 2 Address + 4
64-bit (cMT/

Address Address + 4 Address + 8
cMT X only)

When watch address is set to LW-n, the value written into LW-n represents the channel index

number to be called up. (Start form 0)
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Channel 1
16 bit BCD

Watch indicator

-

50

-

20

20 10

M\~ \ B
NS

10

b+ 10

] ] ] ] ] 10

10

10

A@ Note

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

Channel 2
32 bit unsigned

1

[

40

50

30

40

40

30

30

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

Channel 2
32 bit unsigned

1

7

40

50

30

40

40

30

30

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

Channel 2
32 bit unsigned

-

-

40

50

30

40

40

30

30

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

+0
+1
+2
+3
+4

+0
+1
+2
+3
+4

+)
+1
+2
+3
+4

Watch
address

3

10

40

Watch
address

3

0

40

Watch
address

3

0

40

Index
16 bit BCD

32 bit
unsigned

[Data Index] is a 16 bit unsigned integer. When the designated register of cursor line is 32

If the channel to be viewed has no data, “0” will be displayed, as shown below. In the

example, there is no data in channel 1, when the cursor points at Data 4, “0” will be

Index

16 bit BCD

32 bit
unsigned

Index

16 bit BCD

32 bit
unsigned

Write the number of data to [No. of data address], i.e. “Control address+1”

Write “1” to [Control address] to draw the curve without cleaning the plot. All previous

[ |
bit device, it will be stored in the bit 0-15.
[ |
displayed as shown below.
Channel 1
16 bit BCD
sl Watch indicator Control
No. of Data
40
'_\_‘ Data 1
0 Data 2
20 Data 3
10 | Data 4
l l l l l Data 5
Data 6
Data 7
B [f thereis less data in Channel 1, “0” will be displayed, as shown below.
Channel 1
16 bit BCD
50l Watch indicator 1 | Control
/\/ 3 | No. of Data
40
_\— 30 | Data 1
30 20 | Data 2
20 | 10 | Data 3
10 | Data 4
| l 1 1 1 Data 5
Data 6
Data 7
Example 2
How to show a data block
1.
2. Store the data consecutively beginning at [Data storage start address].
3.
curves will not be erased.
4.

The system will write “0” to [Control address] after marking the plot.
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Word Address

Last displayed graph Display

1 | Control

7 | Mo. of Data

20 | Data 1

30 | Data 2
10 |Data3 Data 1
20 |Data 4
20 |Data 5
40 |Data 6

30 |Data7 T

remains and the current
data graph overlays it.

The previous graph J

A@ Note

B Do not change the content of [Control address], [No. of data address] and [Data storage
start address] between step 3 and step 4 above as doing so might cause error for the
trend curve plot.

Example 3

How to clear the graph

1. Write “2” to [Control address], all the trend curves will be cleared.

2. The system will write “0” to [Control address] after the trend curve is cleared.

Word Address

Last displayed graph 2 | Control Clear
7 | No. of Data

20 |Data1

30 |Data 2

10 |Data 3

20 |Data 4

20 |Data5 ] I ] ! ! !
40 | Data 6 Clears the previous
ot B,

does not display.

Example 4
How to clear the previous trend curve and display new one
1. Write the number of data to [No. of data address], i.e. “control address+1”
2. Store the data consecutively beginning at [Data storage start address].
3. Write “3” to [Control address], the previous trend curves will be cleared and the new
content in data block will be plotted on the screen.

4. The system will write “0” to [Control address] after the trend curve has been plotted.
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Word Address
Last displayed graph 3 | Control Redraw screen
7 | No. of Data
40

20 | Data 1

30 | Data 2

10 | Data 3 Data 1

20 | Data 4

20 |Data 5

40 | Data 6 Clears the previous
graph display, then uses

20 [Data? the current data to
display the graph again.

Example 5

How to use offset mode

If [Offset to start address] is selected, [Control address], [No. of data address], and [Offset
value storage address] will use 3 consecutive addresses.

For example, assume the total number of channels is 3 (start from 0 to 2), and the [Control
address] are LW-0, LW-100, and LW-200, respectively. Then, the other addresses will be set as
follows: (In the example, format 16-bit Unsigned is used and [Offset value storage address] are

all m).
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Item Channel 0 Channel 1 Channel 2
Control Address LW-0 LW-100 LW-200

No. of data LW-1 LW-101 LW-201
address

Offset value LW-2 (=m) LW-102 (=m) LW-202 (=m)
storage address

Data 1 LW-0+m LW-100+m LW-200+m
Data 2 LW-1+m LW-101+m LW-201+m

The following figure on the left shows the result when offset mode is not used while the figure
on the right shows the result when offset mode is used.

No offset settings Has offset settings

Designated Designated

address Control address Control
+1 | No. of Data (n) +1 | No. of Data (n)
+2 Data 1 +2 Offset (m)
"""" Tt Data (n) to be
) displayed on the
____________ graph +m Data 1
+(n+1) patan |[J) 777" T Data (n) to be
’ displayed on the
____________ graph
+(m+n-1) Data n

@ Note

B When [Control address] is set to LW-n, [No. of data address] and [Offset value storage
address] are as follows:
Data Type 16-bit 32-bit 64-bit (cMT / cMT
X only)
Control address LW-n LW-n LW-n
No. of data address LW-n+1 LW-n+2 LW-n+4
Offset value storage address LW-n+2 LW-n+4 LW-n+8
B If the control registers are 32-bit devices, only bit 0-15 will be used for control purpose, bit
16-31 will be ignored. (as illustrated below)
32 hit device
31 16 15 0
+0 0 Control
+1 0 No. of Data
+2 0 Offset
B When the value in [Control address] is not zero, the system will read [No. on data address]
and [Offset value storage address].
B |tis recommended to use [Offset to start address] for data block display with multiple
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channels and the same device type. As shown in the following figure, The control words of

channel 1 is located from LW-n, the control words of channel 2 is located from LW-n+3,

and so on.

Display Area

Address

Control

No. of Data (n)

Channel 1

Offset {m)

Control

No. of Data (n)

Channel 2

Offset (m)

Channel 1's
data (n)

Channel 2's
data (n)

-

New Data Block Display Object

"Geneml; Display Area [Security ]‘Shape |

Data samples : 50 2
[¥] Ensble seroll switch
Profile color
[7] Transparent

Fove: [
Grid
[¥] Enable
Horiz.: 4 ~ division(s)

Channel

Pen property

Samples to scroll © 10 2

Background : o
Cotor: (I

Verti, : 4 & division(s)

OK Cancel Help

Setting

Description

Description

Data samples

I__| WE!NTEK

EasyBuilder Pro V6.10.01



Objects

13-148

Configure the maximal number of data samples (points) to be

displayed.

Samples to scroll

Configure the number of data samples being scrolled.

Enable scroll switch

Clicking

Clicking

-

-

>

displays the previous or next data point.

displays the first or the last data point.

Profile

Set the color of the frame and background of the object.

Transparent

Hides the background. Color selection will not be available.

Grid

Set the number of horizontal and vertical divisions shown by grid.

Channel

Set the color, width and style of each curve.

"

- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

I__| WE!NTEK

EasyBuilder Pro V6.10.01


https://dl.weintek.com/public/MT8000/Project/Part_Sample/Data_Block.zip

Objects

13.20. XY Plot

13.20.1. Overview

XY Plot object is used to display values for two variables (x,y) for a set of data, where the data
comes from word registers. Up to 16 channels can be displayed simultaneously. This object

facilitates data observation and analysis. Additionally, negative numbers can be displayed as

well.

13.20.2. Configuration

e

Click [Object] » [Chart] » [XY Plot] icon on the toolbar to open a [XY Plot] object property dialog

box.

General Tab

I__| WE!NTEK

XY Plot Object's Properties [==al
General |Di5|:;la\-I Area | Shape I Proﬁle|
Comment :
Direction : |Right w | MNo.ofchannels: 2 =
Control Address
PLC name : Local HMI - | [ Setting...
Address i[LW v] 0
No. of data address :
Read address
PLC name : [Loml HMI ']
Separated address for ¥ and ¥ data
¥ data
PLC name : 1ocal o
Address :’Lw ~| 100 16-bit Unsigned
Y data
PLC niame : | Local HVI
Address i[LW | 200 16-bit Unsigned
Limits
[ Dynamic limits
X axis
Low: O High : 32767
Y axis
Low: 0 High : 32757
o) [ cons
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Setting Description
Direction There are four selections, right, left, up or down.
Right Up Down
Right direction Left dlrectlon Up directian U”Q'n—-
Urgm\_ ‘_Ul’lgln Clrgn"L " Down direction
No. of .
Set the number of channels for observation.
channels
Control Controls the operation of all channels simultaneously. When the
address [Control address] is LW-n, assigning values to LW-n will issue
commands to XY plot according to the table below. Meanwhile, LW-
n+1 | controls the number of data points plotted. After operation,
the [Control address] will be reset to O.
Control | Value Result
address
LW-n 1 Plots point on XY curve.
(The plotted points are kept.)
2 Clears all XY curves.
3 Clears then plots new XY curve.
-n+
tW-n+1 Any Controls the number of data points plotted.
number
No. of data address
Controls the number of data points. Each channel can plot up to
1023 points.
Channel Select a channel to configure.
Read Address Device
Select a PLC which will be the source of [X data] and [Y data] and
designate a read address.
The format of the data register blocks used for the display channels
depends on whether [Separated address for X and Y data] and/or
[Dynamic limits] has been selected. See Example 1.
Dynamic ® When not selected (See Example 2)
limits The Low and High limits can be set by entering constants. The Low

and High limits are used for calculating X and Y range in
percentage.

® When selected (See Example 3)

A zoom effect can be created by changing the Low / High Limits.
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Example 1

The format of the data register blocks used for the display channels depends on whether
[Separated address for X and Y data] has been selected, and if [Dynamic limits] has been
selected. The following explains the situations where 16-bit register is used:

® |f [Separated address for X and Y data] is not selected, and set [Read address] to LW-n:

Select [Dynamic limits] Not select [Dynamic limits]

X data Y data X data Y data
Low Limit LW-n LW-n+2 Constant Constant
High Limit LW-n+1 LW-n+3 Constant Constant
1%t data LW-n+4 LW-n+5 LW-n+0 LW-n+1
2" data LW-n+6 LW-n+7 LW-n+2 LW-n+3
3 data LW-n+8 LW-n+9 LW-n+4 LW-n+5
4t data LW-n+10 LW-n+11 LW-n+6 LW-n+7

® |f [Separated address for X and Y data] is selected, and set [X data] to LW-m, [Y data] to

LW-n:

Select [Dynamic limits] Not select [Dynamic limits]

X data Y data X data Y data
Low Limit LW-m+0 LW-n+0 Constant Constant
High Limit LW-m+1 LW-n+1 Constant Constant
1%t data LW-m+2 LW-n+2 LW-m+0 LW-n+0
2" data LW-m+3 LW-n+3 LW-m+1 LW-n+1
3 data LW-m+4 LW-n+4 LW-m+2 LW-n+2
4t data LW-m+5 LW-n+5 LW-m+3 LW-n+3

Example 2

When [Dynamic limits] is not selected, the Low and High limits can be set. The Low and High
limits are used for calculating X and Y range in percentage.
Read Address Value — Low Limit
High Limit — Low Lmit
If [Separated address for X and Y data] is not selected and the address is LW-n, the

Scale (%) =

corresponding limits are retrieved from the addresses as shown in the following table.

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
X axis low limit LW-n LW-n LW-n

X axis high limit LW-n+1 LW-n+2 LW-n+4

Y axis low limit LW-n+2 LW-n+4 LW-n+8

Y axis high limit LW-n+3 LW-n+6 LW-n+12
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Example 3

If [Dynamic limits] is selected, a zoom effect can be created by changing the setting of Low /
High Limits.

In the following example, XL=X low limit, XH=X high limit, YL=Y low limit, YH=Y high limit, and
XY, XY1, XY2 are three XY data. When changing the high limits of X and Y axis, the result is

shown below:

[5 1 o Jes [0 J20 |

LW100 control  LW101 display number

N B

Original
o
[o Y50 o Yoo ]
Y XY2 XY X¥Y1 XY2

I I | ECEE R | SN [5 1 o M+ Qs J20 ]
LW100 control  LW101 display humber LW100 control w101 display number
[ L1

Change the high limit of Y axis to 25. Change the high limit of Y axis to

(zoom in) 100 (zoom out)

C?For more information, see “13.17 Trend Display”.

@ Note

B X and Y data can be set to different formats. For example: If X data uses 16-bit unsigned, Y
data uses 32-bit signed, please note the address setting.
B When using a Tag PLC, such as AB tag PLC, X and Y must be in the same format. When using

different formats a warning will be shown.
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Display Area Tab

13-153

New XY Plot Object ==

- Display Area. | Security | Shape

Profile color
[ Transparent

N i - N e ——

Pen property
CORE T e—
[ |IE=——1————1

Brush property
Reference line

[¥] Limit from device

Device : [Local HMI v] Settings...

Address: [LW ~]0 ‘ [16-bit Unsigned.

[ Reference line 1
[ Reference line 2
[| Reference line 3
[] Reference line 4

[ OK4][ Cancel ][ Help

J

Setting

Description

Profile color

Select the color of the frame and the background, or select

[Transparent] check box to hide the frame and background.

Curve For each channel select the properties of color, width, and line
style.
Maker Select the style of XY Plot. For eMT/iE/XE/mTV series, there are

four different types of XY plot as shown below:

Curve

Cha

Maker :
/. WV

Pen property
Color : ’/'\/\/ T “ ﬁ -
=
Birush property ‘

FPoint width :

EWE!NTEK
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For cMT / cMT X Series, , there are six different types of XY plot as

shown below:

Curve

clnsl

Maker

Pen property

/
Color f," '\v/\a" TAYaY 1 -

Burush property “ i

FPoint width

See Example 4.

Pen property Select color, width and style for the line in XY plot.

Brush
Select point width.

property

Reference line Up to 4 horizontal reference lines can be shown on the graph. Fill in
high, low limits and Y axis percentage values. Different colors can
be selected for each reference line.
If [Limit from PLC] is selected, designate a register to be the read
address of reference line.

Example 4

The curve shown in the following figure is drawn with 7 points numbered from PO to P6.
The steps the system draws the X-axis Projection are:

1. Calculates the two points in X-axis — (Xo, 0) and (Xs, 0).

2. Link all the points in the order of (Xo, 0), PO... P6, (Xs, 0) and returns to (Xo, 0) at last.

3. Fill out all enclosed areas.

Enclosed region

e
)
Ao

Pelatetels.

o
3

"
"

=
205
botetels!
Potelst
btete!
ot
btete!
ot
A
'etetets
Potete!
ot
o
gt

o
ol

<

<

ot

(X, 0) (Xs,0)  (Xo,0) (Xs, 0)

Enclosed region

(0,Ys) 4" Lo

5
. v (0, Yo) 44 /ﬁﬁ
AR (0, Yo) '-0/\/3_"/ S i (0, Yo) 13 —
2 2
. Enclosed region

Se
[}
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@ Note

B Without clearing the drawn points, XY Plot can be drawn a number of times by entering
value 1 in the control address repeatedly. The way to calculate the maximum number of
times is: 32 divided by the number of channels.

1 channel=>» 32 times
2 channels=»16 times
16 channels=>»2 times
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13.21. Alarm Bar and Alarm Display

13.21.1. Overview

Alarm Bar and Alarm Display objects are used to display alarm messages which are defined in
Event (Alarm) Log objects. When the trigger conditions are met, events or alarms will be
displayed as they occur in chronological order in Alarm Bar or Alarm Display object.

Alarm Bar scrolls all alarm messages in one single display line, whereas Alarm Display shows

alarm messages in multiple lines.

C?For more information, see “7 Event Log”.

I {When LW T >= 10) 13:21:06 Event 0 (when LWO

Alarm Bar - Displays alarm messages in one scrolling line.

13112106 13:21:38 Event 2 (when LB10 = ON)
13112106 13:21:38 Event 3 (when LBTT = ON)
13112i06 13:21:38 Event 0 (when LWO == 100)
13112106 13:21:38 Event 1 (When LW 1 >= 10)

Alarm Display — Displays alarm messages in multiple lines.

13.21.2. Configuration

“T :'-:g:-':

Click [Data/History] » [Alarm Display] or [Alarm Bar] icon on the toolbar to open the object

property dialog box. Set up the properties, press OK button, and a new object will be created.
General Tab

The difference between these two objects is that Alarm Display allows an [Acknowledge

address] and a [Scrolling control address] to be set.
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Objects
New Alarm Display Object
Genersl | Alarm | Sort | Security [ Shape | Font |
Comment :
Acknowled ge address
[V] Enable acknowled ge fonction
Device : [LocalHMI '] Cal @
Address: [LW ~|0 16-bit Unsigned
Serolling control address
[¥] Enable scrolling control
Device : [LocalHMI '][ &)
Address: [LW v|0 [16-bit Unsigned
[ OK J [ Cancel ] [ Help
Setting Description
Enable If selected, the [Acknowledge value] selected for the associated

acknowledge

event, specified in Alarm (Event) Log » Message tab will be written to

function the [Acknowledge address] designated in Alarm Display. For more
information, see “7 Event Log”".
Acknowledge value for Event/Alarm Display object
Acknowledge value : 11
Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which
address indicates the first line. Please note that with this address enabled,

the horizontal and vertical scroll bars will not be available on the
object; please make sure that the width of the object is enough for

completely showing the content.

@ Note

B When using a ctMT / cMT X Series model, press and hold the event on the screen to
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acknowledge an event; drag a finger on the screen to scroll.

B When using a cMT / cMT X Series model, a default minimal row height exists in Alarm
Display objects that have enabled Acknowledge function. The minimal row height
prevents the rows to be touch by mistake. On a small-sized HMI, the row height may be

slightly taller when Acknowledge function is enabled.

Alarm Tab
Alarm Bar Alarm Display
New Alarm Bar New Alarm Display
Alarm [Sort | Security | Shape | Font General ‘ Alarm  [Sort [ Title [ Security | Shape | Font
Display Display
Style : |Crystal T Style color = [E
Mode:
Interval : |3.0 v | second(s)
["] Show current and total number of alarm Include categories
Dynamic range Q) Predefined
Include categories
Dynamic range ©) Predefined 0 ~ 255 {see Event (Alarm) Log object}
Caption
0 ~ 255 {see Event (Alarm) Log object} [¥] Use caption
Profile Font size : (16 - Color : B
[7] Transparent
Name
Frame color : S] Background color : &l I
m Caption
‘.
ey Option button visibility
Option button visibility _ _
@) Predefined Dynamic
Q) Predefined Dynamic
. [¥] Enable
(V] Enable
[ ok J[ cancel ][ heb [ ok ][ cancel J[ heb
Setting Description
Display Display settings are only available for Alarm Bar.

iP/iE/XE/eMT/mTV Series

Display

Speed :

Move smoothly (may lead to highter CFU usage)

When [Move smoothly] option is selected, the message will move
along the Alarm Bar object more smoothly. Please note that enabling
this may lead to high CPU loading.

cMT / cMT X Series

The available modes are [Carousel] and [Marquee].
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Display Display
Mods: Mo : °
Interval second(s) Speed :

Show current and total number of alarm
Multi-line display

When [Carousel] mode is selected, the option to display the current
and total alarm count and set the interval in seconds can be enabled.

10px 1 0px

~100/299+11:25:46 Event 15 Lony

When [Marquee] mode is selected, the speed of text movement in
the Alarm Bar object can be adjusted. Enabling multi-line display
allows the event content to be shown in multiple lines within the
Alarm Bar object. Please consider the performance impact when

using this mode.

Include Events in the selected category will be displayed. The categories are set
categories in Event (Alarm) Log object.
For example, if the category is set to “2 to 4” here, only events in
categories 2, 3, 4 will be displayed. For more information, see “7
Event Log”.
cMT / cMT X Series
Dynamic Category Range is an option available only for cMT Series
models. With this option selected, an address can be designated for

dynamically selecting event categories to be displayed.
Include categories

() Predefined @ Drmsinds categniny range

Device : |Local HMI v | Setlings .|
Address : [Lw -| D 16-bit Tnsigned

Fonge begin: L#-0
Fangeend : LW-1

Caption Caption settings are only available for Alarm Display on cMT / cMT X
Series.
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Caption
s caption

Fontsize : |16 - Color : [:]

Hame
Caption Caption

Option
button Show or hide the option button
visibility (cMT .
v Predefined
/ cMT X .
Series) Select [Enable] to show the option button.
Dynamic
Ciption button visibility
© Predefined © Dynamic
Devise : Local HMI | e
Address: [LB ~|0 [
Designate a bit address to control option button visibility.
Sort Tab
Alarm Bar Alarm Display
f New Alarm Bar Object = [ New Alarm Display Object (23] /
| Alrm | Sott | Security | Shape | Font | | General | Alsrm | Sott | Title | Secuity | Shape | Fomt |
Format Format
Sort Sort
Order & Characters Onder & Characters
Display items Display order Display items Displaych... Display order
] Triggerdate [T Trigger date 1]
Trigger time Trigger time 1]
Message E] Message 20 | @
[] Occurrence count 0 =
(¥] [] Elapsed time 0 (v]
[ Prioxity level 1]
[ Category 10 =
Q ?u:bcahegory} }U v

*Each column width is determined by: "Display chars" * (width of the character %)
* Set "Display chars" to 0 to avtofit column width to the contents. (Exception: Event

message)
Dete: (MMDDAYYY v ] Tume: [HEMMSS  ~] Dete: (MMDDRYYY v ] Tone: [HEMMSS  ~]
ok J[ conced J[ o | ok J[ concel Hep |
Setting Description
Order (Alarm Time ascending
Bar) Latest event is placed last in the list (the bottom).
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Objects
Time descending
Latest event is placed first in the list (the top).
Order (Alarm Sort by:
Display) Ascending — Priority Level (cMT / cMT X Series)

Event with highest priority level is placed last in the list (the
bottom).

Descending — Priority Level (cMT / cMT X Series)

Event with highest priority level is placed first in the list (the top).
Ascending — Occurrence Count

Event with highest occurrence count is placed last in the list (the
bottom).

Descending — Occurrence Count

Event with highest occurrence count is placed first in the list (the
top).

Ascending - Time

Latest event is placed last in the list (the bottom).

Descending - Time

Latest event is placed first in the list (the top).

Display order

Select the items to be displayed and use the up and down arrow
buttons to adjust the display order of the alarms.

Date Displays the date tag with each alarm message. The four formats of
date tag:
MM/DD/YY ~ DD/MM/YY ~ DD/MM/YY ~ YY/MM/DD

Time Displays the time tag with each alarm message. The four formats of

time tag:
HH:MM:SS ~ HH:MM ~ DD:HH:MM ~ HH
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Title Tab

New Alarm Display Object : A

| General | Alarm [ Sott | Tile  |Secusity | Shape | Fomt |

Headers
Use headers

Column Header text
R i o
gt | 1o e
Mo esns
_ Occurrence count
Bl Eepe e

. s .

Title settings are available on cMT Series. With [Use headers] selected, the text color and
column headers can be configured.
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Security Tab
Alarm Bar Alarm Display
New Alarm Bar Object @ Alarm Display Object's Properties @
[larm [Sort | Secusity [Shape | Font | [General | Alarm | Sort | Security [Shope | Fomt | Profils |
User restriction Enable/Disable
Object class : [None - [V] Use register statustvalue
*If the vser tries to operate on an object without authorization, LB-12056 will be set to Device : [Local HMI v ][ )|
N Address: (LB .0
Enable if bitis: [ON v
Action : (Do nothing when disabled v
User restriction
Object class : [None v ]
*If the user tries to operate on an object without authorization, LB-12056 will be set to
ON.
[ oK ] [ Cancel ] | Help ] [ OK ] [ Cancel ] I Help ]
Setting Description
Interlock When [Use interlock function] check box is selected,

whether the object is operable is determined by the

state of a designated Bit address. As shown in the above

settings, if LB-0 is ON, the object is operable.
Hide when disabled
When the designated Bit is OFF, the object will be

hidden.

User Set the security class of the object to be operated by an

restriction

Object class

authorized user.

“None” means any user can operate this object. Only

account “admin” can operate “Administrator” object

class.

Make invisible while protected

When the user's privilege does not match the object

class, the object will be hidden.

When this check box is deselected in Alarm Display
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Objects
object settings, the unauthorized user can see the Alarm
Display object, but cannot trigger the object or make any
change.
This check box is greyed out in Alarm Bar object settings.
Font Tab

Set the font size or select [ltalic].

New Alarm Bar Object [==3a]
Alarm | Shape | Font
Attribute
[V 1talic

The font, color, and content of the alarm messages displayed in Alarm Bar and Alarm Display

objects are set in Alarm (Event) Log object:

Event (Alarm) Log @
General | Message
Text
Content : | Event 1: press once to acnowledge -
[ use label library Label Library...
Font: Arial -
Color : I | ~

i- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.22. Event Display

13.22.1. Overview

13-165

The Event Display object displays events from the Event (Alarm) Log that meet the specified

trigger conditions. These displayed events can be sorted based on time, occurrence count, or

priority level. The Event Display object provides information about the events, including the

trigger date / time, acknowledge time, recovered time, message, occurrence count, elapsed

time, priority level, category, and subcategory. Furthermore, it is capable of displaying multi-

lined messages as well.

812113106 22:0%95 Event 3 (when LBI1 = ON) a
e inEee T Zzesmqs TTTTTTTUT Event 1 (When LW 15 10)
5 12/13/06 22:03:12 Event 0 {when LWO0 == 100)
4 12/113/06 22:02: 57 Event 3 (when LB11 = ON)
3 12113106 22:02: 56 22:03:04 Event 2 (when LB10 = ON)
2 12113106 22:02:56 22:02:58 Event 1 iWhen LW 1 >= 10] ﬂ
f 272710 14:32:86 14:32:57 14:32:5% Eventi
IWos<2 |
____________________________________________________________________________ Muiti-text

13.22.2. Configuration

l:.IIII

Click [Data/History] »[Event Display] icon on the toolbar to open an Event Display object

property dialog box. Set up the properties, press OK button, and a new Event Display object

will be created.
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General Tab
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13.22.2.1. eMT, iE, XE, mTV Series
New Event Display Object New Event Display Object (== J
General |EventDisp]ay[Son [Secuxitylshape lFont lEmptyWa.rning‘ Gensial [EventDis'play]Saﬂ ]Seclm'ty[Shape lFom ]EmptyWamingl
Comment Comment :
Ml [Real-ﬁme VJ Mode : lﬂm,}, .l
[V] Refresh data antomatically
Acknowledge
Device : [Loca.lHMl ‘]l el (o)
Address: LW |0 [16-bit Unsigned
Event management
[V] Enable Usage... Event management
ot (R =g (7] Ensble [ Use. ]
Address: LW ~|0 16-bit Unsigned Device : [LocalHMI '}[ et
Serolling control Address: LW v|0 16-bit Unsigned
(V] Ensble Serolling control
Device : [Local HMI - “ [V] Enable
Address: |LW 0 jomi Unsened Device : [LocalHMI '][ )
Address: |LW v|0 |16-bit Unsigned
History control
Usage
Device : [Local HMI b eIt
Address: |LW v|0 !
[¥] Enable reading multiple histories
Mode : [Numberof days (max. 90 days) v]
(o« ][ cancel |[ teb [ o« ][ cancel |[ Hep |
Setting Description
Mode The available modes are: [Real-time] and [History].
® Real-time
All the events triggered since HMI starts up are displayed.
® History
The system reads the event log in HMI memory and displays
them. The content can be updated by changing window. In case
when the trend display shows history data from today, the
display will refresh once per second.
Acknowledge When in Real-time mode and an event is acknowledged by touching
an active display line, the [Acknowledge value] specified in Event
(Alarm) Log object, Message tab, is output to the [Acknowledge
address] of Event Display object. For more information, see “7 Event
Log”.
Acknowledge value for Eventfalarm Display object
Acknowledge value @ 11
History When in History mode and if:
Control ® [Enable reading multiple histories] is not selected
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The history files are sorted by date and each file is given an index. The
latest one is assigned index 0 (in most cases: today), the second latest
file is assigned index 1, and so on. The history control address is used
to specify the history file to be displayed.

If control address is LW-100, and four files exist with dates:
EL_20100720.evt, EL_20100723.evt, EL_20100727.evt, and
EL_20100803.evt.

The index value given to each file is shown below:

Value in LW-100 The corresponding file
0 EL_20100803.evt
1 EL_20100727.evt
2 EL_20100723.evt
3 EL_20100720.evt

® [Enable reading multiple histories] is selected

Displays a list of events triggered in multiple days. The display range
is formed by two consecutive addresses. Please note that the history
control address is defined differently in “Number of days” mode and
in “Index of the last history” mode.

Number of days

Suppose the history control address is set to LW-n, then:

[LW-n]: The start day index (which is expressed as the number of

days before today. 0: today, 1: yesterday, and so on.)

[LW-n+1]: The total number of days to display. The days are
calculated backward from the start day.

Example: If today were 2010/6/10, and LW-n = 1, LW-n+1 = 3, then the
data range will start from 1 day before today, which is 20100609
(yesterday), and include data for 3 days: 20100607~20100609.

[E9EL_20100604 No.4 1KE EVT
[EHEL 20100605 No.3 6KE EVT
EIEL_20100608 No.2 1TKB EVI
[ EL_20100609 4KB EVT
FYEL_20100610 No.0 12KB EYT

Index of the last history

Suppose the history control address is set to LW-n, then:

[LW-n]: The index value of the file to start. 0: the latest file, 1: the
second latest file, and so on.

[LW-n+1]: The index value of the file to end. The specified value must
be greater than that of the start index.

Example: If LW-n =1 and LW-n+1 = 3, then file No.1, No.2, No.3 will be
displayed.

[FIEL_20100604 No.4 1KE EVT
[E2EL_20100605 : No.3 6KB EVT
[FIEL_20100608 No.2 17TKE EVI
[EIEL_20100609 No.1 4KE EVI
[FIEL_20100610 No.0 12KE EVT

The maximum size of data that can be displayed is 4MB. Data
exceeding the limit will not be displayed.
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The following shows how data will be displayed according to data size.
5 history data, each is 0.5MB - Data displayed: 8 x 0.5MB

5 history data, each is IMB - Data displayed: 4 x 1IMB

5 history data, each is 1.5MB - Data displayed:

2 x 1.5MB+1 x 1MB (partial)

i- Click the icon to download the demo project. Please confirm your
internet connection before downloading the demo project.
Event Enable event management

management If this check box is selected, writing a specific value into register LW-n
and LW-n+1, where n is an arbitrary number, will control [Event
Display] object with different commands as shown below:

Address | Value | Command
LW-n 0 Display all events.
1 Hide [Confirmed] events.
2 Hide [Recovered] events.
3 Hide [Confirmed] or [Recovered] events.
4 Hide [Confirmed] and [Recovered] events.
W-n+1 |1 In real-time mode, delete a single selected
event.
Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which

indicates the first line.

In the following figure, there are 10 events recorded in the object,
and value 3 is set at the control address. The upper event object
displays the events in time ascending order, and begins at the 4t
event; on the other hand, the lower one displays the events in time

descending order, and begins at the 7t" event.

4 18:48:19 Test Event
5 18:48:19 Test Event
e L2y 6 18:4820  TestEvent
7 18:48:20 Test Event
8 18:48:20 Test Event
Scrolling
Control
7 18:48:20 Test Event
6 18:48:20 Test Event
5 18:48:19 Test Event
4 18:48:19 Test Event
5 18:48:19 Test Event

If [Scrolling control address] is enabled, the scroll bar cannot be used
for scrolling, but still shows the relative position of the content. If the
control address holds a value that is larger than the total number of
lines, the display will stroll to the end. Please note that with this
address enabled, the horizontal and vertical scroll bars will not be
available on the object; please make sure that the width of the

object is enough for completely showing the content.

—m Click the icon to watch the demonstration film. Please confirm your internet connection
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before playing the film.

13.22.2.2. cMT, cMT X Series

New Event Display Object @

General fﬂEvemDisplayrlrFiller V[Sort IvTitle V[SecurityVIVShape [ Font

Comment :

Acknowledge

Device : [Local HMI ekl

Address : [LW v 0 16-bit Unsigned

Serolling control

[V|Enable
Device : Local HMI 9| e | e
Address : [LW v 0 16-bit Unsigned
History control
[V|Enable Usage...
Device : [Local HMI ek
Address : [LW v|0 5

[¥|Enable reading multiple histories

Mode : |Numbex of days v]

[ o« J[ camcel [ Hep ]

For cMT / cMT X models, only events with “save to history” option selected in the Event
(Alarm) Log settings can be displayed in the Event Display object. The events that are not set to

be saved in the history can be displayed using the Alarm Bar or Alarm Display object.

Setting Description
Acknowledg When an event is acknowledged, the value specified in the Acknowledge
e Value field under the Message tab of the Event (Alarm) Log settings will

be outputted to the Acknowledge address of the Event Display object.

For more information, see “7 Event Log”.

Acknowlédze value for Event/dlarm Display object

Acknowledze value 1 11

Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which
address indicates the first line.

History o [Enable reading multiple histories] is not selected
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Control The history files are sorted by date and each file is given an index which
is expressed as the number of days before today. 0: today, 1: yesterday,
and so on. The history control address is used to specify the history file
to be displayed.

® [Enable reading multiple histories] is selected

Displays a list of events triggered in multiple days. The display range is
formed by two consecutive addresses. Please note that the history
control address is defined differently in “Number of days” mode and in
“Specific days” mode.

Number of days

Suppose the history control address is set to LW-n, then:

[LW-n]: The start day index (which is expressed as the number of days
before today. 0: today, 1: yesterday, and so on.)

[LW-n+1]: The total number of days to display. The days are calculated
backward from the start day.

Specific days

Suppose the history control address is set to LW-n, then:

[LW-n]: The start day index. O: today, 1: yesterday, and so on.

[LW-n+1]: The end day index. The specified value must be greater than
that of the start day index.

Example: When start =4 and end = 7, the specified days will be 4 days
before to 7 days before.

For cMT / cMT X Series, all the events that occurred are displayed and updated in real-time.

Press the Option Button in the upper-right corner of the object and set the start and

end date. If the dates are not set specifically, all the events are displayed.

Cancel Option Done

Cancel Begin Date oK

Include Categories 0-255

Begin Date (@)
E————i 2021-02-09
16:21:07 Event 0
16:21:08 Event 0 Ended Date (—®)
16:21:09 Event 0 2021-02-09
EVENT DISPLAY SETTING
Show triggered events v
Show confirmed events v
Show recovered events v
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cMT / cMT X Series eMT, iE, XE, mTV Series
Event Display Object's Properties @ New Event Display Object =]
| General | Event Display ‘Fxhex [Sort [ Title ISecL\rity lShape | Font IProfile | ﬁem’@l’ Event D’»SP]‘“)"LSP“ 1;?“{*!}'15"329 1 Font J Empty Waming
Display Display —_—
Style : |Crystal Y Style color : || | . Acknowlede stle L(—:M
Max. eventno.: 200 %
Acknowledge style :
Include categories
Caption
[¥] Use caption 0 ~ 255 {see Event (Alam) Log object}
Font size : |16 Z Color : " Color
| Transparent
e Foe: () Beckeowd
}n Caption e ks
‘ Select box : [ 3
Acknowledge Acknowled ge
Text color : | Background color : [ Transparent | Text : :] Background :
Return to normal Retum o normsl
Text color : | [ . Background color : Transparent | Text: E Background :
Option button visibility Grid
@) Predefined *) Dynamic [7] Enable
[¥] Enable Color: | I
[ OK ] ’ Cancel ] 1 Help ] [ OK J [ Cancel ] l Help I
Setting Description
Include Eventsin the selected category will be displayed. The categories are set
categories in Event (Ala rm) Log Object.

For example, if the category is set to 2 to 4 here, only events in
categories 2, 3, 4 will be displayed. For more information, see “7 Event

7

Log”.

Acknowledge
style

Select [Click] or [Double Click] to acknowledge each single event.
When an event occurs the user can tap the event line once or twice
to acknowledge the new event.

When acknowledged, the text color of the event will change to the
selected color, and the acknowledge value associated with that event
will be sent to the register designated in [Acknowledge address]. If
the address is set to LW-100, and the acknowledge value is set to 31,
when user acknowledges the event, value 31 is written to LW-100.
This can be used in conjunction with Indirect Window object so that
when an event is acknowledged, the corresponding message window
is displayed.

Max. event
no. (eMT, iE,
XE, mTV

The maximum number of events to be displayed in this Event Display
object. When the number of the displayed events equals to the set
maximum number, the new coming event will overwrite the latest
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Series) event.

Color Different colors indicate different event states, such as acknowledged,
returns to normal, or selected. The system draws a highlight box
around the latest selected event.

Acknowledge

6 13:12:19 Event 1 (When LW 1 >= 10)
SIS R EVEIE Z (Wi C 810 = ON) e,
T3 qzezas T Event 2 (when LB10=ON) |

2 13:12:14 Event 1 (When LW 1 >= 10)

1. 13%R12:14 Event 0 (when LWO == 100}

Sequence ho. Return to normal Select box
History background (eMT, iE, XE, mTV)
When using Event Display object and select History mode, the
background color of the history record can be customized.
New Event Display Object @
i(’m.l\ Event Display | Security | Shape | Font |Empty Warning |
Include categories: 0 thrn 255 {sse Event (Alarm) Log object}
Color
[ Transparent
Frame ;| v Background : v
History background :  EE_— v
[78:45:43  [Evento R
o
| >
Grid Displays a grid of rows and columns in the object. The color of the

grid lines can be selected.
Auto fit short column (cMT / cMT X Series Default style)
The column width automatically adjusts to the size of the content.

Caption (cMT

Available styles are: Default, Crystal, and Flat.

/ cMT X With [Use caption] enabled, the font size, color, and name of the
Series) caption can be specified for Recipe View object.

Option

button Show or hide the option button

visibility (cMT Predefined

/ cMT X

Series) Select [Enable] to show the option button.

Dynamic
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Ciption button visibility

) Predefined @ Dymaomic

Deviee : |Loal HMI G )&

Address: |LE - |0

Designate a bit address to control option button visibility.

Filter Tab (cMT / cMT X Series)

Event Display Object's Properties

‘General ]Evem Display | Filter ‘Son |Title |Secuxity |Shape | Font IProfile |

Include categories

") Dynamic range @ Predefened
0 ~ 255 {see Event (Alarm) Log object}

Event display

[ Triggered, but not confirmed
[ Triggered and confirmed

[ Recovered, but not confirmed

["] Recovered and confirmed

[ OK ][ Cancel H Help. ]
Setting Description
Include Events in the selected category will be displayed. The categories are
categories set in Event (Alarm) Log object. For example: if the category is set to

2 to 4 here, only events in categories 2, 3, 4 will be displayed. For
more information, see “7 Event Log”.

When [Dynamic range] is selected, the object can dynamically filter
the displayed event categories based on the value in the specified
register.
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Sort Tab
cMT, cMT X Series eMT, iE, XE, mTV Series
(@ < o]
Event Display Object's Properties New Event Display Object @
| General }Evem Display [ Filter Sort lTitle [Secunty lShape [ Font IProfile ‘ ‘ General I Event Display | Sort [ Title 1 Security | Shape | Font l
Format Format
Sort Sort
Order : i Sortby: | Tg
Sort by: |Priority level x Order: thosending, 2 7 | g B
Order & Characters
Order & Characters >
o Display items Displaych.. ~ | |  Displayorder
verview - T
B s : 0
Display items Display chars 4 Display order J‘ Teque)zcg;: 0 Message
| Trigger time — et =
[F] Sequenceno. 0 ‘* Message [V] Trigger time 0 E @
= ‘: | Subcategory 1 J Acknowled ge time 0
|| Triggerdate 0 Subcategory 2 A ] Recovered time 0 J E]
= : [¥] Message 20
[v] Trigger time 0 E] [] Occurrence count 0
= [ Elapsed time 0 =
|| knowledge time O e e ot 3
i *Each column width is determined by: "Display chars" * {(width of the character %)
[”] Recovered time 0 =
— *Set "Display chars” to 0 to autofit column width to the contents. (Exception: Event
Detail message)
Display order

Display items Display chars 4

[7] Sequenceno. 0 A ﬁ;ff:grenm Date : [MM/DDYYYY = Time :

|| Trigger date o]

=P

[¥] Trigger time (4]

[] knowledge time 0

|| Recovered time 0

* Each column width is determined by: "Display chars" * (width of the character 'x")
* Set "Display chars" to 0 to autofit column width to the contents.

Date: [MM/DDIYYYY v] Time: (HHMM:SS  ~
([ox  J[ concel ][ Hep | [ ok ][ cancel |[ e

trigger date  trigger time notification time retfurn to normal time

el (LRI 20 T 120 T 2. ONN EVEROIWREEY
T2 ziddios T ¥ozeiag T Event 2 (when LE
Setting Description
Order Sort by:

Ascending — Priority Level (cMT / cMT X Series)

Events on the Overview page are grouped and sorted by priority
level, with the group of events with highest priority level placed
last in the list (the bottom). On the Detail page, all events in the
group are displayed in a time descending order, with the latest
event placed first in the list (the top).

Descending — Priority Level (cMT / cMT X Series)

Events on the Overview page are grouped and sorted by priority
level, with the group of events with highest priority level placed
first in the list (the top). On the Detail page, all events in the group

are displayed in a time descending order, with the latest event
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placed first in the list (the top).

Ascending — Occurrence Count

eMT, iE, XE, mTV Series: Event with highest occurrence count is
placed last in the list (the bottom).

cMT, cMT X Series: On the Overview page, the group of events with
the highest occurrence count is placed last in the list (the bottom).
On the Detail page, all events in the group are displayed in a time
descending order, with the latest event placed first in the list (the
top).

Descending — Occurrence Count

eMT, iE, XE, mTV Series: Event with highest occurrence count is
placed first in the list (the top).

cMT, cMT X Series: On the Overview page, the group of events with
the highest occurrence count is placed first in the list (the top). On
the Detail page, all events in the group are displayed in a time

descending order, with the latest event placed first in the list (the
top).

Ascending - Time

Latest event is placed last in the list (the bottom).

Descending - Time

Latest event is placed first in the list (the top).

Display order

Select the items to be displayed and use the up and down arrow
buttons to adjust the display order of the events.

Date

Displays the date tag with each event message. The four formats of
date tag: MM/DD/YY ~ DD/MM/YY ~ DD/MM/YY ~ YY/MM/DD

Time

Displays the time tag with each event message. The four formats of
time tag: HH:MM:SS ~ HH:MM ~ DD:HH:MM -~ HH
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Title Tab

Tt colo - | |

[Genexal IEventDisplayIFiltsI lSort ITiﬂe ISecuritylShape IFom. IPxofile |
Headers
Use headers

Column
_ Sequence no.
_ Trigger date
_ Trigger time
_ Acknowledge time
_ Recovered time
_ Message
_ Oceurrence count
_ Elapsed time
_ Priority level
Suategoy |
Suctegoy2

Subcategory 1

Subcategory 2

Header text

(

OK

J [_conce

J

Hep |

Title settings are available on ctMT / cMT X Series. With [Use headers] selected, the text color

and column headers can be configured.
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New Event Display Object
| General | Event Display | Sort Security |Shape | Font |
|

Enable/Disable
[V] Use register statusivalue

Device : [Local HMI

~|CE )

Address: |LB v 0
Enable if bitis :

Action : [Da nothing when dissbled

5

User restriction

Object class : [None

Z)

*If the vser tries to operate on an object without authorization, LB-12056 will be set to

ON.

][ Cancel H Help l

Setting Description

Interlock When [Use interlock function] check box is selected,
whether the object is operable is determined by the
state of a designated Bit address. As shown in the above
settings, if LB-0 is ON, the object is operable.
Hide when disabled
When the designated Bit is OFF, the object will be
hidden.

User Set the security class of the object to be operated by an

restriction

authorized user.

Object class

“None” means any user can operate this object. Only

account “admin” can operate “Administrator” object

class.
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Make invisible while protected

When the user's privilege does not match the object

class, the object will be hidden.

When this check box is deselected, the unauthorized

user can see the Event Display object, but cannot trigger

the object or make any change.

Font Tab

In Real-time mode: Users may select Italic font and set the font size. The font is displayed
according to the setting in Event Log object.
In History mode: Users may select Italic font and set the font size, font and color, or tick the
[Font from label library] check box.

Empty Warning

Attribute
Font : | Arial|
Color : | EG—
[ Font from label library
[ Italic

Size:[16

-
New Event Display Object

| General | Event Display | Secuity | Shape | Font | Empty Waming

(V] Use empty waming
No alarm occurred.

Use label libraxy

Font : (An'al

Color : | IEEG— S ||

[ Italic

When [Use empty warning] is enabled, the text displayed when no event has occurred can be

specified. This feature is not supported on cMT / cMT X Series models.

i. Click the icon to download the demo project. Please confirm your internet connection

before downloadin
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13.23. Data Transfer

13.23.1. Data Transfer (Per-page)
13.23.1.1. Overview

Data Transfer (Per-page) object can transfer values from the source address to the destination
address when the window in which this object is placed opens. The data transfer operation can
be activated by manually pressing the object or by detecting the change of state of the
designated bit.

A@ Note

B When Data Transfer (Per-page) object in Bit-Trigger mode is placed in the common
window, it activates data transfer operation once the specified condition is met,
regardless of the current base window.

13.23.1.2. Configuration

4

Click [Object] » [Data Transfer] » [Data Transfer (Per-page)] icon on the toolbar to open the
property dialog box. Set up the properties, press OK button, and a new Data Transfer (Per-

page) object will be created.
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General Tab
New Data Transfer (Per-page)
General lSecurity I Shape ILabel ‘
Comment :
Attribute
Mode : [Touch trigger 'J
[] Activate after button is released
No. of word : 1
Source
Device : [Local HMI @]
Address : [LW >0
Destination
Device : [Local HMI )G
Address : [LW |0
Notification
[V]Enable () 8et ON Q) Set OFF
["IFollow (set ON when data transfer finished)
Device : [Local HMI '“ @ (G
Address : LB -] o [ )
[ OK ]mecei |[ Help —l
Setting Description
Source )
Data Transfer object reads the data from [Source Address].
address
Destination ) ] L
Data Transfer object writes the data to [Destination Address].
address
Attribute No. of word

Enter the number of words to be transferred. Unit: word.

Mode

Touch trigger

Press the object to activate data transfer operation.

External trigger

The data transfer operation is activated when the state of the
designated bit address changes.

There is a further selection to make of whether the data transfer
operation is activated after OFF to ON, ON to OFF transition, or at
both of the changes of state.
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Trigger ) ) )
Specify a bit address for [External trigger] mode.

address

Notification When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.
Follow

The notification bit will reset to its original state once the system
finishes data transfer.
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13.23.2. Data Transfer (Global): Time-based
13.23.2.1. Overview

Data Transfer (Global) object in Time-based mode can transfer data from the source address to

the destination address based on a time schedule.

13.23.2.2. Configuration

{T:*j'x +

Click [Object] » [Data Transfer] » [Data Transfer (Global)] icon on the toolbar and open the
Time-based tab. Click [New] and set up the properties, press OK button, and a new Data
Transfer (Global) object will be created. Please note that the data should be imported /
exported separately in Time-based mode and Bit Trigger mode of Data Transfer (Global).
cMT / cMT X Series

Data Transfer (Global)

Time-based l Bit trigger |

1 ocal HMI : LB-0] -> [Local HMI : LB-0], Mode : Bit, Time interval=3.0 second(s), transfer length=1bit(s]

[ mew. ][ oeete ][ settngs.. |[ Bgot |[  mport
eMT, iE, XE, mTV Series

Data Transfer (Global)

Time-based |

T =N === == = [en ]
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General Tab

Click the [New] button in the Data Transfer management dialog box.

Data Transfer (Time-based) @
General ;ngcurity‘
Comment :
Attribute
Address mode : ‘Bil > Interval : |3.0 second(s) -
No., of bit: 1

|| Active only when designated window opened
|"|High priority (this may reduce refresh rate of screen components.)

Source

Device : [Local HMI B | T | )
Address : [LB ¥|o
Destination
Device : [Local HMI £ | T | )
Address : [LB—'JI 0
Notification
|¥|Enable Set ON @) Set OFF

[ 1Follow (set ON when data transfer finished)

Device : [Local HMI 'H 3 HIJ
Address : LB v|0
OK I[ Cancel H Help
Setting Description
Attribute Address mode

Select the data type to be transferred from [Bit] or [Word].

No. of bit /No. of word

When [Bit] is selected in [Address mode], set the number of bits
transferred each time when data transfer is triggered.

When [Word] is selected in [Address mode], set the number of
words transferred each time when data transfer is triggered.
Interval

Select the time interval of data transfer; for example, when 3
seconds is set, the system will transfer data every 3 seconds.
Specifying a shorter time interval or a greater amount of data to
transfer may decrease overall system performance; therefore, a
longer time interval or a smaller amount of data to transfer is
recommended.

When a short interval is inevitable, please at least set an interval
longer than the time needed for data transfer operation; for
example, when the data transfer operation takes 2 seconds, the

interval must be longer than 2 seconds.
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Objects
Activate only when designated window opened
Data Transfer object transfers data only when the designated
window is opened.
High priority
Assign a higher priority level for this data transfer. Please note that
this could result in a reduced screen refresh rate.
Source ]
Data Transfer object reads the data from [Source Address].
address
Destination ] ) o
Data Transfer object writes the data to [Destination Address].
address
Notification When enabled, the system will set the designated address ON or

OFF when it’s ready for data transfer.
Follow
The notification bit will reset to its original state once the system

finishes data transfer.
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13.23.3. Data Transfer (Global): Bit Trigger

13.23.3.1. Overview

Data Transfer (Global) object in Bit Trigger mode transfers data from the source address to the
destination address when HMI detects that the state of the designated bit address changes.
This feature is not supported on eMT, iE, XE, mTV models.

13.23.3.2. Operation

“i
S
Click [Object] » [Data Transfer] » [Data Transfer (Global)] icon on the toolbar and open the Bit
Trigger tab. Click [New] and set up the properties, press OK button, and a new Data Transfer
(Global) object will be created. Please note that the data should be imported / exported
separately in Time-based mode and Bit Trigger mode of Data Transfer (Global).

cMT / cMT X Series

Data Transfer (Global)

Ttrnsb@_sed Bit trigger‘

New... ] I Delete ‘ [ Settings... ' { Export ] l Import Exit
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Objects
General Tab
Data Transfer (Bit Trigger) @
Comment :
Attribute
Trigger mode :
No. of word : 1
["|High priority (this may reduce refresh rate of screen components.)
Source
Device : [Local HMI 2| | )
Address : LW >0
Destination
Device : (Local HMI e &)
Address : |[LW v|0
Trigger
Device : [Local HMI e k)
Address : |LB v|0
Notification
[V|Enable ©)Set ON Q) 5et OFF
[ IFollow (set ON when data transfer finished)
Device : [Local HMI YEE )
Address : |LB v|0
(o« [ concel J[ hep ]
Setting Description
Attribute Trigger mode
Trigger data transfer when the state of the designated register
changes from OFF to ON, ON to OFF, or at both of the changes of
state.
No. of word
Set the number of words transferred each time when data transfer
is triggered.
High priority
Assign a higher priority level for this data transfer. Please note that
this could result in a reduced screen refresh rate.
Source )
Data Transfer object reads the data from [Source Address].
address
Destination . . o
Data Transfer object writes the data to [Destination Address].
address
Trigger Set the address used to control data transfer and select the trigger
address mode.

Notification

When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.

Follow

The notification bit will reset to its original state once the system

finishes data transfer.
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13.24. Backup

13.24.1. Overview

Backup (Trigger-based) object and Backup (Global) object can transmit recipe data (RW, RW_A),
event log, recipe database, sampling data, and operation log to an external device (SD card,
USB disk), in a specified time range or format. For example, when the event log is saved in a SD
card, a USB disk can be inserted when HMI power is still ON, and use Backup object to copy the
data into USB disk from SD card, and then remove USB disk without turning off HMI power. The
data saved in USB disk can be used on PC for analyzing. When the system is backing up, the
state of system register [LB-9039] is set ON. With [e-Mail] option, information can be sent to
configured email contacts.

Backup (Trigger-based) object is triggered by pressing the object on the screen while Backup
(Global) object runs in the background regardless of screens being viewed. Backup (Global)
object is available only on cMT / cMT X Series models.

13.24.2. Configuration

b B

On the toolbar click [Object] » [File Operation] to find [Backup (Trigger-based)] and [Backup
(Global) objects.

Open [Backup (Trigger-based)] object property dialog box, set up the properties, press OK
button, and a new Backup (Trigger-based) object will be created.

When using a cMT / cMT X Series model, [Backup (Global)] object is available. Open [Backup
(Global)] object managing dialog box, click [New] to open the object property dialog box, set
up the properties, press OK button, and a new Backup (Global) object will be created.
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General Tab

Backup (Trigger-based)
cMT / cMT X Series

eMT, iE, XE, mTV Series

New Backup (Per-page) Object

Genersl | Qutput | Secusity | Shape | Label |

Comment :

File source : IHisbn’pal eventlog

Range

Start: @ Today © Yesterday

Within : (90 day(s) -

Trigger
Mode : ITouch trigger v]

Activate after button is released

*LB-9039 indicates the status of file backup activity (backup in process if bit is ON).

New Backup (Per-page) Object

General | Output | Advance | Security | Shape | Label |

Comment :

File source : [Hismn'cal eventlog

Range

Start: © Today © Yesterday

Within : (A1 (mecx. 90 da) v

Trigger
Mode : [Tow:h trigger v]

[T Activate after button is released

*LB-9039 indicates the status of file backup activity (backup in process if bit is ON).

Lo J[ coneel ]

J [ concel ]|

Backup (Global) cMT / cMT X Series

Backup (Global)

General | Output

Comment :

File source : [Higﬁm}:el event log

Range

Start: © Today © Yesterday

Within : (90 day(s) -

Trigger
Mode : |Extemal trigger (bif) -

Condition : |QFF->0N v | [¥]Follow (set OFF when backup finished)

Device : [Loca.l HMI
Address: |LB v|0 |

*LB-9039 indicates the status of file backup activity (backup in process if bit is ON).

~EE IS

[ ok ][ cancel ][

Help

J

13-188

Setting Description

Source

[RW], [RW_A], [Recipe database], [Historical event log],
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[Historical data sampling], [Operation log], [SQL Query]

Select one from the above for the source. When backing up
[Historical data sampling], use [Data Sampling object index] to
select the one to back up.

Options other than RW, RW_A will be available only when they are

used in the project file.

Event
category
range

This groupbox will be available only when backing up a historical
event log in CSV format. Two options can be found in this group
box: All and Partial. Selecting partial and entering “3, 5, 8” in the
field will backup events in categories 3, 5, and 8. Selecting partial
and entering “3-8” will backup events in categories 3 to 8.

Range

Historical data sampling

Select a number of files. For example, if [Start] is set to [Current],
and [Within] is set to [5 file(s)], the latest five files in memory will
be backed up.

Historical eventlog

Select a number of days. For example, if [Start] is set to [Yesterday],
and [Within] is set to [2 day(s)], the files obtained yesterday and
the day before yesterday will be backed up. Select [All] to save all
files, and the maximum is 90 days.

Trigger

Mode

There are three ways to activate Backup function.

Touch trigger

Touch the Backup object to activate backup operation.

External trigger (bit)

Register a bit device to trigger the backup operation.

Select whether the backup operation is activated after Off to ON,
ON to OFF transition, or at both of the changes of state.

¥

=a Click the icon to download the demo project. Please confirm
your internet connection before downloading the demo project.
External trigger (word)

Users can specify the number of days to backup data using [Trigger
address]. [Trigger address] usage (suppose LW-n is used):

LW-n: Will start to back up when the value changes from 0 to 1.
LW-n+1: The start date of backup.

LW-n+2: The number of days for backup. (The maximum: 90 days).
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Syntax @
Lw-0
Set 1 to trigger badkwp activity
Liw-1

Define backup start file

:current
: previous

: previous of previous

= RS |

: and so on

L-2
Define backup range

Unit : file no., max. value : 30

Cloze

On cMT-SVR, Backup (Trigger-based) object only supports [Touch
trigger] mode but not [External trigger (bit)] and [External trigger
(word)] modes.

.4

= Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Trigger When the state of the designated register is set ON, the backup
address operation is activated. When the backup operation is done, the

state of the designated register is set OFF.

A@ Note

B All history files should have been saved in memory, either HMI memory, USB disk or SD
card. Otherwise, the Backup object will not work.

B The maximum number of days for backup is 90 days.

B When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the

length of the file names. Fewer files can be saved when the file names are longer.

C?For cMT / cMT X Series, see “7 Event Log” and “8 Data Sampling” that explain the

mechanism of synchronizing data to external device.
i Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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Objects

Output Tab

cMT / cMT X Series

eMT, iE, XE, mTV Series

Backup (Per-page) Object's Properties

Gensrel | Output | Secusity [ Shape | Label | Profils |

Backup (Per-page) Object's Properties

[ Generel | Ovtput | Advance [ Secusity [ Shape | Label | Profils |

Backup position
(O USBdisk 1
@ FTP

(O USBdisk 2 e-Mail

FTP Path :
Duplicate filename
© Overwrite () Append BAK to the existing file

* To use [FTP] to store dats, ensble the FTP server in [FTP] page of [System Parameters]

Backup position
© USB disk 1 (O USBdisk2 e-Mail

") Remote printer/backup sexver

*Use LW-9032~8039 to change the backup folder name.
* To vse [Remote Printex/Backup Server] to store data to a remote PC, enable the sexver in

13-191

dialog first. [Printer/Backup Server] page of [System Parameters] dialog first.
‘ Storage format ‘ Storage format
Format : ISQLihe Database File (*.db) v} Format : IeMT/XE/iEIiPAnTV SERIES Data Sampling File (*.dtl) v
e
| Enable checksum for data integrity @
[ OK J { Cancel ! [ Help [ OK ] [ Cancel 1 [ Help
Setting Description
Backup Select the destination where the source files will be saved to.
position SD card / USB disk

The external device connected to HMI.

Remote printer/backup server (eMT, iE, XE, mTV Series)

This option is available when [System Parameters] » [Printer/Backup

Server] » [Use Remote Printer/Backup Server] is selected.

Please note that [Operation log] backup can only be saved to Remote

printer/backup server. To save into a SD card or USB drive, use the

control address of Operation Log object.

C?For more information, see “26 EasyPrinter”.

E-mail

To send backup using e-mail, go to [System Parameters] » [e-Mail] tab

to configure first, and then open Backup object’s e-Mail tab to

configure the recipient address, subject, and message.
FTP (cMT, cMT X Series)

To save backup to an FTP server, go to [System Parameters] » [FTP]

tab to enable the FTP function first, and then open Backup object’s
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Output tab to set the FTP path and the way to handle duplicate

filenames.

Save format

Select the desired format to back up the file.
eMT, iE, XE, mTV Series:
® HMI Event Log File (.evt) / HMI Data Log File (.dtl)
® Comma Separated Values (.csv)
The [Event] column is included in the backup file to indicate the type

of the event.

A B | c | b [ E |
Event |Category Date Time | Message
2013/7/4) 16:12:11 Event A
2013/7/4) 16:12:12 Event A
2013/7/4) 16:12:33 Event B
2013/7/4) 16:12:36 Event B
2013/7/4) 16:12:37 Event B
2013/7/4) 16:12:37 Event B
2013/7/4) 16:12:39 Event B
2013/7/4) 16:12:40 Event B

=R A= S R ]
oo oo oo s o

0 = Event is triggered
1 = Event is acknowledged
2 = Event returns to normal
EasyConverter can be used to easily convert HMI Event Log File (.evt)
and HMI Data Log File (.dtl) to .xlIs or .csv format.
® SQLite Database File (.db)
cMT / cMT X Series:
® SQLite Database File (.db) (Only for backup to e-mail)
® Comma Separated Values (.csv)
Split by

No split Backup all historical data to the same file.

Date Files are separated according to the date of
historical data.

When [Customized file handling] is used in
Data Sampling, the backup files are
separated in the same way they are by the

rules of customized file handing.

Number of rows Files are separated according to the number

of rows set.

Add BOM (Byte Order Mark) to file header for EXCEL can
interpreting non-ASCII strings correctly.

To back up history logs in .csv format, open the csv file in EXCEL. The
BOM (Byte Order Mark) can be added to the file header so that

the .csv file containing non-ASClI strings can directly be opened in

EXCEL. The title, export time, occurrence count, and elapsed time can
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be included or omitted in the backed-up .csv file.

Storage format
Format : [Cu:umma Separated Valves (*.oov) -
Splitby | Date -|
£4d BOM (Bate Ovder Mark) to file header for EXCEL can interpreting non-43CT1
strings corectly
Include title Include export time
Include ocowrence cownt Include elapsed time

Enable checksum for data integrity
This option is provided for using Backup object to generate a backup
file with checksum. EasyConverter can then be used to examine data

integrity.

Advance Tab (eMT, iE, XE, mTV)

Backup Object's Properties
| General | Advance [Secusity | Shape | Label | Profie |
Serial number (range : 00000 ~65535)

(V] Enable

Source
PLC name:[Loca| HMI v] Settings...
Address:[Lw v|0

* For example, when serial number is 123 :
A data sampling file - 20140407 d1l will be backed up to 2014040700123 41
An event log file - 20140407 evt will be backed up to 2014040700123 evt.

Options
[V| Remove old files after backup

Setting

Description

Serial number

If enabled, when backing up history files, a user-defined, 5-digit
serial number can be appended to the end of the file name of the
history data backup.

The serial number is determined by the value in the designated
source address. After backup, the value of this LW address will
automatically increment by 1.

The range of the serial number is 0~65535

For example, if the serial number is 123, the appended 5 digits will
be 00123.

A data sampling file -20140407.dtl will be backed up as
2014040700123.dtl.

An event log file -20140407.evt will be backed up as
2014040700123.evt.
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Options

Remove old files after backup

If selected, the old history files will be removed after backup.

0 Note

B cMT/cMT X Series does not support Advance settings.

e-Mail Tab
Backup Object's Properties @
[ General | Advance | Security | Shepe | Label | Profile | e-Mail |
[V] 4dd et extension to the filename to skip the anti-virs detection
Recipients
Subject
Subject : -
< »
Use label library
Message
Opening : -
4 »
Use label library
Ending : -
4 »
Use label library
Label Library... ] [Language 1 v]
o) o=
Setting Description
Add .txt

extension to
the filename
to skip the
anti-virus

detection

If selected, when sending backup data as an email attachment, the
filename extension .txt will be added to the file name. This
prevents the mail server or anti-virus software from blocking

emails.

Recipients,
Subject,
Message

Back up the email address of the recipients, the subject of the

email, and the message content.

I__| WE!NTEK

EasyBuilder Pro V6.10.01



Objects

13.25. Media Player

13.25.1. Overview

Media Player object plays video files on HMI. It can, for example, be useful in providing better

instructions onsite to facilitate maintenance.

This object does not work remotely on cMT Viewer.

13.25.2. Configuration

]

Click [Object] » [Media Player] icon on the toolbar to open a Media Player object property

dialog box. Set up the properties, press OK button, and a new Media Player object will be

created.

General Tab

13-195

cMT / cMT X (excluding cMT-SVR) eMT, XE
New Media Player Object New Media Player Object =2
General [ i i
Preview | Security m
Comment: N
Control mode Comment :
) No control
© Use U control Control address
() Use command control Enable
Resume mode PLC name : [Loal HMI v] Setting...
@ Resume previous playback () Resume after restart Address : 0
Command : |LW : 0 Status : LW :0 +3
Parameter 1:|LW:0 +1 Fileindex : LW :0 +4
Parameter 2: LW :0 +2 Starttime : LW :0+5
End time : [LW :0 +6
Update video playing time
Update period : Playing time : |LW :0 +7
Lo e Ext. device
© USE disk ) 5D card @) USE disk Folder name : video
Folder name : video
Attribute
Attribute [[] Auto. repeat Background : I v
Bt | —
*(05 version 2012.11.12 or later support media player only !
o) Comat J[_ro ] o ] o ]
Setting Description

Control mode

No control: Disable manual control by user. Video playback starts
as soon as the window opens.
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Use Ul control: Use built-in user interface to control media
playback.

Use command control: Use control addresses to control media
playback.

Resume

mode

Defines where to resume video playback when changing back to a
window with media player. Options include Resume previous
playback and Resume after restart.

Control

address

® Selected

Designate a word register to control the object operations.
® Not selected

No manual control. Video will be played automatically when the
designated window open:s.

Command (control address + 0)

Enter a value in the Command register to designate which action is
executed.

Parameter 1 (control address + 1)

Enter a value in Parameter 1 associated with each command action.
Parameter 2 (control address + 2)

Enter a value in Parameter 2 associated with each command action.
Status (control address + 3)

Indicates the status or errors.

File index (control address + 4)

The file number in the designated folder. It is recommended to file
the video name with a number.

Start time (control address + 5)

The start time of the video (second). 0, normally.

End time (control address + 6)

The end time of the video (second). (The time length of the video)
Update video playing time

If enabled, the elapsed playing time of video will be written into
[Playing time] register at a rate set by [Update period] in seconds.
Update period

Update period of [Playing time], range from 1 to 60 (second).
Playing time (control address + 7)

The elapsed playing time of video (Second). Normally between

start time and end time.

Ext. device

Play video files in SD card / USB disk.

Folder name

The folder name of video files stored in SD card or USB disk. Files
must be stored in root directory. Subdirectories won’t be accepted.
(For example, “example\ex” is an invalid directory.)

[Folder name] cannot be empty, must be alpha-numeric, and all in
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ASCII character.
Attribute Auto. repeat
When finish playing all the video files, replay from the first file.
Ex: Video 1 > Video 2 > Video 1 > Video 2
Background
The background color of the object.

A@ Note

B The data format for control address is 16-bit Unsigned or 16-bit Signed. If using 32-bit
Unsigned or 32-bit Signed, only the previous 16 bits will be effective.

Control command

The following are the settings of different commands.
® Playindex file

[Command] =1

[Parameter 1] = file index

[Parameter 2] = ignore (set 0)

A@ Note

B Files are stored with file names in ascending order.
B If the file cannot be found, [Status] bit 8 is set ON.
B Please stop the playing video before switching to another.

® Play previous file
[Command] =2
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)

0 Note

B |f [File index] is zero, the same file is replayed.
B If the file cannot be found, [Status] bit 8 is set ON.

® Play next file
[Command] =3
[Parameter 1] = ignore (set 0)
[Parameter 2] = ignore (set 0)

B |f there are no more files, the index O file is played.
B If the file cannot be found, [Status] bit 8 is set ON.

® Pause / Play Switch
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[Command] =4
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)

® Stop playing and close file
[Command] =5
[Parameter 1] = ignore (set 0)
[Parameter 2] = ignore (set 0)

® Start playing from the designated time
[Command] =6
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

0 Note

B Parameter 1 (target time) must be less than the ending of time or it plays the last second.

® Forward
[Command] =7
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

0 Note

B Going forward to the designated second in [Parameter 1]. If the video is paused, the
forwarding action will be started by playing.
B When the designed time is later than the end time, it plays the last second.

® Backward
[Command] =8
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

@ Note

B Going Backward to the designated second in [Parameter 1], if the video is paused, the
backward action will be started by playing.
B When the designed time is earlier than the beginning time, it plays from beginning.

® Adjust volume
[Command] =9

[Parameter 1] = volume (0 ~ 128)
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[Parameter 2] = ignore (set 0)

@ Note

B Default volume is 128.

® Set video display size
[Command] =10
[Parameter 1] = display size (0 ~ 16)
[Parameter 2] = ignore (set 0)

0 Note

B [Parameter 1 =0] : Fit video image to object size.
B [Parameter 1 =1~ 16] : Magnification from 25% ~ 400% in 25% increments where 1 =
25%, 2 =50%, 3 = 75% and so on.

@® Status (control address + 3)

When playing a video the system sets [File Open (bit00)] and [File Playing (bit01)] to ON. If the
file cannot be found, or an invalid command is entered, the Command Error bit 08 is set ON. If
the file format is not supported, or a disk I/O error occurs, during playback, the File Error bit 09
is set ON.

15 09 08 02 01 00 bit
|Reserved(a|l0) ]0[0| |0 0]

00: File Opened / Closed (0 = closed, 1 = opened)

01: File Playing (0 = not playing, 1 = playing)
08: Command Error (0 = accepted, 1 = incorrect)
09: File Error (0 = accepted, 1 = incorrect)

0 Note

B The figure shows the status value associated with each state:
Stop =0, Pause = 1, Playing = 3

Playing

play command

(1,2,3) stop command toggle pause command
(5) (4)
Finish playing
Stop < Pause
stop command (5)

B [Command], [Parameter 1], and [Parameter 2] are write addresses. All others are read
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only.

Preview Tab

Users can test whether the video format is supported by using the preview function.

New Media Player Object 21

General | Preview

Play ‘ I Stop ‘ I ==

Setting Description

Forward << /

Go forward or backward of the video. (in minutes)
Backward >>

Play / Pause Select to start playing video or pausing.

Stop Stop playing and close the video file. To test another video, please
stop playing the current video first.

Load Select a video to preview.

0 Note

B Only one video file can be played at one time.

B If [control address] is not enabled and [Auto. repeat] is not selected, after finish playing
the first file, the system will stop playing and close the video file.

B If [control address] is not enabled, the system will find the first file in the designated
folder and start to play (in ascending order of the file name).

B |f the file can be previewed, the format is supported. If the video image quality is poor,
please adjust the resolution.

B The supported formats: mpeg4, xvid, flv...etc.

B The recommended frame rate for videos is 30fps.

i Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.26. BACnet Schedule

13.26.1. Overview

BACnet Schedule helps visualize and access schedule data (Schedule) in BACnet IP controller
with a graphical Ul. This feature is only applicable for cMT / cMT X Series HMI.

MON TUE WED THU FRI SAT
01:00 01:00 01:00 01:00
Low Low Low Low

02:00
Low
03:00 03:00 03:00 03:00
Mid Mid Mid Mid
04:00
Mid
05:00 05:00 05:00 05:00
High High High High
06:00
High

Add BACnet/IP driver into the device list in System Parameter Settings and check whether a
Scudule is contained in the scanned BACnet/IP device or the imported tag file.
Click [Object] » [Time Related] »[BACnet Schedule] icon on the toolbar to open the BACnet

Schedule property dialog box. Configure the parameters and then click OK, a BACnet Schedule
object is created.
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Objects
General Tab
( New BACnet Schedule Object
General ‘
Comment :
Device : [ Master BMS Panel v
Address : [(17,1)Schedule -
Option button visibility
©@ Predefined ) Dymamic
7] Enable
[ OK ] [ Cancel ] ( Help
Setting Description
Device Select the BACnet/IP device to be read.
Address Select the address tag of the Schedule to be read.
Option
button Show or hide the option button
visibility (cMT .
v Predefined
/ cMT X .
Series) Select [Enable] to show the option button.
Dynamic
Ciption button visibilite
() Predefined @ Dymamic
Device : [Losal HMI &)
Address: |LB ~|0
Designate a bit address to control option button visibility.
Example 1

After downloading the project to HMI, the HMI will automatically read the schedule settings in

the BACnet IP device as shown below.
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%, T Viewer { Simulation )

Click . and then select Value Editor to configure the Values table containing these

columns: Name, Value, Data Type, and Color, as shown below.

7, eMT Viewer  Simulation )

Default value

No Name

No Name

No Name

No Name

No Name

Values

Done

ik

69b735db775cf3ffff

4deb2d2629a6cb5db7

69b71d79fd76df8e7aefco

d76dfcab493e

e39ebcf75d35

Octetstring
OctetString
OctetString
OctetString

OctetString

OctetString

Click e to add a schedule setting. Click @ to refresh schedule data by reading from the

BACnet device.
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e 7
., eMT Viewer ( Simulation ) o= | ]
{.’3}
SUN MON TUE WED THU FRI SAT
00:00 00:00 00:00 00:00 00:00
No Name No Name No Name No Name No Name

As shown in the following screenshot, in a schedule settings window, the Weekday, start time

(From), end time (To), and Value should be configured. Value can be selected from the value

table. (Clicking £ open Value Editor for editing the value table as well.)

(s
., eMT Viewer ( Simulation)

Cancel Option

Weekday

From

To

After the time settings are completed, the values will be written to the corresponding schedule tags

in BACnet device.
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13.27. PLC Control

13.27.1. Overview
PLC Control object can execute commands when it is triggered.

13.27.2. Configuration

it

Click [Object] » [PLC Control] icon on the toolbar to open the PLC Control Object management
dialog box. To add a PLC Control object, click [New], set up the properties, press OK button and
a new PLC Control object will be created.

PLC Control Object

[Local HMI = LB-8999] == Sound control : OFF-=0MN, PLC no response (67 k)
[Local HMI : Lw-100] == Change window (clear data after window changed)
[Local HMI : LW-110] == Write data to PLC {current base window ID)

[Local HMI : LW-120] == General PLC control

Local HMI : LW-120] => Change window (clear data after window changed
Local HML: E

1:
2:
3:
4
5:
[

[ Mew... ] [ Delete I [ Settings... I
Click [New] and the following dialog box appears. See “13.27.2.1 Type of Control”.

PLC Control
Comment :
PLC name : [Loal HMI ']
Attribute
Type of control : {Change window i

Change window
Active only Wyrite data to PLC {current base window ID)
General PLC control
[T Turn on back Back light control {write back)
. Back light control
[ use windew roy i contral
Execute macro program
Trigger address  Screen hardcopy

PLC name :  Local HMI
[ oK ] [ Cancel

0 Note
[ ]

The [General PLC Control] option is not available for cMT / cMT X Series.

B Triggering [Screen hardcopy] in cMT Viewer will result in files being saved into the USB
disk / SD card connected to the cMT / cMT X HMI. Likewise, the [Back light control] option
in cMT Viewer will control the backlight of the HMI itself.
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B Selecting [Change window] or [General PLC Control] as [Type of control] will require more

than one trigger word (consecutive). Using a user-defined tag PLC will require declaring an

array datatype.

13.27.2.1.

Type of Control

® Change window

PLC Control
Comment :
PLC name : Local HMI 7]
Attribute
Type of control [Change window "]

Active only when designated window opened 4, Common Window v]

[ Turn on back light Clear data after window changed

[ Use window no. offset

Trigger address

Address : | Ly v] 0 16-bit Unsigned
[ OK l [ Cancel ]
Setting Description

Active only when
designated

window opened

Allow this operation only if a particular screen is displayed.

Turn on back light

The backlight is turned ON when the window is changed.

Clear data after
window changed

Reset the value at trigger address to zero when the window
object is changed. If [Use window no. offset] is selected, this

option will only show when a negative offset is used.

Use window no.
offset

Select the check box and select a window offset, the new

window no. to change to will be the value in [Trigger address]

plus the offset. For example, if [Trigger address] is LW-0 and
offset is set to -10. When the value in LW-0 is 25, the system
will change to window no. 15 (25-10=15). The range of the
offset is -1024 to 1024.

@ Note

B If[LB-9017] is set ON, the write-back function will be disabled, the new window number is

not written back into a designated address.

Place a valid window number in the designated trigger address to change the base screen to

the new window number. The new window number is written back into the designated
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address.

For example, if current window is window no. 10, and [Trigger address] is set to LW-0,

When LW-0 is changed to 11, the system will change the current window to window no. 11,
and then write 11 to LW-1.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

When the window is changed, the new window number is written back into the address that is

calculated by [Trigger address] and the data format, as shown in following table.

Data Format Trigger address Write address
16-bit BCD Address Address + 1
32-bit BCD Address Address + 2
16-bit Unsigned Address Address + 1
16-bit Signed Address Address + 1
32-bit Unsigned Address Address + 2
32-bit Signed Address Address + 2
64-bit Unsigned Address Address + 4
64-bit Signed Address Address + 4

¥

= Click the icon to download the demo project. Please confirm your internet connection
before downloading the demo project.

® Write data to PLC (current base window)

Each time the base window is changed, the new window number will be written into the
[Trigger address]. If [Use window no. offset] is selected, the window number of the base
window plus the window number offset will be written into the [Trigger address].

® General PLC Control (eMT, iE, XE, mTV)

Transfer word data blocks from PLC to HMI, and vise-versa, and the transfer direction is

controlled by the value in the [Trigger address].

Value in Action

[Trigger address]

1 Transfer data from PLC register 2 HMI RW register
2 Transfer data from PLC register 2 HMI LW register
3 Transfer data from HMI RW register - PLC register
4 Transfer data from HMI LW register - PLC register
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Four consecutive word registers are used as described in the following table:

Address Purpose Description

[Trigger Determine the The valid values are listed in the

address] direction of data above table. When a new control

transfer code is written into the register,

HMI will start to transfer. After data
transfer is finished, the value will
be set to 0.

[Trigger The size of data The unit is word.

address] +1

to transfer.

[Trigger
address] +2

Offset to the
start address of
PLC register

oaw_n

Assume the value is “n”, where n is
an arbitrary number, the start
address of PLC register is [Trigger
address + 4 + n].

Take an OMRON PLC as an
example:

If [Trigger address] uses DM-100,
[Trigger address + 2] will be DM-
102. If the value in DM-102 is 5,
the start address of data source
would be DM-109 (100 +4 +5 =
109).

[Trigger
address] +3

Offset to the
start address of
LW or RW

memory in HMI

Take OMRON PLC as an example:
If set [Trigger address] to DM-100,
[Trigger address + 3] will be DM-
103. If the value in DM-103 is 100,
the start address of memory in
HMI is RW-100 or LW-100.

Example 1

To use PLC Control object to transfer 16 words data in OMRON PLC, starting from address DM-
100, to the HMI address, starting from RW-200. The setting is shown below:

1. Firstly, create a PLC Control object, set [Type of control] to [General PLC control], and set

[Trigger address] to DM-10, that is, to use the four sequential registers start from DM-10

to control data transfer.

2. Confirm the data size and the offset addresses.

Set DM-11 to 16, since the number of words to transfer is 16 words.
Set DM-12 to 86, which indicates the address of data source is DM-100 (100=10+4+86).
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Set DM-13 to 200, which indicates the destination address is RW-200.

3. Set DM-10 according to the direction of data transfer.
If set DM-10 to 1, the data will be transferred from PLC to HMI RW register,
If set DM-10 to 3, the data will be transferred from HMI RW register to PLC.

® Back light control (write back)

When [Trigger address] is turned ON, HMI backlight will be turned ON/OFF and [Trigger
address] will be turned OFF. Any touch on the screen will turn the backlight on.

® Back light control

When [Trigger address] is turned ON, HMI backlight will turn ON/OFF and the state of [Trigger
address] will not be changed.

® Sound control

When the state of the designated [Trigger address] changes, the HMI will play the sound
selected from the sound library. There is a further selection determines whether the sound is
played after Off to ON, ON to OFF transition, or at both of the changes of state.

® Execute macro program

Select a pre-defined Macro from the drop-down list. When the state of the designated [Trigger
address] changes, the selected Macro is executed. There is a further selection determines
whether the Macro is executed after Off to ON, ON to OFF transition, or at both of the changes
of state. If select [Always active when ON], the macro will be executed repeatedly. (The
shortest time interval between runs is 0.5 second.)

® Screen hardcopy

PLC Control

Commen it:

Device : |Local HMI -
attribute
Type : [sereen hardcopy s

Active only when designated window opened

Rotate image 90 degrees

Trigger

Device : |Local HVI = [
Address : [LB ~|0
Screen hardcopy
Trigger mode : | OFF->0N -
Source window
Current base window @) Window no. from register Designate window no.
Device : | Local HML \_/-_‘ |_|7?
Address @ | LW >0 16-bit Unsigned
Cutputto : |UsE disk 1 -
| Customized filename handiing Settings...
| Crop window Settings...
G

I__| WE!NTEK EasyBuilder Pro V6.10.01



Objects 13-210

When the state of the designated [Trigger address] changes, print the selected screen. If select
[SD card] or [USB disk] as [Printer], a “hardcopy” folder will be generated in the selected
external device for saving the printed screen in JPG format. The name of the JPG files starts
from yyyymmdd_0000.

To print the screen using a printer, go to System Parameter Settings » Model tab and set the
printer.

To print the screen using a remote printer, go to System Parameter Settings » Printer/Backup
Server tab and configure the parameters.

There are three options to specify the source window for hardcopy:

Current base window

Print the base window currently opened.

Window no. from register

Print the window designated by the value in a designated word address.

Designate window no.

Directly select a window to be printed.

Customized File Handling

This feature can be used to customize naming of the folders and the JPG files.

Setting Description

Folder name The folder name can be an alphanumeric name, and
certain half-width symbols are allowed:
l@#S%"&()_+{}-=;",.

The folder name can also be specified by a naming syntax.
Dynamic format

The folder names can be set by a designated word
address, or by a naming syntax indicating the current
system time. The syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

Note: Up to 10 layers of folders can be created. The

exceeding layers will be ignored.

File name The way to specify a file name is similar to specifying a

folder name.

Note: If the file name already exists, the system will add

“_0001” to the file name as a serial number. The numbers

of the later files add up until “_9999”. The files after

“9999” will be ignored.

For example, if the three file names exist: “A.jpg”,
“A_0001.jpg”, “A_0003.jpg”. When trigger screen
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hardcopy with the same file name, the coming files will
be named in this order: “A_0002.jpg”, “A_0004.jpg”,
”A_0005.jpg”, and so on.

Crop window
With this option selected, taking a cropped screenshot is possible.

Crop Window x

10. WINDOW_010 hd

LQ, Event bit

Trigger time Message

10:07:29 Event triggered!

x v

OK Cancel

@ Note

B A background printing procedure is performed when the printed window is not the
current base window.

B If the hard-copied window is a background window, its [Direct Window] and [Indirect
Window] objects will not be printed.

o n

B When using a dynamic format name, the system will use a sign as a substitute for

invalid symbols.

B When using a dynamic format name, if screen hardcopy is triggered without specifying
the format first, the system will save the file in the default directory, which is:
hardcopy\yymmdd_0000.JPG

B On cMT/cMT X models, a triggered bit address is reset to its original state automatically,

whereas on eMT/iP/iE/mTV models, the state of a triggered bit address is retained.
i- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.28. Scheduler

13.28.1. Overview

Scheduler object turns bits ON/OFF, or writes values to word registers at designated start

times. It works on a weekly basis.

13.28.2. Configuration

il

Click [Object] » [Time-related] » [Scheduler] icon on the toolbar to open the Scheduler

management dialog box, click [New] to open the Scheduler property setting dialog box.

Scheduler

The following two demonstrations explain the usage of Scheduler.
Example 1
A motor is scheduled to power - ON at 9:00 and power — OFF at 18:00, Monday to Friday.
We are using LB-100 to control the motor state. LB-100 will be set ON at 9:00 and OFF at 18:00.
1. Click the Scheduler icon on the toolbar to open the Scheduler management dialog box,
click [New].
2. In[General] tab, select [Bit ON] in [Action mode] and set [Action address] to LB-100.

Scheduler @
General | Time Set | Prohibit

Comment : Scheduler 1

7] Power-ON start/end action
Action mode

@ BitoN ) Bit OFF © Word write
Action address
PLC name : |Local HMI +| [ setting...

3. In[Time Set] tab, select [Constant].
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Scheduler

| General | Time Set | prohibit |

@ Constant ) Address

[ setting on individual day
Start

9 = HE =

End
Enable termination action

18 = HE =

: )
[5un Mon Tue Wed

HE

= | (HH:MM:55)

[¥]Thu

| (HH:MM:55)

Fri [[sat

4. Enter [Start] time as 9:00:00 and select Monday to Friday. Do not select [Setting on

individual day].

5. Enter [End] time as 18:00:00 and select [Enable termination action] check box.
6. Click [OK], a new Scheduler object will be created on the [Scheduler] list.

Example 2

A thermal heater is scheduled to heat up to 90°C at 08:00 and cool down to 30°C at 17:00,
Monday to Friday. LW-100 is used to store the set point value.

1. Click the Scheduler icon on the toolbar to open the Scheduler management dialog box,

click [New].

2. In [General] tab, select [Word write] in [Action mode] and set [Action address] to LW-100.

3. Select [Constant] for [Word write value settings] and enter 90 in [Start value].

Scheduler

General | Time Set | Prohibit

s

Comment : Scheduler 2

Action mode
) BitOM

Action address

|| Power-ON startfend action

7 Bit OFF

@ Word write

PLC name : lLocaI HMI

vI Setting...

Word write value settings
@ Constant

Startvalue : gg

End value : 3p

4. In[Time set] tab select [Constant].

Address 1 |Lw w | 100

) Address

16-bit Unsigned

Enter [Start] time as 8:00:00 and select Monday to Friday. Do not select [Setting on

individual day].

6. Enter [End] time as 17:00:00 and select [Enable termination action] check box.

Return to [General] tab and enter 30 in [End value].

8. Click [OK], a new schedule object will be created on the [Scheduler] list.
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General Tab
Scheduler @I
Comment : Scheduler 2
Power-ON startfend action
Action mode
() BitON () Bit OFF @ Word write
Action address
PLC name :[Lgcal HMI v] Setting...
Address i[L\.I‘u' - | 100 15-bit Unsigned
Word write value settings
(@ Constant () Address
Startvalue : ap
Setting Description
Power ON Execute the defined action when the HMI is powered ON.
start/end ® Enabled
action When HMI is powered ON within the scheduled time range, the

start action will be performed automatically. When HMl is powered
ON outside the scheduled time range, the termination action will

be executed.

Inside scheduled range

Start time Power ON End time

T

Start action Termination action

Outside scheduled range

Power ON Start time End time
1 ]
': ! i
Termination action Start action Termination action
® Disabled

When the HMI is powered ON at a time later than the start time,
the start action will not be performed, but the termination action
will be performed. When the termination action is not defined, the

scheduled range is not recognized and no action is performed.
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Action mode

Choose the action to do at the given time.

Bit ON

At the start time, set the designated bit ON. At the end time, set
the designated bit OFF.

Example: Start time : 09:00:00 End time : 17:00:00

Start time End time
ON : ; '
09:00:00 12:00:00 17:00:00
Bit OFF

At the start time, set the designated bit OFF. At the end time, set
the designated bit ON.
Example: Start time : 09:00:00 End time :17:00:00

Start time End time
o i
_I : I_
OFF i i i
09:00:00 12:00:00 17:00:00
Word write

The [Write start value] entered here is transferred to the
designated [Action address] word register at the start time. At end
time, the [Write end value] entered here is written to the [Action
address]. The valued can be entered manually or be set by using
[Address] mode. In [Address] mode, the value in the specified
address is the start value where the value in [Address + 1] is the
end value.

Example: Device address: LW-100

Start time: 09:00:00 End time: 17:00:00

Write start value: 10 Write end value: 0

Use register: If control address is LW-n, then enter 10 in LW-n and
enter 0 in LW-(n+1).

LW-100 10 LW-100 0

09:00:00 17:00:00
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@ Note

B Onlyisan [End time] is set in the [Time set] tab will the [Write end value] box appear.

Time Set

Specify start time and end time. [Constant] allows specifying a date or period and time.

[Address] allows controlling the time by the designated address.

[T setting on individual day

End
[|Enable termination action

Start
E] o0 o0 S| (HH:MM:55)
[ sun Man [¥] Tue Wed (V] Thu Fri

[ zat

Scheduler @ Scheduler
General | Time Set | prohibit General | Time 5et | prohibit
@ Constant (7 Address () Constant @ Address

Time setting address

PLC name : [ana| HMI

v] Setting...

Control : [Lw : 0
Status L0 +1
Actionmode : [y . +2
Start time {day) : [Lw:0 +3
Start time (hour) : LW : 0 +4
Start time {minute) : LW :0 +5
Start time (second) : (LW : 0 +&
End time (day) : [Lw:0 +7
End time (hour) @ (LW : 0 +8
End time (minute) : (LW ;0 +9

End time (second) : |Lw : 0 + 10

® Constant
Setting on individual day

If [Setting on individual day] is selected

The same start time and end time can be assigned to different days of the week.

I__| WE!NTEK

Scheduler @
General | Time Set | prohibit
@ Constant () Address
[¥] setting on individual day
Start
] = : o o 0 2| (HH:MM:53)
) 5un @ Mon () Tue “iwed ) Thu () Fri () sat
End
Enable termination action
17 = : |0 = L | (HH:MM:55)
) 5un OMon @ Tue Ciwed O Thu () Fri () 5at

Start action
09:00

Termination action

Monday |-I

Tuesday
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A@ Note

B Start and end time must be entered.

13-217

B Start and end time must be on a different time, or same time but different day.

If [Setting on individual day] is not selected

Start time and end time entered must start and end within 24-hours.

@ Note

Scheduler @
General | Time 5et | prohibit
@ Constant Address
Setting on individual day
Start
9 = o0 = 0 = (HH:MM:5S)
Sun V| Man | Tue Wed Thu Fri Sat
End
/| Enable termination action
17 = 0 = L] 1 (HH:MM:55)

Monday

Start action

Termination action

09:00 17:00

Tuesday

B Start time and end time must be on a different time, different day.

B [fan end time is earlier than a start time, the end action will occur in the next day.

Start date: Monday
Start time: 22:00

End time: 01:00

® Address

Monday Tuesday
o —
22:00:00 01:00:00

The scheduler object retrieves the start/end time and day of week information from word

registers, enabling all parameters to be set and changed under PLC or user control.

Designated as the top address in a block of 11 sequential registers which are used to store time

setting data.

The format of the 11 word registers should normally be 16-unsigned integer. If a 32-bit word

address is chosen, only bits 0-15 are effective, and bits 16-31 should be written as zero.

The following describes each register.

Control (Time setting address + 0)

When [Control] bit is ON, the HMI will read and update [Action mode], [Start time], and [End

time] values.
15

‘ Reserved (0 fixed)

Bit 0: no action 1: read times/action mode

I__| WE!NTEK

EasyBuilder Pro V6.10.01



Objects

A@ Note

13-218

B HMI will not regularly read the data from [Action mode] (address + 2) to [End time]

(address + 10). Please turn [Control] ON when the settings are changed.

Status (Time setting address + 1)

When the read operation is completed, Bit0O of this register turns ON. If time data read is out

of range or incorrect in any way Bit01 turns ON.

15

02 01 00
Bit

Reserved (0 fixed)

Bit 00: Status bit: Read operation completed. (0: reading or reading not started. 1:

reading completed.)

Bit 01: Error bit: Start or end time format incorrect. (0: corrected 1: error)

A@ Note

B After the scheduler reads the data and the status is turned ON (The value in [Address + 1]
= 01), the control bit must be turned OFF (address = 0). The status bit and error bit will be
turned OFF (1-0) at the same time.

Control Bit
{PLC to HMI)

Data in Registers

(PLC to HMI)

Status Bit
(HMI to PLC)

Error Bit
(HMI to PLC)

1 i 6 11
DN 1 1
i : <> [ :
QOFF 1 [ I 1 [ [ 1
D22 LT L2
" * M * \ v
HMI confirms that Control Bit HMI confirms that Contral Bit:
issetON 1 isset OFF ! ! !
; | | : ; | \
—— 3 Read Data - — - % 3 Read Data >
P R T N
P 4 v A T P
| HMI turns Status Bit ON 4= | ) Vo
ON Vo 5 : 8 o
Lo : P Lo
DFF ] : : [ : [ : i
L o N
i ] -’i ' ] i [ ]
1 [ ] [ |
i [] ¥ i L i
1 Error Bit turns ON when.'.' K . X
| error ocours L4 P
ON P .\ 5 8 N
L ; g Lo
OFF

= Communication delays
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Action mode (Time setting address + 2)

Enable/disable [Enable termination action] and [Setting on individual day]. Whatever the
[Enable termination action] bit is, all the time data, from [Control] to [End time (second)], will
be read.

15 02 01 00

it

Reserved (0 fixed) | 0|0 ‘

Bit 00 Enable termination action (0: Disabled 1: Enabled)
Bit 01 Setting on individual day (0: Disabled 1: Enabled)

@ Note

B If [Enable termination action] is OFF, all 11 registers are still read but end time is ignored.
B [f [Setting on individual day] is ON, make sure that all start end times are entered. If more

than one start / end day bit is ON, and error will occur.

Start/End Day (Start Day: Time setting address + 3, End Day: Time setting address + 7)
Designates which day of week is used to trigger the start or end action.

15 07 06 05 04 03 02 01 0o Bit

Reserved (0 fixed) I Sat I Fri lThu |WEd lTue ]MﬂnlSur ‘

Bit 00 Sunday (0: not used 1: used)
Bit 01 Monday  (0: not used 1: used)
Bit 02 Tuesday  (0: not used 1: used)
Bit 03 Wednesday (0: not used 1: used)
Bit 04 Thursday (0: not used 1: used)
Bit 05 Friday (0: not used 1: used)
Bit 06 Saturday (0: not used 1: used)

Start/End Time (Start Time: Time setting address + 4 to + 6, End Time: Time setting address +
8 to + 10)
Hour: 0 — 23 Minute: 0 — 59 Second: 0 - 59

Values outside these ranges will cause error.

@ Note

B 16-bit unsigned integer format must be used; BCD format is not supported here.

B |n [Address] mode, [Control] bit should be set after HMI reboots to update scheduler
time.

B When using RW address, [Control] bit should be set after HMI reboots to update
scheduler time. Placing a Set Bit object with [Set ON when window opens] selected in the

common window is recommended, this can retain last settings after HMI reboots.
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Prohibit tab

Before the scheduled action is performed, the HMI will read the specified bit state. If it is ON,

the scheduled start/end action will be skipped. Otherwise, it will be performed normally.

A@ Note

End time depends on [Action mode] (address + 2). [Enable termination action] (Bit 00)
and [Setting individual day] (Bit 01) are related:

Setting individual day Enabled Disabled
Enable termination action Enabled Enabled Disabled
Scheduler @
General | Time Set | Prohibit
Prohibit
| Use prohibit function
PLC name : |Local HMI | [ setting...
Address : |1 |0

Action: Set Bit

ON .
Start time: 08:00:00
End time: 08:20:00 OFF
07:50:00

I__| WE!NTEK

Start time

The maximum number of Scheduler objects in a project is 64.
A time schedule applies one action only when the start time is reached.

User set OFF

08:00:00

End time

18:10:00

18:20000

[Write start/end value] and [Prohibit] bit is read only once before start action. After that,
even to change the state of [Prohibit] bit or [Write start/end value], the end action and
the value written will not be affected. Also, to read data of [Write start/end value] and
[Prohibit] bit, there is a delay of start action due to the communication.
Each time RTC data is changed, scheduler list entries that possess both start and end
times will be checked for in-range or out-range conditions. For in-range, the start action
will occur. If the end action is not set, the new range is not recognized, the action will not

If several Scheduler objects are set to the same start time or end time, the action is
performed in ascending order of the schedule number.

13-220
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B In[Time Set] » [Address] mode, the system will read [Control] word regularly. The length
of the period depends on the system.

B In[Time Set] » [Address] mode, when start time and end time is out- range, error occurs
in the set action time. (Note: BCD is not an acceptable format)

B In[Time Set] » [Address] mode, the action will not start up until the first time the time
data is successfully updated.

4

- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.29. Option List

13.29.1. Overview

13-222

Option List object displays a list of items that the user can view and select. Once the user

selects an item, the corresponding data will be written to a word register.

There are two forms of this object — [List box] and [Drop-down list]. The [List box] lists all items

and highlights the selected one. The [Drop-down list] normally displays only the selected item.

Once the object is pressed, the system will display a list (which is similar to list box) as shown in

the following figure.

13.29.2. Configuration

=]

Listbox

14 Apr. 2009
13 Apr. 2009
12 Apr. 2009
11 Apr. 2009
10 Apr. 2009
09 Apr. 2009

Drop-down list

14 Apr. 2009 |

14 Apr. 2009

14 Apr. 2009
13 Apr. 2009
12 Apr. 2009
11 Apr. 2009
10 Apr. 2009

Click [Object] » [Option List] icon on the toolbar to open an Option List object property dialog

box. Set up the properties, press OK button, and a new Option List object will be created.
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Option List Tab

13-223

eMT, iE, XE, mTV Series cMT / cMT X Series
New Option List @ Option List's Properties @
Option list [Source data | Mapping | Security | Shape [ Label | Option list [Source data | Mapping [ Security [ Label [ Profile
Comment : Comment :
Attribute Attribute
Mode : | Drop-down List v Direction : |Down v Mode : | Drop-down List v Direction : |Auto v
Background color : ] Background color : ] Style : |Standard. v ‘
Selection color : [ I ) Selection color : [ ] Font size : |Fixed size x]
Row height : |Small v
Monitor Monitor
Device : [Local HMI v“ | E<))] Device : [Local HMI v“ & [G)
Address : [LW v|0 16-bit Unsigned Address : LLW v|0 16-bit Unsigned
Send notification after writing successfully Send notification after writing successfully
[“/Enable [T/Enable
ok | cancel |[ hHep | ok | concel |[ hHep |
Setting Description
Attribute Mode: The list style, either [List box] or [Drop-down list].

Background color: Set the background color.

Selection color: Set the background color for the selected item.
Direction: With the [Auto] option selected, the Option List expands
based on its vertical alignment with the window's centerline as the
reference. If the Option List is positioned above the centerline, its
menu content expands downwards; conversely, if it's positioned

below the centerline, the menu content expands upwards.

Expands downwards above the centerline.

[r—

Expands upwards below the centerline.

With the [Down] option selected, the Option List will consistently
expand downwards. Conversely, with the [Up] option selected, the
Option List will consistently expand upwards.

Please note that if the object is positioned near the window's edge
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and the option to expand towards the edge is selected, the menu
content display will be compressed.

Style: This option is available only when the selected mode is
[Drop-down list]. Available styles are: [Standard] and [Classic]. The
appearance of the objects will be shown in cMT / cMT X Style when
[Standard] is selected, and shown in iE/eMT/XE style when [Classic]
is selected. When the project is converted from iE/eMT/XE to cMT /
cMT X, the default style will be [Classic].

Font size: When [Same size as label] is selected, the font size set in
Label tab will be used for the drop-down list. When [Fixed size] is
selected, the system default font size will be used for the drop-
down list.

Row height: Set the row height for the drop-down list.

Monitor The corresponding value of the selected item will be written to
address [Monitor address].
Write when button is released
If this check box is selected, the selected item value will be written
to [Monitor address] after the button is released.

Send
notification Set On/Off the designated bit address after successfully writing
after writing data to PLC.

successfully

@ Note

B The [write when button is released] option is not available on cMT / cMT X Series models.

13.29.2.1. Source of item data

® Predefine
The list is manually defined in [Mapping] tab.
The number of items can be adjusted by [Item no.], and each item represents one state. Each

item has a corresponding value which will be written to [Monitor address].

® Dates of historical data

New Option List @

Oplion list | Source data ‘Mappmg | Securnty | Shape | Label ‘

Seouree of itam data : lDaLes of history data 'I

ltem data from dates of historical data
Type @ IEvem (Alarm) Log 'J Date : lMMfDDfYY 'I
[ Enable [delete history files] function
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Option List object can be used with historical data display objects, such as Trend Display object,
History Data Display object and Event Display object to control which history file should be

shown. The figure below is an example of Option List used with Trend Display.

06/11/09 -
ﬁ—z [Efl\‘%% AAMAMIA .;\Wl_a\;\nvn ML

o VANNIAL WY SR
ooy B rwam i *.‘xhﬁz.mlﬁmxh AR
06/06/09 ﬂ \ f {
U 13:14:18 13:14:38 13:14:58  13:15:18  13:15:38  13:15:58  13:16:18
LR LAY
Setting Description
Type Two options are available: [Event (Alarm) log] and [Data sampling].
Date Set the date format. YYYY means a four digits year (EX: 2012), YY
means a two digits year (EX: 12), MM means month and DD means
day.
Data Select which Data Sampling object is displayed when [Type] is [Data
Sampling Sampling], and it should be the same as the [Data sampling object

index] configured in [Trend Display] or [History Data Display].

Enable

[delete If selected, a control address can be set. Writing “1” to this address
history data] will delete the history data of the specified date.

function

0 Note

B In [Dates of historical data] mode, since the system automatically reads the historical data
and finds the date information, it is not necessary to configure in the [Mapping] tab.
B The error message displayed in Option List can be modified in [Mapping] tab.
Ttern Walue Tten data
» 0 {ermor) Exvor!!
® Item address
The list will be read from the given [Iltem address] and controlled by [Control address]. The

following options will be available:
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Option List Object's Properties (=

[ Option list| Source dats | Mapping | Security | Label | Profile

Source of item data : [Ihem address v]
Control
Device : Local HMI <G ]S
Address: LW v|0 I

[Address] : set 1 to update item data [Address] + 1 : item count

Item

[ Reverse highflow byte The length of each item : 5 word (s)

Encoding : [UTF-8 (Default) v

Device : [LocalHMI V][ 2 H_TEJ

Address: |[LW v |0

Setting Description

Control [Address]: If the value at this address is changed to 1, the option
list would be replaced by items defined at [Item address]. After
updating, the value will be restored to 0.
[Address + 1]: Define the number of items in [Iltem address].

Item Assign the item address
UNICODE
The item will use UNICODE characters, such as Chinese characters.
The length of each item
Define the number of letters for each item, the unit is Word.

0 Note

B The UNICODE characters used here should be used by Text object, so that EasyBuilder Pro
will compile the needed fonts and download these fonts to HMI, then the UNICODE
letters can be correctly displayed.

B [The number of items] multiplied by [The Length of each item] must be less than 4096
words.

B In [Item address] mode, the system automatically disables the settings in [Mapping] tab.

B After changing windows, the item address content will be removed. To retain it, use "Set

when window opens" setting of Set Word object for automatic content update.

¥

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

® User account

If [Enhanced Security] mode is enabled, [User account] would appear in the [Source of item
data] and it lists the names of users.
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Objects
Option List Object's Properties
[ Option list| Source data | Mapping | Secusity | Label | Profile |
Source of item data : [User account v]
User account
Sort
[ Ascending [7] Descending
Display
[T Privilege [ Secret user
Setting Description
Sort Select the sorting method from [Ascending] of [Descending].
Display If [Privilege] is selected, the privileges for each user will be

displayed in option list.

If [Secret user] is selected, even though it is defined to be hidden in

[System parameter settings] » [Security] » [Enhanced Security], the

users will still be displayed in [Option List].

@ Note

B The address that controls user index is [Control Address +2 (LW-n+2)] which is set in

[System Parameters] » [Security] » [Enhanced Security].

B The [Privilege] option is not available on cMT / cMT X Series models.

Mapping Tab

This table displays all available states/items, their item data and values. To change the number

of available items, please go to [Option list tab] » [Attribute] » [Item no.].
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New Option List Object
| Option list | Source data | Mepping | Secusity | Label | Shape |
Ttem Value Ttern data (A]
0 0
1 1 @
2 2
3 3
4 4
5 (error)
Set default
Import itemn data from recipe record
Error notification
[]Enable
[ OK ] { Cancel ] | Help
Setting Description
Item The system lists all available items. Each item represents a state
that will be displayed in the list. This field is read-only.
Value Here user can assign value for each item, basing on the following
two criteria:
For reading: If the value in [Monitor address] is changed, the object
selects the first-matched item. If no item is matched, the status
goes to error state and signals the notification bit register (if
requested).
For writing: The system writes this value to [Monitor address] when
user selects an item.
Item data Text displayed for each item. The Option List object displays the

text of all items in the list for users to review and select.

Import item
data from
recipe record

This feature is enabled when select [Recipe-Selection] as [Monitor
address]. Click [Import item data from recipe record] to open the
[Records of Recipe Database] setting dialog box. Select [Item data
source], the data belonging to the selected column will all be

imported to Option List object.
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Select a recipe item ..

Item data source : | Newltem v ‘

l Ok ]’ Cancel ‘

Before importing, the number of items in Option List changes
according to the number of items defined in Records of Recipe
Database.

After importing, modifying Records of Recipe Database will not

change the content of Option List.

Error state

On error state, the list box removes the highlight to represent no
item is selected and the drop-down list displays the data of error
state. Only the drop-down list uses error state, list box is not able to
use error state.

For example, item number 8 is the error state when specifying 8 in
[Item no.]. (The first item number is 0)

Set default Reset all values or states to default. That is, set 0 for item 0, 1 for
item 1, and so on.
Error The system will set ON/OFF to the specified bit register when error
notification is detected. The signal of the bit register could be used to trigger a
procedure for correcting the error by using objects such as Event
Log, Alarm Bar, or pop-up window.
¥

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.30. Timer

13.30.1. Overview

Timer object can be used to count the time in a specified mode. Timer object uses the
following 6 variables:

Timer Variable Type Description

Input bit (IN) Bit The main switch of Timer.

Measurement bit (TI) Bit Turns ON when the Timer begins
counting time.

Output bit (Q) Bit Activated when the Timer finishes
counting time.

Preset time (PT) Word Presets a time before the Timer
begins counting time.

Elapsed time (ET) Word Displays the elapsed time.

Reset bit (R) Bit Resets the elapsed time (ET) to 0.

Timer (Per-page): The Timer can be placed in a project window and be activated only in that
window.

Timer (Global): Regardless of which window is displayed on HMI, the Timer starts counting
time when the Input bit is in ON state.

13.30.2. Configuration

'.'?" .

o 1
Click [Object] » [Time-related] » [Timer] icon on the toolbar to open the property dialog box as
shown in the following figure.
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Tirmer @
Timer
Description :
Input bit (IM)
Mode : [on delay -] PLC name : Local HMI ][ Setting...
Time base : [0‘ 1 second(s) ']
Qutput bit (Q)
PLC name 5[Loa| HMIL - ][ Setting... ]
w—l woesle
TI— PT | PT Measurement bit (TT)
PLC name =[Lo<3| HMIL v] Setting...
Elapsed time (ET) Preset time (PT)
Enable [7] Constant preset time
PLC name : || ocal HMI Setting... PLC name :[Lml HMI v] Setting...

Address : [i] 16-hit Unsigned Address : | Lw 10 16-hit Unsigned

I

@ Note

B [Constant preset time] is only available for cMT / cMT X series.
B InacMT/cMT X project, after the [Timer (Global)] icon is clicked, a Timer management

window opens in which timers can be added by clicking [New].

Timer

Mew... ] ’ Delete ] ’ Settings...
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® Ondelay
Mode Register
Input bit (IN): The main switch of Timer.
IN— Measurement bit (TI): Turns ON when the Timer
- - o begins counting time.
s = Output bit (Q): Turns ON when the Timer finishes
Q counting time.
L 2 3 @ 15 Preset time (PT): Presets a time before the Timer
begins counting time.
Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, Tl turns ON and the ET starts counting. The Q remains OFF.
Period 2: When the ET equals to the PT, the Tl turns OFF and the Q turns ON.

Period 3: When the IN turns OFF, the Q turns OFF and the ET is reset to 0.

Period 4: When the IN turns ON, the Tl turns ON and the ET starts counting. The Q remains
OFF.

Period 5: Turns IN OFF before the ET reaches the PT, the Tl turns OFF, and the ET is reset to O.
Since the ET doesn’t reach the PT, the Q remains OFF.

® Off delay
Mode Register
Input bit (IN): The main switch of Timer.
IN Measurement bit (TI): Turns ON when the Timer
. - e | PT begins counting time.
Output bit (Q): Turns OFF when the Timer finishes
Q— counting time.

Preset time (PT): Presets a time before the Timer
begins counting time.
Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, the Tl remains OFF and the Q turns ON, the ET is reset to 0.
Period 2: When the IN turns OFF, the Tl turns ON and the Q remains ON, the ET starts
counting.

Period 3: When the ET equals to the PT, the Q and Tl turn OFF.

Period 4: When the IN turns ON, the Tl remains OFF and the Q turns ON, the ET is reset to 0.
Period 5: When the IN turns OFF, the Tl turns ON and the Q remains ON, the ET starts
counting.

Period 6: Turns the IN to ON before the ET reaches the PT, the Tl turns OFF, the Q remains
ON, and the ET is reset to O,.
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® Pulse

Mode Register

Input bit (IN): The main switch of Timer.
IN —I - Measurement bit (TI): Turns ON when the Timer

begins counting time.

TI—J PT PT
Output bit (Q): Turns ON when the Timer begins

Q— S counting time and turns OFF when the Timer
finishes counting time.
Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description
Period 1: When the IN turns ON, the Tl and Q turn ON simultaneously, and the ET starts
counting.
Period 2: When the ET equals to PT, the Tl and Q turn OFF simultaneously. Since IN is turned
OFF when counting time, the ET is reset to 0.
Period 3: When the IN turns ON, the Tl and Q turn ON simultaneously, and the ET starts
counting.
Period 4: When the ET equals the PT, the Tl and Q turn OFF simultaneously.
® Accumulated ON delay

Mode Register
" | | I_ Input bit (IN): The main switch of Timer.
Measurement bit (TI): Turns ON when the Timer
Tl i IqF'TFI Bl b begins counting time.
|_| Output bit (Q): Turns ON when the Timer finishes
| | counting time.
1 2 3 45 6 7 Preset time (PT): Presets a time before the Timer
begins counting time.
Elapsed time (ET): Displays the elapsed time.
Reset bit (R): Resets ET to O

Description

Period 1: When the IN turns ON, the Tl turns ON and the elapsed time ET starts counting, the
Q remains OFF.

Period 2: When the IN turns OFF, if the ET doesn’t reach the PT, the Tl turns OFF, and at the
same time the Q remains OFF. The ET is in the retentive state.

Period 3: When the IN turns ON, the Tl turns ON. The timer measurement starts again and
the ET starts counting from the kept value. The Q remains OFF.

Period 4: When the ET reaches the PT, the Tl turns OFF and the Q turns ON.

Period 5: When the IN turns OFF, the Q turns OFF. Turning ON the reset bit R will reset the ET
to 0, and then the reset bit turns OFF.
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® Accumulated OFF delay

Mode Register
— R Input bit (IN): The main switch of Timer.
'"'I_I— —l_l— m _I_L Measurement bit (T1): Turns ON when the Timer
Ti+ PT J BT I begins counting time.
R4 ; 110 Output bit (Q): Turns OFF when the Timer finishes
Q- counting time.

12383 o B Preset time (PT): Presets a time before the Timer

begins counting.

Elapsed time (ET): Displays the elapsed time.
Reset bit (R): Resets ETto 0

Description

Period 1: When the IN turns ON, the Tl remains OFF and the Q turns ON.

Period 2: When the IN turns OFF, the Tl turns ON and the Q remains ON. The ET starts
counting.

Period 3: When the IN turns ON, the Tl and Q remain ON, and the ET is in the retentive state.
Period 4: When the IN turns OFF again, the ET starts counting from the kept value.

Period 5: When the ET equals to the PT, the Tl and Q turn OFF simultaneously. Turning ON
the reset bit R will reset the ET to 0, and then the reset bit turns OFF.

A

Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.31. VideoIn

13.31.1. Overview

HMI provides the video In feature that enables users to monitor sites with cameras. The
images/video can also be stored in external devices for further analysis. Sampling applications

include site monitoring, or vehicle/building surveillance...etc.
The following tables show the video input and image capturing behaviors for different models.

cMT-FHD
Other
Model iP iE eMT mTV XE cMT-SVR | cMT-FHDX
cMT/cMTX
cMT-HDM
IP Camera N/A N/A Y N/A Y N/A Y Y
Supported USB Camera N/A N/A Y Y Y N/A Y Y
device type eMT3121A
Video Input N/A N/A N/A N/A N/A N/A N/A
eMT3151A
cMT / cMT X Series — Image Capture/
Model Non-cMT Series — Image Capture
Video Recording
IP Camera Image Capture: one image is captured
at the trigger moment.
Image One image is captured at the trigger moment. Video Recording: video is recorded, for
USB Camera
Capturing a pre-determined duration, around the
trigger moment.
Video Input Several images are captured around the trigger moment.

13.31.2. Configuration

]

Click the Video In icon on the toolbar to open the property dialog box. Set up the properties,

press OK button, and a new Video In object will be created.
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General Tab

eMT, iE, XE, mTV Series
Video Input

USB Camera

Start/stop input : LW-0
Pause : LW-1
RTSP : LW-2 (64 words)

* URL will be reloaded from RTSP address after object restarts.

* [IP Camera] requires OS version 20160411 or later.

o J[ cancel [

Help

|

I__I WE!NTEK

New Video In (USB Camera) X ‘ l New Video In (USB Camera) X
General || General |
| |
Comment ‘ Comment : |
‘ |
O USB Camera O1IP Camera © Video Input © USB Camera O Video Input ()
;» # [USB Camera] can only be used in landscape (horizontal) mode. i
+Set LB-12356 to enable web streaming, and then use web browser to view live video
Erida i W :::"r: USB camera. Note that [Video input (USB camera)] cannot be used at the same
Capture Capture
@ Enable @ Enable
Device: Local HMI vl @ G Device:  Local HMI vl <& &
Address: LB v 0 Address: L8
Storage medium Storage medium
O UsB disk OSD card O 5D card
Record time
Before: 1 seconds After: 1 seconds
Control Control
B cEnable @ Enable
@ Display adjustment
Device: Local HMI v @ Q Device: Local HMI ot <3 I
Address: LW -0 [ [16-bit Unsigned Address: LW [16-bit Unsigned
Start/stop input : LW-0 Start/stop input : LW-0
Pause : LW-1
Contrast adjustment : LW-2
Bright adjustment : LW-3
# [USB Camera] with [Pause Control] requires OS version 20170214 or later.
ok ][ concel J[_ b ]| J[ ol J[ v ]
New Video In (USB Camera) X
General |
Comment
O USB Camera © P Camera O Video Input (i ]
RTSP: //
[ Streaming over TCP
Capture
@ Enable
Device : Local HMI v <s J
Address: LB |0
Storage medium
QO uss disk O D card
Control
@ Enable
@ Dynamic RTSP URL
Device: Local HMI v (e} J
Address: LW ~|lo [16-bit Unsigned
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cMT, cMT X Series

USB Camera IP Camera
‘ New Video In (USB Camera) X ‘ | New Video In (USB Camera) X
| General | | General |
1 Comment : o Comment
© USB Camera OIP Camera [+ | (O USB Camera © P Camera [ ]
* [USB Cameral can only be used in landscape (horizontal) mode. | RTSP://
+Set LB-12356 to enable web streaming, and then use web browser to view live video
from USB camera. Note that [Video input (USB camera)] cannot be used at the same Buffering: 500 2 ms
time. .
Capture Capture
@ Enable Enable
Device : Local HMI v ] o Device : Local HMI v - 3
Address: LB v 0 Address: LB v 0
Record format Record format
© Video Olmage O Video Olmage
Storage medium Storage medium
© USB disk 1 (O USB disk 2 O UsBdisk 1 (O USB disk 2
Record time Record time
Before: 60 2 seconds After: 60 2 seconds Before: 60 2 seconds After: 60 2| seconds
Control Control
Enable 8 Use pause control @ Enable Use pause control
(@ Dynamic RTSP URL
Device: Local HMI v ] e Device : Local HMI b & <
Address: LW vl 0 16-bit Unsigned Address: LW v 0 16-bit Unsigned
Start/stop input : LW-0 Start/stop input : LW-0
Pause : LW-1 Pause : LW-1
RTSP : LW-2 (64 words)
| *URL will be reloaded from RTSP address after object restarts.
* [USB Camera] with [Pause Control] requires OS version 20170214 or later. *[IP Camera] requires OS version 20200929 or later.
[Cox [ concal ][ neo | ([ox J[ concel J[ Hep ]
1 |
Setting Description
Input channel Select the Video Input channel from channel 1 or channel 2.
(Analog video systems)
Encode .
¢ Select the format from NTSC or PAL. (Analog video systems)
ormat

RTSP Enter the IP camera’s RTSP address.
When account and password are required for accessing the IP
Camera, an RTSP address with credentials embedded can be used.
For example:
admin:admin@192.168.1.119:554/cam/realmonitor?channel=1&subtype=0
Streaming over TCP

Select this check box to stream video over TCP.

Buffering This setting allows adjustment of the buffering time between 200
milliseconds and 5 seconds to provide more stable video playback

when the network is unstable.

Capture Select [Use capture function] check box and configure the settings.
address A non-cMT model can capture images while a cMT / cMT X model
not only can capture images but also can record an avi video from n

seconds before to n seconds after the triggering time of the
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designated address.

Capture address

Designate the address that triggers image capturing.
Storage medium

Designate the storage device.

Information about storage type and input type:

Input Type Storage Type
Analog Input | SD card or USB disk.
USB Camera | SD card only. Exception: cMT3092X
IP Camera SD card or USB disk.
Record time (cMT / cMT X Series)
The camera records the video from and to the specified recording

time (n seconds before and after the triggering time of the
designated address). The video is then saved to the specified
storage device. Please note that after the video is recorded, the
HMI may take a while to compress the video. The time needed for
compressing the video may differ between models depending on
CPU performance. A red dot appears in the object indicating that
recording or compressing is in progress. The HMI will not record
the next video during compression.
Record time (eMT Series)
Set a period of time to capture the images.

System Method

Analog video ® The longest period can be set from 10

system seconds before triggering [Capture address]
to 10 seconds after triggering.

® The time interval of image capturing is once
every second.

® The captured .jpg file will be named in the
following format:
Before or after [Capture address] is
triggered: YYYYMMDDhhmmss.jpg
The moment that [Capture address] is
triggered: YYYYMMDDhhmmss@.jpg

For example, set [Record time] “Before” and “After”

to “5” seconds. When the state of [Capture address]

changes from OFF to ON, the system will start

capturing one image per second, from 5 seconds

I__| WE!NTEK EasyBuilder Pro V6.10.01



Objects 13-239

before the triggering time to 5 seconds after the
triggering time, which is 11 images in total including
the one captured at the triggering moment.

USB Only the image of the triggering moment is

Camera captured. The name format:
YYYYMMDDhhmmess.png.

IP Camera Only the image of the triggering moment is

captured. The naming format:
YYYYMMDDhhmmss.png.

¥

= Click the icon to download the demo project. Please confirm your

internet connection before downloading the demo project.

Control If enabled, enter certain value to the control address and the
address following addresses can control Video Input object. For example, if
the designated control address is LW-n (n is any address), enter
certain value to the designated addresses will execute commands
as the following table.
Analog Video Systems

Address | Value | Command

LW-n 0 Stop displaying image

1 Open channel 1 and display the
image on HMI

2 Open channel 2 and display the
image on HMI

3 Open channel 1 but don’t display the
image on HMI (Capture function
operable)

4 Open channel 2 but don’t display the
image on HMI (Capture function
operable)

(W-n+1 |1 Pause / resume the video

LW-n+2 | 1~100 | Adjust the contrast ratio
(Analog video systems only)
LW-n+3 | 1~100 | Adjust the brightness
(Analog video systems only)
USB Camera / IP Camera

Address | Value | Command

LW-n 0 Stop displaying image
1 Start displaying image
(W-n+1 |1 Pause / resume the video
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LW-n+2 | string | RTSP address for IP camera (64
words)

@® After changing the value in [Control address (LW-n)], the
system will keep the new value.

® After changing the value in [Control address + 1 (LW-n+1)],
the system will execute the command and then reset the
value to 0.

® If [Use control function] check box is not selected, the system
will play the image of the selected channel.

® [f [Display adjustment] check box is selected, the contrast
ratio and brightness can be adjusted. (Analog video systems)

0 Note

B Only one channel can be opened at a time, regardless of the type of camera used.

About analog video systems:
B Real-time images can still be captured when Video In is paused.
B Recommended analog video systems and resolutions:

1:1 50%
NTSC 720 x 480 360 x 240
PAL 720 x 576 360 x 288

¥

s Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

About cMT / cMT X Series Video Recording

B Compressing the recorded video may take a period of time depending on the video
length.

B When HMI is compressing a video, it will not record new video even if the designated
address is triggered.

About USB Camera:

B USB camera cannot be viewed on cMT Viewer.

B When the USB Camera is disconnected during video playing, video will not resume when
camera is connected again. If [Control address] is used in the project, please use the
control address to stop and restart video. If [Control address] is not used, switch to
another screen and then return, or restart HMI in order to resume the video.

B The maximum size of Video In object of eMT3070A is 340*240, as for eMT3105P,
eMT3120A, eMT3150A, XE, and mTV Series, the maximum size of Video in object is
640*480.

B When using a USB Camera, the display resolution of the run-time video is determined by
the resolution supported by the USB Camera that is closest to the size of the object. The
resolution supported by the USB Camera may not be identical to the size of the object.
Therefore, it is good practice to adjust the size of object according to the actual resolution
of the video.
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B When using a USB Camera, the right and bottom edge of the Video In object will keep a
distance of 50 pixels away from the window edge to prevent the run-time video from
exceeding the window.

B When using a USB Camera, the background color of Video In object is black. If the
resolution of the run-time video is smaller than the object, the empty area is colored
black. Therefore, it is good practice to adjust the size of object according to the actual
resolution of the video. The tested and available USB Cameras are: Logitech C170,
Logitech C310, Logitech €910, LifeCam VX-2000.

El Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

-!.- Click the icon to download the demo project. Please confirm your internet connection
before downloading the demo project.

About IP Camera:

B Viewing IP camera on cMT Viewer may be possible on a Windows PC, provided that
appropriate third-party codecs are used.

B As compatibility may vary, testing with an actual device is recommended.

B ARTSP address is required for using IP camera. The RTSP address can be found in the
configuration tool of the IP camera, or possibly from an online repository.

B When the IP Camera is disconnected during video streaming, video will not resume when
the camera is connected again. If [Control address] is used in the project, please use the
control address to stop and restart video. If [Control address] is not used, switch to
another screen and then return, or restart HMI in order to resume the video.

B When using an IP camera, the display resolution of the run-time video will be same as
that of the object drawn in the EasyBuilder Pro project. If the actual video resolution is
different from the size of the object, the resolution will be adjusted to fit the object,
which may cause distortion of video image. Therefore, it is good practice to adjust the size
of object according to the actual resolution of the video.

B Use the IP cameras that comply with ONVIF standard, and use RTSP for video streaming.

B To ensure the quality and smoothness of the video, and not to affect HMI’s general
performance, adjust the settings of IP camera when video lags or high CPU loading is
observed. As the project complexity and hardware specs vary from one case to another,
please fine-tune the video parameters accordingly.

B Recommended video specification:

Resolution 960x544 (max.)
Format H.264, MJPEG
Refresh Rate 15 fps
Transmission Speed 800kbps (max.)

|!| Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.32. System Message

13.32.1. Overview

If objects use [Display confirmation request] or [local HMI supports monitor function only] is

turned on/off, the corresponding messages configured here will be displayed in pop-up

message boxes.

13.32.2. Configuration

Click the System Message icon on the toolbar to open the setting dialog box.

System Message

System Message

Confirmation required
Dialog size : @ Small ) Middle () Large

Message : Please confirm the operation

Use label library

oK: 0K

Use fabel library

Cancel : Cancel

Use fabel library

Font : Aril
Deny write-command
Message : The system is being prohibited from writing device registers!
Font : Aril
Use label library

Allow write-command
Message : The system is now allowed to write device registers.

13-242

Font : Aril
Use kbel library
0K | | Cancel
Setting Description
Dialog Size Select the size for pop-up window and texts.
Confirmation If an object uses [Display confirmation request], this message
required would pop up when the object is used. [Message] shown on
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confirmation dialog box, and the text label of the 2 buttons, [OK]
and [Cancel], can be set. Please use the same font for the labels of
[Message], [OK] and [Cancel]. Additionally, only when selecting
[Label Library] for [Message], the use of Label Library for [OK] and
[Cancel] buttons can be enabled.

Deny write- Displays when system tag LB-9196 (local HMI supports monitor
command function only) is turned ON.
Allow write- Displays when system tag LB-9196 (local HMI supports monitor
command function only) is turned OFF.
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13.33. Recipe View

13.33.1. Overview

13-244

Recipe View object can be used to display a specific recipe. All items and values of the recipe

can be viewed by using this object.

13.33.2. Configuration

Click the Recipe View icon on the toolbar to open a Recipe View object property dialog box. Set

up the properties, press OK button, and a new Recipe View object will be created.

General Tab

cMT / cMT X Series eMT, iE, XE, mTV Series
New Recipe View Object (3] Recipe View Object's Properties
General | Security | Shape [ Font | General | Security | Shape | Font | Profile |
Comment : Comment : ™
[7] Filter enabled [7] Refresh data automatically
| <o i
[T Allow in-cell editing Recipe table
Recipe name : |123 b2
Default sort method
Item name Display
1 Newltem ) @] Enable
sy
) Ascending @ Descending
Default sort method
[¥] Ensble Title
profile
Caption F - [l ] B d :
[¥] Use caption rame : __v ackground :
[7] Enable
Name .
R Covtin color: | .|
Selection control
Color: |- S g fha
(o (o J[ oo ]
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The name of each part of the Recipe View object is shown in the following figure.

Title-
Green Part
X
Selection
11.11 66.66 1111 [AAAA «— control-
profile- 22.22 77.77 2222 BBBB Pink Part
Frame and 33.33 88.88 3333 CCCC
Background color ||44.44 99.99 4444 DDDD
5555 |12.34 5555 EEEE
Grid-
dividing line

Setting

Description

Filter enabled

When selected, entering keywords in Recipe View to search for
specific text is possible.

Allow in-cell
editing

When selected, editing Recipe Database directly in Recipe View is
possible.

Refresh data
automatically

When selected, the system will automatically refresh Recipe View
when recipe is changed; otherwise, Recipe View will be refreshed
after window change.

Recipe table

Recipe name

Choose the recipe name or look for other recipes from the drop-
down list.

Display

Choose an item to be displayed by selecting its checkbox.

Default sort

Configure how the items are sorted. [Ascending] and [Descending]

method can be selected.
Style
(cMT / cMT X Available styles are: Default, Crystal, and Flat.
Series only)
Caption With [Use caption] enabled, the text, font size, color, and name of
(cMT / cMT X the caption can be specified. (Use caption is only available when
Series only) the selected style is Crystal or Flat.)
Title The item name assigned in [Data/History] » [Recipe Database].
Transparent
If selected, the title row has no shading; the color selection is not
available.
Profile The frame and background color of the object can be set.
Transparent
Select to hide the background, the color selection is not available.
Grid The dividing lines between columns and rows.

Enable

Select to show the grid.

Auto fit short column (cMT / cMT X Series Default style)

The column width automatically adjusts to the size of the content.
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Selection
Control

Shading color of the selected row.

0 Note

B There are 4 system registers that can be used to view/update/add/delete recipe database:

Selection

Current selection of record in Recipe View object, and it is numbered from zero. If the first

record is chosen, the value of Selection will be 0. When the value of Selection is changed,

the corresponding values will be updated, such as “No”, “Timer_1", “Timer_2", as shown

in the following figure.

Count

Show the number of records in current recipe.

Command

Numeric Input Object's Properties @
General |Daia Entry | Mumeric Format I Security | Shape | Font | Proﬁlel
Description @
[CIreadjvirite use different addresses
Read address
PLC name : | Local HMI | [ setting..
Address : [RECIPE Selechon v
v Recipe_Solar b | v | Selection
Count
Command
Result
Motification No
[T Enable Timer_1
Timer_2
Timer_3
Timer_4
Speed

™Y

Enter certain value will send command to the selected record.

Enter “1”:
Enter “2”:
Enter “3”:
Enter “4”:
Enter “5”:

Enter “6”:

Result

Add a new recipe record.

Update the selected recipe record.
Delete the selected recipe record.
Delete all recipe records.

Write the selected recipe record to PLC.

Update the recipe record selected from PLC.

View the result of executing commands.

Displays “1”: Command successfully executed.
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Displays “2”: The selected record does not exist.

Displays “4”: Unknown command.

Displays “8”: Records reach limit (10000 records), no new records can be added.
Display “16”: Another command is being executed.

Display “32”: Transfer command failed.

C?Please go to [Data/History] » [Recipe Database] tab to create the recipe data before
using Recipe View object. See “24 Recipe Editor”.
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Example 1
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In this example, a recipe database is created to be displayed by Recipe View object. When you

select a recipe record on Recipe View object, the value of [Selection] and the corresponding

values will change accordingly. When finish designing, you can modify the recipe database by

entering a value in [Command].

Simple Recipe View & Recipe Database

No  Name  Timer_1 Timer_2 Timer_3 Timer_4

0 Mercury 10 1 11 12 26,500
I Venus 20 1 21 22 33500
2 Mars 30 2 32 35 41500
3 Jupiter 50 3 53 56 50500
4 Sawm 80 5 85 30 50500

Sveterm Registers:

Selection:‘ 2 | Count:‘ 3 |Command:‘ 0 |Resu1t:‘ 1 |
Selected records: (modify here)
No. Name:
|2 | |Mars |
Timer_1: Timer_z: Timer_=: Timer_o: Speed:
ENRE [ 32 ||ss | |a1500
1. Create a recipe as shown in the following figure.
Recipe Database
Definition |Data | System Registers |
Recipes List :
Recipes Z9[E3 Ttemn name Data type Size  Display width Decimal Pt. Alignment
1. Recipe_Solar No 16-bit Unsigned 1 5 0 Left
Name ASCII 10 8 0 Left
Name_1 32-bit Signed 2 8 0 Left
Name_2 32-bit Signed 2 8 0 Left
Name_3 32-bit Signed 2 8 0 Left
Name_4 32-bit Signed 2 8 0 Left
Speed 32-bit Float 2 8 3 Left
A
v
[ Import... ][ Expont... J New Delete Sethings
[7] Prohibit recipe database update from remote HMI (or set LB-12363 on)
* Atmost 100 items in one recipe are recommended. More items might reduce the performance of HMI.
[ OK J [ Cancel ] [ Help ]
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2. In Data tab create a number of records as shown in the following figure.

Recipe Database @
| Definition | Date | System Registers
Recipes List :
[Recipe Solar (&) ] No Name Newlternl Newltemn2 Newltern
1 0 Testl 10 11 0
2 1 Test2 20 21 0
3 2 Test3 30 0 0
4 3 Testd 50 0 0
5 4 Test5 60 0 0
&
v
< i L
New Delet
[ OK I I Cancel ] [ Help ]

3. Create a Recipe View object and use the recipe database created in the preceding steps.

4. Create 4 Numeric objects using registers “Selection”, “Count”, “Command”, and “Result”.

5. Create corresponding input objects for “No”, “Name”, “Timer_1", ..., “Timer_4", “Speed”.
For example, “Name” is an ASCII item with size “10”. Create an ASCIl object and set

device type to “RECIPE” » “Name”.

Read address

PLZ name : [Lacal HMI W Setting. ..

Address 1 |RECIPE

6. The project is then completed.

7. Asshown above, “Mars” is selected and the corresponding items are also updated. There
are 5 records so the “Count” displays “5”. Try selecting different rows of the Recipe View
object. Fields “Name”, “Timer_1", ...will change accordingly.

8. Try the following operations:

® Add:
To add current data as a new record, enter “1” in “Command”.
® Update:

To update recipe database, enter “2” in “Command”.
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® Delete:

To delete the selected record, enter “3” in “Command”.
® Sort the items.
® Click the title to change the order.
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Example 2

In this example, [RECIPE_Bit] can be used to read / write individual bits of Recipe data.
Although BOOL type items cannot be added to Recipe Database, individual bit access of 16bit /
32bit data is possible.

As shown in the following figure, select [RECIPE_Bit] for the read address of Bit object and
point to the target item, and then the available Bit selections will be displayed. In this manner,

Recipe Database can be used to record, read, and write bit data.

Recipes List :
Recipes H}.‘ F Tten narmne Diata type Jize Display width Decimal Pt. B Ligment
e ‘ e 16-bit Unsigned |1 5 ] Align left
B A-mt Unsgned 2 5 0 Align left
z 32-bit Unsigned 2 5 1} Align left
Read address
PLC name ! | Local HMI v || Settings...
Address | | RECIPE_Rit vl Helechon-0 -
myRecipe » Selection »
[_IInvert signal Count »
Command 3
Result 3
| A v 0
B 2 1
C » 2
3
4
5
B
7

= o
]

ey
oW o=

—
%]
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13.34. Flow Block

13.34.1. Overview

Flow Block object displays the flow status of the blocks in the pipe or the status of the
transportation lines. Unlike Moving Shape object which requires a precise measurement
between two points when drawing a straight line provided by users, the blocks flow at a fixed
interval in a horizontal or vertical straight line. For cMT / cMT X Series models, drawing non-
horizontal and non-vertical lines is possible.

The features of Flow Block:
® Each section of the Flow Block must be a horizontal or vertical straight line and the blocks
flow at a fixed interval within it. For cMT / cMT X Series models, drawing non-horizontal

and non-vertical lines is possible (angle limit: 5 degrees).
® Dynamic speed and direction adjustment (Speed and direction can be controlled by a

designated register.
® Security mechanism (Interlock), which hides Flow Block when the status of designated bit

is invalid.

13.34.2. Configuration

Bz

Click on the Flow Block icon on the toolbar or select [Objects] » [Animation] » [Flow Block] to

create object.

General Tab
Flow block Object's Properties
EJ@H@E[ Security |
Comment :
Flow speed
[T]Reverse direction
[T pynamic speed
Flow speed : [5 -
Setting Description
Reverse The blocks flow in the direction the object is drawn (the blue
direction arrow). If select this check box, the blocks flow in the opposite
direction.
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Flow-direction

>

1

Reversedirection

Dynamic Read address

speed The direction and speed at which the blocks flow can be controlled
by a designated register. The valid rage is -25 to 25. When a
negative value is entered, the blocks flow in a reversed direction.
Setting
Displays the address and format of the designated register. [System
register], [Index register], and [Tag Library] can be set here.

Flow speed 25 flow speed levels, the valid range is 0 to 25 when [Dynamic
speed] is not selected. A larger value indicates a faster speed.

Outline Tab
For setting the outline property of Flow Block. The following illustration shows each item.

Pipe Background Color

PipeBorder Widt
Pipe
. Width
Pipe
Border
Color

Block " Block Block Block
Inter-  Length Width Color
val
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Flow block Object's Properties

| General | Outline | Security |

o Pipe

emny N a—
¥

)

¥

¥

[V Border
Width : 2—.]
B Color: [ I -
‘IDIDDL‘

! Background

Color - ()

Block
Style : | Arrow v

Width: [15 -
Length: |20 v

Interval : |4 v

[V Dymamic color

Device [Local HMI v] Settings...

Address : [LW ,] 0 16-bit Unsigned

Index Color A
I 000000 |
[ it
[ fofof0 L4

[ c0clc

W 7747 il New

5 Fmanandt
« 1 » Delete

m

R R

[ OK J[ Cancel } Help
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Setting

Description

Pipe

Sets the properties of the pipe within which the blocks flow. The
background color, border width and color can be set. When the

